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1 General
Following the release of the successful software package Anadelta Software,  Anadelta
develops its series of programs for road design projects and studies, by introducing the
 Anadelta  Tessera.  Anadelta  Tessera  is  a  continually  developing  specialized
application, offering automated design  and  layout  to  simplify  and  speed  up  the  Road
Design procedure. This sophisticated software replaces the Anadelta Road Design and
takes advantage of all  elements of an existing road  design  that  were included  in the
aforementioned program.

Anadelta  Tessera  is  the  development  of  a  new  generation  series  of  programs  of
Anadelta Software.  In this series, emphasis was put on speed, user-friendly operation
and  accuracy,  thanks  to  the  new  autonomous  integrated  graphics  environment  of
Anadelta Software.

This manual covers every basic feature of Anadelta Tessera, providing examples where
appropriate. Figures, which are true copies of the screen, are given in every chapter,
enabling the user to always perform the correct operations.

Our company has made every effort so  that  the  contents of  this  manual  are  aligned
with the program. However, in a continually developing program, whose purpose  is  to
respond quickly to the ever-broadenings needs and demands of the customers, this is
not always possible.
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2 Technical Support
According to its standard policy, Anadelta Software offers you access to new versions
and any other aid that will help you learn how to use the program correctly. Especially
for Anadelta Tessera, you can download the latest version by visiting the updated site
of our company, in the electronic address www.anadelta.com.

We hope that the continuous and essential technical support offered by our company
will  cover  any  gaps  that  may  exist  in  the  manual,  especially  regarding  the  new
features of the program. Our permanent goal is a substantial cooperation  with  all  our
long-term customers and with everyone who chooses our programs for the  first  time.
We welcome your comments and suggestions both for the manual and for the program.
We thank you all for your choice and trust.

http://www.anadelta.com
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3 Program Requirements

3.1 Software Requirements

The software runs in Windows XP or Vista environment without needing any additional
design program.
It  includes  its  own  design  environment  and  supports  all  basic  operations  of  a  CAD
(Computer Aided Design) program. 

It communicates with other CAD programs via DXF files. 

Finally, the program can print to all printers and Plotters.
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3.2 Computer System Requirements

Minimum requirements:
 Pentium 4 class processor
 512 MB of RAM
 200 MB free disk space
 CD-ROM driver for the initial installation
 USB port for the protection dongle

Recommended:
 Video  card  capable of  3D  accelerated  graphics  is  needed  for  the  photorealistic  3D
mode and video production
 1 GB of RAM
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3.3 Setup Wizard

You can install the program easily, by following the instructions of the setup wizard.

How to install Anadelta Tessera

1. Insert the program CD into the CD-ROM drive.
2. If the setup screen appears, proceed to the next step. Otherwise, in order for  the

installation of  the  program to  begin,  go  to  the  Start  menu,  select  My  Computer,
right-click on the drive where you have inserted the installation CD, select Open and
run the program.

3.When  the  initial  screen appears,  left-click  on  the  Next  button  to  proceed.  If  you
want to stop  the procedure, left-click on the Cancel button.

4. In  the  step  Choose  Components,  in  addition  to  the  main  program  that  will  be
installed, you must also select whether to install the Hardlock Drivers and the WMV
9 program,  which  enables  you to  see  the  auxiliary  videos that  are  included  in the
Help  menu  of  the  program.  Once  you  have  completed  this  step,  press  the  Next
button to proceed to the next step. If you wish to return to the previous screen to
modify your selections, press the Previous button. 

5.Specify the program installation path and press Next.
6.Press the Install button to start the installation of the program.

Once the installation is completed, Anadelta Tessera informs you accordingly, showing
the relevant message.
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3.4 Dongle Insertion

After  the  installation  and  in order  for  the  program  to  operate,  you  must  insert  the
dongle  into  the  USB  port  of  your  computer.  The  dongle  is  included  in  the  original
software package together with the installation CD.
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4 Features
When the program starts, you have two main options. You can either create a new file
and start  importing data into the  empty  file,  or  open  an  existing  Tessera  file  (.ADF
extension) or an Anadelta ROAD CONSTRUCTION file (.HOR extension). If you open an
existing  file,  all  the  selections  and  settings  that  you  have  specified  are  restored,
because such information is saved as part of the file. When you start a new file, you
must  adjust  certain  settings  that  will  help  you  during  the  file  processing.  You  can
modify these setting any time you want to.

Project Elements Import

Tessera  contains  commands that  create many  different  types  of  object,  in  order to
facilitate you during the import and processing of the performance data. The elements
for the  study of  the  terrain,  the  road  layout,  the  profile  and  the  cross-section of  a
road can be imported either  directly  into  the  program  or  collectively  through  ASCII
files, or, for most elements, from DXF files.

Error Undo

If you make a mistake while creating, processing or viewing the study, in most, if not
in all cases, you can undo it. You can undo either your last action or a number of prior
operations. If you accidentally undo an action, you can restore it.

Accurate Design

The  points  are  determined  by  specifying  their  X  and  Y  coordinates  (type  them  or
select them with the  mouse). Tessera  uses  a Cartesian coordinate  system,  both  for
the  Horizontal  Alignment  workspace  and  for  the  Profile  and  Cross-Sections
workspaces. 
You may even select  the  crosshair to  snap points  of  objects.  By  selecting  the  snap
feature, the crosshair goes from line to line and/or from point to  points.  In  this  way,
you can get accurate results without entering coordinates.

Object Properties

There are  certain properties  that  are  related to  all  objects created by Tessera.  For
most objects, you can specify the type of the drawing line (e.g. continuous, dashed or
axial), the scale of the line type, the line thickness and the colour of lines and texts.

Object Processing

Once you have entered the data of the design, you can modify the objects you have
created.  Tessera  offers  various  processing  methods  that  minimize  the  working  time
required.
You can change the properties of the objects and pan or rotate the objects within the
drawing  area.  You  can  even  delete  or  shift  individual  points  of  objects  or/and  add
points to objects. Finally, you have the option to delete or more objects.

Viewing of Objects

The two coordinate axes (an horizontal and a vertical axis) show you at any time the
exact position and the dimensions of your project at real scale.
Tessera enables  you to  change  the  project  magnification  on  your  screen.  You  can
zoom in for detailed works or zoom out the drawing image that appears in the drawing
area in order to see a larger part of the  drawing.  These  operations  are  being carried
out easily and quickly, either by using the mouse wheel or by pressing the <+> or <->
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keys respectively.

To see another part of your drawing, you can pan the  drawing  without changing  the
magnification.  You  can use the  pan  feature by using the  mouse  (click  and  hold  the
middle or the right button), the scroll  bars  or  the  left,  right,  up  and  down arrows  of
the keyboard.
All  of  the  above  will  not  affect  the  true  dimensions  of  the  drawing,  they  will  only
change the way in which the drawing is displayed on the screen.

Calculations

The  program  carries  out  automatically  the  road  calculations  in  the  Horizontal
Alignment, Profile and  Cross-Sections  once you set  the  parameters and  update  from
the other workspaces.
Also,  the  user  can  always  intervene  and  process  the  results  of  the  Horizontal
Alignment, the Profile and the Cross-Sections.
In order to communicate with other  programs,  you can export  this  data to  an  ASCII
file or to a DXF file.

Printing

You can print easily and quickly, directly from the  program,  without the  need of  any
other program. The procedure is simple. First, you specify the properties of the printer
and the  dimensions  of  the  page and  next you select  the  scale  and  the  items to  be
printed. 
By using the Print command  and  before  you proceed to  the  actual  printing,  you can
preview on the screen the image of the drawing to be printed.
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5 Start-up Guide

5.1 Program Start

Before starting a new study, you must create a new project. 

To create a new file

From the File menu, select New Project. This  command  creates  a new file  and  takes
you  to  the  Horizontal  Alignment  workspace.  An  empty  window  will  appear  on  the
screen, since you haven’t inserted any elements yet.

To import terrain points from an ASCII file

1.From  the  File  menu,  select  the  Import  from  ASCII  submenu  and  run  the  Terrain
Points command.

2.From the dialogue box that appears on the screen select the  Projects  subdirectory
and then choose one of the examples contained in this folder, e.g. Demo 1.GRD.

3.When you click Open, a dialogue box appears. Click OK in the dialogue box to import
the terrain points.

4. If you wish to bring the terrain to the screen extents, go to the  Display menu  and
select Zoom Extents.
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5.2 Calculation of Curved Perimeter

Next, you must insert a perimeter, which will demarcate the area in which the triangles
will  be created.  A perimeter  is  a zigzag  line  whose  peaks  must coincide  with  terrain
points.  Therefore,  you  cannot  insert  a  perimeter  unless  you  have  inserted  terrain
points.

How to insert a curved perimeter

From the Terrain menu, run the Calculate curved perimeter command. This command
creates  a  closed  curved  polygonal  line  that  includes  all  the  points  of  the  current
terrain.

How to automatically adjust a perimeter

1.Select the perimeter you wish to adjust.
2.Right  click  on  the  screen to  display  the  shortcut  menu.  To  add  or  delete  points,

select Adjust perimeter Expand or Shrink respectively. 
3.Tick the General checkbox if you wish to add/delete points along the  perimeter,  or

tick  the  Local  checkbox if  you  wish  to  add/delete  points  at  a  single  part  of  the
perimeter. If  you select  Local,  you  must  specify  the  width  of  the  sides  between
which the boundary will be adjusted. The default value is 7 but you can change it.
Next, you must specify the perimeter  part  that  will  be adjusted.  To do  this,  move
the mouse pointer over this part to highlight it.

4.To proceed to the adjustment, roll the mouse wheel down. The effect is cumulative,
namely more points are added or deleted as long as you keep rolling the wheel. The
effect  on  the  boundary  can be  seen  immediately  on  the  screen.  Keep  rolling  the
wheel  until  you are  satisfied  with  the  result.  If  you  wish  to  undo  the  expansion/
shrinkage, roll the mouse wheel up.

5.When  you  finish,  click  OK.  This  closes  the  dialogue  box,  takes  you  back  to  the
program window and applies the adjustment.
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5.3 Oasis Calculation

To insert an oasis, you must have  at  least  one perimeter.  The  oasis  is  used for  the
demarcation of  an  area in which  you will  create triangles  (e.g.  wherever  there  is  a
settlement or a lake). 

How to insert an oasis

From the Terrain menu, run the Insert Oasis command. This command creates an open
polygonal line that enables you to include all  the points that will  not  be used for  the
calculation of the triangles.

The  oasis  processing  features  are  the  same  as  the  ones  of  the  perimeter.  More
specifically, you can:

1.Define  circularly  the  terrain  points  that  will  compose  the  oasis  (the  mouse  snaps
automatically the terrain points).

2.Right click to finish the procedure, when you have completed the entry of points.
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5.4 Terrain Validation

Before  calculating  the  triangles,  you  must  carry  out  terrain  validation.  This  stage
(before creating triangles)  enables  the  detailed validation  of  the  points.  The  terrain
validation is performed automatically when you request triangulation, but it can also be
carried out at any given time, upon request by the user.

How to carry out terrain validation

1.From the Terrain menu, run the Terrain Validation command. The program will start
checking  the  terrain  elements.  A  bar  appears  at  the  bottom  right  corner  of  the
drawing area, showing you the validation progress.

2.When validation is completed, a dialogue box appears on the screen. In this dialogue
box,  you  can  detect  and  correct  any  errors  of  the  terrain  model.  Usually,  most
errors refer to the terrain geometry.

One of the buttons in this window can be used to show you the wrong  terrain  point,
which is highlighted on the screen.
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5.5 Calculation of Triangles

The next step for the creation of the terrain model is the calculation of triangles. First,
however, you must specify the settings of the digital terrain model by clicking Terrain
Options from the Terrain menu.

Calculation of triangles

To  calculate  the  triangles,  run  the  Calculate  Triangles  command  from  the  Terrain
menu.  The  program  will  carry  out  a  Terrain  Validation  and  if  it  doesn’t  find  any
significant  problems,  it  will  start  creating  the  terrain  model  based  on  the  inserted
points, perimeters and oases. In this procedure, the terrain points are interconnected
with straight lines in order to form triangles. To create the terrain model, the program
takes into account the perimeter and any oases that you may have inserted. 

Editing of Triangles

You  can  intervene  and  edit  the  terrain  model.  If  you  run  the  Triangles  Editing
command from the Terrain menu, you will notice that the triangles which  are  located
under  the  mouse  pointer  turn  green.  Move  the  pointer  to  the  desired  triangles  and
click to change the diagonal of the quadrilateral. In this way, you can visually edit any
anomaly  in  the  digital  terrain  model.  The  changes  you  are  making  are  shown
immediately on the screen. The review and editing is facilitated by the various ways of
presentation that the program offers for the terrain model.
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5.6 Calculation of Contour Lines

The next step of the terrain processing is the calculation of the contour lines.

The horizontal  equivalent of  the  contour  lines for  the  current  terrain  is  defined  from
the dialogue box Terrain Options of the Terrain menu. More specifically,  in  the  group
Calculate Contour Lines of the General tab, type in the text box Insert a contour line
every, the distance between two contour lines. From the same group, you can specify
the  elevation  difference  between  two contour  lines in  the  Main  contour  lines  every
text field.

How to calculate the contour lines

From the Terrain menu, run the Calculate Contour Lines command. The program starts
to create the contour lines according to the specified settings.
You  can  activate  or  deactivate  the  display  of  the  contour  lines  by  selecting  the
Options command from the Display menu.
At this point, while viewing the contour lines, it is possible to edit the terrain model in
order to get a better  view of  the  relief.  If  you wish  the  contour  lines to  reflect  the
results of the editing, you must repeat the calculation of the contour lines. 
You can select the way in which the contour lines will appear on the screen (zigzag or
curved).
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5.7 Insertion of Breaklines

The  purpose  of  the  Breaklines  is  the  demarcation  of  the  triangles.  These  are  also
zigzag lines, whose peaks must coincide  with  terrain  points.  During the  triangulation,
the program creates the triangles in a way that their sides coincide with the Breaklines
and never intersect them. 

Insert Breaklines with the mouse

1.From the Terrain menu, select Insert Breaklines. The pointer turns into a crosshair
and snaps only terrain points.

2.Define successively the terrain points that will comprise  the  Breakline.  If  you wish,
the program can include automatically the points that lie between the previous point
and the point that you define. Thus, when the crosshair snaps a terrain  point,  the
screen will display the points that will be included in the breakline.

3.When you have finished the insertion of points, right click to end the procedure.
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5.8 Road Insertion

In  order to  insert  a new road,  first  you must specify  the  coordinates  of  its  PIs  and
then the geometric characteristics of each PI.

How to insert the PIs of a road

1.From  the  Road  Design  menu,  select  the  Insert  road  command.  The  highlighted
square in the middle of  the  mouse  cross shows  you the  spot where the  PI  will  be
placed.

2.By using the mouse, define in ascending  order the  position  of  the  PI  of  the  road’s
tangent curve, from the beginning towards the end of the road.

3.When you have finished the insertion of PIs, right click to end the procedure.

How to define the road preferences 

1.Select the desired road. From the Road Design menu, select Road Preferences.
2. From  the  dialogue  box  of  the  Road  Preferences  command,  activate  a  tab  and

proceed to the desired settings. 
3.When  you have  finished selecting  the  preferences,  click  OK  to  close  the  dialogue

box.

You can make settings referring to: 

· The elements of the road PIs (General, PI and Slopes tabs).
· The road widths (Widths tab).
· The  necessary  settings  for  the  calculation  of  the  superelevations  diagram  (Slopes

and Diagram tabs).
· The stationing preferences (Stationing and Terrain Sampling).
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5.9 Road Calculation - PI Data

To  calculate  the  road,  you  must  go  to  the  Road  Design  menu  and  run  the  Road
Calculation command. 
After you have inserted all  the PIs of the tangent curve of a road  in order to  enable
the calculation of the road, the next step is to specify the data of each PI.

How to insert the data of a road’s PI

1.Select the road you wish to process.
2.Select the PI you wish to process.
3.Right click on the selected PI to display the shortcut menu and choose Properties.
4. From the Properties window select the value of  the  PI  Data.  Click  the  button with

the three dots that is displayed when selecting the box.
5. In the resulting window you can modify the data of the relevant PI.
6.Click OK to confirm the changes or click Cancel to restore the original settings.
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5.10 Widenings

The widening of a pavement is the increase or decrease of the  pavement  semi-width
either  on  its  left  or  on  its  right  side.  By  using  the  widenings  you  can  modify  the
roadlines of the pavement. 

Insertion and editing of pavement widening

Select the road you wish  to  insert  for  widening. From the  Road  Design  menu,  select
Widenings and then select Pavement Widening.

The  program creates  a movable  drawing  of  the  widening,  which  is  identified  by  the
position of a yellow  triangle.  By  using the  mouse,  you can also  specify  the  roadside
that  will  be  widened.  Select  the  appropriate  position  and  left  click  to  insert  the
widening. 

Next, select the widening and from the shortcut menu select Properties.
In the fields of this window you can edit the value of the chainage where the widening
will be inserted, and set  the  width  of  the  widening, which  can be either  positive  for
moving away from the road axis or negative for moving towards the road axis. In  the
other fields, you can set the length of the widening, as  well  as  the  first  and  second
curvature radii respectively. 
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5.11 Stationing

Stationing  can  take  place  after  the  calculation  of  the  road.  Stationing  is  the
calculation and insertion of stations according to the preferences that you specify by
using the Road Preferences command from the Stationing tab. By default, the program
inserts  stations  at  the  beginning  and  at  the  end  of  the  road,  as  well  as  at  the
beginning  and  at  the  end  of  every  curve  (stations  TS and  ST).  You  may,  however,
insert  stations  at  the  other  characteristic  points  of  the  curves,  such  as  at  the
beginning and at the end of the circular arcs (stations CS and  SC),  at  the  centre  of
the circular  arc  (stations  CC)  and  at  the  vertical  from circle’s  centre  to  the  curve’s
centre (stations CP and PC).

The  first  station  of  the  road  is  the  POB  station,  while  the  last  station  is  the  POE
station.  A composite  name is  assigned  to  the  characteristic  stations  of  each  curve.
This name is comprised of one letter (TS, CP, CS, CC, SC,  PC,  ST) and  one number,
which is identified with the numbering of the respective PI (e.g. TS1, CP1 for PI1). The
names of  the  remaining,  non-characteristic  stations  derive  from  a  serial  numbering,
starting from the number that you have assigned.

Automatic insertion of stations

From the Road Design  menu,  select  Stationing.  The  program will  calculate  and  insert
the stations according to the aforementioned preferences.

Insertion of a new station

To  insert  a  new  station,  go  to  the  Road  Design  menu,  select  Stationing  and  then
select  New  Station.  You  will  see  a  green  line,  which  is  vertical  to  the  axis  of  the
selected road. Every time you move the mouse, this line also moves to the position of
the mouse pointer. Select the appropriate position and click the left mouse button to
insert the station. To specify the accurate chainage and the name of the station that
you  have  inserted,  select  the  station  (by  right-clicking  over  it)  and  then  select
Properties. Repeat the procedures for all stations you wish to add.

Delete a station

Select  the  station  you wish  to  delete,  right-click to  display  the  shortcut  menu  and
then select Delete station.

You can also delete all stations of a road. To do that, select the road, go to the Road
Design menu, then to the Stationing submenu and then select Delete stations. 
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5.12 Profile Update

The communication between the three workspaces and the transfer of data from one
workspace  to  the  other  is  performed from the  Project  management  dialogue  box.  If
you wish to request the creation of the road profile and cross-sections based on  the
road data, you must proceed to the relevant updates. When updating from Horizontal
Alignment to Profile, the program will transfer the following data: 

· Terrain Update: the chainage and the name of every cross-section,  as  well  as  the
elevation of the natural ground at the axis of the cross-section.

· Update Diagrams:  transfers  the  diagrams  of  the  left  and  right  superelevations,  as
well as the diagram of tangent curves.

· Update road profile: the road profile (if any) is copied as a road profile tangent.

When  update  is  completed,  the  profile  will  include  the  cross-sections  of  the  project
and their chainages, as well as the elevation of the natural ground.
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5.13 Tangent Curve Creation

The next step in the design of the Profile is the insertion and  processing  of  the  road
tangent, in order to determine the elevation of the road profile.

You can create one or more tangent curves by defining its PIs.

How to create a tangent curve with the mouse

1.From the Profile menu, select Insert Tangent Curve.
2.By  using  the  mouse,  define  the  positions  of  the  Tangent  Curve  Pis  within  the

drawing area.
3.When you have finished, press Esc or right  click  at  any part  of  the  screen to  end

the procedure.

At this stage, you can see on your screen the tangent, which is displayed  in red,  as
well  as the road profile elevations. You  can also  see  the  road  profile,  if  the  program
could  estimate  it  with  the  current  values  of  the  rounding  radii  of  the  tangent  PIs,
which have  a default  value.  If  you wish  to  change the  original  default  value  of  the
rounding radii, go to the Profile menu, select Road Properties and change the value in
the PI initial radius text field.
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5.14 Cross Sections Update

You can update  the  cross  sections  from  the  Horizontal  Alignment  workspace.  More
specifically:

1.From the Project menu, run the Project Management command.
2.For  a  quick  update,  from  the  Update  group,  select  the  item  From  Horizontal

Alignment to Cross Sections.
3. In the box that appears below, you can select the items that you wish to update.
4.Click Update.
5.Click OK to close the dialogue box.

After  you  have  completed  the  update  of  the  Cross  Sections  from  the  Horizontal
Alignment, you must update the Cross Sections from the Profile, in order to have the
roadway elevation for every cross section.  To do  that,  go  to  the  File  menu and  run
the Update from Profile command.

When  updating  from  the  Horizontal  Alignment  to  Cross  Sections,  the  program  will
transfer the following data: 

· Terrain Update: the chainage and the name of every cross section,  as  well  as  the
line of the natural ground on both sides of the cross section axis. The points at the
line of the natural ground, as they result from the intersection of the profile axis with
the triangles of the terrain model. To set the length of the natural ground line, go to
the  Terrain Sampling  tab,  select  the  Road  Preferences  command  and  enter  in the
appropriate fields of the dialogue box the values for the left and right sides. If there
is no terrain model, you can alternatively  request  calculation  of  cross sections.  To
do  that,  from the  Cross  section  elevation  calculation  way,  go  to  the  Calculations
tab, select the General Preferences command and in the  dialogue  box activate  the
option From stations  zone.  In  this  case, the  program creates  a natural  ground  by
projecting  on  the  cross section  axis the  points  contained  in  a  zone  around  every
cross section. You can set the length of the zone in the relevant field  of  the  Road
Preferences command, in the Terrain Sampling tab.

· Update  diagrams:  the  diagrams  that  will  be  transferred  are  those  of  the
superelevations, the semi-width, the paveway and the roadway for the left and the
right sides, as well as the  diagram of  the  tangents,  the  diagrams  of  the  road  that
already exists  on  the  left  and  on  the  right  or  the  generic  use diagrams  that  have
been created.

· Cross  Sections  Synchronization:  the  positions of  the  cross sections are  correlated
based on the  chainage  or  the  name.  The  cross section  correlation matters only  in
case  you have  already  worked  inside  the  Cross  Sections  workspace  and  want  to
update  the  road  cross  sections,  not  to  delete  them  or  create  them  from  the
beginning.

When  you  have  finished  processing  the  road  in  the  Profile  and  Cross  Sections
workspaces,  you  must  update  the  Horizontal  Alignment  in  order  to  insert  the  road
profile and to draw the roadway and sideslope lines along the road.
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5.15 Typical Tasks Import

The lines comprising each one of the cross sections that are included in the program,
are  grouped  in  families.  This  sorting  out  of  the  lines  has  a  qualitative  meaning.  It
allows every  line,  depending on  its  family,  to  locate  cross sections  and  to  calculate
areas, by using every time the proper lines. It also serves to determine how the lines
will  appear  both  on  the  screen  and  on  the  printouts,  as  well  as  to  the  absolute
parametric drawing up of the mass and paving tables.

This  standardisation  of  the  lines  (tasks)  and  the  correspondance  of  the  calculated
quantities  to  the  mass  table  columns  are  referred  to  shortly  as  Typical  Tasks.  The
determination of the  typical  tasks  is  one of  the  main  operations  of  the  program and
must be done before starting to draw the cross sections.

From  the  Parameters  menu,  run  the  Typical  Tasks  command to  open  the  window  in
which you will specify the typical tasks.

How to import typical tasks from another file

1.From the File menu, select the Import submenu and run the Typ. Tasks command.
2.The Open dialogue box appears on the screen. From the File Type  field,  select  the

type of file (*.ATE or *.ADF), then select the desired file and click Open.

Before you run this command, you must be certain that you do not need the  current
typical tasks that you are using for your project. It is advisable to export them first in
a file and then to replace them, because the import of a typical tasks file deletes the
current typical tasks and replaces them with the ones contained in the file.
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5.16 Typical Cross Sections Import

To import typical cross sections from an  external  file  into the  current  project,  go  to
Import submenu of the File menu and run the Typ. Cross Sections  command. You can
import typical cross sections either from another project of Anadelta Tessera (*.ADF),
or from a cross sections text file. 

How to import typical cross sections from another file

1.From  the  File  menu,  select  the  Import  submenu  and  run  the  Typ.  Cross  Sections
command.

2.The Open dialogue box appears on the screen. From the File Type  field,  select  the
type of file (*.ATD), then select the desired file and click Open.
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5.17 Batch Cross Section Calculation

For the program to calculate cross sections, the user or the program must first create
the main parts of the lines, then extend or remove parts of these lines so as to create
between them closed surfaces,  and  finally  measure  the  area of  these  surfaces.  The
calculation of a cross section and the setting of the calculation parameters are being
carried through the Cross Sections Data management  window. This  operation can be
carried out collectively for all cross sections of the project.

The  actions  referring  to  the  calculation  of  a  cross  section  can  be  carried  out
collectively for all  cross sections of  the  project  by running  the  Calculation  command
from the Batch Actions menu. The purpose of this command is the parameterisation of
batch  calculations  in  the  cross  sections  of  the  current  road  of  a  project.  The
calculations may also include settings of the parameters of the branches, the topsoil,
the paving, the sideslopes or/and all of the above. 

In all cases, you must click the Calculation button for the program to start the batch
calculation.  When  calculation  ends,  the  program  informs  you  on  the  results  by
displaying the relevant message in the message window at the bottom of the program
window.  Any problems  that  may  have  occurred,  appear  in  detail  inside  the  window.
Click  the  Exit  button to  close the  dialogue  box and  return  to  the  workspace  of  the
program. 
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5.18 Typical Cross Sections Editing

To  edit  a cross section,  you must set  the  gradient  of  the  sideslopes,  both  for  the
fillings  and  for  the  cuttings.  You  can  set  the  formation  of  the  sideslopes  in  the
Sideslopes tab. 

At  the  bottom of  this  tab,  you will  see  all  the  existing  sideslope  formations  for  the
current  typical  cross  section.  Every  typical  cross  section  must  have  at  least  two
sideslope formations, of which one will correspond to  the  filling  and  the  other  to  the
cutting. To create a new formation, select one of the formations that are listed in the
table (e.g. Filling 1:3, 1:2, 2:3) and click the button that corresponds to the creation
of a new set of sideslopes. A new formation, which is a duplicate of the one that you
selected, will be created on the screen (e.g. New Filling 1:3, 1:2, 2:3). To change the
name of the formation, just activate its field and type the new name. When you have
finished, press Enter to confirm the name. To delete a formation from the table, select
the desired formation and click the respective button.
Now that  you have  created the  new sideslope  gradients,  you  can  go  to  the  Cross
Sections workspace and apply these sideslopes to the cross sections that do not have
an intersection with the natural ground. 

In the Defaults group, you can set the sideslope formations that you wish to apply by
default to the  current  typical  cross section,  both  for  the  left  and  the  right  part,  as
well as for the cutting and the filling. The formations are selected from the respective
drop-down lists of this group. The selected sideslope formation is applied instantly and
appears  in  the  workspace  of  the  typical  cross  section.  The  default  sideslope
formations  are  also  applied  during  the  cross  sections  calculation,  unless  otherwise
selected in the Cross Sections Data window during the calculation of a particular cross
section or in the dialogue box of the Calculation command in the Batch  Actions  menu
during batch calculation.
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5.19 Mass Table

Run the Print mass table command from the Print menu to display the window in which
you will create the mass table.
The dialogue box that appears, has four buttons. Use these buttons to specify certain
information  that  you  wish  to  appear  on  the  mass  table.  These  buttons  are  Table
Titles, Fixed Columns, Fonts and Page Layout.

· To set the general title of the table, click the Table Titles button and type the title
in the Main Title of Mass Table text field. In the two groups that appear, enter the
left and right titles respectively. 

· You can change the names of the titles and specify titles for the axis data and the
mass haul in the window that appears when you click Fixed Columns. 

· You can select the fonts that will be used when printing the mass table, as well as
the font size and style.

· To set the layout preferences, click Page Layout.
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5.20 Export Files to DXF

You can export the contents of  the  Horizontal  Alignment  in  .DXF  format,  to  process
them in another drawing program.

How to export the Horizontal Alignment data to a DXF file

1.From the File menu, select Export to DXF.
2.Enter the name of the file in the dialogue box of the File Name field.
3. In the File Type field, select the type of the file according to the desired version, 14

or 2000.
4.Click Save to finish the creation of the file.

· You  can  export  the  data  of  the  Profile  in  DXF  format,  provided  that  you  have
activated the Profile Print Preferences from the Print menu. The export procedure is
the same that applies to the Horizontal Alignment.

· You can also export the Cross Sections data in DXF format. From the dialogue box of
the Typical Tasks command of the Parameters menu, you can select the format and
the appearance of the lines, as well as whether  some  lines will  be exported  to  the
file  with  a  layer.  The  format  and  the  number  of  all  other  elements  that  will  be
exported, are also selected from the dialogue box of the Print Preferences command
of  the  Print  menu.  Type  the  layer  names  of  every  category  of  elements  in  the
respective DXF layer text box.

How to export the Cross Sections data to a DXF file

1.From the File menu, select Export to DXF.
2.Select the desired cross sections from the dialogue box that appears on the screen.

From  the  Selected  Cross  Sections  and  Cross  Section  Selection  groups,  you  select
the cross sections that will be printed. 

3.Click the Export to DXF button. Enter the name of the file in the dialogue box of the
File Name field.

4. In the File Type field, select the type of the file according to the desired version, 14
or 2000.

5.Finally, click Save to finish the creation of the file.
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6 A First Look

6.1 Creating a New File

If you want to start a new study but you do not  have  files  of  the  Anadelta  Tessera
software package (files with the .ADF extension), you must create a new file to save
the data of your study. 

To Create a New File

From the File menu, select the New Project command or press the Ctrl+N keys or click

 the  button  on  the  main  toolbar  line.  This  command  creates  a  new  file  and
transfers you to the Horizontal Alignment workspace. An empty window will appear on
the screen, since you have not imported any elements yet. The Tessera files have an
.ADF extension.

You can also create files of the Profile and Cross Sections workspaces.
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6.2 Opening an Existing File

The Tessera files have an .ADF extension. To open an existing file, start the program
and select Open from the File menu.  You  can also  open  the  files  by "dragging"  them
from Windows Explorer and dropping them anywhere inside the Tessera window. If the
file is not a Tessera file or a Road Design file, the program shows a warning message,
informing you that you cannot open the file.

You can also start  Tessera  and  open  the  file  by double-clicking a file  from Windows
Explorer. If Tessera is already running, the file opens in a new window.

If, for any reason, the program does not  start  when you double-click a Tessera  file,
you can restore the registration by clicking  ADF files  registration  in  the  Environment
tab that you will find in the dialogue box of the General Preferences command of  the
Tools menu.

To open a new project

1.Start the program.

2.From the File menu, select Open, or press the Ctrl+O keys, or click the  button
on the main toolbar.

3. From  the  Open  dialogue  box,  go  to  the  subdirectory  that  contains  the  file,  select
the  file  and  click  the  Open  button.  The  files  that  you  can  open  in  this  way  are
Anadelta  Tessera  files  (.ADF  extension)  and  Horizontal  Alignment  files  (.HOR
extension) of the Anadelta Road Design program.

You can type the name of the file in the File  Name  field  and  then  click  Open or you
can double-click the file name in the directory of files.

Opening a Project Folder

During the installation of the program the Projects folder is created. This is the folder
where you can save your files. If you cannot find this folder, go to the Tools menu and
click Open Project File to go directly to this folder. 
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6.3 Working with Multiple Files

You can open simultaneously more than one files. To go from one file to another, left-
click the button of the respective file on the task bar  or  press  Alt+Tab.  If,  however,
you go from one window to another when a command is running, then the command is
cancelled. You cannot go from window to window when the program executes certain
operations,  e.g.  calculation  of  the  triangles.  This  feature  enables  you  to  copy  or
transfer objects from and to different files.
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6.4 Workspaces of the Program

The  program has three  workspaces:  Horizontal  Alignmet,  Profile  and Cross  Sections,
where you can process the horizontal alignment, the profile and the cross sections of
your project’s roads  respectively.  For every  project  there  is  an  Horizontal  Alignment
workspace, where you can view and edit all  roads  contained  in your  project.  On  the
contrary, the same project has as many workspaces for editing the profile or the cross
sections, as the roads that you are processing.

The Horizontal Alignment exists by default when you create a new file. The Profile and
 Cross  Sections  workspaces are  created automatically,  either  when you request  the
update of the profile or the cross sections of a road from the Horizontal Alignment, or
when you create a profile or cross sections file respectively.

This allocation facilitates the user to enter, edit and process the data of the design.

You can shift among the workspaces by pressing successively  the  Ctrl+Tab,  buttons
until you are transferred to the desired workspace. Another way is to left-click one of
the tabs at the bottom of the program window. You  can also  go  to  a workspace  by
selecting it from the Display menu.

If you don’t want the program to  display  a workspace,  go  to  the  subject  workspace
and  run  the  Close  window  command  from  the  File  menu,  or  go  to  the  Project
Management  dialogue  box  and  disable  the  relevant  check  box  from  the  Show/Hide
group.
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6.5 Getting Familiar with the Enviornment of the
Program

Upon  program  start,  the  Anadelta  Tessera  window  opens.  This  window  is  your
workspace. It contains objects that  you can use to  create and  process  your  study.
The  following  sections  describe  in  detail  one  by  one  the  objects  contained  in  the
Anadelta Tessera window.

Title Bar

This is the bar on the top of the window. On the left of this bar you can see the file

path and name. On the right, there are three buttons: 

1.The minimize button (left button) minimizes the Tessera window.
2.The middle button has a double  function.  If  the  window  occupies only  part  of  the

screen, then this button maximizes the window so as to occupy the whole screen. If
the  window  is  already  maximized,  then  this  button  restores  the  window  so  as  to
occupy only part of the screen. The functions of this button can also be performed
by double-clicking the title bar.

3.The exit button (right button) closes the program.

If you right-click on the bar, you will display the shortcut menu with the functions that
can be performed on the program window.

Menu Bar

This is the bar with the program menus. From the menu bar  you can access  most  of
the commands of the program.
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Command Bar

The command menus are lists containing the Tessera commands and  are  displayed  in
the form of frames one below the other. The usual form of a Tessera menu is shown in
the Figure:

 

Most  of  the  bar  menus  have  submenus.  The  submenus  are  displayed  when  you
activate a menu on the bar. The availability of a submenu is indicated by an arrow.

To  activate  a menu,  left-click  on  the  menu to  display  it.  Next,  to  activate  a  menu
command, place the pointer over the command  to  highlight  it  and  then  click  the  left
mouse button.

To activate the menu bar from the keyboard, press the Alt  key. To select the desired
menu, use the left and right arrow keys. Once you’ve selected the desired menu, press
 Enter to display it. Use the up and down arrow keys to scroll through the commands
and submenus until you highlight the desired one. Next, press Enter again to execute
the command or to display the submenu.

The number and content of the  menus shown on  the  program bar  vary according to
the  current  workspace.  For  example,  the  Terrain  menu  is  shown  in  the  Horizontal
Alignment workspace, while the Profile menu is  shown in the  Profile  workspace.  Also,
the  Print  menu,  which  is  common  to  both  workspaces,  displays  different  commands.
When a menu or a menu command is not available, the name of the command appears
faded.

Sometimes the icon of the button that  corresponds  to  a command  may  be displayed
on the left of the particular command. You will find this icon on one of the toolbars of
the  window. On  the  right,  you will  find  keyboard  shortcuts,  if  available,  namely  the
keys that you must press to execute the command from the keyboard,  without using
the menus.

Toolbars

Toolbars contain buttons that you can activate by clicking them with  the  left  mouse
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button. These  buttons  are  on  top,  on  the  right  and  below  the  drawing  area.  Each
button  corresponds  to  a  different  command  (the  commands  that  are  used  most
frequently). The command is activated when you click the corresponding button (left-
click on the button). Each workspace has a different toolbar.

Main Toolbar

Contains  the  most  common  commands  that  the  program  uses,  such  as  the  basic
operations New, Open and Save. It also contains the copy, cut, paste, undo and redo
commands.

The main toolbar and the commands it contains are the same for all workspaces.

Balloon Help

The Balloon Help shows  you a short  description  of  every  button.  To see  the  Balloon
Help,  move  the  mouse  pointer  over the  desired  button and  leave  it  there  for  a  few
moments.

Drop-Down Lists of Options

An arrow pointing downwards on the left border of the field indicates the presence of
a  drop-down  list.  The  arrow  is  either  displayed  permanently  or  when  the  field  is
enabled. When the list is inactive, the option shown in the field is the current one. 

To display the options list, left-click on the arrow and the list will drop down. To select
an  option,  place  the  pointer  over the  option to  highlight  it  and  click  the  left  mouse
button or press Enter. The three dots next to an  option mean  that  when you select
this option, the respective dialogue box will appear, enabling you to create a new list
option.

If  there  is  not  enough  space  in  the  list  to  show  all  of  the
available selections, you can gain 
access to all options in the box by moving the scroll bar up and
down in the options list.
To move the scroll bar,  either  left-click  the  two arrows  of  the
scroll bar or drag and drop 
the adjustment button of  the  scroll  bar.  You  can also  use the
up and down keys to scroll
through the options. 

Drawing Area

The black part of the screen is the drawing area and corresponds to a drawing paper
of  infinite  size.  The  size  of  the  drawing  area  varies  according  to  the  size  of  the
Tessera window. You cannot access  the  drawing  area when a window  or  a dialogue
box is open.
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The part of the project that will be displayed in the drawing area is not standard, but
it can be dynamically defined by the user.

Crosshair and Bounding Box

When the mouse pointer is inside the drawing area, it has the form of a crosshair. The
crosshair is  comprised  of  two intersected  lines with  a small  box at  their  intersection
point. The crosshair shows the position of the mouse pointer  inside  the  drawing  area
and  enables  you  to  place  points,  as  well  as  to  select  and  draw  objects.  When  a
command requires from you to define one or more points, the bounding box turns red
and follows the crosshair.

Scroll Bars

On the  right  and  bottom border of  the  drawing  area there  are  two bars.  Use  these
bars to move towards both directions (horizontally and vertically) inside your drawing.
Each bar has a button, whose size is proportional to the magnification percentage on
the drawing screen, always with respect to the limits of your drawing.  To move  from
one part of your project to another, simply use the mouse to drag the  button of  the
bar and drop it at the desired point.

Coordinate Axes

The coordinate axes are on the left and upper border of the drawing area. By default,
the horizontal axis is the X axis and the vertical axis is the Y axis. The step between
the indications of the axis changes dynamically according to the  magnification of  the
screen.

Status Bar

The status bar is located at the bottom of the screen and is comprised of four parts: 

· The first part shows the coordinates of the current position of the crosshair.
· The  second  part  has  a  button  that  displays  the  Input  Form,  which  is  described

below.
· Every  time  you execute  a command, the  third  part  shows  instructions  on  how  to

execute it, while when you don’t execute any command, it shows the identity of the
object under the crosshair, depending on the active statuses.

· In the Profile and Cross Sections  workspaces, the fourth part shows  information  on
the current point of the selected line.

Input Form

Many commands require from you to specify a numerical quantity (coordinates, angle,
percentage). Tessera enables you to input the quantity in two ways.  You  can either
use the mouse to select a point on the drawing area or you can type the quantity in
the relevant fields of the dialogue box of the Input Form command.

When the input form is available in the  current  command, the  middle  part  shows  the
relevant button.

The Input Form is a dialogue box, whose form depends on the command that is being
executed. Some of these forms are shown in the figure:
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How to display the input form

1.Execute the desired command until the program prompts you to  enter  the  relevant
quantity.

2.Press  Enter,  or  use the  left  mouse  button to  click  the  Input  Form  button on  the
status bar.

3.Type the quantity in the respective field/s.
4.Click OK to exit the form.

The Input Form is a dialogue box.



55A First Look

Anadelta Software

6.6 Managing the Program Window

The window of the program has the same features as any other window  of  Windows.
You can maximize it, so as to occupy the full  screen, minimize it, so as to appear as
a button on the Windows task bar, or close it. You can do all  of the above by clicking
each time the appropriate button on the title bar. You can also restore the window, so
as  to  occupy  only  part  of  the  screen.  In  this  case, you can also  move  the  window
anywhere  on  the  screen,  by  using  the  drag-and-drop  feature  after  you  have
positioned  the  mouse  pointer  anywhere on  the  title  bar.  You  can  even  change  the
window size by moving the pointer at the borders of the window (the pointer changes
into one of the forms shown below)   and by using the drag-and-drop feature.
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6.7 The Dialogue Boxes

The dialogue boxes enable you to set the program parameters. They appear when you
execute  certain  commands.  A  dialogue  box  is  comprised  of  a  box  that  has  many
objects, such as buttons, text fields, option fields, which  correspond to  settings  and
are grouped in groups and tabs.

You can select and set any item with the mouse or the keyboard. Use the Tab or the
Shift+Tab  keys  to  go  successively  from  one  field  or  button  to  the  next  or  to  the
previous one, respectively. The item surrounded by a dashed line is the  item  you are
currently using.

When  a dialogue  box is  open,  you don’t  have  access  to  the  items of  the  program’s
main  screen.  To  perform  any  action  on  the  main  screen,  first  you  must  close  the
dialogue box and return to the main screen.

To maximize, minimize or move a dialogue box, proceed as you would do in the case of
a program window.

Most dialogue boxes offer you at all  times two main possibilities. You can either close
the dialogue box and cancel the settings by clicking Cancel, or you can close the box
and accept the changes by clicking OK. 

Some dialogue boxes have only one button, the Close button. In this case, to exit the
dialogue box you must first accept the changes that you have made.

The exit button on the title bar and the Alt+F4 or Esc keys close the dialogue box, but
they  do  not  ensure  that  your  settings  will  be stored  this  depends  on  the  particular
dialogue box.

Tab

When a dialogue box includes many options, for your own convenience, these options
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are  usually grouped in  tabs.  When  you  select  a  tab,  all  options  in  this  tab  will  be
displayed in the dialogue box. The title of the tab appears on the top of the tab.

To move between tabs, use the left mouse button to click the title and  activate  the
tab. To do the same with the keyboard, activate any tab and then select the desired
tab with the left and right arrow buttons.

Group

The  options  –  settings  that  you  can  make  are  listed  in  groups  in  every  tab.  To
distinguish them visually, the groups are  surrounded  by a frame  on  the  top  of  which
they bear a distinctive title.

Buttons

The  buttons  in  a  dialogue  box  usually  display  a  new  dialogue  box  or  carry  out  an

operation. . To activate a button, simply left-click the  button (button  press)
or activate the button and press Enter.

Slide Bars

These are  comprised  of  a longitudinal  bar  with  an  adjustment  button.  Use  the  slide
bars to set the amount of a quantity.

To set the amount of a quantity, drag the button of the bar until the quantity reaches
the desired amount and then release the left mouse button. You can do the same with
the up, down, right and left arrow keys when the bar is active.

Text Fields

The text fields are rectangular boxes, usually white. In a text field you can type text
or numbers, depending on the kind of the setting. For your guidance, next to the fields
(on the right or on the left) a description of the quantity you define as well as the unit
used, are indicated.

To type inside a text  field,  first  you must activate  it.  You  can activate  the  field  by
using the keyboard or the left mouse button. In all  cases, you must first wait for the
cursor  to  appear  (a  flashing  line  inside  the  field)  or  for  the  existing  text  to  be
highlighted.

Options Lists
 

When there is a number of options in a field, usually the field
offers a list of the available options. You can also  type the
option in the current field. Activate the field with the mouse
or the  keyboard  and  then  type  the  option.  If  you  type  it
correctly,  then  the  option  will  appear  highlighted  in  the
options list. You may even select the option from the list, by
using the up and down buttons.

Preview Fields

Sometimes the options lists are linked to certain preview fields. You cannot intervene
in the preview  fields  you cannot  even  select  them with  the  mouse.  They only  show
you the result that you will get if you accept the settings that you have made.
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Drop-Down Lists

When the list field is active, you can use the up and down arrows to scroll through the
options without displaying the list.

Check boxes

Use them to choose one of the available options or to select  whether  a setting shall
apply or not. They are displayed as a circle or a box.

 A white box corresponds to every option. If  the  box is  empty  (inactive)  then  the
setting  shall  not  apply.  If  the  box  is  enabled  (ticked),  the  setting  shall  apply.  You
cannot check the disabled options, which appear gray instead of black. To activate or
deactivate a check box, left-click inside the box or select the check box and press the
 Spacebar key.

 If it is mandatory to choose one setting out of various available  settings,  you will
find these settings in the same group of a list. Next to the settings there is a circular
check box. If the circle is empty, then the corresponding setting shall  not  apply;  the
opposite occurs when the circle is active (there is a dot inside the circle). Use the up
and down arrow keys of the keyboard to select (check) the  desired  setting from the
current group of settings.
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6.8 The Windows

The execution of multiple commands results in the display of one or more windows. 

The window is a screen area that you can move, open and close, just like you would
do  in the  case  of  a  program  window.  When  you  open  more  than  one  window,  you
cannot  work  in  all  windows  at  the  same  time,  you  can  only  work  in  the  current
window.  The  program  windows  usually  contain  lists  of  fields  with  data.  In  most
windows you can change the content of the  fields.  In  the  case  of  a text  field,  left-
click to activate the field and then type a new value or text, just like you would do in
a dialogue box. There are fields where you do not have to type anything. These fields
have lists of preset values. You can choose the desired value from the relevant list. A
button with three dots (…) on the right of an active field means that when you press
this button a dialogue box shall appear.

Management Windows

These are windows that carry out a large number of operations. These windows offer
additional features  and  possibilities,  but  you can manage  them just  like  the  common
windows.

You can change collectively certain fields that belong to the same group by selecting
them all together and then adjusting the property. The settings you make for one field
shall apply to the next fields. There are also standard fields, in which usually an icon is
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displayed. To change the property that the  field  controls,  use the  mouse  to  double-
click the field.

The  management  fields  may  also  contain  buttons,  which  have  the  same  function  as
the buttons of the program main screen toolbars.
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6.9 Error - Confirmation Messages

When an operation is being carried out, Tessera communicates with you by displaying
various messages on the screen. These messages are actually special dialogue boxes,
but they do not have the same form as the common dialogue boxes.

Error – Warning Messages

These  messages  appear  either  when  an  error  has  occurred
and the program cannot continue executing the command, or
to inform you that a procedure has finished.
These dialogue  boxes  have  only  one  button  that  closes  the
box after you have read the message.

Confirmation Messages

These are displayed when you ask the program to carry out an irreversible operation.
In  this  case,  the  program  will  show  you  a  message,  asking  you  to  confirm  the
operation (Yes  or OK buttons) or  to  cancel  the  operation (Cancel  or  No  buttons)  by
clicking the relevant buttons.
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6.10 Executing Commands

In Tessera, there are three ways to select a command: 

1.You can use the mouse to choose a command from a drop-down menu or a shortcut
menu.

2.You can use the mouse to click a button on the toolbars.
3.You can press the auxiliary keys that correspond to the particular command.

To  stop  the  execution  of  a  command,  press  the  Esc  key  or  click  the  right  mouse
button.
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6.11 Using the Shortcut Menus

When  you  click  with  the  right  mouse  button  in  the  drawing  area,  shortcut  menus
appear  on  the  screen.  These  menus  enable  you  to  select  very  quickly  certain
operations.  With  certain  keyboards  you  can  also  display  the  shortcut  menus  by
pressing  the  relevant  key.  The  commands  contained  in  the  shortcut  menus  vary,
meaning that the displayed menu and its options depend on whether an item has been
selected and on the nature of this item.
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6.12 Undo and Redo of Commands

If you execute a command by mistake, in most cases you can undo it. You can undo
either only your last action or various previous operations. You  can also  redo  certain
actions that you have undone accidentally.

How to Undo a Command

From the Edit menu, click Undo, or press the Ctrl+Z keys, or click the button  on
the main toolbar. If desired, you can display the drop-down list of this button. The list
contains the commands that you have  executed  after  you last  started  the  program.
Select the commands you wish to undo.

How to Restore a Command

From  the  Edit  menu click  Redo,  or  press  the  Shift+Ctrl+Z  keys,  or  click  the  button

 on  the  main  toolbar.  If  desired,  you  can  display  the  drop-down  list  of  this
button. The list contains the commands that you have undone. Select the commands
you wish to restore.
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6.13 Specifying Points

When you execute a large number of commands, e.g. to import lines, you must specify
points. In this case, the form of the crosshair changes and the message Specify point
is shown on the status bar. This means that you must specify the X, Y  coordinates for
every point by using one of  the  available  methods  offered  by the  program.  You  can
use the mouse to specify a point by left-clicking inside the drawing area at the desired
point or you can input the absolute coordinates in the Input form.

Coordinates System

Tessera  uses  a  Cartesian  coordinate  system.  This  system  has  two  axes,  x  and  y.
When  you  input  coordinates  values,  you  specify  the  distance  (in  units)  and  the
direction (+ or -) of a point along the X,Y axes with respect to the  start  of  the  axis
(0,0). By default, X is the horizontal axis and Y is the vertical axis. When you create
boundaries, you specify the chainage and the distance from the road axis.

To View the Coordinates

The absolute coordinates for the current position of the crosshair are displayed on the
left of the Status Bar. The coordinates follow the crosshair and change accordingly.

For  most  lines  you  can  view  the  coordinates  of  their  points  from  the  Properties
window, either directly or by using the  Points  command  in the  box of  the  Properties
command.

Input of Absolute Coordinates

The input of the absolute coordinates is very simple. 

To input the absolute coordinates directly:

1.Run the  desired  command  until  the  program  prompts  you  to  specify  one  or  more
points.

2.Press  Enter  to  display  the  coordinates  Input  form  or  click  the  relevant  button on

the status bar .
3.Type the  and  coordinates in the respective fields.
4.Click OK to exit the Input form.

If you wish to specify further points, repeat the procedure.

Accurate Design

Tessera enables  you to  snap objects for  easy  and  accurate design.  By  using  these
tools,  you  can  design  with  accuracy,  without  having  to  input  coordinates  or  make
difficult calculations. You can also use the search tools to find instantly information on
the drawing and its objects.

Grid

The grid is a squared set of lines that covers the whole drawing area. Its use is similar
to the use of a transparent graph paper over your paper drawing. The grid enables you
to  align  objects and  to  visually estimate  the  real  distances.  When  you  work  in  the
Profile and Cross Sections  workspaces, the grid will not be printed on paper. The size
of the grid is adjusted automatically when you zoom in or out, depending on the scale.

Snap Feature
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The  snap  feature  is  a  quick  way  to  locate  or  specify,  depending  on  the  current
operation,  the  exact  position  of  a  point  without  knowing  its  exact  coordinates.
Therefore, this method is very accurate and convenient.

You can use the snap feature anytime Tessera asks you to specify  a point or  a size
which can be specified by selecting a point on the screen, e.g. the  rotation  angle  of
an object. You can enable one or more snap types at the same time. The snap feature
remains enabled until you disable it.

Distance and Angle Measurement

You can  view  the  following  information  between  two
specified points.

1.The distance between the two points.
2.The  angle  of  the  straight  part  with  respect  to  the

horizontal axis, measured both counterclockwise and
clockwise.

3.The  distances  on  the  X  and  Y  axes  (Dx  and  Dy
respectively).

This  information  will  help  you  verify  the  accuracy  of
your data.

You  can also  determine  the  number  of  the  information  that  you will  obtain.  Namely,
you can either perform a simple measurement  of  the  distance  and  view the  distance
and the values of the Dx and  Dy  on  the  third  section  of  the  status bar,  or  you can
perform a full measurement. In this case, the values shown on the status bar are the
same as the values of the simple measurement. The values are also displayed  on  the
screen, together with the value of the angle with respect to the horizontal axis.

To select the type of measurement

1.From the Tools menu, select the General Options command.
2. In the resulting dialogue box, select the Display tab.
3. In the Measure Distance group, select Full or Simple.
4.Click OK to close the dialogue box.

To measure a distance

1.From the Display menu select  Measure  Distance,  or  press  the  Alt+W  keys,  or  click

the button   on the main toolbar.
2.Set the first and the second point of the distance you wish to measure.

Tessera will display the information, as described above 
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6.14 Objects

Selecting Objects

Before editing the objects in your file, you must create a set of selected objects. This
set may be comprised  of  only  one object  or  it  can be a set  of  multiple  objects:  for
example all  objects of  the  same  color  or  all  objects of  the  same  group or  category.
These  sets  must  be  created  before  running  an  editing  command.  You  can  select
objects in one of the following ways. 

1.Use the mouse to select the objects and then run an editing command. 
2.Run a command that creates a set of objects. Then run an editing command.

Whatever the method, when you select  an  editing  command, Tessera  will  search for
objects. There are additional commands that enable you to select drawing elements.

Selecting Objects with the Mouse

The easiest way to create a set of selected objects is to use the mouse. 

How to select an object with the mouse

1.Activate  the  mode  of  the  object  you  wish  to  select  (e.g.  Drawing  mode  in  the
Horizontal Alignment workspace).

2.Position  the  crosshair with  the  bounding  box in such  a way, so  as  to  display  the
object  category on  the  status bar.  You  can generally  do  that  if  you  position  the
mouse pointer over the object (over a part of the object or over the line connecting
parts of the object), e.g. to select a Road you must position the mouse pointer over
a PI, to select a Frame to Print position the mouse pointer over a point within  the
frame.

3.Click the left mouse button.

The selected object will be highlighted on the screen. 

By default, if you select another object with  the  same  procedure,  this  object  will  be
added to the existing set. If you want to add an object that you select to the existing
set, go to the Tools menu ž  General Options ž  Environment ž  Multiple selection and
activate Select with Ctrl. When you select an object by using this option, the existing
selection set is cleared and only the new object is selected. If you select an object by
pressing and holding down the  Ctrl  key, this  object  is  added to  the  existing set.  On
the contrary, if you activate  Select  without Ctrl,  the  multiple  selection  of  objects is
performed without pressing any key, only by clicking the left mouse button.

Selection Box

You can select  objects  by  enclosing  them  in  a  selection  box.  A  selection  box  is  a
rectangular  field  that  you  can  form  within  the  drawing  area,  by  defining  its  two
opposite corners. The order in which you will define the corners is important, because
it determines which objects will be selected. If you create the selection box from left
to right, the selected objects will be those having all their points inside the box. If you
create the selection box from right to left, the selected objects will be those having at
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least one point inside this box.

Deselect All

To deselect all of the selected objects, go to the Edit menu and select Deselect all.

To deselect all of the selected objects from the Edit menu or from the shortcut menu
that appears when you right-click in the drawing area, click Deselect All  or  press  the
Shift+Ctrl+N keys. 

If Select with Ctrl is enabled in the dialogue box of the General Options command, you
can also deselect all objects by left-clicking on an empty spot in the drawing area.

Editing Points of Objects

When selected,  the  object  is  highlighted  and  its  points  are  indicated  by  a  box.  For
example, when you select a line, a box appears at  every  end  of  the  lines where the
line points are. 

If you want to use the points in order to edit an object, select the point that enables
you to run the desired editing command. To select the point of an object, simply click
the  left  mouse  with  the  crosshair  over  the  desired  point.  The  current  point  is
highlighted and is filled with a red color. To move between the points of an object, use

the left and right arrow keys while holding down the Ctrl key, or use the buttons  

 on the main toolbar.

You can edit points with the mouse in order to combine main editing commands, such
as Move, Zoom, etc. To activate a selected point, click again the  left  mouse  button
with the crosshair over the point.
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6.15 Object Properties

Every object that you create in Tessera has a set of properties. These properties are
displayed  in  the  Properties  window.  The  Horizontal  Alignment  workspace  gives  you
easy access to the main properties of the objects. You can also access the properties
from the Object properties toolbar. The best way, however, to modify  the  properties
of a set of objects, is to use the properties window.

To View Object Properties

Go  to  the  window  of  the  Properties command  to  view and  change the  properties  of
one or more objects. 

To view the properties of one or more objects

1. In the drawing area, select one or more objects whose properties you want to view.
 

2. From the Display menu, select Properties  or  press  the  F11  key  or  click  the  button

 on the main toolbar.

You can also execute this command from the  shortcut  menu that  appears when you
right-click on the screen after you have selected an object.

The window lists all properties of the selected objects. It is comprised of two columns.
The Property column shows the name of the property, while the Value  column  shows
the current value of the property. Here you can change any modifiable property.

You can leave the properties window open while you are working. When you select an
object, the Properties window will display the properties of the selected object. When
you select objects of another category, the window will display the common properties
of  the  selected  objects.  If  no  object  is  selected,  the  window  displays  the  main
properties, namely the layer, the color, the line type, the line width and the line type
scale. If no object is selected and you select a new value from this window, then you
specify the current settings for the new drawing elements.

To Edit Object Properties 
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You  can  change  the  properties  of  an  object  from  the  window  of  the  Properties
command. To change the values in this window, select the desired object and do one
of the following:

1.Type a new value.
2.Select a value from a drop-down list. 
3.Change the property through a dialogue box or a window. 

To change the properties of one or more objects

1.From the Display menu, select the Properties command.
2.Select the object/s you wish to edit. In the window of the Properties command you

can see all  properties of the selected object or the common properties in the  case
of multiple selected objects. 

3.Select  the  property you wish  to  change and  type a new value,  or  select  a value
from a drop-down list. In some cases, when you select a property value, the button

 , will be displayed. If you click this button, you will be transferred to a dialogue
box, where you can make the desired changes and then apply them by clicking the
OK or Apply button of the box.

Main Object Properties

The objects that you create in Tessera have  certain main  properties,  such  as  color,
line  type,  line  type  scale  and  line  width.  These  properties  enable  you  to  group
together elements of your design, so as to facilitate the visual identification of  these
items,  both  on  screen and  on  the  printout.  This  makes the  processing  of  the  study
easier and improves the appearance and quality of the end drawings. 

Color

You can define  a color  separately for  every  object  or  generally  for  every  category.
Every color is characterized either by its parameters or by a predefined name. A set of
objects  can  have  the  same  color.  You  can  use  colors  to  distinguish  instantly  the
objects on the screen. The program provides  the  main  colors  with  default  parameter
values and a default name, but you can also define any other color you like.

To select a color for an object or a category, you can choose from the list one of the
default colors or you can define a new color by clicking Other. The default colors are:

BLACK 
GREY
BLUE
DARK GREY
GREEN
LIGHT BLUE
CYAN
LIGHT GREEN
RED
LIGHT CYAN
MAGENTA 
LIGHT RED
BROWN
LIGHT MAGENTA
YELLOW

To Define a New Color 
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1.From the drop-down list of the Color property, which is displayed in the dialogue box
of the Properties command, click Other.

2. In  the  dialogue  box of  the  Color  command,  select  a  basic  color  or  define  a  new
color. 

3.To define a new color, click the Define custom colors button. To define the details
of the new color either  fill-in  the  six  fields  on  the  bottom right  part  of  the  box or
select the color from the palette on the top left part of the screen and  adjust  the
brightness by using the slide bar on the right of the palette.

4.When you have finished, click the Add to custom colors button and then click OK.

Line Types and Line Type Scale

The line type is  a repeated pattern of  dashes,  dots and  spaces.  The  name and  the
definition of the line type describe a specific sequence of dashes and dots as well as
the relevant sizes of the dashes and dots.

There are fifty-two line types in Anadelta Tessera and you can select the desired one
from the drop-down list.

The  line  type  scale  is  user-defined.  The
lower the  value  you  set  for  the  scale,  the
more  the  repetitions  of  the  pattern  per
drawing  unit.  The  default  value  is  1.0.  The
relative  size  of  the  dashes  and  dots  is
always  proportional  to  the  line  type  scale
and  their  size  on  paper  is  always  fixed,
regardless of the print scale. Their on-screen
size  is  always  identical  to  their  size  on
paper, according to the drawing scale.

Line Widths

There are six line widths in Anadelta Tessera.
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This property adds width to the lines of your objects, both
on  screen  and  on  the  printout.  With  this  item  you  can
create  thin  or  thicker  lines,  so  as  to  distinguish  them
visually  and  to  read  your  drawing  easier,  both  on  the
screen and on the printed drawing. 
The objects are printed according to  their  assigned  value.
The  line  width  values are  in  millimeters  and  always  fixed.
The  line  width  of  the  drawings  you  export  to  other  file
formats  can  be  maintained.  The  line  width  also  remains
unchanged  when  you  copy  objects  from  one  file  to
another.
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6.16 Drawing View Options

Tessera  provides  many  options  that  can help  you  control  how  your  drawing  will  be
displayed in the drawing area. The percentage of the drawing inside the drawing area
is the zoom, while the point in the center of the drawing area is referred to as center
of view. A particular zoom and observation  point give  you the  view of  your  drawing.
While  you’re  processing  your  project,  you can change the  view and  go  quickly  from
one  area  of  your  drawing  to  another.  You  can  zoom  in  or  out  the  image  of  your
drawing that is displayed inside the drawing area or to pan it, to save a particular view
and  to  recall  it  again  in  the  future.  The  absolute  sizes  of  the  drawing  will  not  be
affected when you change the zoom or the center of view, only the way in which the
drawing is displayed within the drawing area will change.

Using the Zoom and Pan Commands

The  easiest  way  to  change  the  view  is  to  use  one  of  the  many  zoom  features  of
Tessera in order to increase or decrease the scale of the drawing.

Real-Time Zoom and Pan 

The Zoom and Pan commands of  Tessera  enable  you to  watch  in real  time  how the
view changes. With the Zoom command, you can zoom in or  out  on  the  drawing  by
rolling the mouse wheel.

How to Zoom in real time

Roll the mouse wheel. To increase the image scale (zoom in), roll the mouse wheel up
and to  decrease  the  scale  (zoom out)  roll  the  mouse  wheel down.  You  can  do  the
same by pressing the + and - keys respectively.

With the Pan command, you can change the center of view. 

How to Pan in real time

1.Place the crosshair inside the drawing area.
2.Click the mouse wheel.
3.Hold the mouse wheel down and move the pointer (within the limits  of  the  drawing

area),  until  you view the  desired  part  of  your  drawing.  You  can  do  the  same  by
pressing the up, down, right and left arrow keys.

The Zoom Window Command

You can zoom in very quickly on an area of your drawing if you define its borders. 

The area that  you define  is  centered  in the  new view.  The  size of  the  sides  of  the
defined window is proportional to the size of the drawing area.

To zoom in on an area by defining its borders

1.From the Display menu, run the Zoom Window command, or press the Alt+Z key, or

click the button  on the main toolbar. The mouse pointer turns into a window.
2.Set one corner of the area by clicking the left mouse button.
3.Set the opposite corner.

You can also run this command from the shortcut menu that appears when you right-

click in the drawing area .
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To Display the Previous View

When  you’re  working  on  small  parts  of  your  drawing,  you  will  have  to  zoom  out
frequently to view your whole project. The  Previous Zoom  command  restores  quickly
the previous view. 

Tessera  can  save  an  indefinite  number  of  previous  views.  The  Previous  Zoom
command restores only the zoom scale and the center of  view and  has no  effect  on
the settings or properties of the objects.

To return to the previous view

From the Display menu, run the Previous Zoom command, or click the  button  on
the main toolbar.

To display the next view, run the Next Zoom command from the Display menu.

Centering the View to a Point

You  can  set  a  specific  point  in  your  drawing  as  the  center  of  view.  The  Locate
Coordinates command moves the view to a specific point in the center of the screen,
without changing the zoom. 

To center the drawing within the drawing area

1.From the Display menu, run the Locate Coordinates command.
2. In  the  dialogue  box that  appears,  type the  coordinates  of  the  point  you  wish  to

become the new center of view.
3.Click OK.

The view is shifted and the point that you have specified will be in the center of the
drawing area.

Zoom on Selected Objects 

In order to view on screen the desired objects, run the Zoom on selected command.

The  Zoom  on  selected  command  changes  the  view  so  as  to  include  all  the  user-
selected objects, displaying them with the highest zoom, in order to fit in the drawing
area.

To display all the selected objects

1.Select the objects you wish to be displayed inside the drawing area.
2.From the Display menu run the Zoom on selected command or press the  key.

Zoom on Project’s Limits 

To adjust the view on your project’s limits, select the Zoom extent command.

The view that you get with the Zoom extent command includes all the objects of your
project with the highest zoom, so as to fit in the drawing area.

To display the whole project

From the Display menu, run the Zoom extent command, or press the F4  key, or  click
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the button  on the main toolbar.

Saved Views

You can save  a view to  recall  it  at  a future  time. Tessera  can save  up  to  four  (4)
different views. 

Saving a Reference Point

When you save a view, the following data are also saved automatically:

1.The center of view.
2.The zoom coefficient.

To save a reference point

1.From the Display menu, select the Reference points submenu.
2.From the Reference points submenu, select Insert and then choose one of the four

available points.

Restoring a Reference Point

You can recall a saved view any time you need to use it. 

To recall a saved reference point

1.From the Display menu, select the Reference points submenu.
2.From  the  Reference  points  submenu,  select  the  Select  submenu  and  then  choose

one of the saved views.
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6.17 Modifying the Program Options

You can modify  many  settings  of  the  Tessera  window  from the  dialogue  box  of  the
General Options command of the Tools menu. For example, you can specify the object
selection  method.  Experiment  with  the  available  options  until  you  create  an
environment  that  enables  you to  work with  the  maximum  speed  and  accuracy.  The
settings that you can select in the tabs below can be applied  to  any file,  even  to  a
new project.

To change the options of Tessera 

1.From the Tools menu, select the General Options command.
2.From  the  dialogue  box of  the  General  Options command,  choose  a tab  and  select

the settings you wish to change. 
3.When you have made your options, click OK.

Environment Options

The  Environment  tab  that  you can find  in the  dialogue  box  of  the  General  Options
command, controls the object selection method and the printing parameters.

You can make the following settings:

1.Method of multiple object selection.
2.Printing page definition.
3.Registration of .ADF files with Tessera.

Display Options

The Display tab in the dialogue  box of  the  General  Options  command  controls  mainly
the way in which the main items of the program are displayed. For example,  you can
modify the type and size of the fonts that will be used when viewing fixed texts.



77A First Look

Anadelta Software

You can make the following settings:

1.Antialiasing of figures.
2.Define the number of data shown when measuring the distance.
3.Select the fixed text font.
4. Filling the Select Objects/Zoom quadrilateral (window).

Text Font

You can define a font and a font size for  the  on-screen texts.  Select  the  font from

the Font dialogue box that appears when you click the button , in the Display
tab of the General Options dialogue box.

To  change  the  font  or  the  font  size  –  To  use  bold  or  italics  in  selected  text  or
numbers
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1.Select the desired font in the Font dialogue box of the Font list, and then select the
desired Script from the Script list.

2. From the Size list, select the desired font size.
3.From the Style list, select the desired style.

The  Sample  preview  field  shows  how  the  text  will  be  displayed  according  to  your
settings.

Terrain Options

The Terrain tab in the dialogue box of the General Options command contains settings
for the terrain.
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The settings included in this tab are:

· Instant triangulation when inserting Breaklines.
· Definition  of  the  variation  of  the  points  that  will  be  included  automatically  when

inserting Breaklines or Boundaries.
· Definition of the highest value in m3 for the identification of the volumetric regions.

Cross section Options

The Cross Section dialogue  box of  the  General  Options  command  contains  the  Cross
Sections settings.



80 Anadelta Tessera

Anadelta Software

The settings that you can make in the above tab are:

Set the decimal digits that appear on screen:
· when editing lines.
· when viewing Dx, Dh and elevations.
· when viewing superelevations.

Set the decimal digits for export to Ascii files:
· for Dx from axis and elevations.
· for chainage.

Select the files from which the following are obtained:
· the typical families for a new project.
· the typical cross sections for a new project.
· the drawings library for a new project.
· the walls library for a new project.
 
Profile Options

The  Profile  tab  that  appears  in  the  dialogue  box  of  the  General  Options  command
contains the Profile settings.
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The settings you can make in this tab are:

Set the decimal digits that are displayed on screen:
· on Dx display.
· on Dy display.
· on slope display. 

Set the decimal digits for export to Ascii files:
· on Dx.
· on Dy.
· on slopes.

· Set the moving step for unfreezed segments.
· Enable the automatic check when inputting data based on chainage.

Ascii Options

The  Ascii  tab  in dialogue  box of  the  General  Options command contains  settings  for
data export to Ascii files.
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The settings you can make in this tab are:

· Selection of the text format (Windows / Dos)  for  the  import or  export  of  text  files
(For compatibility with older versions).

· Selection of the way the angles will be displayed.
· Selection of the way the angles will be displayed with respect to the x or y axes.

DXF Options

The Dxf tab in the dialogue box of the General Options command contains settings for
data import from Dxf files.
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Select Import Viewports when a file is not imported correctly.
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6.18 Project Management

The communication between the three workspaces and the transfer of data from one
workspace to another is done from the Project Management dialogue box. 

To  display  the  box,  click  the  button  on  the  main  toolbar  or  execute  the  Manage
command from the menu Project. In the dialogue box you can request  the  update  of
one  workspace  from another  (e.g.  from  Horizontal  Alignment  to  Profile).  To  update,
first select the desired road from the list on the top part of the box. Next, if you wish
to update with the main options, click the corresponding button of  the  Quick Update
group  in the  Updates  tab.  This  deletes  the  old  data  and  creates  all  data  from  the
beginning.  Or,  in  the  Update  group,  select  from  the  two  drop-down  lists  the
workspaces where the updates will take place. All  the updates that are to take place
will  be  displayed  in  the  checklist  under  the  drop-down  lists.  You  can  uncheck  any
update you do not want to take place. In all  cases, click the Update button, to carry
out the update. 

Selected Road Information

Once you have selected the road as described above and gone to the  Selected  road
information tab, this dialogue box informs you on the updates that must take place so
that the road is synchronized in all three workspaces. 

Update Cross Sections from Horizontal Alignment

If, from the drop-down lists of the Update group, you select to update from Horizontal
Alignment to Cross Sections, the resulting options are:
· Terrain Update: Only if this command is active, the Terrain is updated. In case this

update  has already  been performed once and  you wish  to  update  again,  click  the
Update button. In the resulting dialogue box you can specify the update as well  as
the line to which the terrain points will be transferred.

· Update Diagrams:  Select  this  command  if  you  modify  any  of  the  diagrams  in  the
Horizontal  Alignment  mode  and  you wish  to  update  the  corresponding  ones  in  the
Cross Sections.

· Update Cross Sections: Select this option to update the cross sections.  A dialogue
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box appears in which you can specify the actions to be performed.

The following dialogue box includes all the above windows that appear for the Updates
(Terrain  Update,  Update  Cross  Sections).  Namely,  if  you  select  only  the  Terrain
Update, the window appearing includes the Terrain Update and Cross section compare
groups, if you select  only  the  Update Cross  Section,  the  window  includes  the  Cross
Section Synchronization and Cross section compare groups. If you select to update all
fields (Terrain Update, Update Diagrams, Update Cross Sections) the following window
appears. 

 

In this window, you can select  from the  drop-down  list  of  the  Terrain Update  group
the  line  onto  which  you want to  insert  the  terrain  points.  With  the  Recreate  cross
sections option the program deletes any existing cross sections and updates again the
terrain.
In case new cross sections have been inserted in the Horizontal Alignment mode, you
can  select  the  Add new  field  in  the  Cross  section  synchronization,  in  order  to  add
these new cross sections to the Cross sections mode, without affecting  the  existing
cross sections. In the opposite case, namely if you delete certain cross sections from
the Horizontal Alignment, then in the aforementioned group you must select the Delete
old field, in order to delete these cross sections without affecting the remaining ones.
Finally, in the Cross section  compare  group,  you can select  the  way  in which  cross
sections will be updated, i.e. either based on the Chainage or the Name.

Update Cross Sections from Profile

If, in the Update group, you select from the drop-down lists to update from Profile to
Cross Sections, the resulting options are:
· Update Road Profile:  This  option transfers  the  road  profile  elevations  to  the  Cross

sections mode.
· Create Cross Sections: Deletes any existing cross sections and  creates  new ones,

where the terrain is an horizontal straight section that crosses the axis and has an
elevation equal to the Terrain Profile.

· Update Diagrams:  Select  this  command  if  you  modify  any  of  the  diagrams  in  the
Profile mode and you wish to update the corresponding ones in the Cross Sections.

Update Profile from Horizontal Alignment

If,  in  the  Update  group,  you  select  from  the  drop-down  lists  to  update  from  the
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Horizontal Alignment to Profile, the resulting options are:
· Terrain Update: Only if this command is enabled, the Terrain is updated.
· Update Diagrams:  Select  this  command  if  you  modify  any  of  the  diagrams  in  the

Horizontal  Alignment  mode  and  you wish  to  update  the  corresponding  ones  in  the
Cross Sections.

· Update Road Profile: In case you have deleted the road profile from the Profile, you
can  transfer  it  from  the  Horizontal  Alignment  but  only  if  you  first  update  the
Horizontal Alignment from the Profile.

· Terrain on  Pavement line:  Provided  that  the  widths  of  the  road  design  have  been
defined correctly (Road Design ž Road Preferences ž  Widths tab), you can transfer
the Pavement lines to the Profile by selecting this command.

· Terrain on Roadway line:  Here too,  you must have  defined  correctly  the  widths  in
order to be able to transfer the Roadway lines to the Profile mode.

· Update structures: This command updates the structures in the Profile.

Update Profile from Cross sections

If,  in  the  Update  group,  you select  from the  drop-down  lists  to  update  from  Cross
Sections to Profile, the resulting options are:
· Terrain Update: This command updates the Terrain.
· Update Diagrams:  Select  this  command  if  you  modify  any  of  the  diagrams  in  the

Cross section mode and you wish to update the corresponding ones in the Profile.
· Remote  Update:  Use  this  command  to  display  in  the  Profile  elevations  of

characteristic Cross sections points (e.g. ditch deep point, pavement edge, etc.).

When you select the Remote Update command the following dialogue box appears:

In this window, type in the Profile line to create field the desired name of the new line
that will be inserted into the profile. 
· If the from reference line group is activated, the available fields will be:

· H:  from  reference line:  From the  resulting drop-down  list  select  the  line  whose
elevations you wish to transfer to the profile diagram.
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· A/A: In case there are more than one lines of the same group, select which line will
be the reference line based on their order of import.

· From  axis:  Specify  the  distance  from the  road  axis where the  elevations  of  the
reference line points will be obtained.

· From  diagram:  Select  the  diagram  that  will  define  the  distance  where  the
elevations will be obtained.
Invert diagram signs: When diagrams referring to the left part of the cross section
are  going to  be used,  you  must  activate  this  field  so  that  their  values  can  be
assigned to the left part of the cross section.

· From reference point: Depending on the selected reference line,  you can specify
which point of this line will transfer its elevation to the Profile.

· Dx:  If you have selected From diagram or From Reference  Point,  you can define
here  an  extra  offset  to  the  distance  of  the  point  whose  elevation  will  be
transferred to the Profile. 

· From the H and Dx from the drop-down list of the  from flag  group,  you can select
the cross section point whose elevation will appear in the Profile.

Update Horizontal Alignment from Profile

If, in the Update group, you select from the drop-down lists to update from Profile to
Horizontal Alignment, the resulting options are:
· Update  Road  Profile:  This  option  transfers  the  PIs  of  the  tangent  curve  to  the

Horizontal Alignment.
· Update structures: This option updates the structures in the Horizontal Alignment.

Update Horizontal Alignment from Cross sections

If,  in  the  Update  group,  you select  from the  drop-down  lists  to  update  from  Cross
Sections to Horizontal Alignment, the resulting options are:
· Update roadlines: This update transfers  the  roadlines,  e.g.  the  Pavement  roadlines

and the  Roadway  roadlines,  to  the  Horizontal  Alignment  mode.  A main  prerequisite
for this update is the correct placement of the flags in the Cross sections. 
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6.19 Saving a File

While working on a file, you must save it at regular intervals. If you want to create a
new copy of your file without altering the original file, you can save it under a different
name.

To save a file:

1.From the File menu, select the Save command, or press the Ctrl+S keys, or click the

button  on  the  main  toolbar .  If  you have  already  saved  and  named your  file,
Tessera  automatically  saves  the  changes  you  have  made  and  you  can  continue
editing the file. If this is the first time you save the  file,  the  Save as  dialogue  box
appears on the screen.

2. In the File Name field of the Save as  dialogue  box,  type the  new name of  the  file
(the file extension is not required).

3.Click the Save button.

Tessera files have the .ADF extension.
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6.20 How to Select and Save Files

The  program will  frequently  ask  you  to  give  the  path  and  the  name  of  a  file.  This
enables the program to read the file and use its data, e.g. when you open a program
file or when inputting data.

You can do this from the Open dialogue box. 

In this box, first you must go to the location (drive, folder, subfolder) where your file
is. To do this, use the buttons and lists of the box.

To open a file,  type the  full  path  and  name of  the  file  in  the  File  name field  on  the
bottom part of the box and click the Open button. You can also open a file by double-
clicking  its  name  in  the  Files  field  or  by  clicking  once  and  then  clicking  the  Open
button. 
The  files  field,  apart  from  the  files  of  the  current  subfolder,  also  contains  the
subfolders included in the current subfolder. To open a subfolder,  select  it  and  press
Enter or double-click with the mouse.
In the File Name field, you can enter the full  name of the file or you can activate the
drop-down list of the field. The list includes the files you have opened recently, since
you last started the program. You can navigate inside this window by using the PgDn
and PgUp  arrows or the Home and End  keys to go to  the  beginning or  to  the  end  of
the window, respectively. Next press  Enter  to  select  the  desired  file  and  then  press
Enter again to open it. Of course, you can open  the  file  far more quickly  by double-
clicking it.  To cancel  the  selection,  simply  click  the  Cancel  button or  press  the  Esc
key.
The  Save as  dialogue  box has a similar  function.  To save  a file,  you must  click  the
Save button.
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6.21 Closing a File

The Close command closes the current file. If you have saved the changes you have
made recently to the file, you can close Tessera without saving the file again. If you
have  not  saved  the  changes,  Tessera  prompts  you  to  do  so,  by  displaying  the
relevant confirmation message.

1.On the Windows  taskbar,  left-click  on  the  button that  corresponds  to  the  desired
file, in order to display the file.

2. From the File menu, select the Close command or press the Ctrl+F4 keys.
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6.22 To Exit Tessera

The  Exit  command  closes  all  open  files  and  the  program.  If  you  have  saved  the
changes  you  have  made  recently  to  all  open  files,  you  can  close  Tessera  without
saving the files again. You can also double-click the exit button on the title bar. If you
have  not  saved  the  changes,  Tessera  prompts  you  to  do  so,  by  displaying  the
relevant confirmation message.

From the File menu, select Exit or press the Alt+F4 keys.
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7 Horizontal Alignment

7.1 The Horizontal Alignment Environment

7.1.1 Workspace

Every  time  you  create  a  new  file  or  open  an  existing  one,  you  are  transferred
automatically to the Horizontal Alignment workspace. If you are in another workspace,
you can return to the Horizontal Alignment by clicking the Horizontal Alignment tab at
the bottom of the screen or by executing the Horizontal Alignment command from the
Display menu. 

At the top of the screen, you can see the familiar menu bar  where you can find  the
File, Edit, View,  Project,  Tools,  Print  and  Help  menus,  which  contain  commands that
are common to all workspaces, as well as special commands that are displayed or can
be  used  only  in  the  Horizontal  Alignment  workspace.  There  are  also  three  menus,
Drawing,  Terrain,  and  Road  Design,  which  are  displayed  only  when  you  are  in  this
workspace. Below the menu bar, you will  find  the  main  toolbar and  below  the  latter,
you will find the State and Horizontal Alignment toolbars, which  contain  buttons  that
carry out basic operations. Right below these toolbars  there  is  the  Object Properties
toolbar, where you set the properties of the objects, such as the color, the line type
and the line width, the layer to which an existing drawing object belongs, the current
terrain,  as  well  as  the  properties  that  will  be assigned  to  every  new  object  that  is
being created. This toolbar does not have any buttons, only drop-down lists.
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On the left part of the program’s window, you will  find  the  Element  Drawing  toolbar,
whose functions  refer  to  the  creation  of  Horizontal  Alignment  objects.  This  toolbar
offers access to the most common commands for the creation of elements referring to
the design, terrain, road and printing pages. 
If desired, you can maximize the drawing area so as to occupy the full  screen of your
computer.  You  can  do  this  either  by  executing  the  Full  screen  command  from  the
Display menu, or by pressing the Ctrl+Alt+V keys.

7.1.2 Workspace Modes

There are four modes in the Horizontal Alignment workspace. This allocation facilitates
the user to insert, edit and process the elements of the design.

· Drawing Mode:
In  this  mode  you  can  enter  and  edit  any  of  the  drawing  objects,  such  as  lines,
circles,  ellipses,  arcs,  texts,  etc.  In  this  mode  only  the  drawing  objects  can  be
selected  on  the  drawing  screen and  you can execute  only  commands  referring  to
such objects.

· Terrain Mode:
In this mode you can insert - edit the  terrain  elements  of  your  project  and  create
the terrain model.

· Road Mode:
In  this  mode  you can insert  -  edit  the  roads  of  your  project,  while  you  can  also
perform the road stationing and the formation of the roadlines.

· Print Mode:
Here you can specify the format, the elements that will be displayed and the part of
your design that will be printed to the printer or the Plotter. 

Mode Toolbar

Each of the four buttons on this toolbar corresponds to a mode. Every time you click
one  of  these  four  buttons,  a  mode  is  activated  and  the  other  three  modes  are
deactivated. It is possible to activate more than one mode.

How to activate multiple modes

Press and hold the Shift key and click the  button that  corresponds  to  the  mode  you
wish to activate, maintaining active the already selected mode.

By  default,  the  first  three  modes  are  always  active  every  time  you  create  a  new
Tessera file.

7.1.3 Categories of Objects

Every object you create belongs to a category of the Horizontal Alignment workspace.
Most objects, even if they have a different shape, may belong to the same category.
For example, a quadrilateral and a straight part are both drawing lines.
The object categories of the Horizontal Alignment workspace are described below. To
view  the  identity  of  an  object,  either  select  the  object  and  run  the  Properties
command,  or  drag  the  crosshair  over  the  object  (the  corresponding  drawing  mode
must be active) and read its identity in the third part of the status bar.

Drawing Elements

1.Drawing Line: An open or closed zigzag line, comprised of one or more straight parts.
2.Circle: A circle.
3.Circular Arc: The part of a circle.
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4.Ellipse: An ellipse.
5.Elliptical Arc: The part of an ellipse.
6.Text: A line of alphanumeric characters.
7.Clothoid: A line in clothoid shape.
8.Parabola: A line in parabolic shape.

The drawing elements are created by defining their main points, e.g. the centre and a
point of a circle’s circumference. These points are an integral part of the drawing lines
and you can view and modify them at any time while editing your design.

Rendering/Terrain Elements

1.Terrain Point:  A  point  whose  position  in  space  is  defined  by  three  numbers,  the
coordinates X,Y,Z.

2.Triangle: A triangular flat surface.
3.Breakline: A line on which the triangles always abut and they never intersect it.
4.Perimeter: A closed line demarcating an area that contains triangles. 
5.Oasis: A closed line without any triangles.
6.Contour lines: Lines on which every point has the same elevation.

Road Elements

1.Road: It consists of PIs. 
2.PIs: The points that define the sides of the road's tangent curve. The points of the

PIs (e.g. radius, length of clothoid) determine the position and the form of the road
axis. When you select a road, you actually select the closest PI.

3.Roadway  Lines:  These  are  lines,  along  the  road  axis,  belonging  to  the  roadway
surface of the current road.

4.Sideslope Lines: These are straight lines, parallel to the road axis, belonging  to  the
surface of the sideslopes on both sides of the current road.

You  cannot  create  the  Roadway  Lines  and  the  Sideslope  Lines  from  the  Horizontal
Alignment; they are created automatically during the calculation of  the  road  and  the
update from the  Cross  Sections  workspace.  You  can,  however,  select  them and  set
some of their main properties, display them on screen, use the snap feature on  them
and print them as part of your final drawing.

Print Elements

Page:  A rectangular  surface  whose  dimensions  correspond  to  the  dimensions  of  the
paper page that you have set,  always  according to  the  print  scale.  The  part  of  the
design that is included in the selected page is the one that will  be printed  when you
request a printout.

7.1.4 Horizontal Alignment Display Options

You  can  choose  which  object  categories  or  which  parts  of  the  objects  (e.g.  line
points) will be displayed on screen. 

How to define how the objects are displayed

1.From the Display menu, run the Options command, or press the F2 key, or from the

Horizontal Alignment toolbar click the button . The Horizontal Alignment Options
window appears on the screen.
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The window consists of two parts. The object categories  are  displayed  on  the  left
part.

2.Select an object category. 
3. If you want none of the elements of the category to be displayed, uncheck the box

next to the category name on the left part of the window. If you want only some of
the elements of a category to be displayed, select them from the right part  of  the
window by ticking  the  corresponding  check  box,  which  is  displayed  next  to  their
name.

4.To exit the window, click the exit button   on the title bar of the window.

When the General option is ticked, the available options are:
· Grid: Shows or hides the grid.
· Volumes:  This  option  opens  the  legend  with  the  volumetric  differences  (fillings,

cuttings, unalterables). 
· Fillings: Shows or hides the fillings.
· Unalterable: Shows or hides the unalterables.
· Cuttings: Shows or hides the cuttings.
· Shading: Select this field to render the regions with hatch instead of shading.
· Surfaces: Select this option to hide from the legend the  surfaces  that  cover  the

fillings, the cuttings and the unalterables. 
· Legend: Shows or hides the Volumes legend.
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When the Drawing option is ticked, the available options are:
· Polyline Points: Shows or hides the polyline points.
· Layers: This option includes all  the available drawing layers that you can enable  or

disable.

When the Terrain option is ticked, the available options are:
· Points: Shows or hides the Terrain points. 

· Point names: Shows the names of the Terrain points.
· Point elevations: Shows the elevations of the Terrain points.

When  both  of  the  above  options  are  ticked,  the  names  of  the  points  are  displayed
above the bordeline and the elevations are displayed below the borderline.
· Triangles: Once the triangulation is performed, the resulting triangles are displayed. 

· Triangle faces: Shows the faces of the triangles.
· Shading: This option shows the morphology of the terrain.
· Elevation  shading:  Shows  the  relief  in  a  coloured  presentation  according  to  the
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elevation of points. 
· Boundaries: Shows or hides the boundaries of the elevational zones.
· Legend: Shows or hides the Elevation Shading legend.
· Slopes coloring: Shows the terrain slopes in a coloured presentation. 

· Legend: Shows or hides the Slopes Coloring legend.
Note: The Elevation Shading cannot be displayed when the Slopes Coloring is displayed
and vice versa.
· Breakline: Shows the breaklines.
· Boundaries: Shows the boundaries that have been drawn (Oases, Perimeters).
· Contour  lines:  You  can  display  the  contour  lines  once  their  calculation  has  been

carried out. 
· Contour Lines Elevations: Shows the elevations of the contour lines. 
· With  the  Curve  or  Straight  Lines  option,  you  can  define  the  way  in  which  the

contour lines will be rendered.

When the Road option is ticked, the available options are:
· Filled: This option draws the roadway. 

· Slopes coloring: Shows the roadway slopes.
· Tangent: Shows or hides the road’s tangent curve. 

· Profile  PIs:  Once  the  Profile  is  updated  from  the  Horizontal  Alignment,  you  can
display the PIs of the profile. 

· PI Detail: Shows the centre of the circular arc of every PI, as well as the radii that
correspond to the characteristic stations. 
· Optical lines: When a PI of the road is selected, this option displays the  optical

lines that define the surrounding visibility.
· Axis: Shows or hides the road’s axis.
· Roadway: Shows or hides the roadway. 

· Sideslopes: Once the Horizontal Alignment is updated from the Cross Sections, you
can display the sideslopes (fillings and cuttings).

· Widenings: Shows any widenings that may have been drawn.
· Stations: Once the stationing is performed, you can display the stations. 

· Lines: Shows the lines that define the width of each cross section.
· Required  side  free  space:  Once  the  visibility  calculations  are  performed,  you  can

display the Required Side Free Space.
· Available side free space: This option displays the Available Side Free Space.
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7.1.5 The Snap Feature

You can only snap items shown on the screen. You can not use the snap feature on
drawing elements that belong to hidden or non-selectable layers.

The snap feature uses visual assistance to help you distinguish the snap type and use
the snap feature more effectively. The visual assistance is comprised of the following
items:

1.Notations: They indicate the type of snap by displaying the corresponding symbol at
the point of snap. 

On line point, terrain point, station or PI:

On line:

On grid:

On line intersection:

On extension:

2.Magnet:  Moves  the  pointer  automatically  to  lock  it  on  a  snap  point,  when  the
pointer is close to this point.

With the snap feature you have the following possibilities:

1.Snap drawing elements:
· On Line point
· On Line
2.On Extension: to snap the  extension  of  a line,  place  the  crosshair over a point of

the line and then move it to the desired side. Note that in order to use this type of
snap, you must also select the snap on point.

3.On Line section: if the lines are not intersected, you must also select both the snap
on point and the snap on extension.

4.Snap terrain elements:
· On terrain point
· On triangle line
5.Snap on grid
6.Snap road elements:
· On road PI
· On road cross section

How to activate and set the snap feature

1.From the Display menu run the Options command, or press the F2 key, or  from the

Horizontal Alignment toolbar click the button . The Horizontal Alignment Options
dialogue box appears on the screen.

2.From the left part of the window select Snap.
3.Select the type/s of snap you want to use, by ticking the relevant check box, next

to the name of the snap on the right part of the window.

4.To close the window, click the button. .
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When the Snap option is enabled, you can see all the fields that you can snap:
· Drawing: You can select one or more of the  above  available  fields,  in  order to  use

the snap feature in the drawing mode.
· Road: Select the fields you wish to snap.
· Terrain: Select the desired type of snap.
· On grid: When this field is selected and the  grid  is  enabled,  you can use the  snap

feature on any point of the grid.

If certain options are disabled, this is because from the Display tab you have  chosen
not to display them. To activate them, go to this tab and choose to display them. 

7.1.6 Selection of Objects

To select the objects, the corresponding mode must be activated. Therefore, for  the
drawing  elements  you must activate  the  Drawing  mode,  for  the  road  elements  you
must activate the Road mode and for the print elements you must activate  the  Print
mode.

Very often, especially when multiple modes are simultaneously active, it is  difficult  to
select an object that is too close to or on  top  of  another.  In  such  cases,  move  the
crosshair over the point where the desired object is and click the right mouse button.
A shortcut menu will  appear  on  the  screen.  This  shortcut  menu contains  the  Object
selection...  commands,  which  are  as  many  as  the  selectable  objects.  Run  the
command that corresponds to the object you want to select.

7.1.7 Main Object Properties

With Tessera you can edit  the  main  properties  of  the  drawing  objects in two ways:
either from the Object properties toolbar or from the Properties command window.

The Object Properties Toolbar

You can use the lists  of  the  Object  properties  toolbar to  view directly  or  to  change
the main  properties of a drawing  object,  such  as  the  Line  type,  the  Line  width  and
the Color. The Object properties toolbar includes  all  the  commands that  you need in
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order  to  view  and  change  the  main  properties  of  an  object.  When  you  select  an
object, its properties are displayed automatically in the drop-down lists of the toolbar.

Color Editing

From  the  Color  field  (the  first  field),  you  can  view  and  change  the  color  of  the
selected object. 
The drop-down menu includes  the  Layer  colors (only  for  the  drawing  elements),  the
fifteen default colors, and  all  the  colours  you have  defined  from the  dialogue  box of
the Color command. If the desired color is not on the list, select the Other option and
define a new color from the dialogue box of the Color command.

When no objects are selected, the current color  is  displayed.  When  you create new
drawing objects, these objects will appear in the current colour. 

When multiple objects are selected, if all  the drawing objects have the color property
and are of the same color, then this color is displayed, otherwise the field is blank. If
only drawing objects are selected and their colour is the one of  the  layer,  the  Layer
option is displayed in the field. The Layer value means that the color of the object is
the same as the color you have defined for the layer to which the object belongs. 

To change the color of an object

1.Select the objects whose color you wish to change.
2.From the Object properties toolbar, activate the color selection drop-down list. 
3.Select a color.
4. If you do not see the desired color, select Other. 
5. In the Color command dialogue box, select the desired color.
6.Click OK.
Tessera  will  change the  color  of  the  selected  objects  into  the  color  that  you  just
selected.

Line Type Editing

From the Line type field, you can view and change the line type of a selected object,
and set the current line type. 

The drop-down list includes  the  Layer  line  type (only  for  the  drawing  elements)  and
the default line types.

When  no  objects are  selected,  the  current  line  type is  displayed.  The  new  drawing
objects that will be created, will have the current line type. 

When  multiple  objects  are  selected,  if  all  the  drawing  objects  have  the  line  type
property  and  the  same  line  type,  then  this  type  is  displayed,  otherwise  the  field  is
blank. If  only  drawing  objects of  different  layers  are  selected  and  they all  have  the
layer line type, then the Layer value appears in the field. The Layer value means that
the object’s line type is identical to the one you have defined  for  the  layer  to  which
the object belongs. 

To change the line type of an object

1.Select the objects whose line type you wish to change.
2.From the Object properties toolbar, activate the line type selection drop-down list. 
3.Select a Line type.
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Tessera will change the line type of the selected  objects into the  line  type you just
selected.

Line Width Editing

From  the  Line  width  field,  you  can  view  and  change  the  line  width  of  a  selected
object, and set the current line width. 

The drop-down list includes the Layer line width (only for  the  drawing  elements)  and
the five default line widths.

When no objects are  selected,  the  current  line  width  is  displayed.  The  new drawing
objects that will be created will have the current line width. 

When  multiple  objects  are  selected,  if  all  the  drawing  objects  have  the  line  width
property and the same line width,  then  this  value  is  displayed,  otherwise  the  field  is
blank. If only drawing objects of different layers are selected and they all have the line
width  of  the  layer,  then  the  Layer  value  is  shown  in  the  field.  The  Layer  value
indicates that the line width of the object is the same as the one you have defined for
the layer to which the object belongs. 

To change the line width of an object

1.Select the objects whose line width you want to change.
2.From the Object properties toolbar, activate the line width selection drop-down list. 
3.Select a line width.
Tessera will change the line width of the selected objects into the line width you have
selected.

7.1.8 Project Information

You can view the data of all  objects of the project in the dialogue box of the Project
data  information  command  of  the  Tools  menu.  This  command  opens  the  following
dialogue box:

This  box  shows  all  information  about  the  objects  of  all  project  categories  of  the
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Horizontal  Alignment  workspace.  Each  tab  of  the  dialogue  box  corresponds  to  an
object type.

You can use the dialogue box of the Find command to find easily any desired object:

Tessera searches the text you have typed in the field throughout the selected tab. If
desired, you can request from the program to find whole words only.

How to search a text in the Information dialogue box

1.Go to the desired tab (e.g. Terrain Points) and  click  the  button  on  the  top  of
the dialogue box. The Find dialogue box will appear on the screen.

2. In  the  Find what  text  field,  type the  text  you  want  to  find.  If  you  want  to  find
whole words only, then you must tick the Match whole word only check box.

3.Click  the  Find  Next  button.  Tessera  will  select  the  first  text  that  matches  the
criteria you have specified. If you want to continue the search to find the next text,
click the same button again. Otherwise click the Cancel button to close the dialogue
box.

When the search is over, Tessera will display the relevant message.

If desired, you can export to a text file the information you see in a tab. Simply go to

the tab whose data you want to save and click the button   at the top left of the
dialogue box. The Save as dialogue box will appear on the screen. In this box you must
specify  the  path  and  the  name of  the  file  that  will  be created.  When  you  click  the
Save button, Tessera will create a text file that will contain the tab data and will have
the .txt extension. You can set the character coding from the ASCII tab that you will
find in the dialogue box of the General Options command of the Tools menu.

7.1.9 Quick Find

You can also  use the  Quick Find  command  to  locate the  desired  objects  within  the
drawing area. You can run this command from the Display menu by clicking the button

.

This part  allows  you to  move  among the  project's elements  (Text,  Point,  PI,  Station
section and Ch). 
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From here you can go to any element by simply entering
its name. If, for example, you want to go to point 389 (i.
e.  to  make it  current),  all  you have  to  do  is  type  this
number in the relevant field and click the Locate button
or press the  Enter  key  regardless  of  the  mode  you are
in.  

7.1.10 Moving Project Elements

In the Horizontal Alignment  mode,  you can move  certain elements  of  the  project  by
running  the  Move  command  of  the  Tools  menu.  This  command  opens  the  following
window:

 

Select the element you wish to move (Drawing, Terrain, Roads) from the window.
In the Move by (X, Y) field, type in meters the desired distance by which the move will
take place on the X and Y axes.

7.1.11 Colour Zones

Color Zones Adjustment

In the Horizontal Alignment mode you can set the colour zone of the road and terrain
slopes by running the Color Zones Adjustment command of the Tools menu. When you
run this command, the following window appears on the screen:
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· To  enter  a  new  Color  Zone,  type  in  the  field   the  number  that  will

represent the initial value of the Zone and then click the button    to register the
value or press the Enter key.

· To delete a Colour  Zone  you must first  select  the  Zone/s  that  you don’t  need by

left-clicking  the  colored  boxes.  By  selecting  even  one  Zone,  the  button    is
enabled. To delete the zone, click this button or press the Delete key.

· If  you want to  reverse the  colours  of  the  Zones  (e.g.  in  the  above  figure,  if  you

want black to become the first color and red the last color), click the button . 
· If you want to place a specific colour in a Zone, right-click on any box to open the

color palette as shown in the figure below:

Select the desired color and click OK to confirm.

· To  create a color  shading based  on  specific  colors  (e.g.  shades  of  red)  you  must
first select the boxes that will be the standard colors (e.g. red will be the first color
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and white will be the last one) and then click the button . 
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7.2 Topographical Background - Workspace - Terrain

7.2.1 Creating the Terrain Model

The  terrain  model  consists  of  points,  triangles,  contour  lines,  breaklines,  perimeters
and oases. In the Horizontal Alignment workspace of Anadelta Tessera you can import
or create the terrain model elements and edit them so as to optimize them in various
ways. You can create the terrain model in the following ways:

1.Directly from the Horizontal Alignment workspace.
2. Import from text files (ASCII).
3. Import from DXF files.

7.2.2 Terrain Management - Properties

The  Professional  version  supports  the  simultaneous  existence  of  multiple  terrain
models. That means that it is possible to create more than one terrain in the same file.
It is also possible to calculate the volumetric difference of the two terrains. 

Terrain management  is  performed  from  the  Terrain  Properties  management  window.
Here you can run all  main commands referring  to  terrains,  e.g.  to  create or  delete  a
terrain.

How to open and close the Terrain Properties management window

1.Click the button  on the Horizontal Alignment toolbar. The  management  window
appears on the screen.

2.Proceed to the desired modifications.
3.When you have finished, click the exit button to close the management window and

return to the main screen.

At first, the management window contains only one terrain, which cannot be deleted.
You can create new terrains and name them as you wish.

How to create a new terrain

1.Open the Terrain Properties management window, as described above.
2.To  create  a  new  terrain  whose  elements  will  be  inserted  by  you,  click  the  New



109Horizontal Alignment

Anadelta Software

button .

A new terrain will be created.  Its  name will  be comprised  of  the  word  Terrain  and  a
serial number, e.g. Terrain 1, Terrain 2, etc. Namely, every terrain has a unique name.
Once the terrain has been created, you can change its name. 

To change the name of a terrain

1.Open the Terrain Properties management window.
2.Left-click on the terrain name to activate the relevant field.
3.Type in a new name.
4.When you have finished, click the exit button to close the management window and

return to the main screen.

All operations regarding the terrain (e.g. Point import) take place in the current terrain.
A  drop-down  list  in  the  Object  Properties  toolbar  allows  you  to  define  the  current
terrain.

How to make a terrain current

Select  the  current  terrain  from the  Terrain  drop-down  list  of  the  Object  Properties
toolbar.

The program allows you to create a true copy of the terrain you are editing.

How to copy a terrain

1.Open the Terrain Properties management window, as described above.
2.To create a new terrain, which will be a true copy of an existing one,  left-click  on

the  terrain  name  to  activate  the  relevant  field  and  then  click  the  Copy  button

.

You can also delete a terrain.

How to delete a terrain

1.Open the Terrain Properties management window, as described above.
2.To delete a terrain, left-click on the terrain name to activate the relevant field and

then click the Delete key .
3. If  you wish  to  delete  the  terrain,  click  OK  on  the  confirmation  message  that  will

appear.
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Very often, while you are working, you may choose to make certain terrains  invisible,
or while editing a terrain you may  choose  the  other  terrains  to  be displayed  without
being editable. You cannot edit or select the elements of a non-selectable terrain, but
the  elements  are  visible  when  the  terrain  is  visible.  It  is  possible  to  use  the  snap
feature on objects of a non-selectable terrain. The terrains that are not visible will not
be displayed on the screen, but you can still print them.

How to make a terrain visible or invisible/ selectable or non-selectable.

1.Open the Terrain Properties management window.
2.Select the fields of the terrains you want to make visible or invisible.
3.Double-click  on  the  Visible  field  to  change the  icon  so  that  it  corresponds  to  the

desired state. When a terrain is visible, then the icon looks like   while when it is

not visible the icon looks like .
4.Select the fields of the terrains you want to make selectable or non-selectable.
5.Double-click on the Selectable field to change the icon so that it corresponds to the

desired state. When a terrain is selectable, then the icon looks like  while when it

is non-selectable it looks like .
6.When you have finished, click the exit button to close the management window and

return to the main screen.

7.2.3 Terrain Options

Every terrain has its own elements, i.e. points, lines and triangles, as well as  its  own
settings  –  options  and  properties,  regarding  the  calculation  of  the  triangles  and
contour  lines,  the  insertion  of  points  and  the  way  the  terrain  is  displayed  on  the
screen.

How to change the options of a terrain

1.From the Terrain menu, select the Terrain Properties command, or from the Terrain
Properties management window, enable one of the fields of the Options column and

click the button with the three dots .

2.Use  the  Previous  Terrain   or  Next  Terrain  buttons  ,  at  the  bottom  right
corner of the dialogue box to go to the terrain whose settings you want to change.
Make sure that the name of the terrain appears on the title bar of the dialogue box.
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3.Go to the desired tab and make your settings.
4. If you wish to restore  the  settings  that  applied  before  making  your  changes,  click

the Restore from Horizontal Alignment button  at the bottom right corner of the
dialogue box. If you wish to restore the default settings that the program applies to

every  new  terrain,  click  the  Set  default  settings  button  .  Finally,  for  the
Professional  version,  if  you want the  current  terrain  settings  to  be  copied  to  the

other terrains, click the Copy to all terrains button. . 
5.To  exit  the  dialogue  box click  OK to  confirm  the  changes you have  made  or  click

Cancel to return to the main screen.

7.2.4 Terrain Points

Terrain points appear on the screen as grey dots. You can create them one by one or
import  multiple  terrain  points  from  text  or  .DXF  files.  Terrain  points  have  four
properties: their x, y, z coordinates and their names.

They can be imported in the same file and in three ways. Namely, some points can be
imported manually and some from a text file. They can also be imported in more than
one phases, i.e. you can import points twice from a text file.

The  terrain  points  are  the  base  for  the  creation  of  the  terrain  model.  All  other
elements  (triangles,  breaklines,  etc.)  refer  to  them  and  they  cannot  exist  without
them. The program has certain restrictions regarding the points. For example, it is not
possible for two points to have the same group of three coordinates or to be less than
one centimetre away from each other.

Importing Terrain Point from ASCII Files

The import of  terrain  points  from text  files  is  the  most  common, since  the  files  that
derive from the various recording instruments are in such format. Every line of such a
file must  correspond to  a point and  include  the  values  of  the  four  elements  of  the
points. The elements of every point must appear in the same order from line to line. 

How to import terrain points from a text file

1.From the File menu, select the Import from ASCII submenu and then run the Terrain
Points command. This command will be displayed on the menu only if you first select
the creation of a new file or open an existing one. In the resulting dialogue box you
can  select  a  file  of  terrain  points  (usually  these  files  have  the  .XYZ  and  .GRD
extensions)  containing  the  X  and  Y  coordinates,  the  elevation  of  the  points  and
their names, which can be their serial number or a description (eg. S5).

2.From the Browse field find the subfolder where your file is located. If your file has a
different extension than  the  ones  stated above,  select  All  files  from  the  File  Type
drop-down list to display it. Select the  desired  file  and  click  Open.  Note  that  your
file must not be open in another program, otherwise an error message may appear.
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3.The  program will  try  to  sort  the  file’s  data in four  columns. At  the  bottom of  the
dialogue box, you can view the form of part of the file namely the order in which the
X,  Y  coordinates,  the  terrain  elevations  and  the  names  of  the  points  have  been
imported. In the Separator group you must select the symbol/s that will be used for
the  separation  of  the  point elements  into  columns,  by  ticking  the  relevant  check
boxes.  The  most  common  separators  are  the  space,  the  comma  and  the  Tab
symbols. If another symbol is used in your file,  then  tick  the  Other  check box and
type  the  symbol  in  the  text  field.  In  case  there  are  two  or  more  separating
characters in the line (usually spaces) to delimit a column, tick the Merge delimiters
check  box,  so  that  the  separation  in  columns  can  be  carried  out  correctly.  By
default, the program reads the data of the first column as the X coordinates of the
points, the data of the second column as the Y coordinates,  the  data of  the  third
column as Z elevations of the points and the data of the last column as their names.
If  the  order  of  the  elements  in  your  file  is  different,  then  you  must  select  the
correct  order from the  menu that  is  displayed  when  you  left-click  on  the  column
title.  You  must also  specify  the  format  of  your  created file.  If  your  file  has  been
created in DOS environment, tick the DOS (OEM) check box. In the Start line  field,
type the number of the line from the beginning of the file, to indicate the point from
which the  program will  start  to  import data.  In  this  way  you  can  omit  lines  that
contain titles or/and comments, or even the import of the first points that are in the
beginning of the ASCII file.

4.Confirm by clicking OK. The program reads the data and  imports  it  to  the  file.  If  a
problem  occurs  during the  file  transfer,  the  program will  display  the  relevant  error
message on the screen.

The points will appear on the screen, according to the way you have selected. If you
want  to  check  the  points  for  possible  errors  (e.g.  double  points)  you  must  run  the
Terrain Validation command to check and correct them. 

Creating Terrain Points 

Although the insertion of terrain points from Anadelta Tessera is not very common, it is
very useful in case you want to add some points.
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How to create terrain points

1.From the Terrain menu, run the Insert point command, or  click  the  button  on
the Elements Drawing toolbar.

2.Use the mouse to set the position of the terrain point.

As regards the names  of  the  points  that
will  be  inserted,  you  can  either  request
from  the  program  to  name  them
automatically when they are  inserted,  or
you can insert then  without a name and
name  them  afterwards,  from  the
Properties command window. You can do
this from the dialogue box of the  Terrain
Options  command.  If  you  want  the
program  to  automatically  name  the  new
inserted  points,  you  must  tick  the
Automatic  naming  check  box  in  the
General tab of  the  Point  insertion  group.
The  name  given  by  the  program  is
comprised  of  the  prefix  that  you  have
typed  in  the  Prefix  text  field  and  of  a
serial number.

Editing Terrain Points

You can edit the points you have inserted, so as to give the  model  exactly  the  form
that  you wish.  Therefore,  you can edit  the  coordinates  of  the  points  or  delete  the
points that you do not need.

Moving and Renaming Terrain Points 

You can move the Terrain Points of your file. 

How to move or rename the selected Terrain Points 

1.With  the  mouse  pointer  over  the
desired  Terrain Point,  click  the  left
mouse button to select the point.

2.Open  the  Properties  command

window  .  To  change  the  name
of the point, type the new name in
the Name field. In the Terrain Point
X, Terrain Point Y  and Terrain Point
Z  fields,  type  the  coordinates  and
the new elevation.

To move a point faster, select it, activate it and move it to its new position by using
the mouse or the Input Form command.

Deleting Terrain Points 
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You can delete one or more Terrain Points, if desired. 

How to delete the selected Terrain Points 

1.Select the Terrain Points you wish to delete.
2.From the shortcut menu that is displayed when you right-click in the drawing area,

run the Delete Objects command, or from the Edit menu run the Delete command, or

press the Del key, or from the main toolbar click the button .

If desired, you can delete all terrain points of your file.

How to delete all the Terrain Points 

From the File menu, select the Delete all  submenu and then select the Terrain Points
submenu and run the All command. 

How to delete all the Terrain Points inside or outside a region

1.Select  the  boundary  (perimeter  or  oasis)  inside  or  outside  of  which  you  want  to
delete points.

2. From the File menu, select the Delete all submenu and then select the Terrain Points
submenu  and  run  the  Inside  selected  boundary  or  Outside  selected  boundary
command, respectively. 

Deactivating Terrain Points 

In many cases,  there  are  points  you want to  exclude from the  triangulation without
deleting them, e.g. stops. The inclusion of a point in the  Terrain  Model  is  a property
defined exclusively by the user. You can select  not  to  include  a point in the  Terrain
Model by deactivating it. 

How to deactivate a point

1.Select the Terrain Point you wish to deactivate.
2.Open the  Properties  command window.  From  the  drop-down  list  of  the  Activated

field, select No. To activate a point, select Yes.

To view and activate all  the deactivated points,  run  the  Terrain Validation  command
from the Terrain menu.

Adding Points– Updating the Terrain Point Elevation from the Existing Model

Every time you insert a new point, this has always zero elevation. You can update the
elevation of the point from the existing terrain model. 

How to update the elevation of a Terrain Point 

1.Select the Terrain Point you wish to update.
2.From the shortcut menu that is displayed when you right-click in the drawing area,

run the Adjust Elevation command.

Updating the Terrain Point Elevation from another Terrain

You can adjust the elevations of a terrain based on another terrain. From the Terrain
menu, run the Adjust Elevations command. The following dialogue box appears on  the
screen.
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From  the  drop-down  list  of  the  To  field,
select  the  terrain  that  will  be  updated  and
from  the  drop-down  list  of  the  From  field
select the terrain on which the update will be
based. Next, click the OK button to apply the
update.

7.2.5 Creating and Editing Perimeters

For the  correct  triangulation,  before  the  insertion of  the  triangles  you must insert  a
perimeter,  which  demarcates  the  area  in  which  the  triangles  will  be  created.  A
perimeter  is  a zigzag  line  whose  peaks  must coincide  with  terrain  points.  Therefore,
you cannot insert a perimeter unless you have first inserted terrain points.

A perimeter can be inserted in three ways:

1. It can be created by the user, who must define its points one by one.
2. It can be calculated automatically by the program.
3. It can be imported from a text or DXF file.

In all cases, once it is created, the perimeter can be modified so as to describe better
the terrain boundaries. Perimeters are shown on screen in green. 

You can insert more than one perimeters. Two perimeters cannot be intersected,  but
one perimeter may be enclosed in another with an oasis between the two perimeters.
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Automatic Calculation of the Perimeter 

To  save  time,  you  can  request  from  the  program  to  automatically  calculate  the
external perimeter. After this  calculation,  you can adjust  the  perimeter  by adding or
deleting points.

How to insert automatically a curved perimeter

From the Terrain menu, run the Calculate curved perimeter command. This results in a
closed curved tangent line that includes all points of the current terrain.

Inserting a Perimeter 

To insert a new perimeter, you must set the terrain points that define it. The points of
a perimeter must coincide with the  terrain  points.  This  method serves  mainly  for  the
insertion of an internal perimeter.

How to set the points of a perimeter

1.From the Terrain menu,  run  the  Insert  perimeter  command, or  from the  Elements
Drawing toolbar,  click  the  relevant  button.  You  will  see  the  highlighted  box in the
middle of the mouse cross, showing you where the perimeter point will be placed. 

2.Define circularly the terrain points that will compose the perimeter (the mouse snaps
automatically the terrain points).

3.Once  you  have  finished  inserting  of  the  points,  click  the  right  mouse  button  to
complete the procedure. 

Automatic Point Inclusion

If you wish, you can request from the program to automatically include points that are
located between the point you define and its previous point. To do this, go to dialogue
box of the General Options command of the Tools menu and in the Insert/Delete group
of the Terrain tab tick the Point inclusion when inserting Breaklines/Boundaries check
box.  The  text  field  below  the  check  box  shows  the  maximum  variation  for  the
automatic inclusion of a point.

Import of Perimeters from External Files

Perimeters  can  be  imported  either  from  ASCII  text  files  or  when  importing  other
elements (e.g. drawing elements), which are all saved in a DXF file. 

Automatic Addition or Deletion of Perimeter Points

To adjust a perimeter faster, you can use the automatic perimeter adjustment.

How to automatically adjust a perimeter

1.Select the perimeter you wish to adjust.
2. From the shortcut menu that  is  displayed  when you right-click on  the  screen,  run

the  Adjust  perimeter  Expand  or  Shrink  command  to  delete  or  add  points,
respectively. This command opens the following dialogue box.
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3. If you want to add/delete points along the whole length of the  perimeter,  activate
the General selection field. If you want to add/delete points to only one part of the
perimeter, select Local. If you select Local, you must specify the width of the sides
between which the boundary will be adjusted. The default value is 7. If you want to

change  this  value,  click  the  button   to  decrease  it  or  the  button    to
increase  it.  Next,  you  must  define  the  perimeter  part  that  can  be  adjusted  by
moving the mouse pointer over it to highlight it.

4. For the adjustment to take place, click the Expand/Shrink button , at the bottom
of the dialogue box or roll the mouse wheel down. The effect is cumulative, namely
more points are added or deleted as you keep rolling the wheel.  The  effect  on  the
boundary can be viewed immediately  on  the  screen.  Keep clicking  the  button until
you are satisfied with the result. If you want to undo the expansion/shrinkage, click

the Reset button  or roll the mouse wheel up.
5.When you have finished, click OK to apply the adjustment. This closes the dialogue

box and returns you to the main screen.

Adding Points to a Perimeter

How to add points to a perimeter

1.Select a point of the perimeter.
2. From the shortcut menu that  is  displayed  when you right-click on  the  screen,  run

the Expand to the beginning or Expand to the end command, depending on what the
side  you  wish  to  insert  the  point  (the  points  of  the  boundaries  have  a
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counterclockwise direction). This command adds a new point to the line on screen,
before or after the point you originally  selected.  The  original  point is  highlighted  in
red, and you can place the new point by moving the mouse pointer as shown in the
figure. The points on which the new point intersects  are  displayed  in yellow, while
the  points  that  are  to  be added  are  displayed  in  green.  The  original  form  of  the
boundary is displayed as a dotted line.

If you wish, you can request from the program to automatically include points that are
located between the point that you define and the previous point.

Deleting a Perimeter Point and a Terrain Point

The Point removal command deletes the selected  PI  of  the  perimeter/oasis  and  joins
the previous PI with the next one. The program does not delete the terrain point. You
can  also  run  this  command  by  pressing  the  Shift+Delete  keys.  If  you  have  already
created triangles  and  then  you delete  a perimeter  point,  the  triangles  will  remain  as
they were and  the  terrain  validation  will  report  the  errors.  Therefore,  you must also
make the relevant corrections on the terrain model.
The  Point  removal command deletes the  selected  PI  of  the  perimeter/oasis  and  the
corresponding terrain point. 

Deleting a Perimeter

You can delete one or more perimeters of the file. The procedure is similar to the one
for the Terrain Points.

7.2.6 Creating and Editing Oases

To  insert  an  oasis  you must have  at  least  one perimeter.  The  oasis  demarcates  an
area that  will  be free  of  triangles  (e.g.  wherever there  is  a housing  settlement or  a
lake). To insert an oasis, follow the same procedure that applies to the insertion of a

perimeter, only in this case you must click the button . The editing options for the
oases are the same as the ones for the perimeters.
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7.2.7 Inserting Breaklines

The purpose of the Breaklines is the demarcation of the  triangles.  Breaklines  are  also
zigzag lines, whose peaks must coincide with terrain points. As a result, to insert them
you  must  have  first  inserted  terrain  points.  During  the  triangulation,  the  program
creates  the  triangles  in  such  a  way,  so  that  their  sides  always  coincide  with  the
breaklines and never intersect them. Thus, it is possible to simulate lines such as the
tops and feet of sideslopes, the roadlines of existing roads, etc.

Breakline Insertion

One way to insert Breaklines is to define their PIs on screen by using the mouse. 

Inserting Breakline with the mouse
1.From  the  Terrain  menu,  run  the  Insert  Breakline  command,  or  from  the  Elements

Drawing toolbar, click the  button. The pointer turns into a crosshair and snaps
terrain points only.

2.Define successively the terrain points that will comprise the breakline. If desired, the
program can automatically  include  points  that  are  located  between  the  point that
you define and  the  previous  point.  Thus,  when the  crosshair approaches a terrain
point, the screen will also display the points that will be included into the line. 

3.When you have finished inserting points,  click  the  right  mouse  button to  complete
the procedure. 

A breakline may intersect with other terrain lines (Perimeters, Oases, Breaklines), only
on  terrain  points.  In  this  case,  the  program  does  not  allow  PI  insertion,  while  the
points where the BKL is intersected are displayed in yellow.
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Also, a breakline cannot refer to disabled points. For this reason, when you approach
the mouse pointer to such points, a yellow circle appears around the point.

You  can also  insert  breaklines after  the  creation  of  triangles.  In  this  case  you  can
choose the triangulation to be carried out immediately upon breakline insertion, so that
the triangles that are affected by the inserted breakline are immediately reformed. 

To do this, go to the dialogue box of the General Options command of the Tools menu
and  in  the  Import/Delete  group  of  the  Terrain  tab,  tick  the  Triangulation  when
inserting Breaklines check box. 

Conversion of Drawing Lines to Breaklines

Another way to create a breakline is the conversion of a drawing line. Select the line
to be converted and  from the  shortcut  menu that  appears when you click  the  right
mouse button select the Conversion submenu and  then  run  the  Convert  to  Breakline
command. For the conversion to take place, all  line  points  must  coincide  with  terrain
points.  The  properties  of  the  new  breakline  are  the  current  ones.  The  drawing  line
remains almost unchanged.
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Editing Breaklines 

You can insert additional points to a breakline, delete a point from a breakline or delete
the whole breakline.

Breaking and Merging Breaklines

For  easier  management  of  the  lines,  you  can  break  a  breakline  in  two  or  more
breaklines, or you can merge multiple breaklines together into a single breakline.

Merging Breaklines

To  merge two breaklines,  select  them both  and  then  run  the  Merge  lines  command
from the menu that is displayed when you right-click on the screen. For the merging to
take place, the last PI of one breakline must be the first PI of the next breakline.

Breaking Breaklines:

If desired, you can break a brakline into two or more parts. 

To break a breakline in two

1.Select the breakline you wish to break. Select the PI where breaking will take place.
2.From the shortcut menu that is displayed when you right-click in the drawing area,

run the Break at point command.

If desired, you can break a line into many parts; each of these parts will be comprised
of only two PIs.

To break a line in multiple parts

1.Select the breakline you wish to break.
2.From the shortcut menu that is displayed when you right-click in the drawing area,

select the Break lines command.

Converting Breaklines to Drawing Lines

To  convert  a  breakline  into  a  drawing  line,  select  the
desired  breakline  and  from  the  menu  that  is  displayed
when you right-click on  the  screen run  the  Convert  to
drawing  line  command.  The  properties  of  the  new  line
are the current ones.

7.2.8 Terrain Validation

The terrain validation must be performed before  the  triangulation.  This  stage  (before
creating  triangles)  aims at  the  detailed validation  of  the  points.  Terrain  validation  is
performed automatically when you request triangulation, but it can also be carried out
at any given time, upon the user’s request.

How to perform terrain validation

1.From  the  Terrain  menu,  run  the  Terrain Validation  command,  or  press  the  Ctrl+G
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keys, or from the Horizontal Alignment toolbar click the  button. The program will
start  validating  the  terrain  elements.  A  bar  appears  at  the  bottom  right  of  the
drawing area, showing you the validation progress.

2.When validation is over,  a dialogue  box opens on  the  screen.  In  this  box you can
find and correct any errors of the terrain model. In this phase (the terrain model has
not yet been created), most errors refer to the terrain geometry.

The dialogue box has four  tabs.  The  first  two tabs (Structure,  Excepted)  display  all
kinds of problems.  In  the  Excepted  tab  you can see  the  points  that  were exempted
either by the user or by the program, according to the terrain model settings. Finally,
in the Total actions tab, you can see the  actions  that  will  be carried  out  to  correct
the errors that have been detected during the terrain validation. The first  three  tabs
consist of two groups. 

In the Terrain Elements  group, at the top left of the window, you can see  the  tree-
structure graph with the terrain elements where a problem was detected.

Left-click  on  the  +  symbol  next  to  each  element  category  or  double-click  on  the
category, to  view  the  relevant  elements.  Left-click  on  the  +  symbol  next  to  each
element or double-click on the element to view the problems of this element. You can
select an element by left-clicking on it. The name of the selected element appears in
the Selected Element box right below. 
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Below this group there are the buttons with the relevant actions. If you click the 
button, the problems of all  elements and all  categories  will  be displayed,  while  if  you

click the  button, the problems will shrink.

The   button transfers  the  drawing  view to  the  drawing  area where the  selected

element is. This  element appears highlighted  on  the  screen.  With the    and  
buttons you can change accordingly the view in the drawing area.

In the Energy group, which is located at the right part of the window, you can define
the  actions  that  will  be carried  out  to  solve the  problems  that  were  detected.  The
appearance  of  the  group depends  on  the  current  tab.  You  can  delete,  activate  or
deactivate the selected element, or you can select no to proceed to any action at all.
If an  option is  not  available  for  the  particular  element,  either  this  option will  not  be
displayed at all or it will be inactive.

At the bottom of the window you will find the    buttons; use these buttons
to carry out an action for all elements of the selected category.

Finally,  by  ticking  the  Merge  check  box,  the  double  points  (points  whose  x,  y,  z
coordinates are the same) are deleted.

7.2.9 Triangulation and Contour Line Calculation

The  next  step  in  the  creation  of  the  terrain  model  is  the  triangulation  and  the
calculation of contour lines. Prior  to  this,  however,  you must specify  the  settings  of
the  digital  terrain  model  by  clicking  the  Terrain  Options  command  from  the  Terrain
menu.

Triangulation

Triangulation Settings

To select the  triangulation settings,  run  the  Terrain Preferences  command  and  then
go to the Triangulation group of the General tab. 
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When the Minimum acceptable height  check
box  is  ticked,  Tessera  ignores points  whose
elevations are lower than the value typed in
the corresponding  field.  When  the  Maximum
acceptable  height  check  box  is  ticked,  the
program ignores the points whose  elevations
are higher than the value of the  field.  When
the  Maximum  face  length  check  box  is
ticked, the  program will  not  create triangles
with faces larger than the value indicated  in
the corresponding field.

Triangulation

For the triangulation to  take  place,  run  the  Triangulation  command  from the  Terrain

menu, or press the Ctrl+B keys, or from the Horizontal Alignment toolbar click the 
button. When  the  Terrain Validation  is  completed,  if  there  is  no  significant  problem,
the  program  will  start  creating  the  terrain  model  based  on  the  inserted  points,
perimeters,  oases  and  breaklines.  During  this  process,  the  terrain  points  are  joined
together with straight lines to create triangles. When creating the  terrain  model,  the
program takes into account the breaklines,  the  perimeter,  as  well  as  any oases  that
you may have inserted. 

When  the  calculation  is  over,  if  you  have  selected  to  view  the  triangles,  and
specifically only the faces of the triangles, you will see the following screen. 

An empty area (as shown in the figure) means that the distance  between  the  points
of that area was higher than the one you had specified in the digital terrain model, and
as a result the points were not joined to create triangles. These areas are the “natural
oases”,  whose  maximum face is  the  one  you  specified  in  the  Triangulation  dialogue
box. 

Insertion of Triangles

You  can  also  create  triangles  manually.  To  do  this,  select  the  Insert  Triangles
command from the Terrain menu and then select one of the three secondary options,
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which are:
· Three Points: With this option you can create triangles using any terrain point.
· Repeat Last Point: When you run this command, the first point of every triangle you

create will be the last point of the previous triangle.
· Point  and  face:  To  draw  triangles  with  this  command,  you  must  define  only  one

point/face of the triangle, since its two other points are defined automatically by the
existing adjacent triangles.

Editing of Triangles

You  can  intervene  and  edit  the  terrain  model.  If  you  run  the  Triangles  Editing
command from the Terrain menu,  you will  notice  that  the  triangles  under the  mouse
pointer are turning green. Move the pointer to the desired triangles and click  the  left
mouse button to change the diagonal of the quadrilateral. In this way, you can visually
correct any anomaly in the digital terrain model. The changes you are  making  appear
immediately on the screen. The review and editing process is facilitated by the various
methods that the program offers for the presentation of the terrain model.

Scanning Triangulation for Holes

If  certain  parts  of  the  terrain  model  that  you  have  created,  have  holes,  you  can
request from the program not only to scan for these holes, but also to create triangles
in  these  parts  without affecting  the  remaining  terrain  model.  To  do  this,  select  the
Scan Triangulation for Holes command from the Terrain menu and then  select  one of
the following available options:
· Insert Drawing Lines: When you select this option, the program marks the holes with

drawing lines.
· Insert  Perimeters:  With  this  option,  the  program  inserts  perimeters  instead  of

drawing lines in the holes.
· Triangulation:  With the  triangulation option,  triangles  are  created in the  places  of

the holes, without affecting the remaining terrain model.

Calculation of Contour Lines

The next step in the presentation of the terrain is the calculation of the contour lines.
 

The horizontal equivalent of contour lines for
the  current  terrain  is  defined  from  the
dialogue  box  of  the  Terrain  Preferences
command.  More  specifically,  go  to  the
Calculate Contour Lines group of the General
group and in the Insert a contour line every
text  field  type  the  distance  between  two
contour  lines.  In  the  Main  contour  lines
every text field of the same  group,  you can
specify the elevation difference between two
main contour lines.

How to calculate the contour lines

From  the  Terrain  menu,  run  the  Calculate  Contour  Lines  command,  or  from  the

Horizontal Alignment toolbar, click the  button.

When  this  operation  is  over,  you  can  view  the  contour  lines  that  were  drawn  by
selecting the View contour lines option. 
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At this point, while viewing the contour lines, you can edit the terrain  model  in  order
to get a better view of the relief. To view the editing results on the contour lines, you
must repeat the contour line calculation. 

You  can choose,  from the  Display  options  (Curved or  Straight  lines  fields),  how the
contour lines will appear on the screen (zigzag or curved).

7.2.10 Display of Terrain Elements

The program enables you to control how the  terrain  elements  will  be displayed,  both
on screen and on the printout.  

You can select  which  elements  of  a terrain  will  appear  on  screen and  how they will
appear, from the dialogue box of  the  Display Options  command  and  from the  Terrain
Preferences dialogue box, and more specifically  from the  View  1,  View 2  and  View  3
tabs. Here you can define which of the terrain elements (and of the remaining project
as  well)  will  be visible  in order to  facilitate  your  work,  as  well  as  how  they  will  be
displayed. More specifically, the following apply to every terrain element: 

1.Points:  Points  appear  on  the  screen as  gray  dots.  If  desired,  you can display  the
name and the elevation of the point. The name of the point appears at the top right
of the point,  while  the  elevation  appears at  the  bottom right  of  the  point.  Enable
this  view  either  from  the  Terrain  Preferences  dialogue  box,  or  from  the  Options
command dialogue box. In all cases, select the desired terrain and tick the Points (to
view  the  points),  Names  (to  view  the  names)  and  Elevations  (to  view  the
elevations) check boxes. 
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2.Breakline  and  Boundaries (perimeters  and  oases):  Breaklines  appear  on  screen  as
continuous red lines, while perimeters and oases  appear  as  continuous green  lines.
You can activate this view either from the Terrain Preferences dialogue box or from
the  dialogue  box of  the  Options  command. In  all  cases,  select  the  desired  terrain
and tick the Breakline check box (to view the breaklines) and the Boundaries check
box (to view the perimeters – oases). 

3.Contour lines: They are displayed on screen as continuous lines (curved or zigzag),
the main ones in yellow and the intermediate ones in purple. If desired, the contour
line elevations can be displayed through the lines.  You  can activate  the  display  of
the  contour  lines  either  from  the  Terrain  Preferences  dialogue  box,  or  from  the
dialogue box of  the  Options  command. In  all  cases,  select  the  desired  terrain  and
tick the Contour lines (to view the contour lines), the Contour Lines Elevations  (to
view  their  elevations)  and  the  Curves  check  boxes  (to  view  the  contour  lines  as
curves). 

You can set the curvature factor, i.e. how rounded the curves will be, by moving the
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slider located in the Terrain Preferences  dialogue  box,  right  below  the  Curves  check
box. To  decrease  the  curvature  move  the  slider  to  the  left,  while  to  increase  the
curvature move the slider to the right. 

Display of Triangles

Tessera offers you four possible views of the triangles and you can combine  them to
achieve the best results. 

1.General: Regardless of how the triangles will be displayed, you can choose  to  view
or hide  them from  the  dialogue  box  of  the  Options  command.  Select  the  desired
terrain  and  tick/untick  the  Triangles  check  box,  to  show  or  hide  the  triangles,
respectively.

2.Faces: You can chose to view the triangle faces either from the Terrain Preferences
dialogue box or from the dialogue box of the Options command. In all  cases,  select
the  desired  terrain  and  tick  the  Grid or Faces  check  box,  respectively.  The  figure
shows an  example  of  the  way  the  triangles  are  displayed  when  you’re  using  this
method.

3.Shading: The figure shows an  example  of  triangles  with  shading.  You  can activate
the shading from the same dialogue boxes as in the case of the faces, only now you
must  tick  the  Shading  check  box of  the  Shading  group  in  the  View  1  tab  of  the
Terrain Preferences  dialogue  box.  Use  the  sliders  to  set  the  brightness  from  the
Volume field, as well as the color of  light  from the  Ambient  Light  field.  To set  the
angle of the light, left-click in the white box.
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4.Elevation Shading: The figure shows an example of triangles with elevation shading.
You  can activate  this  view  from  the  same  dialogue  boxes  as  in  the  case  of  the
faces, only now you must tick the Elevation Shading check box in the View 2 tab of
the Terrain Preferences  dialogue  box.  If  you want to  also  view a legend  with  the
elevation zones in the drawing area, tick the Legend check box. Likewise, to view a
separating  line  on  the  color  zones  boundary,  tick  the  Boundaries  check  box.
Regarding  the  elevation  definition  of  the  zones,  these  can  be  defined  either

automatically by the program when you click the  button or you can define them

by filling in the Minimum elevation and  Step  fields  and  clicking  the   button.  To
set the colors, there are six color combinations  stored  in the  program memory  and
you  can  choose  the  desired  one  from  the  drop-down  list.  When  you  select  the
Personal  1  and  Personal  2  combinations,  you  can  create  your  own  color
combinations.  To select  the  color  of  a zone,  click  on  the  zone’s  colored  box  and
select a color  from the  resulting dialogue  box.  To automatically  fill  the  boxes  with
interpolations of two boxes, select the desired two boxes  by click  the  right  mouse

button and then click the  button. If you want the color zones to be reversed in

terms of elevation, click the  button.

5.Slopes  coloring:  Tessera  also  provides  you  the  possibility  to  color  the  triangles
according to their slopes. You can activate this view from the same dialogue boxes
as in the case of the faces, only now you must tick the Slopes coloring check box in
the View 3 tab of the Terrain Preferences dialogue box. The parameters that apply
to the zone coloring are the same as in the case of the elevation shading.
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7.2.11 Terrain Model Export

Exporting Terrain Points to a Text File

You can create a file  that  will  contain  the  terrain  points  of  the  current  terrain.  The
format of such files is similar to the format of the files that you use in order to import
terrain points. You can set the character coding from the ASCII tab that you will find
in the dialogue box of the General Options command of the Tools menu.

To export terrain points to ASCII files

1.From the File menu, select the Export to ASCII submenu and run the Terrain Points
command.

2.Specify the path and the  name of  the  file  where the  points  will  be saved. Terrain
points will be exported to a file with the .GRD extension.

3.Click OK to create the file.

Exporting the Whole Terrain Model to Text Files

You can export  the  terrain  model  you have  created in the  Anadelta  Road  Design  to
text  files  (ASCII).  The  software's  export  files  are  compatible  with  the  RDDSS  (Road
Design Digital Submission Specifications). 

How to export the terrain model to ASCII files

1.From the File menu, select the Export to ASCII submenu and run the Terrain Points
command. The terrain points are exported to  three  files,  one for  each  category of
elements. The terrain points will be exported to a GRD file, the triangles to a TRI file
and  the  breaklines to  a BKL  file.  You  can export  RLN  files  by running  the  Drawing
Elements command of the same submenu.
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2.Tick the check boxes for every category of terrain points you wish to export. In the
text field, type the file name and the drive path where your files will be created. If
desired, you can specify the path for each category by clicking the button next to
every text field. 

3.Click OK to create the files. If the terrain points don’t have a name, the program will
ask you whether you wish the  names  to  be added automatically,  showing  you the
relevant confirmation message. Click OK to proceed.

7.2.12 Terrain Model Import

Opening an Older Version File (Files from Anadelta ROAD DESIGN 3.xx)

In  Anadelta  Tessera  you  can  edit  files  of  the  Horizontal  Alignment  mode  of  the
Anadelta  Road Design  3.xx  software  pack.  You  can  open  these  files  with  the  Open
command. The  program recognizes  fully  the  terrain  elements  contained  in such  files,
enabling you to continue processing your work.

Importing the Whole Terrain Model from Text Files

You can import a terrain  model  from text  files  (ASCII)  by running  the  Terrain Points
command from the Import from ASCII submenu of the File menu. The procedure is the
same as for the export of the terrain model. The terrain elements are imported in the
current terrain.

Importing Terrain Points per Cross Section

The program can add points to  a terrain  based  on  the  data resulting from the  cross
sections. More specifically, the Terrain Points per cross section files command of  the
Import from ASCII submenu of the File menu, imports additional points  from a terrain
file  per  cross  section  (*.ACS).  Such  files  are  also  created  by  the  Cross  Sections
program (Version 3.xx), as well as from the  Cross  Section  workspace  ú  File  menu ú
Export to ASCII submenu ú  Lines command. To execute this command, you must have
selected a calculated road where stationing has been performed. 

Importing the Whole Terrain Model from a DXF file

The last type of files from which you can import data are files with a .DXF extension.
These files  guarantee  compatibility  when working with  other  drawing  packages  (e.g.
AutoCAD), from which the DXF files are exported.

How to import the terrain model from DXF files

1.From the File menu, select Import from Dxf and then run the  Import  Terrain  from
DXF command.
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2.The  program  reads  the  file  and  displays  the  dialogue  box  shown  below.  In  the
Terrain tab select whether the points will be imported from Point  or  Polyline.  When
you  tick  the  Create  points  check  box  in  the  Create  from  POINT  group  or  in  the
Create from POLYLINE group, the options of each group become available.

3.Tick the  check  boxes  for  every  category of  terrain  points  you wish  to  import and
from the drop-down lists select the layer where these terrain points are. When the
Layer  sorting  box is  ticked,  the  program will  sort  out  the  layers  according  to  the
objects that are located in every layer.

4. If, in addition to the terrain points, you wish  to  import all  other  data of  the  file  in
the form of drawing, you must also select the Loading drawing option.

5.Click OK for the file to be read. The result of this import will be displayed immediately
on the screen. The elements are imported in the current terrain.

If you want all data of the Dxf file (and the terrain points) to be imported in the form
of drawing,  you must select  Import  from Dxf  from  the  File  menu  and  then  run  the
Import Drawing from Dxf command.

7.2.13 Calculating Slope Areas

Area Calculation

With  the  Calculate  Slope  Areas  command  of  the  File  menu,  you  can  calculate  the
horizontal  areas in  groups  that  are  determined  according  to  the  terrain  slope.  This
calculation can be performed either for the whole area of the terrain or for a specific
part. This command results in the following window:
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If  you  want  the  calculation  to  be  applied  to  the  whole  terrain,  select  from  the

 drop-down list the desired scale according to which the areas

will  be displayed  and  then  click  the    button,  so  that  the  surface  areas  can  be

calculated in m2, as shown in the figure below:

To calculate the area of a particular surface, go to the Horizontal Alignment mode and
circle  with  a  drawing  line  all  the  terrain  points  you  wish  to  be  taken  into  account
during the calculation. 

Next, click the  button to move the coordinates of the selected line to the left part
of the window, as shown below:
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To save the results of the area measurement in text files, click the  button, while

to open an existing text file click the  button.

To delete the data from the Calculation Boundary window, click the  button.

7.2.14 Surface Calculation - Volumes

Volumes

With  the  Calculate  Volumes  Difference  command  of  the  Terrain  menu,  you  can
execute volumes calculations. The  calculation  is  performed between  one terrain  that
you select from the drop-down dist of the Definition A group and a terrain or  a plane
that you select from the Definition B group.

To select a terrain, tick the Terrain check box and select  the  terrain  from the  drop-
down list. To select a plane, tick the Plane check box and  select  the  plane  from the
tabs right below.  Each  tab  corresponds  to  a plane  definition  method.  If  the  plane  is
parallel to the XY plane, select the respective tab and type the elevation of the plane
in the Z text field. If the plane is defined by three points, go to the respective tab and
type the coordinates of each point. If  the  plane  is  defined  by two points  and  by its
angle  with  respect  to  the  horizontal,  display  the  Axis  and  angle  tab  and  type  the
coordinates of the points  and  the  angle.  If  you select  a terrain  point on  the  screen

and click the  button, the coordinates of this point are copied.

In all cases, when you click the OK button, the relevant calculations are performed. In
the drawing area, the cuttings areas are displayed in red,  the  fillings  in blue  and  the
part  of  the  terrain  that  remains  unchanged  is  displayed  in  gray.  From  the  General
category  of  the  Options  command  dialogue  box,  you  can  define  how  the  volumes
differences will be displayed.
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7.2.15 Adjusting the Elevations

From  the  Road  Design  menu  of  the  Horizontal  Alignment  mode,  select  the  Adjust
Elevations command. With this command you can adjust the elevations of a terrain to
another terrain.
To execute this command, follow the steps below:

· Import a terrain (File ú  Import from ASCII ú  Terrain Points).

· Create a new Terrain (from the Horizontal Alignment toolbar ú  ).
· In the Object Properties toolbar, activate the second terrain  that  you created and

then import the desired terrain in the same way as described above.
· When both terrains have been imported from the Road Design menu, click the Adjust

Elevations command. The following window will appear on screen:

· In the To field select the terrain that will get the elevations, while in the From  field
define the terrain from which the elevations will be obtained.

· Click OK to close the window and to perform the adjustment of elevations.

7.2.16 Slope Analysis

With slope analysis you can control the rainwater run-off, provided that the horizontal
and vertical road design are completed. 

Selecting the Slope Scale
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To select the desired scale, go to the Road Design menu, select the Road Preferences
command and define the slope scale  in the  Slope Analysis  tab.  The  following  window
appears on the screen:

In the Sampling group you can define the Maximum  and the Minimum steps according
to  which  the  program searches  the  slope  differences  in  the  parts  of  the  road.  The
bigger these steps are, the quicker the analysis, but with less accuracy.

In  the  Color  scale  group,  you  can  select  the  desired  scale  from  the

 drop-down list.
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7.3 Road Design

7.3.1 Introduction

This chapter explains all  operations that you can perform from the  Road  mode of  the
Horizontal Alignment workspace  or  that  are  directly  related to  the  design  of  a road.
The data of the tangent curve are entered  graphically,  showing  also  the  distance  of
the PI to be inserted from the previous one, or numerically (by typing the coordinates
of the PIs). They can also be imported from a text file or you can convert  a drawing
line to a tangent curve.

Before the road is calculated, you must check all properties of the road, the properties
of the PIs and the general preferences. You  can select  from numerous  sequences  of
transition curves and turns for every  PI  and  for  two successive PIs.  For every  PI  or
couple  of  PIs,  the  program  suggests  the  appropriate  values  for  the  length  or  the
parameter of the clothoid or the tangent offset.

You  can  also  intervene  graphically  to  the  axis  before  or  after  the  cross  section
calculation or even after the stationing. Every time you move an object, the program
checks  whether  there  is  an  acceptable  solution.  You  can  insert  the  cross  sections
numerically,  but  it  is  also  easy  to  insert  graphically  the  cross  sections,  as  well  as
widenings and shoulders. This insertion is even easier when you use the snap feature
on terrain point, drawing, etc.

After the calculation of the axis, you can view and edit the superelevation diagram by
applying  different  rules  and  different  parameters.  After  the  statioting,  you  can
immediately  update  and  view  the  Profile  workspace  with  the  profile  of  the  natural
terrain,  as  well  as  the  Cross  Section  workspace  with  the  natural  terrain  per  cross
section.  In  the  final  stage,  when  you  update  from  the  Profile  and  Cross  Sections
workspaces, you can view in the Horizontal Alignment workspace data referring to the
road profile, the roadlines and the sideslopes of the road.

7.3.2 Creating a New Road

If you have opened a HOR file, Tessera recognizes automatically the roads  contained
in the file and there is no need to recalculate them. In this case, you can also see the
sideslope and roadway lines, if any.

A road in Tessera is comprised of PIs. The procedure that you should follow to insert
and calculate a new road has seven stages:

1.Definition of the names and coordinates of the road PIs .
2.Determination of the curve type at each road PI and of the corresponding values (e.

g. Radius). 
3.Determination  of  the  road’s  specifications  regarding  its  widths  and  the

superelevation diagram.
4.Calculation  of  the  road  and  PI  data  editing  in  case  an  error  occurs  during  the

calculation of the road.
5.Definition of widenings and medians.
6.Creation of cross sections.
7.Update of the other two workspaces.

Inserting a Road

To insert a new road, you must first specify  the  coordinates  of  its  PIs  and  then  the
geometric characteristics of every PI.

How to insert the PIs of a road
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1.From  the  Road  Design  menu,  run  the  Insert  road  command, or  from the  Elements

Drawing toolbar, click the  button.  The  highlighted  square  in the  middle  of  the
mouse cross shows you the place where the PI will be inserted.

2.Use the mouse  to  specify  in ascending  order the  position  of  the  PIs  of  the  road’s
tangent curve, or use the Input Form dialogue box or the dialogue box of the snap
feature for more accuracy, working from the beginning to the end of the road.

3.When  you  have  finished  importing  PIs,  click  the  right  mouse  button  to  end  the
procedure. 

If you want to set the road PIs with higher accuracy, you can do this from the window
of the Road PIs command.

You can also create a tangent  curve  from a drawing  line.  Simply  select  the  drawing
line  and  from the  menu that  will  be displayed  if  you right-click in the  drawing  area,
select  the  Convert  submenu  and  run  the  To  road  command.  A  new  road  will  be
created, whose PIs will be the points of the drawing line. The order of the  PIs  is  the
same as the order in which the points of the drawing line were inserted.

Importing a Road from a Text File

You can import the tangent curve of a road from text files (ASCII). To do this, select
the Import from ASCII submenu of the File menu and run the New road tangent curve
command. A dialogue box will appear on the screen, where you can select  a tangent
curve file (such files have usually the .XYV extension), containing all  data required for
the calculation.

Each line of the file corresponds to a PI. A comma separates the  data on  every  line.
The  first  data is  the  code  that  corresponds  to  the  type of  turn.  The  codes  of  the
transitions are listed in the following table.

Code Type of turn

1 Clothoid – Circle - Clothoid

2 Parabola – Circle - Parabola

3 Compound

4 Clothoid – Circle – Egg-shaped – Circle –Clothoid

5 Clothoid – Circle – Clothoid (two PIs) / Hairpin bend

6 Clothoid – Circle – Circle – Clothoid

10 Auxilliary PI (Used only when the previous PI is 4 or 5 or 6)

The codes from 1 to 3 refer only to the PI of the particular line. The codes from 4 up
to  6  refer  to  the  PI  of  the  particular  line  and  to  the  next  one,  which  is  always
indicated by the code 10.

The other data that you must input is the PI name and the X and Y coordinates. Then,
and according to the type of the PI, you must input the necessary elements and the
method that you have selected for the  calculation  of  the  PIs.  To do  this,  go  to  the
Project menu ú  General  Preferences  command ú  Calculations  tab  ú  Elements  input
type group.
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For the clothoid and the parabola (codes 1 and 2), first you must input the parameter
or the length of the clothoid or the leading tangent offset (depending on the selected
calculation method), and then the radius and the corresponding value at the entrance.
For  the  compound,  you  must  input  the  angle  of  the  leading  curve  or  the  leading
tangent offset or the tangent length following this  order,  and  then  the  radius  of  the
trailing curve, the radius of the main circular arc, the radius of the exit arc and finally
the angle of the exit arc or the  trailing  tangent  offset  or  the  tangent  length  for  the
exit. For the double PIs, the values are  the  leading  element and  follow  the  radius  of
the first circular arc, the radius of the second circular arc and the trailing element. For
the auxiliary PIs (code 10) no additional data is needed, since all  the  necessary  data
have been input for the previous PI.

Importing a Road from a Project

To transfer a calculated road from an existing file to the current project, you must go
to the File menu and run the Load Road from Project command. The following window
will appear on the screen:

Here,  you can select  the  road  you wish  to  import.  Click  the  OK  button to  view  the
calculated road, which maintains not only its PI data but also its sideslopes.

Terrain Profile

When  the  road  design  is  performed,  you  can  view  what  the  terrain  profile  will  be,
without having to update the Profile workspace. In this way, you can view the slopes
of the terrain at the point where the road has been designed.  Thus,  you can detect
possible problems (big terrain slopes) and correct them by moving the road design. To
do  this,  select  the  Terrain Profile  option from the  Road  Design  menu.  A  window  will
appear on the screen, showing the designed terrain profile. 

7.3.3 Road Properties

The specifications of a road depend on many factors. The specifications that must be
adhered  to  are  usually  those  stipulated  by  the  relevant  regulations  or  by  the
supervising  authority  or,  finally,  by  the  project's  needs.  In  any  case,  the  careful
setting  of  the  road’s  specifications  is  a main  prerequisite  when  designing  a  road,  in
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order for the road to have the desired layout. 

How to set the specifications of a road in Tessera

1.Select the desired road and from the Road Design menu select the Road Preferences
command.

2.From the dialogue box of the Road Preferences command, select a tab and proceed
to the desired settings. 

3.When you have finished setting the preferences, click OK to close the dialogue box.

You can make settings about: 

· The elements of the road PIs (General, PI and Slopes tabs).
· The road widths (Widths tab).
· The necessary parameters for the calculation of the superelevation diagram (Slopes

and Diagram tabs).
· The stationing preferences (Stationing and Terrain Sampling tabs).

Chainage 

The  chainage  of  the  road  axis is  performed according to  the  order in which  the  PIs
were inserted, starting from the first PI.

Starting Chainage

The  initial  value  of  the  starting  chainage  is  zero.  If  your  design  concerns  only  a
section of a road, obviously the Starting Chainage is different. This is defined from the
dialogue box of the Preferences command.
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How to define the Starting Chainage

1.From the Road Design menu, run the Road Preferences command.
2. In the displayed dialogue box, select the General tab.
3. In the Start Ch text field, type the Staring Chainage of the road.
4.Click the OK button.

Reverse Chainage

Chainage is performed according to the order in which the PIs were inserted, i.e. zero
chainage coincides with the first road PI that you inserted and is  independent of  the
PI names. To reverse the  chainage,  select  the  road,  right-click in the  drawing  area,
and from the displayed menu run the Reverse road command. The program will rename
the  PIs  and  update  the  stations  of  the  horizontal  alignment  based  on  the  new
chainage.  In  addition,  the  widenings  will  be  transferred  to  the  opposite  side  of  the
road. In order for the profile and the cross sections to  comply,  you must proceed to
the relevant update.

7.3.4 PI Properties

The  properties  of  the  PIs  are  defined  from the  Road  Design  menu,  by  selecting  the
Road  Preferences  command.  Set  the  properties  in  the  corresponding  fields  of  the
General and PI tabs, in the dialogue box shown below: 

In  the  General  tab,  you  can  set  all  the  parameters  required  for  your  project.  The
required  data  is  the  road(s)  design  speed  V(km/h),  the  coefficient  of  transverse
friction f  and  the  maximum curve  superelevation q.  Type  these  values in the  Design
speed  (km/h)  and  Coefficient  of  transverse  friction  fields  of  the  General  tab
respectively, and in the Maximum curve superelevation field of the Limit Values  group
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in the Slopes tab. 

To set the type and the data of the calculated curve at every  new PI,  go  to  the  PI
tab. In this window and only in the Professional version, you can select the new PIs to
be of the Clothoid –Circle  –  Clothoid  or  Cubic  Parabola  type,  by ticking  the  relevant
check box. In  the  Standard  version,  the  new PIs  are  bound to  be of  the  Clothoid –
Circle – Clothoid type.

In  the  Circular  arc  radius  text  field,  enter  the  curvature  radius  R.  The  minimum
suggested value for the curvature radius, which is displayed next to the field, derives
from  the  above  formula  and  depends  on  the  design  speed,  the  coefficient  of
transverse  friction  and  the  maximum curve  superelevation that  you  have  entered  in
the General tab. You have the option to change the minimum radius, if desired.

In the last three fields, you can set the parameter A of the curve, the  length  of  the
clothoid  L  as  well  as  the  offset  ε,  by  using  either  the  clothoid  or  the  parabola  (
Professional version) as transition curve.  According to  literature,  when the  transition
curve is a clothoid, these three values are related with the following formulas:

 
If  you  change,  for  example,  the  length  of  the  clothoid,  then  the  offset  and  the
parameter A will also change. Depending on the calculation method you have selected
from  the  Project  menu ú  General  Preferences  ú  Calculations  tab  ú  Elements  input
type group, only one of the three text fields is active. 

When the transition curve is a parabola, the formulas applied for the calculation of the
values will change according to the type of the parabola, which is also selected  from
the  Elements  input  type  group  of  the  Calculations  tab  in  the  dialogue  box  of  the
Project menu. 

When you have made all the desired settings as described above, and if these are the
settings that you usually work with, it is recommended to click the OK button. The To
all PIs button replaces all the values of the existing PIs of the road with the ones you
have entered in the dialogue box.

7.3.5 Editing PIs

Adding PIs to a Road

You can add as many PIs as you want to an existing road.

How to add a PI to a road

1.Select the road you wish to edit by placing the mouse pointer over a PI and clicking
the left mouse button.

2.From the shortcut menu, which is displayed if you right-click in the drawing,  select
Extend  towards start  or Extend  towards end,  depending on  the  direction  towards
which you wish to insert the new PI.

3.Specify the position of the new PI. If the new PI  is  inserted between  two existing
PIs, the program displays a confirmation message, and you must select whether the
PIs that are next to the new one will be renamed.



143Horizontal Alignment

Anadelta Software

Moving PIs on a Road

You can easily  move  the  PIs  with  the  mouse.  Left-click  to  select  and  highlight  the
desired PI and then simply drag the PI to the desired place. When you drag the PI, the
L1  and  L2  distances  between  the  PI  you  are  dragging  and  its  two  adjacent  ones
(previous and next) appear on the left of the status bar.

You  can  also  change  the  position  of  the  PI  from  the  window  of  the  Properties
command.

When  this  window  is  open  and  you  select  the  desired  PI,  you  can  define  the  new
position of the PI by typing the X and Y coordinates in the PI X and PI Y text fields.

Batch Moving of Road PIs

From  the  Road  PIs  command  window  you  can  carry  out  a  batch  editing  of  the  PIs
positions.

How to carry out a batch move of the road PIs

1.Select the desired road and then run the Road PIs  command  from the  Road  Design
menu.

2.The  program displays  the  following  window, which  is  comprised  of  twelve  columns
that correspond to the serial number of the PI, the X and Y coordinates of each PI,
the distance from the previous PI, the angle from the previous section, the  leading
clothoid  parameter,  the  leading  clothoid  length,  the  leading  tangent  offset,  the
circle  radius,  the  trailing  clothoid  parameter,  the  trailing  clothoid  length  and  the
trailing tangent offset. Each line of the window corresponds to a PI.
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3.Change the values in the desired text fields by typing the new coordinates and then
press the Enter key to save the value. 

4.Click the  OK  button to  confirm  the  changes or  click  Cancel  to  restore  the  original
settings.

Renaming Road PIs

The program renames the PIs of a road in ascending order and according to the order
in  which  the  PIs  were  inserted.  To  change  the  name  of  a  PI,  run  the  Properties
command and in the PI name field change the name of the PI. 

Deleting a Road PI

You can also delete a road PI. 

How to delete a road PI

1.To select the road PI you wish to delete, place the mouse pointer over the  PI  and
click the left mouse button.

2.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,
select the Delete PI command.

Graphical Change of the Radius

You can move graphically the radius of a road PI.

How to move graphically a radius 

1.Select the PI whose radius you wish to change.
2.You  will  notice  that  a  yellow  box  appears  at  the  point  that  corresponds  to  the

center of the circular arc.
3. If you place the mouse pointer there, the color changes.
4.With  the  mouse  pointer  in the  square, click  the  left  mouse  button to  lengthen  or

shorten the radius of the selected PI’s circular arc.



145Horizontal Alignment

Anadelta Software

7.3.6 Editing Road Stations

From the Road Design menu, run the Road Stations  Table  command. In  the  displayed
window you can proceed to the batch editing of the stations positions. 

The  above  window  has  three  columns:  Station  name,  Chainage  and  Distance  from
previous station. There are also three buttons:

: Insert new station.

: Delete selected station.

: Numbering of next station based on the name of the selected one.

7.3.7 Editing PI Data

Once you have imported all  the PIs of a road’s  tangent  curve,  the  next step for  the
calculation of the road is to define the data of every PI.

How to input the data of a road’s PI

1.Display the window of the Properties command.
2.Select the road you wish to edit.
3.Select the PI you wish to edit.
4. In the Properties command window, select the value of the PI  Data  property.  Click

the three-dots button , appearing when you select the box.
5.The following dialogue box appears on screen:
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Follow the same procedure to change the data of  a road’s  PI,  regardless  of  whether
the road is calculated or not.

From the Curve Type field, select the desired type of curve for the PI. The parameter
fields change based on the curve type.

7.3.8 Types of Transition Curve

Anadelta Tessera offers various types of transition curves, both in the Standard and in
the Professional version. 

How to change the type of transition curve

1.Display the Properties command window.
2.Select the road you wish to edit.
3.Select the PI you wish to edit.
4. In the Properties command window, select the value of the PI  Data  property.  Click

the three-dots button , appearing when you select the box.

Transition Curves in the Standard Version

There are three available types of transition curves in the Standard version: the simple
clothoid, the compound and the clothoid circle clothoid (two PIs).

Simple Clothoid

The  most  common  type  of  curve  is  the  clothoid.  When  you  select  Clothoid  Circle
Clothoid from the drop-down list  of  the  Curve Type  field,  the  dialogue  box of  the  PI
Data command opens as follows:
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In the Circular arc radius  text field, you can edit in meters the  radius  of  the  circular
arc  of  the  turn. The  radius  R can even  get  a  zero  value  if  the  road  axis  follows  a
zigzag line (in case you have to depict  an  existing state).  If  the  values in the  fields
are such,  that  it  is  impossible  to  calculate  the  curve,  then  the  fields  appear  in red.
Enter the data for the leading transition curve in the text fields of the left column and
the data for the trailing transition curve in the text fields of the left column, since you
have the option to create asymmetrical turns. Depending on  how the  parameter,  the
length and the offset derive, according to your selection in the Calculations tab of the
dialogue box of the General Preferences command, only one of the three text fields is
active. Also,  the  Clothoid data  field  displays  the  minimum  and  maximum  values  you
have  set  for  the  clothoid  (A,L,ε).  The  clothoid  values  derive  from  the  aesthetic
convention 1/3<A/R<1m, and by applying the relation A2=L*R the result is R/9<R<L or
R/3<A<R.

When the curvature radius R changes, the values of the clothoid length also  change,
while a change in the length of  the  clothoid  also  changes the  value  of  the  offset  ε.

Any change of the parameters affects the value of the A/R ratio (= ). The limits
of this ratio depend on the PI angle, therefore the maximum value derives from the CS-
SC>=0.15TS-CS convention, while the minimum value derives from the TS-CS>=0.4Ε∆Ε
convention.

The A/R ratio must be within the range of the suggested values. The minimum value of
this  ratio  ensures  the  minimum  clothoid  length  for  adjusting  the  cross  slope  or  the
superelevation. It also ensures  the  minimum length  imposed by reasons of  dynamics.
The  minimum value  of  the  ratio  is  replaced  by  the  minimum  value  of  the  aesthetic
convention  (1/3)  for  angles  wider  than  182  degrees,  while  the  maximum  value  is
replaced by the  maximum limit  of  the  aesthetic convention  for  angles  narrower  than
137 degrees. The minimum value can be skipped for high curvature radii where the use
of clothoid  is  not  required.  The  maximum value  can also  be  skipped  for  road  design
with  high  clothoid  parameter  values without  an  intermediate  circular  arc.  When  the
curvature  radius  R  changes,  the  suggested  limits  of  the  selected  parameter  also
change accordingly. 
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When  you  click  the  Def.  Values  button,  the  program  enters  in  the  fields  of  the
selected parameter the minimum value that has been calculated based on the  radius,
for the entrance and the exit. You can choose whether the field will be filled with the
minimum  or  average  or  maximum  value  of  the  parameter  from  the  menu  that  is
displayed if you click the right mouse button.

Compound Curve

The  next transition curve  is  the  compound.  When  you  select  the  Compound  option
from the drop-down list of the Curve Type field, the Curve parameters group of the PI
Data command is displayed as shown in the figure:

The group has three columns with text fields. In the Radius (m) text field of the middle
column, you can edit in meters the radius of the turn’s circular arc. Enter the data for
the leading transition curve in the text fields of the left column (Leading Data) and the
data for the trailing transition curve in the text fields of the right column (Trailing Data
). Here, in the Radius (m) text field, you can edit in meters the radius of the circular
arc at the entrance or exit of the turn. According to the calculation method you have
selected  for  the  compound  curves  in  the  dialogue  box  of  the  General  Preferences
command, only one of the other three text fields is active: the central angle (°), the
 Offset  (m),  namely  the  distance  of  the  central  circular  arc  from  the  side  of  the
tangent  curve,  or  the  length  of  the  tangent  (m).  The  other  two  fields  are
automatically calculated by the program and their data are displayed in the box.

Clothoid – Circle – Clothoid (2 PIs)

If you want to design a hairpin bend between two PIs,  you must select  the  Clothoid
circle clothoid (2 PIs) from the drop-down list of the Curve Type field. The Curve data
 group in the dialogue box of the PI Data  command  box is  displayed  as  shown in the
figure:
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The group has two columns with text fields. Enter the data for  the  leading  transition
curve in the text fields of the left column (Leading Data) and the data for the trailing
transition curve in the text  fields  of  the  right  column  (Trailing Data).  In  the  Circular
arc  radius  (m)  text  field  of  each  column,  you can edit  in  meters  the  radius  of  the
circular arc of the turn. It  is  known that,  depending on  the  position  of  the  road  PIs
and the value of the offset, there is only one value for the radius that abuts on both
PIs.  When  you  click  the  Def.  Values  button,  the  program  calculates  this  value
according to the current value of the leading and trailing offset and enters the result
in the relevant fields. According to the calculation method you have  selected  for  the
compound curves in the dialogue box of the General Preferences command, only one of
the other three text fields is active: Cloth. Parameter, Cloth. Length (m) or  Tangent
offset (m). The other two fields are automatically calculated by the program and their
data are displayed in the box.

Transition Curves in the Professional Version

The  Professional  version  offers  three  additional  types  of  transition  curves:  cubic
parabola, transition curve of two adjacent PIs with two circular arcs, and egg-shaped
curve.

Cubic Parabola

By selecting the Cubic parabola from the drop-down list of the  Curve Type  field,  the
dialogue box of the PI Data command is displayed as shown in the figure:
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In the Circular arc radius  text field, you can edit in meters the  radius  of  the  circular
arc  of  the  turn. In  the  text  fields  below,  enter  the  data for  the  leading  and  trailing
transition  curves  in  the  left  and  right  columns,  respectively.  According  to  the
calculation method you have selected for the length and the offset in the dialogue box
of the General Preferences command, only one of the three text fields is active. Also,
in the Parabola Type group, you can select one of the available cubic parabola types,
which can be different from one PI to another.

Clothoid – Circle – Circle - Clothoid

If  you want to  design  a hairpin  bend  between  two PIs  with  two different  curvature
radii, you must select the Clothoid circle circle clothoid (2 PIs) from the drop-down list
of  the  Curve Type  field.  The  Curve  data  group  in  the  dialogue  box  of  the  PI  Data
command is displayed as shown in the figure:

The group has two columns with text fields. Enter the data for  the  leading  transition
curve in the text fields of the left column (Leading Data) and the data for the trailing
transition curve in the text  fields  of  the  right  column  (Trailing Data).  In  the  Circular
arc  radius  (m)  text  field  of  each  column,  you can edit  in  meters  the  radius  of  the
circular arc. It is known that, according to the position of the road PIs and given the
value of a radius and  the  value  of  the  leading  and  trailing  offsets,  there  is  only  one
value for the second radius that abuts on both PIs. Therefore, when you change the
value  of  the  leading  radius,  the  trailing  radius  also  changes  automatically.  If  you
change the leading offset, the leading radius will change accordingly.  When  you click
the Def. Values button, the program suggests certain values for both radii,  according
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to the angles of  the  two PIs  and  the  values of  the  leading  and  trailing  offsets.  The
suggested values are shown in the corresponding fields. Right below and depending on
the calculation method you have selected for the clothoid in the  dialogue  box of  the
General Preferences command, only one of the other three  text  fields  i.e  Parameter,
Length(m) or Offset(m), is  active.  The  other  two fields  are  automatically  calculated
by the program and their data are displayed in the box.

Egg-shaped Curve

By selecting the Clothoid circle egg-shaped circle clothoid (2 PIs) from the drop-down
list  of  the  Curve  Type,  the  Curve  data  group  in  the  dialogue  box  of  the  PI  Data
command is displayed as follows:

The group has three columns with  text  fields.  In  the  Circular  arc  radius  (m)  field  of
each  column,  you can edit  in  meters  the  radius  of  the  circular  arc  of  the  turn.  By
clicking the Def.  Values  button, the  program calculates  the  radii  of  the  circular  arcs
according  to  the  angles  of  the  two  PIs  and  the  values  of  the  leading  and  trailing
offsets, and enters the results directly in the corresponding fields. Enter the data for
the leading transition curve in the text fields of the left column (Leading Data) and the
data for the trailing transition curve in the text fields of the right column (Trailing Data
). Depending on the calculation method you have selected in the Elements input type
of the  Calculations  tab,  in the  dialogue  box of  the  General  Preferences  command  of
the  File  menu,  only  one of  the  other  three  text  fields  i.e  Parameter,  Length(m)  or
Offset(m) is active. The other two fields are automatically calculated by the program
and their data is displayed in the box.

7.3.9 Superelevation Diagram

Methods for the Calculation of the Superelevation Diagram

To  specify  the  preferences  that  will  apply  for  the  calculation  of  the  superelevation
diagram, run the Road Preferences command from the Road Design menu and then go
to the Diagram tab. The following dialogue box will open:
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In this dialogue box, first select the method for the calculation of the superelevations.
All of the following shall apply to curves of the clothoid-circular arch-clothoid type. In
the  case  of  the  simple  circular  arc,  the  program  ignores  your  selection  of  the
superelavation  calculation  method.  Even  in  the  case  of  double  PIs,  these  are
considered as a single curve for the purposes of the superelevation diagram.

When  you  select  the  German  Preferences  option,  the  program  assumes  that  the
superelevations change (from the dual-grade station to the single-grade one) from the
beginning  of  the  curve,  namely  from  the  position  where  TS  station  will  be  inserted
afterwards. It also assumes that the end of the curve (TS station) is the  restoration
point of the superelevations in the dual-grade station state. The start and end points
of the  circular  arc  (CS and  SC) are  identified  with  the  start  and  end  points  of  the
single-grade station. The figure shows two examples  of  superelevation diagrams  that
have been calculated in this way.
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The  first  example  has  been  calculated  based  on  uniform  pavement  superelevation,
which  will  be  analyzed  hereinafter,  while  the  second  one  was  based  on  linear
interpolation on the clothoid. Apart from the two lines of  the  superelevation diagram,
the figure also shows the curvature diagram, with the characteristic positions TS, CS,
SC and ST.

When  you  select  the  American  Preferences  option,  the  program  assumes  that  the
superelevation of the external side at point SC  (beginning of  curve) and  at  point ST
(end  of  curve) has already  changed  to  zero  value.  The  start  and  end  points  of  the
circular arc (TS and CS) are identified, as stated above, with the start and end points
of the single-grade station. The points where the superelevation variation begins  and
ends (on tangents) derive  from linear  calculation.  The  figure shows  two examples  of
superelevation diagrams that have been calculated in this way.
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From the dialogue box shown below,
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you  can also  select  the  superelevation  calculation  method  inside  the  curve.  If  you
select Uniform pavement superelevation, the  superelevation of  the  inner  side  of  the
road will  maintain  the  value  it  has on  the  tangents,  until  the  superelevation  of  the
outer side assumes the value that corresponds to the state of the single-grade station
of uniform superelevation.  The  state  of  uniform  superelevation  is  maintained  until  it
assumes its maximum value at the CS point; this value remains the same until the SC
point. From SC to ST, the procedure is reversed.

If  you  select  Linear  interpolation  on  the  clothoid,  the  superelevation  of  the  road’s
inner  side  changes linearly  (from  the  value  on  tangent  to  the  maximum  value)  and
regardless of the change of the  superelevation on  the  outer  side. The  above  figures
show the two alternative solutions of superelevation diagrams (inner roadline) for each
of the first two calculation methods.

The Distance for joining  superelevations  matters  only  when the  German Preferences
and Linear interpolation on the clothoid check boxes are ticked. When the turns are of
the same direction and the distance between the  end  of  the  trailing  transition curve
(ST) and the beginning of the leading transition curve of the next turn (TS) is shorter
than the distance you have typed in the Between same direction turns text field, then
the left and right superelevations will remain unchanged between the two turns.
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In the case of two consecutive opposite direction turns, if the distance between  the
end  of  the  trailing  transition curve  (ST)  and  the  beginning  of  the  leading  transition
curve  of  the  next  turn  (TS)  is  shorter  than  the  distance  you  have  typed  in  the
Between opposite direction turns text field, then at the exit of the first  turn  the  left
and  right  superelevations  are  restored  gradually  to  the  0%  value,  and  not  to  the
values of the normal cross section (-2%, 2% or -2.5%, 2.5%), while the zero point of
the  superelevations  is  not  ST,  but  the  center  of  the  TS-ST  distance,  where  the
superelevations of the next turn begin. 

Superelevation Diagram Values

To set the values of the superelevation diagram, namely the superelevation values on
tangents and turns, go to the Road Design menu, run the Road Preferences command
and make your settings in the dialogue box of the Slopes tab.
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Enter the values of the superelevations on a road’s tangents in the Superelevations on
tangents (%) group fields. In the Pavement left  and Pavement right text fields, enter
the  left  and  right  superelevations  of  the  pavement,  respectively.  Enter the  left  and
right superelevations of the shoulder in the Shoulder left and Shoulder right text fields,
respectively. 

In  the  Maximum  curve  superelevation  field,  enter  the  value  of  the  maximum
superelevation along the circular arc. This setting shall  apply to all  PIs and to update
them  you  must  click  the  To  all  PIs  button.  If  you  want  the  superelevations  on
tangents to apply also to the turn, then the value that you will enter in the field must
be negative to the value that you entered for the tangent (e.g. -2% or -2.5%). If you
want to change the maximum superelevation at a particular turn, you can do this from
the window of the Properties command.

In the Shoulders group, select how the program will calculate  the  shoulders.  Detailed
explanations  on  the  fields  are  provided in another  chapter,  where the  calculation  of
shoulder elevations is analysed. 

In the Max added slope of boundary lines (Ds max) field, enter the maximum variation
rate  of  the  outer  roadline  (maximum  longitudinal  slope)  between  the  value  of  the
normal cross section (-2% or -2.5%)  and  the  maximum value.  This  is  required  in the
case of short clothoid lengths, in order to avoid breaks at the roadlines.

The Minimum boundary lines added slope (Ds min) field affects the elevation diagram
that  will  derive,  by  determining  the  minimum  variation  rate  of  the  outer  roadline
(minimum longitudinal superelevation) between the value of the normal cross section (-
2% or -2.5%) and the positive value (2% or 2.5%). This is required in the case of long
clothoid lengths, in order to avoid superelevation values near 0% for the road section
that  will  be calculated.  The  figure shows  how  this  value  affects  the  superelevation
diagram for both calculation methods, when the value in the relevant field is 1%.
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The  Added  slope  of  boundary  lines (on  turns without transition curve)  field  matters
only when the clothoid length is zero and the value specifies the variation rate of the
outer roadline (longitudinal slope) from the value of the normal cross section (-2% or -
2.5%)  to  the  maximum  value.  This  is  required  for  the  calculation  of  the  necessary
length for the cross slope variation. This length  is  calculated  in conjunction  with  the
value of the next field.

The  Superelevation  variation  on  tangents  %  (on  turns  without  transition  curve)
matters  only  if  the  clothoid  length  is  zero  and  determines  the  percentage  of  the
attenuation  length  (%) on  the  tangent  with  respect  to  the  total  attenuation length
that is required. The total superelevation attenuation length is the length required for
the cross slope variation from the position of the normal cross section to the position
of the maximum superelevation.

When a PI element that affects the superelevation diagram changes, then, when you
click OK  to  close the  dialogue  box of  the  Road  Preferences  command,  the  following
confirmation message will appear on screen,

prompting you to confirm the recalculation of the superelevation diagram. If you select
 No, in order for the roadlines to be recalculated, go to the Road Design menu, select
the Recalculate submenu and run the Superelevations command.
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7.3.10 Displaying the Superelevation Diagram

To  view  the  superelevation  diagram  for  the  current  road,  run  the  Superelevation
Diagram command of the Road Design menu. The following tab appears:

The three lines correspond to the curvature diagram (grey line), the superelevation of
the left roadline (red line) and the superelevation of the right roadline (yellow line). Of
course, in order that these lines are displayed, the calculation of the road must have
already been performed.

As you will see, this tab has a menu entitled Diagrams and a toolbar (apart  from the
main one) with the operations that you can carry out from here. The only purpose of
this  tab  is  the  graphic  presentation  of  the  superelevation  diagram  of  the  selected
road, and therefore you cannot edit the diagram directly with the mouse, you can only
change the preferences.

If  you  wish  to  change  the  values  of  the  diagram,  you  must  either  run  the  Edit
Diagrams command of the Diagrams menu, or change the values of the superelevation
diagram settings from the Diagram and Slopes tab of the Road Properties dialogue box,

which are displayed if you click the  button.

If you want to increase the horizontal axis scale with respect to the vertical V/X, run

the Stationing command of the Diagrams menu or click the  button or press the F5
key. If you want to reduce the horizontal axis scale with respect to the vertical V/X,

run the Spacing command, of the Diagrams menu or click the  button or press the
F6 key.
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If you want to define the exact ratio of the V/X
scales,  run  the  Scale  X/Y  command  of  the
Diagrams menu.  The  dialogue  box shown in the
figure  will  appear  on  screen; type  the  value  of
this ratio in the text field of this box.

If you don’t want to view the axis and the curvature diagram, click the  button. To
view them again, simply click the same button again.

7.3.11 Setting the Widths

You can set the widths of the various elements of a roadway from the dialogue box of
the Widths tab, which is  displayed  if  you run  the  Road  Preferences  command  of  the
Road Design menu.

The tab has two groups of text fields. Enter the widths for the left  and  right  part  of
the road in the text fields of the left and right column, respectively. The  widths  that
you must enter are explained below in the order they appear: 

· the  pavement  width,  namely  the  distance  from  the  road  axis  to  the  end  of  the
course layer,  

· the  lane  width  (a),  which  is  used  in  the  calculation  of  the  Ds  slopes  of  the
superelevation diagram, 

· the  distance  of  the  semiaxis  (auxiliary  axis)  from  the  cross  section  axis  (mostly
double branch cross sections), 

· the emergency lane width, 
· the shoulder width, namely the distance between the end of the course and the end
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of the shoulder’s surface, 
· the median width,  namely the  distance  between  the  road  axis and  the  end  of  the

median. 

Based on this data, during the calculation  of  the  road  the  program will  calculate  the
boundary lines, namely the pavement line, the shoulder line, the  lines of  the  auxiliary
axes and the median lines. These widths refer to the beginning of  the  road  and  they
are fixed and equal to the values entered in the corresponding  fields.  If  you want to
enter a variation of the widths between two chainages, you can do this after the road
has been calculated, by inserting the appropriate widening type.

If you modify any of the widths after the road has been
calculated,  click  the  OK  button  to  close  the  dialogue
box of the  Road  Preferences  command. A confirmation
message  will  appear  on  the  screen,  prompting  you  to
confirm the recalculation of the boundary lines.

If you modify the lane width, a message will appear,
prompting  you  to  confirm  the  recalculation  of  the
superelevation  diagram.  If  you  select  No  and  you
want  the  boundary  lines  to  be  recalculated,  select
the Recalculate submenu from the Road Design menu
and run the Roadlines command.

7.3.12 Calculation of a Road

If the data you have entered for the PIs are not acceptable, the program will display
the  corresponding  error  messages,  in  the  message  window  at  the  bottom  of  the
screen.

For example, if the trailing clothoid of a PI (PI1) and the leading clothoid of the next PI
(PI2) overlap,  it  is  evident  that  the  road  cannot  be  created  and  the  corresponding
message is displayed. The program will give you the Tang + Tang?  total value and the
PI1PI2  distance.  The  error  is  that  this  value  is  higher  than  the  PI1PI2  distance,
therefore the difference of these two values gives the value of the error, namely how
many metres are missing. You can solve this problem by modifying the curvature radius
or the clothoid length (leading or trailing accordingly). Even if the leading clothoid and
the trailing clothoid of a PI overlap, a message will appear, informing you at  which  PI
this overlap occurs. You can deal with this problem either by increasing the PI angle or
by decreasing the length of the clothoid (leading or trailing accordingly). 

After the calculation of the road, you can edit the PIs, as previously described. When
an element of the PI that affects the layout geometry changes, then the relevant part
of the curve is recalculated automatically.

If  the  move  is  interrupted  at  a  point  where  calculation  is  not  possible,  an  error
message will appear in the  message window  at  the  bottom of  the  screen,  explaining
why there is no solution.

The calculation of the road includes the calculation of the axis curve, the  calculation
of  the  roadway  –  pavement  roadlines  and  the  calculation  of  the  superelevation
diagram. Both  during  the  calculation  of  the  roadlines  and  during  the  superelevation
diagram,  the  program  takes  into  account  various  elements,  which  are  analyzed  in
separate paragraphs.



162 Anadelta Tessera

Anadelta Software

Undo Road Calculation

If you wish, you can undo the road calculation, in order to edit or change its elements.
Undoing  the  calculation  does  not  affect  the  values  you  have  defined  until  now  for
each PI. Simply run the Undo Road Calculation command from the Road  Design  menu.
This  is  useful  for  inserting  and  editing  road  elements  without  direct  control  by  the
program.

7.3.13 Widenings

Inserting and Editing Pavement Widenings

The  concept  of  pavement  widening  in  Tessera  means  to  increase  or  decrease  the
semiwidth of  the  pavement  on  its  left  or  right  side.  You  can  use  the  widenings  to
configure the roadlines of the pavement. The program creates automatically two types
of roadway widenings. The first type refers to the roadway widening for  the  creation
of additional traffic lanes, while the second type refers to  the  automatic  widening  of
the pavement on curves.

Inserting and Editing a Pavement Widening

Select the desired road where the widening will be inserted and  then,  from the  Road
Design menu, select Widenings and then Pavement Widening.

The  program creates  a movable  drawing  of  the  widening  with  a yellow  triangle.  The
widening is defined by the position of the mouse pointer. With the mouse you can also
specify the road side where the widening will take place. Once you have selected the
appropriate position, click  the  left  mouse  button to  insert  the  widening. Note  in the
figure below that the new widening configures the roadlines of both the paveway and
the pavement. 
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Next,  run  the  Properties
command,  to  open  the  window
shown  in  the  figure.  Immediately
after  the  insertion,  the  new
widening  remains  selected.  If  you
have  somehow  unselected  the
widening,  you can select  it  again
by  clicking  the  mouse  with  the
pointer  inside  the  corresponding
auxiliary triangle (the white one).

In  the  first  field  of  the  window,
edit  the  value  of  the  chainage
where  the  widening  will  be
inserted.  In  the  second  field,
enter  the  widening  width,  which
can  be  positive  for  moving  away
from the road axis, or negative for
moving  towards the  road  axis.  In
the  next  three  fields,  enter  the
widening  length,  as  well  as  the
first  and  second  curvature  radii
respectively,  as  shown  in  the
figure.
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In the last field,  enter  the  type of  widening, which  concerns  mainly  the  form of  the
rounding arcs that are being used.

When  you close the  window, the  program  will  insert  the  widening  according  to  the
data you have entered, from the point you have  specified  until  the  end  of  the  road.
Upon  insertion  of  a  pavement  widening,  a  respective  shoulder  modification  is  also
inserted  with  the  same  characteristics.  Namely,  a  change  in  the  road’s  width
(widening) also affects  (modifies)  the  shoulder  (pavement  roadlines),  while  this  does
not  occur  when  inserting  shoulder  widenings,  a  procedure  described  in  a  following
paragraph.

Next,  you  can  insert  another  widening,  with  negative  width  value  (using  the  same
principle as described above) at another position  after  the  first  widening, in order to
create a road section like the one shown in the figure:

In  this  example,  the  value  entered  for  the  first  widening  is  +2  and  for  the  second
widening is -2. 



165Horizontal Alignment

Anadelta Software

Note that it is possible to insert additional widenings between the aforementioned two
ones. If the widening that you are inserting overlaps with an already existing one, or if
the  values you have  entered  are  not  compatible,  then  the  program  will  inform  you
about  this  error  and  will  not  take  into  account  the  widening  when  configuring  the
roadlines,  while  the  arrows  indicating  the  beginning and  the  end  of  the  widening  as
well as the corresponding triangle will turn yellow. 

The  procedure  for  editing  widenings  is  the  same  that  applies  to  the  editing  of  all
elements (Cross sections, PIs, points, perimeters, etc.). Namely, you must select  the
desired  element  and  click  the  right  mouse  button.  To  select  a  widening,  left-click
inside the triangle of the desired widening and then right-click to display the widening
editing menu. Select Properties to display  the  dialogue  box and  enter  the  new data.
Any editing action on a widening applies also to the respective shoulder.

To  delete  a  widening,  select  it  and  then  right-click  in  the  drawing  area;  from  the
displayed menu select Delete object “Widening.... (Road…)”. If the respective shoulder
widening  is  also  selected,  then  in  the  shortcut  menu,  the  Delete  command  will  be
displayed and you can use it to delete both widenings. 

Inserting and Editing a Pavement Widening on Curve

If you wish to insert a widening on a curve, select the road PI where the widening will
be inserted and from the  Road  Design  menu select  the  Widenings  submenu  and  then
run  the  New  Widening  on  Curve  command.  The  program  will  calculate  the  required
widening based on the vehicle type that you have defined in the Road Design menu Š
Road preferences command Š General tab Š Vehicle type group.

The procedure for editing a curve widening is the same that applies to  the  editing  of
all  elements.  Left-click  inside  the  triangle  of  the  widening  and  then  right-click  to
display the widening editing menu. Select Properties and enter the new data.

Inserting and Editing a Shoulder Widening 

The  concept  of  shoulder  widening  in  Tessera  means  to  increase  or  decrease  the
semiwidth  of  the  roadway  on  its  left  or  right  side.  Use  the  shoulder  widenings  to
configure  the  roadlines  of  the  pavement.  As  mentioned  in  the  previous  paragraph,
when inserting a pavement widening, the shoulder  widening  is  inserted automatically.
However, it is possible to insert shoulder widenings separately.

To  insert  the  particular  shoulder  widenings  (without  changing  the  pavement  width),
from the Road Design menu select Widenings and then run the New Shoulder Widening
command. The insertion procedure is  the  same  as  the  one described  in the  previous
paragraph for the pavement widenings. 

The procedure followed for editing shoulder widenings is similar to  the  one for  editing
widenings, regardless of whether or not the shoulder has resulted from the insertion of
a corresponding pavement widening. In case that the shoulder corresponds to  (i.e.  it
has  the  same  starting  chainage)  a pavement  widening,  every  editing  action  on  the
particular  widening  will  also  affect  the  parameters  of  the  shoulder.  Therefore,  you
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must edit shoulder widenings only after you have edited  the  corresponding  pavement
widenings.  When  you  change  the  chainage  position  of  a  shoulder  widening  that
corresponds to  a pavement  widening, the  shoulder  will  no  longer  correspond  to  this
particular widening. 

Everything  we  have  mentioned  previously  for  the  pavement  widenings  also  applies
when you insert or edit a shoulder that overlaps with an adjacent one. To delete the
shoulder widening, select Delete object “Shoulder widening (Road…)” from the shortcut
menu. 

Inserting and Editing Medians

The concept of the  median  in Tessera  means  to  create a zone in the  middle  of  the
pavement. This  zone is  defined  by two roadlines,  the  left  and  the  right  median  line.
Note that, during the creation of the  road’s  cross sections,  the  Horizontal  Alignment
workspace  supplies the  Cross  Sections  workspace  with  the  diagrams  of  the  left  and
right medians. These diagrams can be used for determining the  inner  roadlines  of  the
pavement  (in  the  case  of  double  branch  cross  section)  or/  and  for  inserting  a
pavement encasing material based on the diagram (e.g. kerb, N. Jersey).

Inserting a Median

Set the widths for the left and right median in the same way you set the left and right
semiwidth  of  the  road,  separately  for  every  road  of  the  project.  You  can  set  the
widths of the median from the dialogue box that is displayed in the Widths tab of the
Road Preferences command of the Road Design menu. In all cases, enter the widths of
the left and right median in the relevant fields of the dialogue box that is displayed on
the screen.  
In  this  way,  a  median  is  inserted  in  the  center  of  the  roadway.  The  width  of  the
median is the same from the beginning to the end of the road. To view the roadlines of
the medians, you must have selected the display of the road’s boundary lines.  

Median Widening

In this paragraph you will see how to modify the medians of a road. To add a median
widening, activate the Road mode and select the desired road. From the Road Design
menu,  select  the  Widenings  submenu  and  then  run  the  New  Median  Widening
command. 

The program will make a moveable yellow draft drawing of the median, at the chainage
you have specified with the mouse.  With the  mouse  you can also  select  the  side  of
the road where the widening will take place.

Next,  select  the  widening  and  run  the  Properties  command. In  the  first  field  of  the
window,  edit  the  value  of  the  chainage  where the  widening  will  be  inserted.  In  the
second  field  enter  the  value  of  the  widening. This  can be positive  for  moving  away
from  the  road  axis or  negative  for  moving  towards the  road  axis.  In  the  next  three
fields, enter the widening length, the first curvature radius, and the second curvature
radius, respectively. In the last field enter  the  type of  the  widening, which  is  mainly
the type of the rounding arcs that are being used. 

When  you close the  window, the  program  will  insert  the  widening  according  to  the
data you have entered, and will configure the corresponding median boundary line from
the position you have specified until the end of the road. 

Editing a Median

The  procedure  for  editing  medians  is  the  same  that  applies  to  the  editing  of  all
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elements (Cross sections, PIs,  points,  perimeters,  etc.).  Left-click  inside  the  triangle
of  the  desired  median  and  then  right-click  to  display  the  relevant  menu.  Select
Properties and enter the new data.

Deleting a Median Widening

To delete the  median  widening, click  the  right  mouse  button and  from the  displayed
menu select the Delete object “Median widening (Road…)” command. 

7.3.14 Stationing

When the calculation of the road is completed, stationing can take place. Stationing is
the calculation of the position of stations on the road axis. The stations  are  inserted
according  to  the  preferences  defined  in the  Stationing  tab  of  the  Road  preferences
command of  the  Road  design  menu.  By  default,  the  program  places  stations  at  the
beginning and at the end of the road, as well as at  the  beginning and  at  the  end  of
every curve (stations TS and ST). If  you wish,  you can insert  stations  at  the  other
main points of the curves, such as at the beginning and the  end  of  the  circular  arcs
(stations CS and SC), at the center of the circular arc  (station  D) as  well  as  at  the
points where the verticals from the center of the circle to the tangent intersect with
the  road  axis  (stations  CP  and  PP,  approximately  in  the  middle  of  the  transition
curves). 

The name of the first station is POB, while  the  name of  the  last  station  is  POE.  The
cardinal cross sections of every curve get a composite name composed of  one letter
(TS, CP, CS, CC, SC, PP, ST) and one number, which is identified with the numbering
of the respective PI (e.g.  CS1,  CP1  for  PI  1).  The  names  of  the  other,  non-cardinal
cross-sections  derive  from  serial  numbering,  starting  with  the  number  you  have
assigned.

For the tangents, the program starts after the last station of the previous curve (e.g.
ST1)  and  continues  to  insert  stations  at  the  distance  that  you  have  predefined  in
meters  (e.g.  d=20)  up  to  the  last  station  before  the  next  curve  (e.g.  TS2).  The
distance of the last station from the beginning of the next curve will be greater  than
the Minimum space at end of segment that you have defined in the Stationing tab. 

For  the  curves,  the  program  starts  after  the  first  cardinal  station  (e.g.  TS1)  and
continues to place stations at the distance that you have predefined  in meters  (e.g.
d=10) up to the last station before the middle of the curve (e.g. CC1).  The  distance
of the  last  station  from  the  middle  of  the  curve  will  be  greater  that  the  Minimum
space at end of segment that you have defined in the Stationing tab. 

If  desired,  stations  that  follow  after  the  middle  of  the  curve  can  be  inserted
symmetrically  with  respect  to  the  previous  ones.  The  same  procedure  is  actually
repeated, starting from the end of the curve and towards the middle. To do this, the
Symmetrical stationing on turns field must be selected. The cardinal stations CP, PP,
CS  and  SC  are  interpolated  at  the  corresponding  positions  without  affecting  the
distances between the non-cardinal stations.

Stationing Options for the Current Road

To set the stationing options, go to the Road Design menu, run the Road Preferences
command and  select  the  options  in the  Stationing  tab.  This  command  results  in  the
dialogue box shown in the figure. Here you can select the stationing options. 
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You can enter the distance between the stations on tangents and the  corresponding
distance  on  turns in the  Stationing  on tangents  every  (m)  and  Stationing  on  turns
every (m) fields.

In  the  Minimum  space  at  the  end  of  segment  field,  you  can  enter  the  minimum
distance that the last station must have from the end of each segment. A segment is
any  tangent  or  turn.  If  the  Symmetrical  stationing  on  turns  has  been  selected,  a
segment is  the  half  of  the  curve.  In  the  Min. Distance  from  Cardinal  Cross  Section
field  enter  the  minimum  distance  that  a  cross  section  must  have  in  order  to  be
inserted before or after a cardinal cross section. 

In the Stationing normalization on tangents group,  you can optimize  the  positions of
the cross sections on tangents. This applies to tangents having fewer cross sections
than the number you have entered in the For  cross sections less than:  field.  In  this
case, the program will insert the last cross section of the Tangent in the middle of the
distance between the penultimate cross section and the next cardinal cross section. If
you also activate the Symmetrical stationing field, then the position  of  first  and  last
station of the tangent will be inserted at an equal distance from the beginning and the
end of the tangent.

In  the  last  four  fields  you can select,  if  desired,  the  symmetrical  stationing  on  the
turns  and  the  characteristic  points  where  stations  will  be  inserted,  by  ticking  the
relevant check boxes.

To confirm the parameters you have entered, click the OK button. If you change the
stationing preferences after the program has already inserted stations, when you close
the dialogue box, the program will display a confirmation message for the recalculation
and the re-insertion of the stations of the selected road.
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Automatic Insertion of Stations

From the Road Design menu and the Stationing submenu, run the Stationing command

or, on the Horizontal Alignment toolbar click the  button, or press the <Alt>+<U>
keys, to proceed to the calculation and insertion of stations according to the
aforementioned options.

Inserting a New Station

To insert a station, from the Road Design menu, run the New Station command or, on

the Elements Drawing toolbar click the  button. You will notice a green line, which
is vertical to the axis of the selected road. Every time you use the mouse, this line
moves to the position where the mouse pointer is. Select the desired position and
insert the station by clicking the left mouse button. To specify the exact chainage and
the name of the inserted station, select the station (by left-clicking on it) and run
the Properties command, to display the relevant dialogue box. Repeat the process for
all stations you wish to insert.

Deleting a Station

To delete a station, select the station you wish to delete, click the right mouse button
and select the appropriate command (Delete cross section) from the displayed menu.

You can also delete all  stations  of  a road.  To do  this,  select  the  road  and  from the
Stationing submenu of the  Road  Design  menu run  the  Delete  stations  command. You
can also carry out the same operation if you select the Delete submenu from the File
menu and then run the Stations command.

Editing Stations

To edit a station, select with the mouse the road where the station is and then select
the station. 
You can move between stations with the <Ctrl>+< > keys for the next station and

the <Ctrl>+< > for the previous station. Right click on the screen to display the
shortcut menu. From there, run the Properties command to display the dialogue box
shown in the figure:
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The  first  three  fields  are  the  name  of  the  station,  its  chainage  and  its  angle  with
respect to the vertical to the road axis. 

If  you change the  Name  of  a non-cardinal  station,  the  program  will  prompt  you  to
confirm  the  name  (code)  changes  for  all  of  the  next  non-cardinal  stations.  If  you
change the Chainage  of  the  station,  the  station  moves,  while  at  the  same  time  the
terrain  elevations  and  the  values  mentioned  below  are  updated.  If  you  change  the
Angle, you can rotate the level of the station with respect to the vertical to the road
axis.

The Station X, Station Y, Terrain  elevation  and  Road  profile  elevation  fields  are  only
for information purposes and their values are updated automatically after each change
of  the  station  chainage.  The  Terrain  elevation  field  is  updated  only  when  the
Triangulation has already been performed. The Road  profile  elevation  field  is  updated
only when the road profile has already been calculated in the Profile and Update road
profile from Profile to Horizontal Alignment.

The  Pavement  superelevation  left,  Pavement  superelevation  right,  Shoulder
superelevation  left  and  Shoulder  superelevation  right  fields  are  also  for  information
purposes  and  their  values  are  automatically  updated  every  time  you  change  the
superelevation diagram. 

The  next four  fields  refer  to  the  pavement  and  roadway  left  and  right  semiwidths.
These fields are updated automatically by the program every  time  you insert,  edit  or
delete a pavement or shoulder widening, and  every  time  the  road  is  calculated.  This
automated process is referred to as initial update.
They are also updated every  time  the  Roadlines are  updated  from Cross  Sections  to
Horizontal Alignment, in order to reflect the real widths, as they have been calculated
in the Cross sections after applying the Typical cross section or after a change in the
coordinates has taken place at Cross section level. It is also possible  for  the  user  to
change their values directly. However, any future change in the widenings will restore
the  initial  update  of  the  widths.  You  can  achieve  the  same  result  by  runing  the
Recalculate  Roadlines  command  from  the  Road  Calculations  submenu  of  the  Road
design menu. Any update or change of the widths has a direct effect on the layout of
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the roadlines, the pavement and the roadway.

The  Sideslope start  left,  Sideslope start  right,  Sideslope end  left  and  Sideslope  end
right fields are updated automatically by the program when the Horizontal Alignment is
updated  from  the  Cross  Sections  workspace.  If  the  value  of  any  of  these  fields
changes, then the corresponding roadline also changes automatically.

Finally,  at  the  bottom of  the  dialogue  box you can see  the  distance  of  the  current
station from the previous one.

Stationing on Cross Section Chainage

In  case  you have  a complete  project  (Horizontal  Alignment,  Profile,  Cross  Sections)
and you wish to change the horizontal alignment and to maintain the already  existing
stations, go to the Road Design menu and from the Cross Section Stationing submenu
run the Stationing on Cross Section Chainage command. This  command  results  in the
following window,

where you can select the cross sections you want to transfer to Horizontal Alignment.
Moreover, if the Delete existing stations and Names from Cross Sections  check boxes
are ticked, you can delete the older stations of the layout and transfer the names of
the  cross  sections  to  the  Horizontal  Alignment,  so  that  the  two  workspaces  are
synchronized. Once you have made the desired settings, click theStationing button to
perform the road design stationing. 

Cross Section Terrain

After the stationing, you can see what the  terrain  will  be like  in every  cross section
without having to update the Cross Sections workspace. To do this, select the Cross
section  window  command  from the  Road  Design  menu.  A window  will  appear  on  the
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screen where the terrain of the selected cross section will be drawn. To move to the
next or previous cross section, you must click the  relevant  button at  the  top  of  the
window.

7.3.15 Creating Service Roads

The Professional version features the automatic creation of the axes of service roads
parallel  to  the  main  artery.  To  use  this  command,  select  the  road  where  the  main
artery is. From the Road Design menu, run  the  New Road by Copying Tangent  Curve
command. The following dialogue box appears on screen:

In  the  Tangent  curve  distance  field,  type  the
distance of the service road from the axis of the
artery.  The  value  of  the  distance  is  positive  if
you  want  the  new  road  to  be  inserted  to  the
right  of  the  artery  and  negative  if  the  road  is
inserted  to  the  left.  When  you  click  OK,  the
program will  create the  axis of  the  new road  in
parallel  to  the  artery.  The  radius  of  each  PI  of
the  new  road  will  be  decreased  or  increased
according to the distance of the two roads. 

Stationing Based on another Road

The calculation and insertion of stations (e.g. road 2) can be performed by taking into
account the stations of another  road  (e.g.  road  1). The  positions of  the  stations  of
road 2 will result from the intersection of the extension of the main road stations with
the axis of road 2. Also, the names of the stations of road 2 will be the same as  the
names of the stations of road 1.

This  operation is  performed from the  Road  Design  menu,  where you must select  the
Stationing submenu and then run the Stationing (Partial/Dependent)  command. In  the
resulting dialogue box,
 

type the chainage of the section where partial stationing will take  place  in the  From
Ch. and To Ch.  fields.  For the  stationing  to  take  place  as  described  above,  tick  the
Depending on road check box and from the drop-down list, select  the  road  based  on
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which the  stationing  will  be performed.  In  the  case  of  service roads,  in  the  Station
Orientation group, tick the Perpendicular to main road option. Finally, press OK for the
stationing to take place.

For more information regarding the composite cross sections and the partial/dependent
stationing, refer to the chapter Composite Cross Sections - Horizontal Alignment.

7.3.16 Editing Diagrams

During the calculation  of  the  road,  apart  from the  calculation  of  the  axis curve,  the
program  calculates  automatically  the  diagrams  of  the  road,  based  on  the  data  you
have entered and the settings you have made. 

You  can  view,  edit  and  export  these  diagrams  in  text  file  format  or  you  can  load
diagrams from text files. To view the diagrams, run  the  Edit  diagrams  command  from
the Road Design menu. When you run this command and a road has been selected, the
following dialogue box appears on screen:

Everything  described  in  this  paragraph  applies  to  all  three  workspaces:  Horizontal
Alignment, Profile and Cross sections.

From the Diagram drop-down list, select the desired diagram of the selected road. The
diagram is displayed in the area right below, consisting of a table  with  three  columns
and variable number  of  lines.  When  importing –  editing  a diagram,  you must keep  in
mind  that  you  are  actually  importing  or  editing  the  breaking  points  (PIs)  of  the
diagram. Each line corresponds to a breaking point (both the end and the  beginning).
The titles of the columns are shown in gray in the first line. Their names are S/N, Ch.,
Size  and  Radius.  The  program  fills  in  the  first  column  automatically  with  the  serial
number of the breaking point; it is displayed in gray and the user cannot intervene. In
the second column you must always enter the Chainage, in the third column you must
enter the value of size represented by the diagram, and in the fourth column you must
enter the  curvature radius  for  the  particular  PI  of  the  diagram (only  for  diagrams  of
pavement, roadway and profile width).
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If you click the  button, the diagram will be deleted. The program will display a
warning message, prompting you to confirm the deletion. If you want to delete the
diagram, click Yes.

To change the name of a diagram, click the  button. Enter the new name of the
diagram in the corresponding text field of the dialogue box and click the OK button.

To delete all data, click the  button. The program will delete all data of the
selected diagram.

If you click the  button, a new diagram will be created. This button displays a
drop-down list with the available types of diagrams. Select the type of the diagram
you wish to create. The creation feature is only in the Cross Sections workspace and
not in the Horizontal Alignment. If you select New generic use diagram, the program
will display a dialogue box where you must enter the name of the new diagram in the
relevant field. 

After the diagram has been created, you can enter the data in the relevant fields. To
select a field, left-click on it and then start typing. Press the Enter key to confirm the
data you have entered and to move to the next field on the right. You can also move
between the fields by using the up, down, right and left arrow keys. If you are at the
end of a line, you can press the Enter key to move to the first field of the next line. 

To insert a new line at the end of the table, simply select the cell that corresponds to
the last column and line and press Enter. If you want to insert a new line between two
existing lines, select the immediately next line and press the Ctrl+I keys. The new line
will be inserted right above the selected one. If you wish to delete a line, simply select
the line and press the Ctrl+D keys.
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7.3.17 Terrain Sampling

To  define  the  terrain  sampling width  for  the  cross sections of  road,  go  to  the  Road
Design menu, run the Road Preferences command and open the Terrain Sampling tab.

In the Cross section width left and right fields, enter the desired terrain width of every
cross section. 
You can use the Station zone length field to set the zone length when you don’t have
a terrain model but only points above or close to the cross sections level. To change
the  terrain  sampling  way,  go  to  Project  menu  Š  General  Preferences  command  Š
Calculations tab Š Cross section elevations calculation way group Š  By station zones.
 

In  this  case, the  program creates  a natural  terrain,  displaying  on  the  cross  section
axis, the points contained in a zone around every station. 
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7.3.18 Horizontal Alignment Statistics

If you select the  Horizontal  Alignment  Statistics  command  from the  Tools  menu,  the
following window will appear on the screen:

Here  you  can  view  all  elements  and  data  used  in  each  mode  of  the  horizontal
alignment. More specifically, you can view:

· the number of elements existing in the drawing.
· the terrains with the points, boundaries, triangles, etc.
· the roads with their elements (PIs, cross sections, etc.).
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7.3.19 Structures

Overview

Tessera makes the calculation and management of the structures a simple procedure.
It  is  better  to  insert  the  Structures  from  the  Horizontal  Alignment  after  having
completed  the  Road  Design  at  all  three  levels  (Horizontal  Alignment,  Profile,  Cross
sections). Then the program will automatically insert the Structures and will configure
their faces and sideslopes. You can also insert a Structure at the Cross section level
before the design is completed, as you can also insert them directly  from the  Profile.
In this case, the calculation is performed gradually. In all  cases, the calculation is  an
easy  procedure,  with  successive  corrections  and  repetitions.  The  program  can
accommodate  a  number  of  values,  enabling  the  complete  parameterization  of  the
structures. 
The following drawing shows  all  angles  that  are  required  for  the  implementation  of  a
structure, namely:

· Angles of 1s t, 2nd, 3rd and 4th wing wall: the angles between the wing walls and the
verticals to the sides of the structure.

· Side Angle: the angle between the vertical to the side of the structure and its axis.
· Structure Angle: this is determined by the vertical to the structure axis and the road

axis.

Inserting a new structure

To insert a new structure, select Structures from the Road Design menu and then run
the New Structure command. You will notice a blue rectangle, which is vertical to the
axis  of  the  selected  road  and  follows  the  mouse  pointer.  Select  the  appropriate
chainage and then insert the structure by clicking  the  left  mouse  button.  To specify
the  exact  chainage  and  the  name  of  the  selected  structure,  run  the  Properties
command from the  shortcut  menu.  Repeat  the  procedure  for  all  the  structures  you
wish to insert.

Deleting a structure

To  delete  a structure,  select  the  desired  structure,  click  the  right  mouse  button  to
display the shortcut menu and run the Delete object ”structure” command.
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You can also delete multiple structures of a drawing. To do this, select the  road  and
from the File menu select the Delete command and then Structures. 

Resetting a structure

This operation configures the cross section of the structure, so that the left and right
ends of the bottom slab of the structure pass through  the  intersection  points  of  the
road's sideslopes with the natural terrain. Namely, it is the automatic calculation of the
structure  that  leads  to  the  cancelation  of  any  changes  (elevations  and/or  slope)
affecting the placement of the structure. To reset a structure, select Structures from
the Road Design menu and  then  select  Reset structure;  or,  from the  shortcut  menu
select Reset structure. In case you have more than  one structures and  you wish  to
reset them all, select Structures from the Road Design menu and then select Reset all.
You can also  Reset  the  structures from the  Structure  cross  section  window  of  the
shortcut menu.
Every time the Chainage or  the  angle  of  a structure  changes,  the  structure  is  reset
automatically.  

Adjusting sideslopes to structures

To run this command, go to the Road Design menu, select Structures and then select
Adapt sideslopes to structures. If, for any reason, the sideslopes cannot be adjusted
according to the structure, you can achieve that by running this particular command.

Batch Structure Naming

Run this command to name simultaneously all  structures of your project, regardless of
their  type (Box  or  Tubular  structure).  To  do  this,  select  Structures  from  the  Road
Design  menu  and  then  select  Batch  Structure  Naming.  The  following  window  will
appear on the screen:

In the Box structures name and Tubular structures name  fields,  type the  name you
wish  to  assign  to  all  structures.  In  the  Start  numbering  from  field,  type  the  first
number for the numbering of the structures. In  the  Select  action  field,  select  one of
the  available  actions,  which  refer  either  to  the  naming  and  the  numbering  of  the
structures separately for each type, or to the naming and the numbering regardless of
the structure type.
Click the Apply button to apply the settings you have made, or click the Close button
to close the window and return to the horizontal alignment workspace.

Structure cross section
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In the window that is displayed when you run  the  Structure  cross section  command
from the shortcut menu,  you can see  a virtual  cross section  to  which  the  structure
you have inserted in the horizontal  alignment  is  adjusted.  In  the  following  figure you
can see some of the values of the structure cross section that you can edit.

The other values that you can edit are the following:

Fixed  value:  Select  which  of  the  available  options  will  become  the  fixed  value.  The
fixed value can be the left or the right elevation, the axis elevation and the slope. The
field of the element that gives the fixed value becomes inactive. Then, any change in
one of the other three fields leads automatically to the  change of  the  remaining  two
fields.
Slope: Define the desired slope of the structure. 
Left and right edge elevation: In these fields you can change the elevations of the left
and the right edge of the structure, respectively.
Axis elevation: In this field you can change the elevation that the structure will have,
with respect to the axis.

Structure Properties

After  the  insertion  of  a  structure,  you  can  define  the  properties  of  this  structure.
Select the structure, right-click to display the menu and run the Properties command.
The following window will appear on the screen:
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The settings you can make are the following:

Name: Here you can change the name of the structure.
Ch.: Specify the exact position of the structure. 
Angle: In this field you can set the desired angle of the vertical to the structure’s axis
with respect to the road’s axis.
Type: From the drop-down list of this field you can select between the two available
types of structures (Box and Tubular culvert).
Width (clearance): Set the width.
Height (clearance): Set the desired height of the structure.
Left and right side angle: Rotate the structure’s entrance and exit.
Wing wall angle 1, 2, 3, 4: In these fields you can specify the angle of the wing walls.
End length: On the right and left of each wing wall there  is  an  extra wall,  parallel  to
the construction roadline that is represented by a line at the end of the sideslope. In
this field you can specify the length of this wall.
Left and right grate width: Specify the desired grate width  on  the  left  and  the  right
side of the structure. This  option is  displayed  in the  properties  window  when one or
both sides of the structure are in a cutting. 

All  other  properties  of  the  structures have  already  been  described  in  the  Structure
Cross Section paragraph.

Update structures

To  update  the  Profile  with  the  structures  you  have  created  in  the  Horizontal
Alignment,  select  the  Management  command  from  the  Project  menu  or  click  the
relevant icon.  Next,  in  the  Update  group,  tick  the  Update  structures  check  box  to
update both the Chainage and the elevation of the structure. If you go to the Profile
workspace, you will notice that there are three symbols referring to the structure; the
middle  one shows  the  elevation  on  the  axis  while  the  other  two  symbols  show  the
elevations of the left and right edge.
If you are not satisfied with the result, you can edit certain properties of the structure
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in the Profile mode. To view the  properties  of  the  structure,  select  the  structure  by
clicking the left mouse button, and then run the Properties command from the shortcut
menu. To apply the changes you have made in the Horizontal alignment, select Update
structures from Profile to Horizontal Alignment.

Exporting Structures Data to an ASCII file:

1.From  the  File  menu,  select  the  Export  to  ASCII  submenu  and  run  the  Structures
Data command.

2.Specify the path and the name for the file you wish to save. The structure data will
be exported to a file with the .CSV extension.

3.Click OK to export the data.
To export the data you must go to the Horizontal Alignment workspace.

7.3.20 Intersections

Creating an Intersection

To insert an intersection, select the two roads where the intersection will be created
(for multiple selection use the ctrl key) and from the menu that is displayed if you click
the right mouse button, select the New intersection command. Alternatively, from the

Elements  Drawing toolbar,  click  the   button.  In  the  case  of  a  crossing,  if  you
select the first method for creating an intersection, the first selected road will be the
main road, while if you select the second method, the main road will be the one with
the widest roadway. If both roads have the same roadway width, then the main road
will be the one with the widest pavement.
A rhombus or a triangle will appear on the screen, at  the  point where the  two roads
intersect; this is the symbol of the intersection and you can also use it to select the
intersection. You can also view the configuration of the roadlines and medians of  the
intersection  that  have  been  calculated  according  to  the  predefined  Intersection
Preferences (Default) of the program.  

Intersection Preferences (Default)

By default, the preferences for the intersections are defined by using the Intersection
Preferences  (Default)  command  of  the  Intersections  submenu  in  the  Road  Design
menu. A dialogue box with four tabs will appear on the screen. In the Quarter tab, you
can set the preferences for the transition of an intersection's quarters (radii, offsets,
etc.)  and  for  the  configuration  of  the  necessary  traffic  lanes.  In  the  Large
Channelising  Island  and  Small  Channelising  Island  tabs,  enter  the  settings  for  the
construction  of  the  channelising  islands.  Finally,  in  the  General  tab,  enter  the
preferences for the median and the widenings of the main road.

Intersection preferences

An intersection can have the shape of a crossing (cross) or a T shape. Apart from the
relevant configuration, the shape is symbolized by the corresponding selection symbol,
which can be a rhombus or a triangle respectively. These symbols appear in yellow for
all  intersections,  except  for  the  symbol  of  the  selected  intersection  that  appears  in
blue.  When  you  select  an  intersection,  you  also  select  the  current  quarter,  which
appears  in  white.  A  direction  arrow  of  the  same  color  corresponds  to  the  current
quarter.
In case that the intersection has the shape of a crossing, all  its quarters are  active,
while when the intersection has a T  shape,  only  two of  its  quarters are  active.  The
inactive quarters have only the Move to: group. 
To  define  the  preferences  of  an  intersection,  select  the  intersection  by  clicking  its
symbol and from the menu that is displayed if you click the right mouse button, select
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the  Intersection  preferences  command.  The  following  window  will  appear  on  the
screen:

The Intersection preferences window has seven tabs. The first four tabs refer to  the
settings of the quarters, the next two tabs refer  to  the  channelising islands and  the
last tab features the general settings of the intersection. In this window, where the 4
th  quarter  is  the  current  one,  you  can  define  the  preferences  for  the  type  of  the
quarter  transition (radii)  as  well  as  some  other  parameters referring  to  traffic  (extra
lanes). 

In the 4th Quarter group, you can view the angle formed by the two axes (in degrees)
and select one of the six available transition ways:
· One radius: only one circular arc
· Three radii RAS: three circular arches with 2:1:3 radius ratios according to the RAS-

K-1 regulations. When the radius of the middle circular arc  changes,  the  other  two
radii change automatically, provided that the Auto check box has been ticked.

· Three  radii  AASHTO:  three  circular  arcs  with  leading  and  trailing  offsets  on  both
sides, according to the AASHTO regulations.

· One radius Taper: a circular arc between 2 Tapers. The  leading  and  trailing  Tapers
are  characterized  by offsets  and  L:T  ratios  (Longitudinal  to  Transverse,  length  to
offset), according to the AASHTO regulations. 

· Taper 2 radii: two circular arcs after a Taper, according to the RAS-K-1 regulations,
when there is no deceleration lane. The Taper is characterized by an offset and a L:
T ratio and is always formed on the side of the superior road.

· Clothoid: a circular arc between two clothoids, a leading and a trailing one, with the
relevant parameters. 

In the Direction to: group you can define the desired movements of vehicles, as well
as whether there will be a left turn, deceleration and acceleration lanes and a

triangular island. This group has further settings, that you can view by clicking the 
 button as shown below:
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The Left turn lane data are shown in the following figure:

In the Right field, enter the width of the section of the left turn  lane  that  will  be on
the right of the road axis, according to the direction of  the  lane.  The  minimum value
that this field can accept is 0 and the maximum value is the sum of the width of  the
left  turn  lane  and  the  minimum width  of  the  median  or  the  hatch.  In  this  way,  the
widenings of both sides of the main road that are required for the configuration of the
left turn lane with the median or hatch are set indirectly (General tab next). 

The data of the Deceleration lane are shown in the following figure:
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In the Emergency lane width field,  enter  the  distance  of  the  marginal  strip  from the
edge  of  the  paveway.  This  width  is  applied  to  the  whole  length  of  the  deceleration
lane and  can differ  from the  width  of  the  main  road’s  Emergency  lane.  The  update
takes place automatically in the  transition section  by using a different  width  for  the
guidance strip with respect to the width of the corresponding paveway widening.

The data you define for the Triangular Island are shown in the following figure:

In this figure, the gray indicators show you how the triangular island was constructed.
To  view  these  indicators,  you  must  have  enabled  the  Auxiliary  data  field  of  the
Intersections  group  in  the  General  category  of  the  Horizontal  Alignment  Options.
Distance 1, Distance 2 and  Radius  define  the  start  point for  the  construction  of  the
triangular island. Distance 1 is the distance between the triangular island  that  will  be
constructed and  the  gray  auxiliary  line  near  the  marginal  strip.  The  user  must  then
select  the  appropriate  transition  so  that  the  marginal  strip  (or  the  edge  of  the
paveway) snap on the aforementioned indicator. 

The Channelising island 2 is displayed as follows:  
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In  the  Display  field  you  can  define,  if  desired,  whether  or  not  there  will  be  a
channelising island at the  intersection.  You  can also  tick  the  Force  small  field  if  you
want  to  insert  a  small  channelising  island  when  there  is  a  left  turn  lane,  which,
depending  on  the  way  the  channelising  islands  are  created  by  the  program,  would
automatically lead to the insertion of the big one.
In this tab you can also  enter  all  the  desired  parameters for  the  channelising island,
either big or small. 

In  the  following  figure  you  can  view  the  basic  elements  that  contribute  to  the
calculation of the big channelising island: 
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First the channelising island is defined between the two arcs formed by the  entrance
and exit tracks of the superior road. The radii that are used for the tracks are entered
in the Entrance radius  and Exit radius  fields, respectively. The program adjusts these
radii  by  one  meter,  showing  you  the  relevant  message,  so  that  the  width  of  the
resulting channelising island is between the limits of the Minimum width and Maximum
width fields.

The arc with Head radius rounds up the front part of the channelising island, as shown
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in the detail of the above figure. The head radius is also adjusted by the program, to
give the Head offset from the limit of the passing lanes of the superior road. In case of
modification, the corresponding message is also displayed. Then the channelising island
is limited by two tangent lines, to the two original arcs. The  tangents  start  from the
point that you define in the Edge distance. This distance is calculated by the limit  of
the passing lanes of the superior road.

The end of the channelising island is defined by first applying the End  width  between
the two tangents. Next, the channelising island is further limited by applying the Width
decrement on end by designing a parallel to the tangent, on the side of the entrance
lane. The channelising island closes at the back  section  by applying  an  arc  with  End
radius.  The  elements  related  to  the  calculation  of  the  channelising  island  end  are
shown in the detail of the above figure. 

The  program inserts  automatically  a small  channelising island  if  there  is  no  left  turn
lane on the main road. The Channelising island 2 tab appears as shown in the following
dialogue window,   
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which, apart from certain characteristics of the  big channelising island,  also  contains
the extra options Width and Center distance.
The channelising island is first defined between the two arcs that  are  formed by the
entrance and exit tracks of the superior road. The radii used for the tracks are defined
in the Entrance radius  and Exit radius  fields, respectively. These arcs are  tangent  to
two parallel lines, whose in-between distance is  equal  to  the  Width.  These  two lines
are parallel to a straight line that derives from the curve of the secondary road's axis
by 6 degrees around a point whose distance from the boundary of the passing lanes of
the superior road is the Center distance. 
The arc with Head radius rounds up the front part of the channelising island. Then, the
channelising island is limited by two lines which are tangential to the two original arcs.
The  Road  distance  determines  the  point from which  these  straight  lines  begin.  This
distance is calculated by the boundary of the passing lanes of the superior road. The
end  of  the  channelising  island  is  defined  by  applying  an  arc  with  End  radius.  The
aforementioned values are shown in the figure below:
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In  the  General  tab,  you  can  set  the  general  preferences  for  the  medians  and  the
widenings of the main road. The tab is displayed as shown below: 

In the Main road median group, you can enter the  minimum and  the  maximum width,
the head radius, the minimum length as well as the margin of the island. These values
are displayed in the following figures: 
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The lengths of  the  transitions  before  and  after  the  intersection  are  the  same.  They
differ only if the value of the Minimum length, which refers to the length of island 1, is
higher than the value of the Transition of the Left turn lane. In this case, the value of
the length of island 1 becomes higher than the value of the transition length of island
2 and equal to the Minimum length.
In cases such as when you wish to edit the width of the traffic lanes or the Right field
of the left turn lanes (2nd or / and 3rd quarter) for the correct and automatic setting
of the widenings, which are  automatically  inserted before  and  after  the  intersection,
press the Suggest values button in the General tab.
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7.4 Printing

7.4.1 Preferences Setting

The Print menu contains the settings for the appearance of  the  Horizontal  Alignment
printouts.

Page Setup

First  you  must  set  the  preferences  for  the  paper,  such  as  the  feed  tray,  the
orientation and the paper size.

How to setup the print page 

1.From the Print menu, select the Page Setup command.
2.From the Print Setup dialogue box, in the  Name field  of  the  Print  group  select  the

desired printer by choosing  from the  dropdown list  one of  the  available  printers  of
the  system.  The  other  fields  of  the  group  show  information  about  the  selected
printer, such as  the  status,  the  model,  the  port  or  the  location of  the  printer,  as
well as any additional user-defined information – comment.

3.Click  the  Properties  …  button  to  change  the  Windows  printer  options  for  the
selected printer. A dialogue box opens, enabling you to adjust settings that are not
controlled by Tessera.

4. In  the  Size  field  of  the  Paper  group,  select  from  the  dropdown  list  one  of  the
available paper sizes. From the Source field, select one of the available  paper  feed
trays. 

5. In the Orientation group, select the orientation of the text on the paper for printers
that support landscape orientation (Horizontal) or portrait orientation (Vertical). You
can  change  the  orientation  to  achieve  a  text  rotation  of  0  or  90  degrees  by
selecting Vertical or Horizontal option, respectively.  The  document icon  shows  the
orientation  of  the  paper  on  the  selected  printer.  The  letter  icon  shows  the
orientation of the text on the page.

6.Vertical: Orientates  and  draws so that  the  short  end  of  the  document represents
the top part of the page.

7.Horizontal: Orientates and draws so that the long end of  the  document represents
the top part of the page. 

If you change the  current  printer,  then  the  settings  that  are  supported  by the  new
printer will be kept, while for the other settings the default settings of the new printer
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shall apply.

Print Settings

This paragraph explains the dialogue box of the Print Preferences command, where you
can define the print settings (data, options) for the whole file.  The  print  preferences
are common to every road contained in the file, as well as to the background (terrain-
rendering) and the drawing objects. The dialogue box has three tabs. The General tab
contains settings referring to the scale, the grid type and the type of paper that the
printer uses. In the Print elements tab you can choose  whether  the  drawing  objects
will be printed or not. Finally, in the  Options  tab,  you can make settings  referring  to
the decimals that will be used for the numbers that will appear in the printout.
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Setting the Print Scale

Before inputting the pages to be printed, you must set the scale. 

To set the scale

1.From the Print menu, select the Print Preferences command.
2.Type  the  scale  in the  text  field  of  the  Scale  group of  the  General  tab,  e.g.  type

1000 in the field if you want to print on a 1:1000 scale.

The scale setting affects the way that many objects appear on the screen, mainly the
height  of  letters  in all  texts  and  the  dimensions  of  the  print  frames.  Therefore,  you
must set the scale as soon as you start to draw your design.

Selecting Drawing Objects for Printing

In the Print elements tab you will find the  Drawing  check  box.  Tick  this  box to  print
the  drawing  objects.  Note  that  only  the  drawing  elements  that  belong  to  printable
parts will be printed.

Printing the Grid and Coordinates on the Print Page

You can choose to print the grid and its coordinates at the margins of the page and at
its points. You have three options:

· None: The grid will not appear at all.
· With full lines: the grid will appear in the form of straight lines, which are parallel to

the coordinates axes and extend up to the margins of the print page.
· With  “crosses”:  the  grid  appears in the  form of  crosses,  equally  spaced  one  from

another.
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To select how the grid will be printed

1.From the Print menu, select the Print Preferences command.
2. In the Grid Type group of the General tab, select one of the available options.

If you choose the grid to appear on the printout, in the per text field  you must type
the actual distance (meters) between the lines or crosses.

If you have chosen to print the grid, you can also select the coordinates of the grid to
appear at the margins of the print page.

To select how the grid coordinates will be printed 

1.From the Print menu, select the Print Preferences command.
2. In the Grid Type group of the General tab, tick the Show coordinates around frames

check  box  and  in  the  Font  height  in  cm  field,  type  the  height  of  the  letters  in
centimeters. 

If the selected form of the grid is the cross, then you must set the size of the cross
and select the option that shows the coordinates on every cross.

How to define the form of grid crosses

1.From the Print menu, select the Print Preferences command.
2. In the Grid Type group of the General tab, type the dimensions of the cross in the

"Cross”  Size  field.  If  the  dimensions  you  type  is  the  actual  distance,  tick  the  m
check box, while if it is in centimeters of printable paper tick the cm of page check
box.

3. If you want the coordinates of the center of each cross to be printed  next to  the
crosses, tick the coordinates at “crosses” check box and in the  Font  height  in cm
field type the height of the letters in centimeters.

Setting Decimal Points for the Print Elements 

In the Options tab, set the number of the decimal points for the  lengths of  both  the
road and the terrain. You can also set the angle measurement unit.

7.4.2 Selecting Terrain Objects

In the dialogue box of the Terrain elements printing preferences command of the Print
menu,  you  can  specify  which  of  the  terrain  objects  will  be  printed  and  how.  The
dialogue box is divided in as many tabs as the terrains in the file (Professional version).
Each one of the terrain tabs has two tabs, the Lines preferences tab for the lines
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and the Text options tab for the  texts,
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If there is a terrain that you don’t want to print, untick the Print check box in the tab
of the relevant terrain. Each tab has check boxes for each  one of  the  terrain  object
categories  that  are  available  in Tessera.  If  you don’t  want to  print  one  or  more  of
these terrain objects, untick the relevant check boxes. You can make settings for the
objects that will be printed from the relevant fields that are on the same line with the
element.  For  the  lines  you  can  change  the  color,  the  type  of  line  and  the  width,
always in the terms of printing. The last column refers to the export to DXF format.

You can also change the color of the texts. To change the text font, select the Font

field and click the button with the three dots  to open a font dialogue box. In  this
box, you can choose a new font or whether the characters will  appear  bold  or  italic.
To change the font height, simply type the new height in the Size field, in centimeters
of printing paper. Here too, the last column refers to the export to DXF format.

7.4.3 Road Objects Selection

In the Road elements printing preferences command  dialogue  box of  the  Print  menu,
specify which road objects will be printed and in what form.  The  box is  divided in as
many tabs as the roads in the file (Professional version). Each road tab has four sub-
tabs, the Lines preferences for the lines,

the Text options for the texts
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the Settings for printing the road,

the PI Tables for setting the elements that will be printed in the tables of the road PIs.
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If  there  is  a road  you  don’t  want  to  print,  untick  the  Print  road  check  box  in  the
relevant tab of the Road elements printing preferences window. Each  tab  has check
boxes for each one of the road object categories that are available in Tessera. If you
don’t want to print one or more of these road objects, untick the relevant check box/
es.  In  the  Color,  Type,  Size  and  DXF  Layer  fields  you  can  make  settings  for  the
objects that you have selected to print.

7.4.4 Inserting and Editing Pages

The printing process is based on the use of print pages. Namely, you must specify an
area that  will  contain  the  elements  that  will  be printed.  The  dimensions  of  the  print
page are proportional to the paper page you have defined in the Page Setup dialogue
box and to the print scale. In the dialogue boxes of the Preferences, Terrain printing
preferences  and Road  printing  preferences  commands  you  can  select  the  elements
that will be displayed in this area.

Inserting Print Pages

You can insert a print page very easily, by using the mouse.

To insert a print page

1.From  the  Print  menu,  run  the  New  Page  command  or,  on  the  Elements  Drawing

toolbar, click the  button.
2.Position the page by defining its center, either by clicking the left mouse button or

by  entering  the  center’s  coordinates  with  the  assistance  of  the  Input  Form
command.

The page number is written at the top of the print  page,  according to  the  order the
page was inserted. 
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It  is  possible  to  insert  a new page,  which  is  conjoined to  another  existing page,  so
that they coincide on one of their sides. 

How to insert a print page next to an already existing one

1.From  the  Print  menu,  run  the  New conjoined page  command,  or  on  the  Elements

Drawing toolbar, click the  button.
2. Joint  the  page with  another  page  by  placing  the  pointer  into  an  already  existing

page, on the side you wish to join the pages. The page will  be placed  next to  the
existent one.

3. Left click to finalize the make the position of the page.

Editing Print Pages

You can change the position of a print page, or rotate the page, in order to  get  the
position in the drawing. You can also delete a print page. 

Moving and Rotating Print Pages with the Mouse

You can move or rotate a print page by using the mouse. 

To move a print page with the mouse

1.Select the page by left clicking in it. 
2. Left click again on the selected page.
3.Move the page to its new position by defining its center with the left mouse button.

You  can also  move  the  page  by  entering  the  coordinates  of  its  center  with  the
assistance of the Input Form command.

To rotate a print page with the mouse

1.Select the page by left clicking in it. 
2.Having selected the page, position the crosshair on  the  rotation  control  point (top

right of each page) to highlight it and to make it appear in white  color.  Click  again
the left mouse button.

3.Rotate  the  page  by  moving  the  crosshair  in  circular  direction.  When  the  page
reaches the desired position, click again the left mouse button to  finalize (confirm)
the position. You can also rotate the page by using the Input Form command.

Moving and Rotating Print Pages

You can also perform the  actions  of  the  previous  paragraph  from the  window  of  the
Properties command.

To rotate and move a print page

1.Select the page by left clicking in it. 
2.Having  selected  the  page,  run  the  Properties  command  from  the  shortcut  menu,

which is displayed if you right click in the drawing area.  The  following  dialogue  box
will appear on the screen:
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3.Enter  the  new  values  of  the  X  and  Y  coordinates  of  the  page  center  in  the
respective value fields of the Center X and Center Y properties. 

4. In the value field of the Angle property enter the new value of the rotation angle of
the print page with respect to the horizontal direction.

5. In the value fields of the Margin  top  (cm),  Margin  bottom (cm),  Margin  left  (cm)
and Margin right (cm) properties type the desired margins of the page.

6. In all  cases, click  the  exit  button ,  at  the  top  left  of  the  window, to  close the
Properties command window.

Deleting a Print Page

If you want to delete a print page, the program enables you to do so as follows:

To delete a print page.

1.Select the page by left clicking in it. 
2.Having selected the page, run the Delete Object “Page” command, from the shortcut

command which  is  displayed  if  you right  click  in the  drawing  area,  or  on  the  main

toolbar click the  button.

The other pages will be renumbered, so that there is no gap in their numbering.

PI Tables

When the  Print  mode  is  activated,  an  outline  appears  near  every  PI,  indicating  the
position where a small table with  the  PI’s  data will  be printed.  The  data that  will  be
printed in this table, are selected from the dialogue box of the Road Print Preferences. 
You can move and rotate these tables  exactly  as  you would  do  for  the  print  pages.
You can also request from the program to rotate them, so  that  they become parallel
to the selected print page. Simply select the print page and  from the  shortcut  menu
that  is  displayed  if  you right  click  in the  drawing  area,  run  the  PI  Table  Orientation
command. This command rotates only the tables whose PIs are within the  margins  of
the selected page. 
If you have moved or rotated some tables, run the Reset PI Tables command from the
Print  menu.  The  tables  will  be  restored  to  their  original  positions  and  they  will  be
rotated, either to become parallel to the print page to which they belong or, if there is
no print page, to become vertical.
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7.4.5 Preview

When you have finished making settings for the print preferences and the print pages,
according to those described  in this  chapter,  you can first  display  the  print  preview
and then print your drawing.

To preview a print page 

1.From the Print menu, run the Print command. The Print Horizontal Alignment window
will appear on the screen.

2.Click the maximize button on the  title  bar  to  view the  window  on  full  screen.  This
window is comprised of the following:

· Preview: the bottom part of the window where the image of the whole or part of the
selected page is displayed.

· Toolbar: this is located at the top of the window. It carries the buttons that control
the  transition  from  page  to  page  and  the  modification  of  the  size  of  the  page’s
viewable area. More specifically, the buttons on the toolbar are the following in order
of appearance:
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· First Page: Left click on the , button to view the first page.

· Previous Page: Click on the , button to view the previous page.

· Next Page: Click the , button to view the next page. 

· Last Page: Left click the , button to view the last page.

· Zoom In: Click the , button to zoom in on the page. This feature does not affect
the print size. 

· Zoom Out: Click the , button to zoom out on the page. The zoom feature does
not affect the print size. 

· Full Page: Click the , button to view the whole page.

· Print Page: Click the , button to set the options before printing and to print the
pages.

· Page  Elements:  This  section  is  located  below  the  preview  section  and  shows
information  regarding  the  page  that  appears  in  the  preview  page,  as  well  as
information on the selected printer and the useful dimensions of the paper.

7.4.6 Printing a Page

You can print a page by running the Print command of the Print menu. This command
results in the dialogue box shown in the figure:

How to print the Horizontal Alignment

1.From the Print menu, run the Print command. The Print Horizontal Alignment window
will appear on the screen.

2.Click the  button.
3. In the Print dialogue box, make the desired settings.
4.Press the OK button to start printing.

In this dialogue box, you can also select whether the drawing will be printed  in black
and white by ticking the B & W printing check box, at the bottom left of the dialogue
box, or to print to a file, by ticking the Print to  file  check  box.  If  you wish,  you can
print only part of the print pages in more than one copy.

Printing all pages, selected pages or a range of pages 
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1.From the Print menu, run the Print command. The Print Horizontal Alignment window
will appear on the screen. 

2.Click the  button.
3. In the Print dialogue box, which is below the Print range field, enter the part of the

document you wish to print. 
· To print all pages of the file, select the All check box.
· To print a range of pages, select the Pages check box and enter the range of pages

you wish  to  include  in the  printout,  by typing the  number  of  the  first  page in the
From: field and the number of the final page in the To: field.

To print two or more copies simultaneously

1.Click the Print button.
2. In the Copies field, enter the number of the copies you wish to print.

To print a copy of the whole document, tick the Collate check box before printing the
first page of the next copy. If you prefer to print all  the copies of the first page and
then print all the copies of the next pages, untick the check box.

Alternatively, you can print  only  one print  page,  the  current  one.  To do  this,  select
the page and then run the Print command from the shortcut menu that is displayed if
you  right  click  anywhere in the  drawing  area.  The  next steps  are  identical  to  those
described above.

7.4.7 Export to DXF File

You can export  the  contents  of  the  horizontal  alignment  to  .DXF  format,  so  as  to
process them in another drawing program.

How to export data to a DXF file

1.From the File menu, select the Export to DXF command.
2. In the displayed dialogue box, enter the name of the file in the File Name field.
3. In the File Type field, enter the type of the file, depending on  the  desired  version,

14 or 2000.
4. In all cases, click the Save button to finish the creation of the file.

In the dialogue boxes of the Print Preferences,  Terrain Printing Preferences and Road
Printing Preferences commands you can set  the  form of  the  elements  and  how they
will be displayed, as well as which elements will be exported to your file and to which
layer. Therefore, it is advisable to preview first the whole or part of the design. Before
exporting the file you must also have set the correct scale based on which the size of
the  data  font  is  determined.  Throughout  the  program,  the  size  of  the  elements
(names, terrain point elevations, PI names, cross sections and other texts) are in cm.
In the DXF  file  this  value  is  expressed  in “universal”  m.  The  conversion  is  performed
with the use of the drawing scale.





Chapter

8



206 Anadelta Tessera

Anadelta Software

8 Profile

8.1 Creating a Road Project

With Anadelta Tessera you can start creating a new Profile project in two ways:

1.You can request the automatic creation of  the  Profile  based  on  the  elements  that
you have inserted in the Horizontal Alignment or in the Cross Sections workspaces.

2.You  can  create  directly  a  new  Profile  project  that  you  can  process  only  when
working  in  the  Profile  workspace  and  then,  if  necessary,  to  create  the  Cross
Sections of the same road. 

Creating a New Profile Project

This procedure is useful in case you wish to use the program only for creating a single
profile, and also for making measurements by using cross sections.

In the Profile, a terrain line is comprised of points and a set of coordinates (Chainage,
H), and each set corresponds to the chainage of a station and to the elevation of the
terrain  on  the  axis where the  station  is.  The  new  project  that  you  are  creating  is
empty, namely it doesn’t contain any stations or lines. All  the elements  of  the  profile
(stations, terrain elevations, etc., apart from the road profile) must be created by the
user, as described in the next paragraph.

How to create a new Profile file

From the File menu, select the New Project… submenu and run the Profile command.

Creating  or  Updating  a  Profile  from  the  Horizontal  Alignment  or  the  Cross
Sections workspace

This  procedure is  performed after  you  have  completed  the  horizontal  design  of  the
road  in  the  Horizontal  Alignment  workspace  or  after  you  have  created  the  Cross
Sections independently and you wish to create and edit the Profile. In the first  case,
the cross sections that will comprise the Profile are those that have derived from the
road stationing, while in the second case the cross sections are the ones of the Cross
Sections workspace.

How to create the Profile from the Horizontal Alignment

1.From the Horizontal Alignment workspace, select the road whose Profile you wish to
create or update.

2.From the Project menu, run the Manage command, or  click  the   button on  the
main toolbar.  In  the  Quick  Update  group,  click  the  From  Horizontal  Alignment  to
Profile button. The following confirmation message will appear on the screen:

3.Click Yes to continue. The program will create the Profile. A message appears at the
end of the procedure, informing you that the procedure has been completed. To run
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the command, you must have performed stationing on the selected road. When this
type of update takes place, the main terrain line and its points are created. The left
and  right  superelevation  diagrams,  as  well  as  the  tangent  diagram  are  also
transferred. Finally,  if  there  is  a  road  profile  diagram  in  the  Horizontal  Alignment,
then this diagram is copied to the main tangent curve of the Profile.
Alternatively, you can fully define which elements of the Profile will be updated. To
do this, use again the Manage command. From the Update group of the Updates tab
in the command’s dialogue box, select From  Horizontal  Alignment  in  the  first  drop-
down list and To Profile in the second drop-down list. Next, select which updates will
take  place  by  ticking  or  unticking  the  relevant  check  boxes  and  then  click  the
Update button.

The program will  create the  Profile  workspace,  if  there  is  no  profile  for  the  selected
road; next, in Profile workspace, the program will  create the  Terrain  line  if  you have
requested it  or  by default  if  this  is  the  first  time  this  workplace is  being created.  If
certain cross sections of the road in the  Horizontal  Alignment  workspace  are  outside
the terrain model, these cross sections get the elevation of the previous cross section
and the program shows  you a warning  message,  informing  you about  the  inability  to
find natural ground for these cross sections.  If  your  project  does  not  have  a terrain
model or points, the Terrain Line will be created anyway, but all elevations of its cross
sections will be zero. You can use the aforementioned commands to update again the
Profile, after having edited the road design in the Horizontal Alignment workspace.

How to create the Profile from the Cross Sections

1.Go  to  Cross  Sections  workspace  that  corresponds  to  the  road  whose  Profile  you
wish to create or update.

2.From the Project menu, run the Manage command,  or  click  the   button on  the
main toolbar. From the Update group of the Updates tab in the command’s dialogue
box, select  From  Cross  Sections  in  the  first  drop-down  list  and  To  Profile  in  the
second  drop-down  list.  Next,  select  which  updates  will  take  place  by  ticking  or
unticking the relevant check boxes and then click the Update button.  The  program
will create the Profile workspace, if there is no profile for the selected road; next, in
Profile workspace, the program will create the Terrain line if you have  requested  it
or by default if this is the first time this workplace is being created. The diagrams of
the Cross Sections workspace, as well as any new line that originates from selected
points of the Cross Sections, will also be transferred,  if  you have  requested  so  by
making  the  relevant  selections.  You  can  use  the  aforementioned  procedure  to
update again the Profile, after having edited the Cross Sections workspace.
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8.2 Workspace

Every  time  you open  or  create  a  Profile  project,  you  are  transferred  to  the  Profile
workspace.  The  biggest  part  of  the  screen  in  this  workspace  is  occupied  by  the
graphic representation of  the  profile.  At  the  bottom of  the  screen,  you can view (if
any) the superelevation and tangent diagrams.

To go to the Profile workspace

From the View menu run the Profile command, or select the Profile tab at the bottom
of the main screen. The program transfers you to the Profile workspace.

Similarly to the Horizontal Alignment workspace, at the top of the screen you will find
the familiar menu bar, with the File, Edit, View, Project, Tools, Print and Help menus. A
new menu has also been added to the  Profile.  Below  the  menu bar,  you will  find  the
main  toolbar  and  below  the  latter  you  will  find  the  View  toolbar,  which  contains
buttons that carry out operations relevant to the elements that are displayed on  the
screen, especially in the drawing area. 
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On the  left  of  the  screen,  you can see  the  Element  Drawing  toolbar  that  contains
various operations, which have been categorized in four groups. From now on, the first
group will  be referred  to  as  Drawing,  the  second  as  Edit,  the  third  as  Print  and  the
fourth as Bruckner. 

The status bar  at  the  bottom of  the  screen is  comprised  of  four  sections.  The  first
section shows the coordinates of the current position of the  crosshair (chainage  and
absolute elevation), as well as the elevation discrepancy between the station and the
terrain  elevation  at  the  particular  chainage.  The  second  section  displays  the  Input
Form, if available. Next to  it  you can see  the  type of  the  line,  e.g.  Natural  Ground,
Tangent Curve,  etc.,  on  which  the  crosshair is  located.  The  fourth  and  last  section
shows information about the selected station or PI of the profile.

The  profile,  the  surface  diagram  and  the  Bruckner  diagram  are  usually  displayed  in
skewed scale (different scales for the X and Y axes).  You  can define  the  scale  ratio
for  the  display  of  the  profile  on  screen  from  the  dialogue  box  of  the  Scale  X/Y
command of the View menu. Type the ratio in the dialogue box and then click the OK
button. 

You can increase this ratio by 20%,  if  you run  the  Zoom out  command  (<F5>)  from
the View menu, or decrease the ratio by using the Zoom In command (<F6>). You will

have  the  same  result  if  you  click  the    buttons  for  zooming  out  and  the  
buttons for zooming in. You will find these  buttons  on  the  View  toolbar.  If  you want
the  profile  zoom ratio  on  the  screen  to  be  the  same  as  the  one  you  have  set  for

printing, press on the same toolbar the  button.
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8.3 Profile Workspace Modes

There are five modes  in the  Profile  workspace.  This  allocation  facilitates  the  user  to
insert,  edit  and  process  the  elements  of  the  design.  By  default,  the  Profile  mode  is
always active every time you create a new Tessera file.

Profile Mode

In this mode you can create, edit and print the profile of a road.

In  the  Profile  mode  you  can  create  two  types  of  lines:  the  terrain  lines  and  the
tangent curves.  A terrain  line  consists of  one or  more points  that  are  visible  to  the
user. Every point of this line has a set of coordinates x and h, that corresponds to the
distance of the station from the beginning of the road (Chainage) and to the elevation
of the terrain on the station. The terrain line points are  displayed  on  the  screen and
they are contained in a small box in order to  be more distinguishable.  You  can insert
more  than  one natural  ground  lines.  The  program considers  the  first  inserted line  as
the  main  line.  The  terrain  lines have  always  points  at  the  same  chainages.  Tangent
curves  are  also  comprised  of  one or  more points  that  are  visible  to  the  user.  Every
point  of  a  tangent  curve  has  a  set  of  coordinates  (x,  h)  that  correspond  to  the
chainage and the elevation. A rounding radius corresponds to every PI. By default, the
value of the first and last PI’s radius is zero. Here too, you can insert more than  one
tangent  curves,  but  the  first  tangent  curve  is  always  considered  as  the  main  or
current one. The graphical representation of the lines is displayed in the drawing area.
You can move left, right, up and down within the drawing area by using the respective
arrow keys or the mouse.

The  current  point  is  the  selected  point,  which  appears  highlighted  in  pink  on  the
screen. The relevant information on the current point is displayed at the bottom right
of the  screen,  in the  last  section  of  the  status bar.  In  case  that  the  current  point
belongs  to  a  tangent  curve,  the  following  information  is  displayed  in  the  order
described below: the PI serial number from the beginning of  the  line,  the  distance  of
the point from the beginning, namely from its Chainage (X), its absolute elevation (H)
and the rounding radius (R). Regarding the natural terrain, the following information is
displayed in the  order described  below: the  station  name,  the  station  chainage,  the
absolute  elevation  (H)  and  the  elevation  difference  between  the  terrain  and  the
current tangent curve (Dh).

At the bottom of the drawing area and below the profile graph, you can see the data
axes  (or  tables)  of  the  various  lines  whose  names  are  displayed  on  the  left.  The
available data tables are: Station  name,  Chainage,  Terrain  elevation,  Natural  terrain
slope, Distance between successive cross sections, Road profile elevation S, Roadline
slope  S+DS,  Distance  between  tangent  curve  points,  Tangent  curve  slope,  Oblique
slope left, Oblique slope right, Level discrepancy, Superelevation right, Superelevation
left  and Display data.  The  first  five  tables,  which  refer  to  the  Natural  Ground,  are
shown in green and  they are  displayed  when there  is  even  a single  terrain  line.  The
next five tables are shown in red and they are displayed when there is  even  a single
tangent curve. The last five tables are displayed in gray when there is both a terrain
line and a tangent curve.

You can choose which tables will be displayed on screen, as well as the order in which
they will be displayed. To move a table, select it by clicking the left mouse button and
move it to the desired position. More specifically:

1.Click the left mouse button to select the data axis or table you wish to move. The
color of the table changes automatically from green (in the case of a Natural ground
table) to purple. 
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2.Left-click on the selected table to drag–and-drop it to the desired position.

To  select  which  axis  data  will  be  displayed  from  the  View  menu,  run  the  Display

Options command, or press the F2 key, or click the  button on the View toolbar.
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8.4 Profile Display Options

1.From the View menu, run the Display Options command, or press the F2 key, or click

the  button on the View toolbar. The following dialogue box appears on screen:

2.Select one of the item categories that are displayed on the left part of the window. 
3. If you want none of the items of the category to be displayed, untick the box next

to the name of the category. If you want only some of the items of a category to
be  displayed,  select  them  from  the  right  part  of  the  window  by  ticking  the
corresponding check box, which is displayed next to their name.

4.To exit the window, click the exit button  on the title bar of the window.

When the General option is ticked, the only available option is:
· Grid: Select this field to display the grid.
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When  the  Drawing  option  is  ticked,  the  available  options  are  the  same  as  in  the
Horizontal Alignment, namely:
· Polyline Points: Shows or hides the polyline points.
· Layers: In this field you can see all  the available layers of the drawing and you can

choose to show them or hide them. 

When the Table data option is ticked, the available options are:
· Station name: Shows or hides the station names axis.
· Chainage: This axis shows the Chainage per point.
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· Terrain Elevation: The terrain elevation per point.
· Terrain slope %: The terrain slope between successive cross sections. 
· Distance between (m): The distance between successive cross sections.
· Road profile elevation (m): Shows the road profile elevation per point.
· S: The longitudinal slope of the road per point.
· S+DS: The longitudinal slope of the roadlines per point.
· Distance: The distances between successive points of the tangent curve.
· Tangent curve slope: The slopes between successive points of the tangent curve.
· Oblique slope left: The oblique left slope per point.
· Oblique slope right: The oblique right slope per point.
· Elevation discrepancy: The elevation discrepancy between road profile and terrain.
· Superelevation right: The values of the right superelevations per point.
· Superelevation left: The values of the let superelevations per point.
· Display data: This option refers to all  of the aforementioned data that is shown per

point. You can choose to display this data:
· Per cross section: The data is shown per cross section chainage.
· Interpolate every (m): The data is shown per fixed distance, which  is  set  in the

immediately next field.
· Hide  successive identical  values:  In  the  case  of  interpolation,  select  it  to  hide

the similar values for successive points. 

When the Diagrams option is ticked, the available options are:
· Superelevation left: Shows or hides the left roadline of the superelevation diagram.
· Superelevation  right:  Shows  or  hides  the  right  roadline  of  the  superelevation

diagram.
· Tangent curves: Shows or hides the tangent curve diagram.
· Axis: Shows or hides the axis of the superelevation diagram.
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When the Terrains option is ticked, the available options are:
· Natural Ground: Shows or hides the Natural ground line.
· Current terrain: Select the terrain whose data will appear on the screen (e.g. in the

data  tables  below  the  drawing).  In  the  window  shown  in  the  figure  above,  both
grounds are selected but the current terrain is Natural Ground 1.

When the Road profiles option is ticked, the available options are:
· Tangent: Shows or hides the tangent curve and road profile set.

· Tangent: Shows or hides the tangent curve of the road profile. 
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· Curve: Shows or hides the road profile curve.
· Current tangent  curve:  Select  the  tangent  curve  whose  data  will  appear  on  the

screen (e.g. in the data tables below the  drawing).  The  current  tangent  curve  will
be  the  one  that  will  share  its  data  with  the  Horizontal  Alignment  and  the  Cross
Sections during the update procedures.

When the Mandatory points option is ticked, the only available option is:
· Mandatory  point  …:  The  names  of  all  mandatory  points  that  have  been  inserted

appear  on  the  right  part  of  the  window.  From  there,  you  can  show  or  hide  the
desired points.
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When the Snap category  is  ticked,  all  fields  that  correspond to  objects that  can be
snapped with the mouse pointer appear on the right part of the window.
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8.5 Bruckner Mode

In this mode you can edit the data of the mass haul diagram (Bruckner) and insert the

haul lines. To go to this mode, click the relevant   button as  shown in the
figure below. The drawing area displays the Bruckner diagram, as this derives from the
cross section data.

In the Bruckner mode, you can see the line of the algebraic sum of the cubes. Every
point of this line has a set of coordinates (x, h) that corresponds to the Chainage and
to the algebraic sum of the available masses (cuttings – fillings) from the beginning of
the road. The cross section points can be seen on the screen and they are surrounded
by a small square frame (true cross sections) or a rhombus (interscalar cross sections,
inserted automatically into the surface diagram). The haul lines on the other hand, are
horizontal lines that intersect with  the  cube line  at  two points  at  minimum.  You  can
insert more than one haul line. The graphical representation of the lines is displayed in
the drawing area. You can move left, right, up and down within  the  drawing  area by
using the respective arrow keys or the  mouse.  To select  a haul  line,  left-click  on  it.
The color of the line changes from yellow to blue.
At the bottom of the drawing area and below the surface graph, you can see the data
axes or tables of the various lines whose names are displayed on the left. The tables
are:  Station  chainage,  Station  name,  Distance  between  successive  cross  sections,
Cuttings  area,  Fillings  area,  Self-Distributions  (m2),  Cuttings  (m3),  Fillings  (m3),
Volume  difference  and  Bruckner.  The  first  three  tables  are  green,  the  next  three
tables are yellow, the last three axes are red and the last one is gray.
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8.6 Surface Diagram Mode

In this mode, the drawing area displays the road surface diagram, as this derives from
the measurement of the  cross section  areas.  To go  to  this  mode,  click  the  relevant

, button as shown in the figure below.

In the Surf. Diag. Mode, you cannot create or edit any of the cross sections that you
see. In the drawing area there  are  three  lines:  the  cuttings line,  the  fillings  line  and
the line of the sums. The cuttings line, which is displayed in red color, is comprised of
sets of coordinates (x, y), which represent the station chainage and the  area of  the
station cutting (in m2). Respectively, the fillings line is displayed in green color and its
ordinate corresponds to the area of the station filling (in m2). The aforementioned two
lines  represent  the  areas before  deducting  self-distributions. By  default,  the  area of
the cuttings is positive and the area of the filling is negative. The line of the sums on
the surface diagram after the deduction of self-distributions is displayed in gray  color
and corresponds to the algebraic sum of the aforementioned two lines.

The line points are displayed on the screen and they are contained in a small box to be
more distinguishable. At the points  where,  either  the  line  of  the  sums  intersects  the
horizontal  axis,  or  the  line  of  the  fillings  or  the  line  of  the  cuttings  becomes  zero
(shifting from a cross section that lies entirely in a cutting  or  filling  to  a mixed cross
section  and  vice  versa),  the  program  inserts  automatically  an  interscalar  cross
section, which does not correspond to any of the cross sections that are displayed in
the Cross  Sections  workspace.  This  serves  for  the  more accurate calculation  of  the
mass haul diagram (Bruckner). All lines have points at the same places. 
The axes or tables at the bottom of the drawing area are the same as those that are
displayed in the Bruckner mode.
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8.7 Terrain Profile Line

If you have created a profile project without having the Horizontal Alignment, or if you
wish  to  insert  a second  terrain  line  which  will  correspond,  e.g.  to  the  terrain  profile
below  a roadline,  then  you must insert  the  line  points  in  one  of  the  ways  that  are
described below.

Creating a Terrain Line with the Mouse

You can create a terrain line directly in the Anadelta Tessera environment  by setting
its points one by one with the mouse. 

To create a terrain line with the mouse

1.From  the  Profile  menu,  run  the  Insert  Terrain  command, or  from the  Edit  toolbar,

click the  button (green).
2.Use the mouse to define the positions of  the  terrain  line  points  within  the  drawing

area. To define a profile more accurately, use the  Input  Form dialogue  box.  If  the
line that you are inserting is the first one, then the axes referring to this line and its
points  (namely  the  cross sections of  the  road)  are  also  displayed.  In  the  case  of
secondary terrain lines, then you’re actually defining only  the  elevations, since  the
cross  sections  and  their  in-between  distances  have  already  been  set  when  you
inserted the first terrain line.

3.When  you  have  finished,  press  Esc  or  right-click  anywhere  on  the  screen  to
complete the insertion of points.

The profile and the relevant data on the axes are displayed on the screen

Creating a Terrain Line by Typing Absolute or Relative Coordinates

You can insert a line by typing its data on a list.

How to create a Terrain line from the window of the Line edit command

1.From the Profile menu, run the Line edit command. The following window appears on
the screen:
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2.Click the  (button (green) at the top left of the window. A dialogue box appears
on the screen, where you must type a name for the new curve. 

3.When you have  finished typing,  click  the  OK button  to  return  to  the  dialogue  box
and start typing the points. 

The main section of the dialogue box is  comprised  of  a table  with  six  columns  and  a
variable number of rows. Each row  corresponds  to  a cross section.  The  titles of  the
columns are shown in gray on the top. The columns are: A/A, Station, Ch., H, Dx and
Slope%. The program fills in the A/A column automatically with the serial number of the
cross section and the user cannot intervene. In the other columns you can enter the
cross section data.  If  you haven’t  inserted any other  terrain  line  yet,  then  only  the
first  row  of  the  table  will  be filled.  If  there  is  already  a natural  ground, then  this  is
considered as the main one and the data in the Station and Ch. columns will be copied
to the new ground. In this case, you cannot edit the data of the row in the  Station,
Ch.  and  Dx  columns.  In  other  words,  the  Chainages  of  the  new line  are  always  the
same as the ones of the main line and you can only intervene to the elevation of the
line at the station. 

In the Station column, enter the name of the station you wish to be displayed at the
profile axis. The positions of the points can be defined in one of the following ways:



223Profile

Anadelta Software

1. If you know the chainage and the elevation of the points that will comprise the line,
type them in the Ch, and H columns respectively. 

2. If you know the distance of a point from its previous point, type it in the Dx column.
 

3. If you know the slope of  a point with  respect  to  its  previous  point,  type it  in  the
Slope% column. 

When  you  change  the  data  of  one  cell,  the  other  cells  of  the  row  are  updated
automatically.

To select a field, left-click in it and then start typing. If you wish to restore the data
of the  cell,  press  the  Esc  key.  Press  the  Enter  key  to  confirm  the  data  you  have
entered and to move to the next field on the right.  You  can also  move  between  the
fields by using the up, down, right and left arrow keys. If you are at the end of a row,
you can press the Enter key to go to the first field of the next row. 

Regarding the main line of the terrain, if you wish to insert a new station at the end of
the table, go to the sixth column of the last station and press  the  Enter  key. If  you
want to insert a new station between two existing stations, select the immediate next
station  and  press  the  Ctrl+I  keys.  The  new  station  is  inserted  automatically  in  the
middle of the distance between the selected station and its previous one. If you wish
to delete a station, simply select the desired station and press the Ctrl+D keys.

Importing Terrain Lines from a Text File (.txt)

If the points of a terrain line are available in digital form (ASCII text files) and you wish
to import all  of them to your project along the  road  axis or  parallel  to  the  road,  you
can use the specialized operation of batch point insertion. This method is very useful
when you wish to transfer a profile from one file to another.

How to import the Natural Ground from an ASCII file

1.From the File menu, select the Import from ASCII submenu and then run the Terrain
Profile command. The Open dialogue box appears on the screen.

2.Select the desired file and click Open.

The text files that the program searches to find have the .txt extension and must be
comprised of at least three columns.
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These columns are the station name, the station Chainage and the station  Elevation.
The  first  rows of  the  file  may  contain  comments  on  the  starting  chainage  and  the
name of the line, but the program will ignore them. The rows containing the data are
separated  by a row  that  must  contain  at  least  three  consecutive  dashes  (___).  In
case  that  the  terrain  line  that  you wish  to  import is  the  main  one,  the  program will
read  the  contents  of  the  second  column.  In  the  opposite  case,  the  program  shall
ignore them and the points of the new line will have the same distances as the ones of
the main line files, while their elevations will be those that the program has read from
the file. Obviously, the file must have as many stations as the already existing Natural
Ground.

If the  file  does  not  comply  with  the  aforementioned requirements,  then  the  program
will not be able to read the file and will display the relevant error message.

Copying a Terrain Line

You can create a copy of a terrain line with elevation offset.

How to copy a terrain line

1.Select the desired terrain  line  and  from the  Profile  menu  run  the  New terrain  with
Offset command, or from the menu which is displayed if your right-click anywhere in
the drawing area, run the Copy with offset command.

2.The program will prompt you to enter the elevation  of  the  first  station  of  the  new
line, showing you the message Enter profile point on the Status bar. Enter the new
point either by clicking  the  left  mouse  button in the  drawing  area or  by using the
Input Form command.

The profile of the new curve will be displayed on the screen. The other points of  the
curve will be inserted with respect to the position of the first station. 
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You can also copy the main line of the natural ground from the window of the Line edit

command. Just click the  button. A dialogue box appears on the screen, where you
must type a name for the new curve. Click the OK button. The program will  create a
new  terrain  line,  which  will  be  a  true  copy  of  the  main  line,  without  any  elevation
offset. Next, you can proceed to the offset by clicking the dH button at the top of the
window,  and  type  the  value  in  the  Move  line  by  Dh,  as  described  in  the  following
section.
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8.8 Terrain Profile Editing

You can edit the Terrain lines that you have created, so as to give them the desired
form.

Changing the Name of a Terrain Line

To change the name of a terrain line, from the Profile menu run the Line edit command
and then click the Name Change button. In the resulting dialogue box,  type the  new
name. Next, click the OK button.

You can also  edit  the  name of  a line
from  the  window  of  the  Properties
command,  which  is  displayed  if  you
click the right mouse button after you
have  selected  the  line  you  wish  to
rename.  Simply  run  the  command  to
open the window and in the field that
corresponds  to  the  Name  command,
type the desired name.

Moving a Terrain Line

You can move a terrain line with respect to the elevation.

To move a line with the mouse

1.Select the line you wish to move.
2.From the menu that is displayed when you right-click in the  drawing  area,  run  the

Move command.
3.The program will prompt you to set a reference point, by showing you the relevant

message  in  the  third  section  of  the  status  bar.  Set  a  reference  point  either  by
clicking  the  left  mouse  button  in  the  drawing  area  or  by  using  the  Input  Form
command.

4. In the next step, the program will prompt you to set an end point, by showing you
the relevant message in the  third  section  of  the  status bar.  Proceed as  described
above. The line will be transferred to the position you have specified.

This type of  transfer  has the  meaning  of  vertical  shift.  Therefore,  although  you can
specify both points with a different chainage, only their elevation discrepancy is taken
into account.

You can also move the line from the window of the Line edit command.

How to move a curve from the window of the Line edit command

1.From the Profile menu, run the Line edit command or select a terrain line and then,
from the menu which is displayed if  your  right-click anywhere in the  drawing  area,
run the Line edit command.

2.From the drop-down list at the top of the displayed window, select the curve (if not
selected) you wish to move. The data of the selected curve are shown in the table
in the middle of the box.

3.To  move  the  curve,  click  the   button on  the  right  of  the  drop-down  list.  The
following dialogue box appears on the screen:
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4. In the Move line by Dh text field, type the distance at which you wish to move the
curve, entering a positive sign for moving the line upwards and  a negative  sign for
moving the line downwards.

5.Click the OK button. The curve will be moved within the drawing area and the table
data will be updated with the new values.

You can also move only part of a terrain line by elevation or by the X axis (in the case
of the main curve).

Inserting a Point on a Natural Ground Line

You can insert one or more points on a Natural Ground line. 

To insert a point on a terrain line with the mouse

1.With the mouse pointer  over a point of  the  terrain  line,  select  the  Terrain line  by
clicking the left mouse button.

2.Select the point next to the point you wish to insert.
3. From  the  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,  run  the

Extend to left or Extend to right command, depending on  which  direction  you wish
to insert the point.

4.The program will ask you to specify the position of the new point,  by showing  you
the  relevant  message on  the  Status  Bar.  Set  the  point either  by  clicking  the  left
mouse button on the screen or by using the Input Form command.

The point will be inserted at the position you have specified. Every time  you insert  a
point on a line, a point with the same chainage will also  be inserted on  every  terrain
line of the project, while its elevation will be calculated  through  a linear  interpolation
from the neighboring points of the lines. Inserting a new point actually means inserting
a  new station  into the  road.  The  new station  will  be named after  its  serial  number,
namely, if the terrain lines have 25 stations, the name of the new station  will  be 26.
Of course, you can rename the station, if desired.

You can also insert a point on  the  main  natural  ground  from the  window  of  the  Line
edit command.

Moving a Terrain Line Point

You can move a terrain line point easily and quickly by using the mouse.

How to move a terrain line point

1.With the mouse pointer over a point of the terrain line, select the line  you wish  to
edit by clicking the left mouse button.

2.Highlight the point you wish to move.
3.Specify  the  new  position  of  the  point.  You  can  move  the  point  vertically  or

horizontally. Regarding the horizontal offset, this is only possible up to the positions
of the two neighboring stations.
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At the same time, the points of the other curves on  the  same  station  will  be moved
horizontally,  in  order  to  get  the  same  chainage,  but  they  will  maintain  their  H
elevation.

You can do the same from the dialogue box of the Line edit command.

How to move a terrain line point from the window of the Line edit command

1.From the Profile menu run the Line edit command, or select a terrain line and then,
from the menu which is displayed if  your  right-click anywhere in the  drawing  area,
run the Line edit command.

2.From  the  drop-down  list  at  the  top  of  the  window,  select  the  terrain  line  (if  not
selected) you wish to move. The data of  the  selected  line  are  shown in the  table
that is displayed in the middle of the box.

3. If the selected line is not the main one, you can intervene only in the H and  Slope
columns,  namely  you  can  move  a  point  only  by  elevation.  When  the  Move  next
check box is ticked, the points at the far right of the point that  you’re  moving  are
also moved by the same distance. If the terrain line is the main one, you can move
the points horizontally, by editing the data in the Ch, and Dx columns.

Batch Editing of Terrain Line Points

You can carry out a batch  editing  of  the  points  positions either  from the  window  of
the Points command in the Properties or from the window of the Line edit command.

How to carry out batch editing of the profile points 

1.Select the profile you wish to edit by left-
clicking  on  it  with  the  mouse  when  the
pointer is on one of the profile points.

2.Display  the  Properties  command  window.
In  the  value  field  of  the  Points  property,

click the button with the three dots  the
right of the field. The window of the Points
list command  appears on  the  screen.  This
window  has  two  columns,  which
correspond to the Distance from Start and
to  the  Elevation.  Each  line  of  the  window
corresponds to a line point.

3.Change the values in the  desired  fields  by
typing the new coordinates. 

4.Every  time  you  change  a  value,  press
Enter to confirm the new value.

Deleting a Terrain Line

You  can  delete  very  easily  any  terrain  line  you  don’t  want  to  be  included  in  your
project any longer.

How to delete the selected terrain line

1.With  the  mouse  pointer  on  a point of  the  terrain  line,  select  the  line  you wish  to
delete by clicking the left mouse button.

2.From the Edit menu, run the Delete command, or, from the menu that is displayed if
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you  right-click on  the  screen,  run  the  Delete  Objects  command,  or  press  the  Del
key. If the line you selected to delete is  the  main  one,  this  action  also  deletes all
lines of the Natural Ground. 

Deleting a Terrain Line Point

You can delete one or more points of a terrain line.

How to delete a terrain line point

1.With the mouse pointer on a point of the terrain line, select the line you wish to edit
by clicking the left mouse button.

2.Select the point you wish to delete.
3.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Delete Point command.
This action also deletes the points of every terrain line that are at the same chainage.
You can also  delete  a point from the  dialogue  box of  the  Line edit  command, if  you
select  the  line  that  corresponds  to  the  station  to  be  deleted  and  then  press  the
Ctrl+D keys.
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8.9 Road Properties

If you run the Road preferences command from the Profile menu, the following dialogue
box will appear on the screen:

The  box has two tabs,  where you can  make  various  settings  for  the  road  and  the
Bruckner diagram. 

The General tab offers the following settings:
· PI start radius: Enter the value of the PI radius that the program will give to every

new tangent PI that you insert. 
· Starting chainage: In this field you can enter the starting chainage of the road.
· Eye  elevation:  In  this  field  you  can  enter  the  value  of  the  elevation  for  the

calculation of the minimum radius, in order to ensure the necessary sight distance.
· Left and right lane width: Enter the road’s traffic width for the calculation of the Ds.
· Design Speed: Enter the road’s design speed. 

· Speed V85: Enter the working V8 5 speed. 

When you have finished your settings, click the  OK  button to  save  the  changes and
return to the Profile workspace.
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8.10 Creating and Inserting a Tangent Curve

The  next step in the  design  of  the  Profile  is  the  insertion  and  editing  of  the  road’s
tangent  curve.  The  end  purpose  is  to  determine  the  elevation  of  the  terrain  road
profile. You can insert the tangent curve PIs and their data in three ways.

1.Batch import of lines from text files (.txt)
2. Insertion of PIs within the Anadelta Tessera environment.
3.Conversion of a natural ground line to tangent curve.

Importing a Tangent Curve Line from a Text File (.txt)

If the tangent curve PIs and their data are available  in digital  form (ASCII  text  files)
and you wish to import them into your design, you can do this anytime, either  during
the first stage of your design or while editing your  design,  and  for  as  many  times as
you  wish.  This  method  is  very  useful  when  you  wish  to  import  into  the  program
tangent curves from other files.

How to import a tangent curve from an ASCII file

1.From  the  File  menu,  select  the  Import  from  ASCII  submenu  and  then  run  the
Tangent curve command. The Open dialogue box appears on the screen.

2.Select the desired file and click Open. The text files  that  the  program searches  to
find have the .txt extension and must be comprised of at least three columns. These
columns are the tangent curve Name, its Chainage  and its Elevation.  The ASCII file
may contain  the  PI  rounding radii  and  you can import  them  into  a  column,  which
must be the next column after the elevation. The first lines of the file may  contain
comments,  but  the  program  will  ignore  them.  The  rows  containing  the  data  are
separated by a row, which must contain at least three consecutive dashes (___).

If the  file  does  not  comply  with  the  aforementioned requirements,  then  the  program
will not be able to read the file and will display the relevant error message.  After the
file has been read, a new tangent curve will appear in the drawing area.

Creating a Tangent Curve

You can create one or more tangent curves by specifying the tangent curve PIs.

How to create a tangent curve with the mouse

1.From  the  Profile  menu,  run  the  New  Tangent  Curve  command,  or  from  the  Edit

toolbar, click the  button (red).
2.Use the mouse to define the positions of the tangent curve PIs  within  the  drawing

area. To define a PI more accurately, you can use the Input Form dialogue box.
3.When  you  have  finished,  press  Esc  or  right-click  anywhere  on  the  screen  to

complete the procedure.

In this phase,  you can see  on  your  screen the  tangent  curve,  which  is  displayed  in
red, as well as the elevations of the road profile per cross section. You  can also  see
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the road profile, if it can be calculated with the current values of the PI rounding radii.
The next step is to edit the default value of  the  rounding radii  of  the  tangent  curve
PIs. If you wish to change the default value that the program assigns to the rounding
radii, go to the Profile menu, run the Road properties command and change the value
in the PI initial values text field.

You can also insert a tangent curve from the window of the Line edit command.

How to create a tangent curve from the window of the Line edit command

1.From the Profile menu, run the Line edit command. 

2.Click the  button (red) at the top left of the window. A dialogue box appears on
the screen, where you must type a name for the new tangent curve. 

3.When  you  have  finished  typing,  click  the  OK  button  to  return  to  the  previous
window and start typing the points. You will notice that the tangent curve that you
have created appears highlighted in the drop-down list.

When a tangent curve is selected, the main section of the dialogue  box is  comprised
of a table with six columns and a variable number of rows. Each row corresponds to a
PI. The titles of the columns are shown in gray on the top. The columns are: A/A, Ch,
H, Dx, Slope% and Radius. The program fills in the first column automatically with the
serial number of the cross section and the user cannot intervene. In the other columns
you can enter the PI data from left to right. It is not mandatory to fill all columns. Only
the first column of the table appears filled. 

To select a field, left-click in it and then start typing. If you wish to restore the data
of the  cell,  press  the  Esc  key.  Press  the  Enter  key  to  confirm  the  data  you  have
entered and to move to the next field on the right.  You  can also  move  between  the
fields by using the up, down, right and left arrow keys. If you are at the end of a row,
you can press the Enter key to go to the first field of the next row.

The horizontal position of a PI can be defined in the following ways:

· In the Ch. column you can specify the PI chainage.
· If you know the distance of a point from its previous point, but  you don’t  know its

chainage, type the distance in the Dx column.

The position of a point with respect to  the  elevation  can be defined  in the  following
ways: 

· In the H column you can specify the PI elevation.
· In  the  Slope%  column  you  can  type  the  slope  of  the  point  with  respect  to  its

previous point. 

In the Radius field you can type the value of the PI rounding radius. When you enter
data  in  one  of  the  table’s  cells,  the  other  cells  of  the  same  row  are  updated
automatically. 

Regarding the  tangent  curve  PIs,  if  you wish  to  insert  a new  PI  at  the  end  of  the
table, select the last field of the last PI and press Enter. If you wish to insert a new PI
between two existing ones,  select  the  immediate  next PI  and  press  the  Ctrl+I  keys.
The new PI will be inserted right above the selected one and at the  half  distance. If
you wish to delete a PI, simply select the desired PI and press the Ctrl+D keys.

Conversion of a Terrain Line to Tangent Curve

To convert a terrain line to a tangent curve, select  the  desired  terrain  line  and  from
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the menu that is displayed if you right-click in the drawing area run the  Copy  terrain
to new tangent curve command.

Inserting and Editing Tangent Curve Radii

To complete the calculation of the road profile, you must insert the rounding radius for
every PI. This is done from the Properties command window.

How to insert the value of a PI rounding radius

1.Select  (highlight)  the  desired  PI  and  run
the Properties command.

2.From  the  window  of  the  Properties
command enter the value of the rounding
radius  in theRadius  field.  In  this  window
you can also view the minimum curvature
radius  of  the  curve,  which  ensures  the
required  sight  distance.  The  minimum
radius  is  calculated  based  on  the  value
you have entered in the Eye elevation, in
the  Road  preferences  of  the  Profile
menu.

When you close the screen window, the road profile appears rounded according to the
value of the curvature radius, but only if this value is compatible with the other data
(namely,  only  if  the  curvature  radius  does  not  overlap  the  curvature  radii  of  the
adjacent PIs).

You can also edit the curvature radii from the dialogue box of the Line edit command.
Select the desired tangent curve and in the last column, type the new radii values.

Finally, when a tangent line has been calculated, you can change the curvature radius
of a PI and view the result in real time. If you select with the left  mouse  button the
flags of the desired PI, you will notice that  their  color  changes.  You  can increase  or
decrease the PI radius by left-clicking the (left or right) flag. Move the mouse to the
left or to the right to increase or  decrease  the  flag,  respectively.  Finally,  click  again
the  left  mouse  button  to  finish  the  procedure,  or  click  the  right  mouse  button  to
restore  the  flags  to  their  original  position.  The  yellow  flags  indicate  overlapping  of
successive circular arcs which are not displayed.
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8.11 Editing a Tangent Curve

You  can  edit  the  tangent  curves  that  you  have  inserted,  so  as  to  give  them  the
desired properties.

Changing the Name of a Tangent Curve

To change the name of a tangent curve, click the  button from the window of the
Line edit command. A dialogue box appears on the screen, where you must type a new
name. Next, click the OK button.

You  can also  edit  the  name of  a tangent  curve  from  the  window  of  the  Properties
command. Simply run the command and in the Name field, type the desired name.

Moving a Tangent Curve

You  can  move  a  tangent  curve  both  horizontally  (Chainage)  and  vertically
(elevations).  The  steps  to  follow  are  those  described  above  for  moving  the  terrain
lines. The only difference refers to the relative position of the two points  that  define
the  movement,  while  their  difference  in  the  horizontal  direction  is  also  taken  into
account (in addition to the vertical direction).

You can also move the tangent curve from the window of the Line edit command. The
procedure is the same as the one described above for the vertical movement of terrain
lines.

Adding a PI to a Tangent Curve

You can add one or more points to a terrain  line.  The  insertion of  a PI  to  a tangent
curve will not affect the other tangent curves.

You can do the same from the dialogue box of the Line edit command.

Moving a Tangent Curve PI

You can move  the  PI  of  a tangent  curve  by applying  the  same  procedure  that  you
would use for the  terrain  lines.  A PI  can only  be moved  within  the  boundaries  of  its
two adjacent PIs. The same action is possible from the  dialogue  box of  the  Line  edit
command. You can also move points from the window of the Points command, as well
as from the window of the Properties command.

Deleting a Tangent Curve and Tangent Curve PIs

Delete a tangent curve or a PI in the same way that you would use to delete a terrain
line or a terrain line point.
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8.12 Road Profile Calculation Data

The  road  profile  that  corresponds  to  the  tangent  curve  of  a  road  is  calculated
automatically upon the insertion of the road’s tangent  curve  and  based  on  the  initial
rounding radii of the tangent curve PIs. The road profile is re-calculated automatically
every time you edit the data of any of its PIs. To view the data of a PI, select the PI
and run the Properties command.

In the resulting window, you can see the tangent length and the curve arrow in the 
and d fields respectively.

Moreover, on the axes at the bottom of the drawing area, you can see the road profile
data for every cross section.

Copying a Road Profile to a Terrain Line

You can copy the road profile of a tangent curve to a terrain line. From the shortcut
menu that is displayed if you right-click in the drawing area, run the Copy road profile
to new terrain command. A new terrain line will be created, whose points will coincide
with the road profile of the tangent curve.
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8.13 Mandatory Points

The  mandatory  points  enable  the  setting  of  the  coordinates  from  which  the  road
profile will pass. 

How to create mandatory points

1.From  the  Profile  menu,  run  the  New  mandatory  point  command,  or  click  the  
button in the Edit section of the Elements Drawing toolbar.

2.Use the mouse to define the position of the mandatory point.

The names of the inserted points  are  determined  automatically  by the  program upon
insertion of the points. Select a point and right-click in the drawing area to open the
Properties shortcut menu. Enter the new name in the Mandatory point name field.

Moving and Renaming Mandatory Points

How to move or rename the selected Mandatory Points

1.Select the Mandatory Point you wish
to  move,  by clicking  the  left  mouse
button  when  the  pointer  is  on  the
point.

2.Open  the  Properties  command
window  by  right-clicking  in  the
drawing area. In the Mandatory point
name  field  type  the  new  name,  if
you  wish  to  change  it,  and  in  the
Mandatory  point  X  and  Mandatory
point Y fields type the coordinates.

 
To move a point faster, select it, activate it and move it to its new position by using
the mouse.

Editing Mandatory Points

From the Profile menu, run the Mandatory Points Edit  command. The following window
will appear on the screen:
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This window is comprised of the following columns:
· No: The serial number of every point.
· Ch.: The chainage of every point.
· Elevation: The elevation where a specific mandatory point is located.
· Name: The name of every point.

In this window you can edit  all  data of  a point.  If  you wish  to  add  a point and  you

know its Chainage and Elevation, click  the  respective  button;  an  empty  line  will
appear  on  the  screen where you can enter  the  characteristics  of  the  point.  If  you

wish to delete a mandatory point, click the respective  button.
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8.14 Profile Data

The data displayed on the profile axes can be viewed in the form of a table, from the
window of the Display Data command of the Profile menu. 

To save the data of the window in a text file,  click  the   button.  The
Save dialogue box appears on the screen. Go to the subfolder where you wish to save
your file and type the file name. Finally, click the Save button.

If you tick the  Interpolation  between  cross sections check  box,  the  program checks
the profile data in the S,S+DS, Oblique slope left  and Oblique slope right columns with
respect to a fixed distance and shows  the  results  by adding new rows to  the  table.
The distance between the chainages where the check takes places is defined from the
 View menu Ž Display Options command Ž Table data Ž Display data group.

If you tick the Hide successive identical values check box, the program only shows the
first of a column’s values that are identical and in adjacent cells. Obviously, if all  cells
of a row are empty, the program will not show the row at all.

The  aforementioned two check  boxes  do  not  affect  only  the  data  displayed  in  the
dialogue box, but also the data of the axes displayed in the program window.
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8.15 Printing

The  profile  printing  and  the  creation of  a freezed  segment  take  place  in  a  different
mode than the profile editing, as we have already mentioned. To go to this mode, click

the  button on the Status bar. 

In  this  mode  you can create a freezed  segment  and  print  the  profile.  You  can  also
define  the  positions where the  flags will  be displayed  during printing.  If  you wish  to
return to the profile editing mode, click again the relevant Profile button.

This mode has many differences compared to the profile-editing mode. First of all, you
cannot  edit  any lines.  When  you click  the  button,  the  Print  group  of  the  Elements
drawing toolbar is activated; the print pages are displayed in the drawing area in blue,
one next to the other, from left to right. The drawing must be positioned at the top of
the page, between the first and the second horizontal lines.

The  space  between  the  second  and  the  third  line  is  occupied  by  the  data  axes  or
tables of the profile, and some space on the left of the first page is reserved for  the
scales and the titles of the axes. Very often, in order for the elevation of the Profile to
fit in the page margins, you must create a freezed segment or a break. You can have
as many breaks as necessary. If there are more than one pages in the  printing  area,
then the pages are separated by blue vertical lines. The dimensions of the print pages
are proportional to the true dimensions of the  paper  and  to  the  scale  that  has been
set. You can set the true dimensions of the paper from the Print menu Ž  Page Setup
command Ž Paper group Ž Size field.
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Based on  these  dimensions,  and  more  specifically  on  the  page  height,  the  program
calculates  how  many  centimeters  will  be  occupied  by  the  profile  drawing  and  how
many by the data axes, always with reference to the print scale that you have set.

Use the Profile print preferences command of the Print menu to  select  the  data that
will be printed in the profile. Set the elevation and length scales from the Parameters
tab.

In  the  same  tab  you  can  set  which  data  will  be  printed  as  axes  or  tables  at  the
bottom of the page, and in which order. The available data axes or tables are  shown
on the right of the frame in the order they will appear on the printed profile. To select
whether a table will appear or not, tick or untick respectively the check box beside the
table’s name. To change the order of appearance, select the table (left-click on it) to
highlight it (the field  fills  with  color)  and  then  drag  and  drop the  table’s  name up  or
down. 

In the Lines tab
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you  can specify  which  lines will  be printed  and  displayed,  as  well  as  the  properties
(color,  line  type,  thickness)  that  the  lines  will  have  both  on  screen  and  on  the
printout.

In the Table Data tab,

you  can  specify  the  form  of  the  data  that  will  be  printed  on  the  axes  (axis  title,
decimals, font color, font, size, etc.). To apply the changes you have made, click the
Apply button. To save your settings in order to apply them to every project, click the
Save Default button. To restore the default settings, click the Load Default  button. To
close the dialogue box and return to the Profile, click the OK button.
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Creating a Freezed Segment

To be able to move within the screen of the print mode, proceed as described above.
Namely,  you  can  use  the  up,  down,  left  and  right  arrow  keys  to  move  to  the
respective directions, or use the mouse wheel; to move by double-step, hold the Shift
key down and press the respective arrow key. In this screen you can also  move  the
whole profile or only a part of the profile in order to create a freezed segment. To do
this, use the PageUp and PageDown keys.

To create a freezed  segment,  run  the  Freeze  segment  command  of  the  Print  menu.
The whole procedure is as follows: Highlight  the  last  point of  the  area to  which  you
wish to assign a certain reference level  and  run  the  Freeze  segment  command  from

the Print menu, or click the  button, or press the Ctrl+L keys.  

Note that  a  new  horizon  elevation  appears  on  the  selected  station.  Now  the  area
before the current point is “frozen”. That means that its position on the screen will not
change.  Namely, if  you move  the  drawing  within  the  screen (PageUp and  PageDown
keys), the whole drawing will move up  and  down except  for  the  frozen area.  Repeat
the  freezing  procedure  for  the  other  areas  of  the  profile  to  create  the  freezed
segment. The vertical step according to which the profile moves when you press  the
PageUp and PageDown  keys also  depends on  the  current  magnification,  but  you can
set  it  from  the  Tools  menu  Ž  General  Options  command  Ž  Profile  tab  Ž  Minimum
moving step for unfreezed segments field.

The  Unfreeze  segment  command  of  the  Print  menu  “unfreezes”  the  (frozen)  area

where  the  current  profile  belongs.  You  can  run  this  command  by  clicking  the  
button or by pressing the Ctrl+U keys; you can also run the Unfreeze All  command to
unfreeze the whole profile.

Editing Flags

In the print mode, a flag with the PI data is displayed on every PI. To move a flag you
must first select it. Next, activate it (by left-clicking inside the circle of the  selected
flag), move  the  crosshair to  the  desired  flag  position  and  click  again  the  left  mouse
button. If you don’t want a particular flag to be displayed, select it and from the menu
that is displayed if you right-click in the drawing area, run the Hide  flag  command. If
you want to view again the particular flag, select the respective tangent curve PI and
from  the  menu that  is  displayed  if  you right-click on  the  screen,  run  the  Show  flag
command. To delete all  flags, go to  the  Print  menu,  open  the  Flags  secondary  menu
and  run  the  Delete  All  command.  To  restore  the  deleted  flags,  run  the  Reset  all
command from the same menu. 

If  you have  moved  a  flag,  you  can  align  it,  in  order  for  the  flag  to  get  the  same
chainage as the tangent curve PI. To do this, select the flag and run the Align by Ch.
command from the menu that is displayed if you click the right mouse button. You can
do  the  same  for  all  stations  by running  the  Align all  by Ch.  command.  If  you  want,
apart from the horizontal alignment, to bring all  flags to the elevation of the selected
one, from the same menu run the Align all  by Ch., H command; if you wish to align all
flags so that their distance from the PI is the same  as  the  one of  the  selected  flag,
from the same menu run the Align all by Ch., Dx command.

Preview and Print

By running the Print profile command of the Print menu, you can preview and print the
profile. 
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To print from the Print profile window, where you can preview  a page to  be printed,
click the last button with the printer icon. In the Print dialogue box, make the desired
settings. Click the OK button to start printing.
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8.16 Export to DXF File

From the Profile workspace you can export four types of DXF files. These files contain
the  Profile  (with  or  without  the  Superelevation  Diagram)  or  the  separate
Superelevation Diagram or one of the Surface Diagrams or the Bruckner Diagram. 

How to export data to a ASCII file

1.From the File menu and the Export to DXF submenu, select Profile or Superelevation
diagram or Bruckner diagram or Surface diagram.

2.Enter the name of the file in the dialogue box of the File Name field.
3. In the File Type field, select the type of the file according to the desired version, 14

or 2000.
4. In all cases, click Save to finish the creation of the file.

To  set  the  form of  the  elements  and  how  they  will  be  displayed,  as  well  as  which
elements will  be exported  to  your  file  and  to  which  layer,  go  to  the  Print  menu  and
open  the  dialogue  box of  the  Profile  Print  Preferences  command, in the  case  of  the
Profile, or the Superelevation Diagram Print Preferences command  in the  case  of  the
Superelevation Diagram.
For  this  action,  it  is  best  to  preview  first  the  whole  drawing  or  part  of  it.  Before
exporting the file, you must have also set the proper drawing scales by which the data
font size will be determined. Throughout  the  program,  the  sizes  of  the  data (names,
terrain point elevations, PI names, station names and any other text) are given in cm.
In a DXF file this size is translated into “universal” m. The  conversion  takes  place  by
using the drawing scale.  
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8.17 Export to ASCII File

To export a curve or a tangent curve or any other element to an ASCII file, go to the
File  menu  and  from the  Export  to  ASCII  submenu  run  the  Terrain profile  or  Tangent
curve  or Bruckner  diagram  command. The  Save as  dialogue  box  will  appear  on  the
screen. In this  box you must specify  the  path  and  the  name of  the  file  that  will  be
created.  When  you  have  finished,  click  OK  to  create  the  file.  To  export  Drawing
elements,  Line  types  and  Hatches,  follow  the  instructions  for  the  respective
commands of the Horizontal Alignment.
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8.18 Printing the Superelevation Diagram

You  have  the  option  to  print  the  superelevation  diagram  separately.  Its  form  is
determined  according  to  the  selections  you  have  made  in  the  dialogue  box  of  the
Superelevation  diagram  print  preferences.  To  print  the  diagram,  run  the  Print
superelevation diagram command of the Print menu. 
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8.19 Bruckner Diagram

When you go to the Bruckner mode, the Bruckner diagram is displayed in the drawing
area. The Bruckner toolbar is also activated at the left of the screen. The elements of
the diagram derive from the quantities that  were calculated  during the  cross section
calculation in the Profile workspace. If the cross sections change, when you enter the
Bruckner  mode,  the  program  will  show  you  the  relevant  confirmation  message  for
updating the diagram. If you wish to update the Bruckner diagram at any other time,

click the   button on the Bruckner toolbar. 

At  crossings  with  other  roads,  it  is  possible  to  have  local  increase  of  cuttings  or
fillings. In this case, the line of the cubes is vertical. To insert a crossing you must be
in the Bruckner mode.

How to insert a crossing in the Bruckner diagram

1.Click the   button on the Bruckner toolbar. A white  vertical  line  appears in the
drawing area and moves according to the mouse movement, snapping the chainages
of the diagram cross sections.

2. Left-click to select the chainage where you will insert the crossing.
3.Select the side to which the crossing will be moved, by left-clicking a point on  the

left or on the right of the line. Depending on where the pointer  is  located,  a white
arrow appears on top of the line, showing you which part will be moved.

4.When you move  the  mouse  pointer, the  selected  part  of  the  diagram also  moves.
Move the diagram to the desired position and left-click to finish the procedure.

You can cancel the insertion procedure at any time by pressing the Esc button.

How to insert a haul line into the Bruckner diagram

1.Click the   button on the Bruckner toolbar. A blue horizontal line appears in the
drawing  area and  moves vertically,  following  the  mouse  movement.  The  length  of
the  line  changes  according  to  the  vertical  position  of  the  line,  so  that  the  line
always starts and ends on the line of the cubes.

2. Left-click to select the vertical position where you will insert the line.
3.Select  the  first  point  of  the  line  and  then  the  second  point  by  clicking  the  left

mouse  button.  The  points  where  the  line  can  stop,  are  points  where  the  line
intersects the diagram. When you approach a point, its color changes from white to
blue. The haul line will be drawn between the two selected points.

The  insertion of  the  haul  line  into the  drawing  area indicates  the  way  in  which  the
cuttings will be hauled and moved towards the fillings. Note that you can specify the
critical distances of the diagram in the Bruckner tab of the dialogue  box of  the  Road
properties command.
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You can also specify what the overhauls will be and where they will be hauled, or what
the borrows will be and where they will be transferred from.  Also,  the  transfer  line  is
drawn on every concavity, so as to trim the edges of the convexes or concaves. The
relevant areas in m3 and the start and end chainages of every section are also shown.
You can insert more than one haul line, as long as they do not overlap horizontally.

If desired, you can change the number of concavities that a haul line crosses. Select
the haul line and from the menu that is displayed when you right-click in the  drawing
area, run the Line section points  command. The  line  will  be displayed  again  with  the
maximum length it can get, and you must specify the new section points as previously.

If you are not satisfied with the position of a haul line, you can shift it vertically. Left-
click on the line to select it, so that its color changes from yellow  to  blue,  and  then
activate it by left-clicking it again. Next, transfer the line by moving the mouse pointer
to the desired position and left-click to finalize the line position. Next, the program will
prompt you to  specify  the  start  and  end  points  of  the  haul  line,  as  you did for  the
insertion of the line.

If you wish the program to move the selected haul line to the  appropriate  position  in
order to minimize the filling transfers, run the Optimize haul line command. To do this,

click the  button on the Bruckner toolbar.

You can delete a haul line very easily.

How to delete a haul line

1.Select the haul line you wish to delete.
2.From the Edit menu, run the Delete command, or, from the menu that is displayed if

you  right-click on  the  screen,  run  the  Delete  Objects  command,  or  press  the  Del
key.

After  the  insertion  and  optimization  of  the  haul  lines,  the  program  calculates
automatically  all  mass  hauls  that  are  required  for  the  construction  of  a road.  These
actions  are  reflected on  the  Mass haul  diagram  (Bruckner)  and  the  calculations  are
summarized in the Mass haul  table.  To print  this  Table  from the  Bruckner  mode,  run
the Print mass haul diagram command from the Print menu. The Print preview  window
will open as shown in the figure.
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To view the first page, click the  button. To view the previous, the next or the last

page, click the    buttons respectively. Click the  button to  zoom in on

the displayed page or click the  button to zoom out. This feature does not  affect

the print size. Click the  button to  set  the  print  options.  Click  the   button to

print the table. Click the  button to open Microsoft Excel and to transfer the table’s
data into this program.





Chapter

9



252 Anadelta Tessera

Anadelta Software

9 Cross Sections

9.1 Introduction

The cross sections of  a road  are  created and  edited  in a workspace  other  than  the
Horizontal  Alignment  and  Profile  that  we  have  described  in  previous  chapters.  The
Cross  Sections  workspace  offers  special  functions  that  can cover  the  needs  of  the
most demanding users. Before starting the detailed presentation of every function, and
for  the  better  understanding of  how this  workspace  works,  we  shall  describe  briefly
the structure and philosophy of the Cross Sections workspace. 

The tab of the Cross Sections workspace contains the cross sections of a road. Every
cross section of the road is identified by a chainage and a name.  The  chainages  and
names of the cross sections can derive either automatically, if this information already
exists  either  in the  Horizontal  Alignment  or  in the  Profile  workspaces of  the  specific
road, or they can be imported from a serial text file, or, the user can enter them one
by one.

A Cross Sections project is comprised of one or more cross sections. 

Every  cross section  is  identified  by  its  chainage,  which  is  the  main  value  used  for
arranging the cross sections in their workspace. You can view and edit one by one the
cross sections of a project on the screen. The program also offers special  operations
for batch editing.

Any  intervention on  the  natural  relief  of  the  ground  until  the  road  acquires  its  final
form is represented in a cross section  by using the  appropriate  lines.  When  a road’s
cross section is in the  initial  stage,  namely before  you start  configuring it,  it  usually
contains only one line, the “Natural ground” line. The Natural  ground  line  depicts  the
ground  surface  before  any  intervention.  In  most  cases,  at  least  one  more  line  is
added,  the  “Artificial  ground”  line,  during  the  final  stage  of  the  cross  section
processing. The Artificial ground line depicts the final surface of the ground, as this will
derive  after  the  execution  of  tasks,  either  in  the  case  of  a  cutting  or  a  filling.
Regarding the cross sections, you must use further lines to fully describe the geometry
of the street. For this reason, the program offers a variety of lines that the user can
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select  and  use according to  the  project’s  needs  and  characteristics  (e.g.  benches,
unsuitables, paving layers, etc.). 

The  simplest  form for  processing  a cross section  is  to  design  every  line  by  defining
each  point  individually,  as  you  would  do  if  you  were  to  design  the  cross  sections
manually. In this case, the program must calculate the areas that are formed between
the lines, in order to draw up the mass table. For this reason, the lines are grouped in
main  categories  -  families,  depending  on  their  functional  role.  For  example,  in  the
aforementioned cross section, the program will automatically calculate  separately the
two  areas that  are  formed between  the  natural  ground  and  the  artificial  ground,  in
order for you to know the surface of the cutting and filling.

In a more advanced processing stage, the user may insert, e.g.  the  Artificial  ground,
without having defined accurately the starting and end points. The program will define
these points during the  calculation.  The  program will  automatically  extend or  cut-off
the edges of the Artificial ground, so that the latter “wraps” upon the Natural Ground.

The use of special lines for every task enables the program to automatically calculate
the sections of the lines, as well as the produced (lengths-areas), in order to draw up
quickly and easily the tables of quantities. The arrangement and standardisation of the
lines, as well as the cross reference of the relevant calculated quantities to the mass
table columns are referred to shortly in the program as “Typical Tasks”. Of course, the
user is free to parameterize the lines – members of the aforementioned families and to
create new ones, according to the specific requirements of every project. 

The typical cross sections are a parametric way to describe the lines that comprise a
cross section. Just like cross sections, they are also comprised of four main parts, the
branches, the topsoil, the sideslopes and the pavings.

The typical cross sections, which constitute the most automated stage in the cross
section processing, are also based on the typical tasks. By using a typical cross
section, the user does not create one by one the lines of every cross section, but he
defines the form of the cross section qualitatively and geometrically, both in the
cutting and filling. In practice, this means the creation of a cross section like the one
shown in the figure:
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The user must have defined, always in the typical cross section, the characteristics of
the  cross section,  such  as  the  number  of  branches,  the  way  that  the  road  profile
elevation will be applied, the number of paving layers, the thickness and the geometry
(widths, superelevations, sideslope layers’ slopes) of the layers,  the  sequence  of  the
sideslopes’ slopes, as well as the extent of the topsoil. A typical cross section can be
defined in an absolute  or  in a dynamic way. When  using the  absolute  definition,  the
main  sizes  that  characterize  a  typical  cross  section,  e.g.  road  profile  elevation,
pavement width, roadway width, superelevations, have  fixed values and  they do  not
depend on the chainage  where the  typical  cross section  will  be applied.  When  using
the dynamic definition, the  values of  the  main  sizes  of  the  typical  cross section  are
not fixed, but they change based either on the chainage or on the relevant  diagrams
(profile, superelevation, width, etc.), or by special  functions  (as  in the  case, e.g.  of
the shoulder superelevations calculation).

Having all  the aforementioned data when calculating  automatically  the  cross section,
the program will determine the form of the cross section (cutting, filling  or  composite
cross section), create automatically the required lines, place them by elevation and by
horizontal  alignment,  set  their  points  based  on  the  geometrical  characteristics  that
you have defined, and finally it will calculate the areas or the lengths of the lines.

The typical cross sections, as well as the typical tasks, can also be found in separate
files  of  an  external  library (directory ...\Anadelta\Tessera\Csec) and  you  can  import
them at will, into every cross section project – file, thus creating an internal library of
Typ. Cross Sections and Tasks, especially set up for the particular project. The user is
also enabled to export to the external library both the set of the typical tasks that he
has created for a project as well as the typical cross sections that have been created
by the user or have derived from modifications in existing cross sections.

You can also create, edit, import and export various diagrams to/from serial text  files
(ASCII). The diagrams in the cross sections workspace are used for stating a change
in a value,  e.g.  superelevation,  width,  elevation,  etc.  with  respect  to  the  chainage.
The  user  is  also  enabled  to  import and  export  several  other  data of  his  choice.  For
example, you can easily import or export the points of a line, e.g. the Artificial  ground
line or the Natural ground line from/to a serial text file (ASCII), or  to  import –  export
certain drawings to/from external library files, or to proceed to  the  batch  assignment
of the excavation  percentages of  every  cross section  (soil,  rock,  etc.)  based  on  an
external file.



255Cross Sections

Anadelta Software

Finally,  some  of  the  program's  special  functions  enable  you  to  import,  copy,  cut,
paste, delete, and edit multiple lines for a group of selected cross sections.

This  chapter  describes  the  operations  that  you can carry  out  in the  Cross  Sections
workspace. These operations are classified into the following categories:
· File operations: Select files for editing,  import data from files,  export  data to  files,

view ASCII files for reading, delete files.
· Cross section operations: Add and delete a cross section, change the chainage.
· Calculation  operations:  Calculation  of  cross  sections,  assignment  of  drawings,

creation of lines, copy, deletion and move of lines. The operations  of  this  category
can be carried out in two easy ways, either for multiple cross sections at the same
time or separately for every cross section. 

· Printing  operations:  Setting  of  printing  and  printer  parameters,  cross  sections
printing, mass tables printing.

· Operations for files with multiple roads (Professional version): Join cross sections of
various roads into a composite cross section,  change the  current  road,  add  a new
road, delete an existing road.

The stages that are usually followed during the design of a road’s cross sections are:

1.Creation of workspace and cross sections.
2.Cross section management.
3.Set up of typical tasks.
4.Creation and editing of lines.
5.Update of cross sections with the profile, width and superelevation diagrams.
6.Cross section calculation – application of typical cross section.
7.Addition of special lines to the cross sections.
8.Operations of batch cross section management.
9.Operations of batch line management.
10.Calculation of a road’s areas.
11.Mass table drawing-up – calculation of volumes.
12.Printing of cross sections, export to files.



256 Anadelta Tessera

Anadelta Software

9.2 Creating a Project

With  Anadelta  Tessera  you  can  start  creating  a  new  Cross  Section  project  in  two
ways:

1.You  can  request  the  automatic  creation  of  the  cross  sections  based  on  the
elements  that  you  have  inserted  in  the  Horizontal  Alignment  or  in  the  Profile
workspaces. 

2.You can create a new file that will contain only the Cross Sections  workspace. The
file that  you are  creating is  empty,  namely it  doesn’t  contain  any cross  sections,
and you must create them manually.  This  procedure is  useful  in  case  you wish  to
use the program only for carrying out measurements on a project.

Creating a New Cross Section Project

This procedure is useful in case that the road project has been designed and you wish
to use the program only for measuring the project’s cross sections.

How to create a new Cross Sections file

From  the  File  menu,  select  the  New Project…  submenu  and  run  the  Cross  Sections
command.

The file that you are creating is empty, namely it doesn’t contain  any cross sections
or lines. All  elements, such  as  cross sections,  lines,  etc.,  must  be either  created by
the user or imported from a text file (ASCII).

A Cross Sections  project is comprised of one or more cross sections. In order for  the
program to  calculate  an  area,  every  cross section  must have  at  least  two lines the
one of which being the Natural Ground (e.g. Natural Ground  and  Artificial  ground).  All
points of a line comprised  in a cross section,  have  a set  of  coordinates  (x,  h),  that
corresponds to the distance of the point from the road axis (distance from axis) and to
the absolute elevation of the terrain at the point. 

Creating or Editing Cross Sections from the Horizontal Alignment

This  procedure is  performed after  you  have  completed  the  horizontal  design  of  the
road in the Horizontal Alignment workspace and you wish to create and edit the road’s
cross sections.

This action enables the program to create the cross sections and the Natural  Ground
line for every cross section in the Cross Sections  workspace. If your project does not
have a terrain model or  points,  the  cross sections will  be created anyway,  but  they
will not have the Natural Ground line.

How to create the Cross Sections from the Horizontal Alignment

1.From the Horizontal Alignment workspace, select the road whose Cross Sections you
wish to create or update.

2.From  the  File  menu,  run  the  Update  cross  sections  command.  The  following
confirmation message will appear on the screen:
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Click Yes to continue. The program will create the cross sections.

To run the command, you must have performed stationing on the selected road.

You can also create the Cross Sections  from the Horizontal Alignment in the dialogue
box of the Manage command of the Project menu. Select  the  road  from the  relevant
list  at  the  top  of  the  dialogue  box and  then  click  the  From  Horizontal  Alignment  to
Cross Sections  button in the Quick Update group.  The  procedure is  the  same  as  the
one described above. A message appears at the end of the  procedure,  informing  you
that the procedure has been completed. 

When this type of update takes place, the program creates the road’s cross sections,
together with  the  main  terrain  line  and  its  points  for  every  cross  section.  Also,  the
pavement width diagram, the roadway width diagram, the left and right superelevation
diagrams, the left and right semiaxis diagrams, as well as  the  diagrams  that  the  user
has created from a drawing line (diagrams of the existing road and other diagrams) are
also transferred. Note that through this type of update the cross sections are created
again from the beginning and any data that existed in the  Cross  Sections  workspace
before the update will be deleted.

Alternatively,  you  can  fully  define  which  elements  of  the  Cross  Sections  will  be
updated. To do this, use again the Manage command. From the  Update  group of  the
Updates tab in the command’s dialogue box,  select  From  Horizontal  Alignment  in  the
first drop-down list and To Cross Sections  in the second drop-down list.  Next,  select
which updates will  take  place  by ticking  or  unticking  the  relevant  check  boxes  and
then click the Update button.

The program will create the Cross Sections  workspace, if there is no such  workspace
for the selected road; next, in the Cross Sections  workspace,  the  program will  insert
the cross sections with the Natural Ground line if you have requested so, or by default
if this is the first time this workplace is being created.
You can use the aforementioned commands to update the Cross Sections, in case you
have modified the road design in the Horizontal Alignment workspace.

Creating a Cross Section Project from a Profile Project

The elements that the Profile supplies to the Cross Sections workspace are the station
names with  the  respective chainages,  an  indicative  Natural  Ground  with  two  points,
and the road profile diagram. 

The first point of the natural ground is on the cross section axis and at the elevation
defined  by the  Profile,  while  the  second  point is  a little  further  to  the  right,  at  the
same elevation.

How to create the Cross Sections from the Profile

1.Go to the Profile workspace that corresponds to the road whose Cross Sections  you
wish to create or update.

2.From the Project menu, run the Manage command. 
3. In the Update group of the Updates tab, select From Profile in the first  drop-down
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list and  To  Cross  Sections  in  the  second  drop-down  list  and  then  tick  the  Create
Cross Sections  check box. Click the Update button to create the cross sections. If
you wish to also update the Cross Sections  with  the  road  profile  diagram,  tick  the
Update  road  profile  check  box.  To  update  the  other  diagrams,  tick  the  relevant
check box. 
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9.3 The Workspace

This paragraph describes the Cross Sections  workspace. The particular workspace has
many differences compared to the other two workspaces that have been described so
far.  To  go  to  the  Cross  Sections  workspace,  click  the  Cross  Sections  tab  at  the
bottom of the screen, over the status bar, or run the Cross Section command from the
 View  menu.  The  tab  is  displayed  only  if  you  have  carried  out  the  cross  section
creation procedure.

Similarly to the Horizontal Alignment and Profile workspaces, at the top of the screen,
you will find the familiar  menu bar,  with  the  File,  Edit,  View,  Project,  Tools  and  Help
menus. There are also four new menus: Actions, Batch Actions, Parameters and Print.
Below the menu bar, you will find the main toolbar and below the  latter,  you will  find
the  View toolbar,  which  contains  buttons  that  carry  out  operations  relevant  to  the
elements that are displayed on the screen, especially in the drawing area. 

At the  left  of  the  program’s window  you will  find  the  Lines  toolbar,  whose  functions
refer to the creation and editing of the cross sections lines.
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There are also the scroll bars, while in the middle of the cross section (at the
point where the x abscissa equals to zero), you can see the road axis, which is
displayed as a red axial line. If you do not wish to view the axis line, click the 

 button on the View toolbar. If you wish to view the axis line,  click  again
the  same  button.  If  you wish  to  view  a  grid  in  the  drawing  area,  click  the
second button on the View toolbar.

 

To  select  a line  on  the  screen,  place  the  crosshair  over  the  line  and  click  the  left
mouse button.  A selected  line  is  highlighted  (it  changes color)  and  a small  blue  box
appears on every point of the selected line. The  active point of  the  line  is  displayed
with a pink box. If you have selected the fifth, sixth, seventh or eighth button of the
View  toolbar or  any combination of  them,  then  the  slopes,  the  horizontal  distances,
the  vertical  distances  and  the  coordinates  of  the  points  are  displayed  over  the
straight parts or the points of the selected line.

After the calculation of the cross section, you can choose to also view the calculated
areas on the screen. Simply left-click on the region whose area you wish to view. The
area is activated immediately and the region is filled with color, so that its boundaries
can be viewed clearly.
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In the drawing area you can see all  lines that comprise a cross section, and you can
select and edit those lines. In the Cross Sections  workspace,  you can view and  edit
only the selected cross section.

The  Cross  Section  data  management  window  is  displayed  at  the  left  of  the  main
screen window. The management window is primary, since here you can execute most
of the operations referring to a cross section, while you can also view all  parameters
of the cross section calculation, as well as the calculated quantities/areas. The name
and the chainage of the current cross section (the one you see on your screen) in the
file,  are  displayed  in the  Cross  Section  selection  drop-down  list  of  the  window.  You
may choose not to display the management window. Simply click the first button from

the left of the View toolbar . If you wish to display again the window, click again
the same button. If the management window is closed, the name and the chainage of
the cross section appear in green letters at the top left of the drawing area.

The status bar is displayed  at  the  bottom of  the  screen and  exactly  below  you can
see the message window. 
The status bar is comprised of four sections. The first section shows the coordinates
of the  current  position  of  the  crosshair (distance  from axis and  absolute  elevation).
The second section enables you to  display  the  Input  Form,  if  available.  Next  to  the
input form, in the third section, you can see the type of the line (e.g. Natural Ground)
where  the  crosshair  is  located,  or  read  various  messages  –  instructions  that  the
program shows to guide you during the execution of the various commands. The fourth
and  last  sections  display  information  on  the  selected  line  (total  line  points,  serial
number of the selected point and coordinates of the selected point).

The message window is the space where the program displays various messages about
the  problems  that  are  detected  during  the  calculation  of  a  cross  section.  The
messages are divided in three categories: information, warning and error.

The snap can be set from the dialogue box shown in
the figure. This box appears by running  the  Options

command of  the  View menu  or  by  clicking  the  
button  on  the  View  toolbar  or  by  pressing  the  F2
key.  If  you select  the  Show  line  points  check  box,
the points of all  lines that are  included  in the  cross
section are displayed.  If  you select  the  Batch  area
selection  check  box,  you  can  select  all  areas  that
are  created  after  the  cross  section  calculation  by
pressing and holding the Ctrl key.
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9.4 Road Properties

If you run  the  Road  preferences  command  from the  Parameters  menu,  the  following
dialogue box will appear on the screen:

The  box  has  three  tabs,  where  you  can
make  various  settings  for  the  road,  the
benches  and  the  excavation  percentages
of the cross sections. 

In  the  General  tab,  you  can  enter  the
description of  the  road  in  the  Description
text  field  and, if  you  wish  to  change  the
starting  chainage  of  the  road,  enter  the
value in the Starting Chainage text field. In
the  shoulders  group  you  can  specify  the
shoulder calculation way and the values of
the  left  and  right  elevation  of  the
shoulders,  as  described  in  the  next
chapter. The Benches tab contains  all  the
necessary  settings  for  the  automatic
creation  of  benches,  while  in  the
Percentages  tab  you  can  specify  the
percentages of every soil category and the
bulking  factors  for  every  category.  When
you  have  finished,  click  the  OK  button  to
save your changes and return to the Cross
Sections workspace.
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9.5 Cross Sections Management

Moving Between Cross Sections

For  moving  between  cross  sections,  the  Cross  Section  data  window  features  two
buttons, one drop-down list and a scroll bar, but you can also use the dialogue box of
the View toolbar.

If you click the  button of the Cross Section data window, the  program transfers

you  to  the  previous  cross  section  (based  on  the  chainage)  while  the   button
transfers you to the next cross section. You can do the same by pressing the Page Up
or Page Down keys respectively. The cross sections are sorted out in ascending order
according to their chainage. 

There are also two extra functions, enabling you to  go  to  any of  the  project’s cross
sections.  The  first  function  is  executed  from the  Cross  Section  selection  drop-down
list  in  the  Cross  Section  data  window.  In  this  list,  you  can  see  the  name  and  the
chainage of  the  current  cross section.  If  you left-click  on  the  list,  a  menu  appears
where all  the cross sections of  the  current  project  are  sorted  out  by chainage,  and
you can choose the cross section where you wish to go.

The second function that you may use to find  a cross section,  is  executed  with  the
assistance of  the  scroll  bar,  which  is  located  at  the  top  of  the  Cross  Section  data
window. 

Here, you can select the cross section that will appear on the screen as follows: Left-
click on  the  rectangular  box  on  the  scroll  bar.  The  name  and  the  chainage  of  the
current cross section in the file are displayed in the Cross Section selection drop-down
list. Hold the left mouse button down and scroll until you see the name of the desired
cross section; then release the mouse button.

The  last  search function  can be executed  with  the  Cross

Section data window open  or  closed.  Click  the   button
on the View toolbar to open the dialogue box. The box has
two text fields and a button. If you wish to  go  to  a cross
section whose chainage is known, type the chainage in the
 Chainage  field  and  then  click  the  Locate  button. If  there
isn’t  any  cross  section  at  the  specified  chainage,  the
program  will  transfer  you  to  the  immediate  next  cross
section. If you wish to go to a cross section whose name is
known, type the name in the  Cross  section  field  and  then
click the Locate button.

 
Cross Section Insertion
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In  the  Cross  Sections  workspace,  the  user  can add  the  desired  cross sections to  a
road. 

How to insert a new cross section

1.From  the  Cross  Section  data  window,  click  the

 button.
2.The dialogue box appears on  the  screen,  where

you  must  enter  the  data  of  the  new  cross
section  (name  and  chainage).  The  program  fills
automatically  these  fields  (namely,  it  gives  the
name  of  the  current  cross  section  with  an
accent and  selects  a chainage  with  respect  to
the next cross section),  but  you can still  enter
the values you desire.

3.When you have finished, click  the  OK button  to
create  the  new  cross  section,  which  will  be
displayed in the drawing area. This cross section
will be empty, namely it will not have any lines.

You can also add a cross section when importing lines from ASCII text  files.  Another
feature is the batch import of cross sections from another project.

Changing the Cross Section Chainage and Name 

This  paragraph  describes  the  way  in  which  the  name  and  the  chainage  of  a  cross

section  are  specified.  This  can be done  by  clicking  the   button.  A  dialogue  box
appears  on  the  screen.  In  the  Name field,  type the  new name (code)  of  the  cross
section by using any combination of capital letters and numbers.

In  the  Chainage  field,  type  the  chainage  (in  meters)  of  the  cross  section  in  the
project.  This  data will  appear  in the  section  that  shows  information  on  the  current
cross section. Although the same file may contain  two cross sections with  the  same
name,  it  is  not  possible  to  have  two  cross  sections  with  the  same  chainage.
Therefore,  if  you  accidentally  type  a  chainage  that  has  already  been  assigned  to
another cross section, the program will show you the following error message,

informing you that the cross section cannot be transferred.

Deleting Cross Sections
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To delete a cross section, click the  button. In the
resulting window, click Yes  to confirm that you wish to
delete  the  cross section,  otherwise  click  No.  You  can
also delete multiple cross sections at once.
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9.6 Typical Tasks

9.6.1 Creation - Management of Typical Tasks

The lines comprising each one of the program’s cross sections are grouped in families.
This sorting out of the lines has a qualitative meaning. It allows every line, depending
on its family, to locate cross-sections and to calculate areas, by using the appropriate
lines. It also serves to determine how the lines will appear both on the screen and on
the  printouts,  as  well  as  to  the  absolute  parametric  drawing-up  of  the  mass  and
paving tables.

This standardisation of the lines (tasks) and the linkage of the calculated quantities to
the mass table columns are referred to shortly as Typical  Tasks. The determination of
the  typical  tasks  is  one  of  the  main  operations  of  the  program  and  must  be  done
before starting to draw the cross-station.

From  the  Parameters  menu,  run  the  Typical  Tasks  command  to  open  the  window  in
which you will specify the typical tasks.

Import of Typical Tasks from a File

To  import typical  tasks  from an  external  file  into the  current  project,  go  to  the  File
menu, open the Insert submenu and run the Typ. Tasks command. Before running this
command,  however,  you must be certain that  you  do  not  need  the  current  typical
tasks that you are using for your project. It is advisable to export them first into a file
and  then  to  replace  them,  because  the  import  of  a  typical  tasks  file  deletes  the
current typical tasks and replaces them with the ones contained in the file.

You can import the typical tasks either from a typical tasks file (*.ATE) or you can use
the typical tasks of another Tessera file (*.ADF).
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How to import typical tasks from another file

1.From the File menu, select the Import submenu and run the Typ. Tasks command.
2.The Open dialogue box appears on the screen. From the File Type  field,  select  the

type of file (*.ATE or *.ADF), then select the desired file and click Open.

Creation of Typical Tasks Files (*.ATE)

The  typical  tasks  can  be  saved  in  the  external  library  (directory  ...
\ANADELTA\TESSERA\CSEC). The default extension of these files is ATE.

How to export typical tasks to a text file

1.From the File menu, select the Export submenu and run the Typ. Tasks command.
2.The Export Typ. Tasks dialogue box appears on the screen. Enter the file name and

click the Save button.

Typical Tasks of a New File 

The typical tasks of a new project are also imported automatically from a typical tasks
file (*.ATE). This file is  selected  from the  General  Options dialogue  box of  the  Tools
menu. More specifically, the full name and the path of the file are displayed in the New
project's typical cross sections field of the Cross Sections tab. If you wish to select a

new file, click the  button. Select the desired typical tasks file from the dialogue box
that  will  appear  on  the  screen.  Once  you’ve  made  your  selection,  click  the  Open
button to return to the General Options dialogue box, and then click the OK button to
close the dialogue box and return to the main screen.

9.6.2 Families

The typical tasks are comprised of families. The main available task families are those
listed below, together with a description of the behavior of every family’s lines during
the calculation and the area measurement of the cross sections.

NGD (NATURAL GROUND): This family – task represents the natural ground level before
any intervention into the cross section. The Natural Ground line of every cross section
does  not  extend nor  is  it  cut-off  automatically.  It  always  remains  unchanged  during
the  calculation  of  cross  sections  and  contributes  to  the  formation  of  the  Natural
ground envelope. It cannot be used in the typical cross section.
TSL (TOPSOIL):  This  family –  task  represents  the  excavation  line  for  the  removal of
the Topsoil. It is always below the natural ground, usually parallel to it, at a depth of
0.2 - 0.3  m,  without this  being mandatory.  After the  calculation  of  a cross section,
this  task  contributes  to  the  formation  of  the  Natural  ground  envelope.  The  tasks
belonging to this family cannot be used in the typical cross section.
SIMP  (IMPROVEMENT,  FOUNDATION):  The  tasks  of  this  family  usually  represent
improvements  that  are  being made  always  under  the  natural  ground  and  sometimes
under  the  road  (in  the  case  of  a  cutting)  for  the  improvement  of  the  ground,  or
excavations for the foundation of walls. These tasks require a section with the current
natural ground envelope.  After being calculated,  they contribute  to  the  formation  of
the Natural ground envelope. The tasks belonging to this family cannot be used in the
typical cross section.
FDL  (FOUNDATION  LAYER):  The  tasks  of  this  family  usually  represent  lines  over  the
natural ground envelope, after the natural ground has been formed by the Topsoil and
the Improvements - Foundations.  These are layers of materials for the  foundation of
walls, or layers of materials before the  filling. After being calculated,  they contribute
to the formation of the Natural ground envelope. They cannot be used in the  typical
cross section.
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NGD.ENV.  (NATURAL  GROUND  ENVELOPE):  This  is  the  bottom  envelope  that  derives
from the natural ground and the topsoil. If there are also tasks  of  the  SIMP  and  FDL
types, these also  form the  natural  ground  envelope according to  the  order they are
inserted. The natural ground envelope is a fictitious line and does not correspond to a
task, but it is used as  a boundary  for  the  creation of  the  Artificial  ground  line.  It  is
comprised of the lower elevation points of the lines belonging to the  NGD,  TSL, SIMP
families and of the upper elevation points of the lines belonging to the FDL family.
AGD (ARTIFICIAL GROUND): This task represents the final level of the  artificial  ground
works in a cross section. In order to be calculated, it requires a section with the final
natural ground envelope. Its top part where the paving and the encasing solids will be
laid is the Ledge. The lateral oblique parts are the sideslopes. After being calculated, it
shapes the artificial ground envelope. The tasks belonging to this family can be used in
the typical cross section.
PVL  (PAVING  LAYERS):  The  tasks  of  this  family  represent  the  paving  layers,  e.g.
Courses (Surfacing, Wearing Course, Binder Course, SubBase Course), mining materials
(Base, SubBase, Drain Layer, Grading Layer), roadway shoulders, special constructions
that are being used mainly for the detachment – endistancement of the encasing solid
from  the  edge  of  the  course,  and  generally  lines  over  the  artificial  ground  that
comprise  the  paving.  They  require  a  section  with  the  current  artificial  ground
envelope, which they also shape after they have been calculated. The tasks belonging
to this family can be used in the typical cross section.
GTT (GUTTER): The tasks of this family represent the encasing solids of the roadway’s
paving materials (kerb channels, gutters, N.Jersey). They are sorted out  in the  cross
section  by  branch  (left,  right)  and  by  side  (left,  side,  centre).  They  are  either
supported  on  or  shape  the  underlying  PVL.  They  are  calculated  together  with  the
corresponding PVL and they require a section with the artificial ground envelope, which
they also shape after  they have  been calculated.  The  tasks  belonging  to  this  family
can be used in the typical cross section.
SSC (COATING): The tasks of this family usually represent the sideslope coatings with
topsoil in the fillings (parallel to the sideslopes or not) or the construction of retention
zones or rock traps in the cuttings, on the external side of the gutters. They require a
section both  with  the  natural  ground  envelope and  with  the  current  artificial  ground
envelope, which they also shape after they have been calculated. The tasks belonging
to this family can be used in the typical cross section.
AGD.ENV. (ARTIFICIAL GROUND ENVELOPE): This is the top envelope that derives from
the tasks of the AGD, PVL, SSC and GTT  families.  It  is  a fictitious  line  and  does  not
correspond to any task. It assists during the calculation of all tasks above the Artificial
Ground.
EML (EMBANKMENT LAYER): The tasks of this family represent layers that are laid over
the  natural  ground  envelope  (e.g.  the  separation  of  the  filling  in  various  filling
materials). They must be laid by elevation, from the lower to the upper one. They are
laid under the  Artificial  Ground  and  they are  calculated  starting  from the  lower  one.
They require a section both with the Artificial ground and with the current envelope of
the  artificial  ground’s  bottom  layer,  which  they  also  shape  after  they  have  been
calculated. They cannot be used in the typical cross section.
EML.ENV.  (EMBANKMENT LAYER  ENVELOPE):  It  is  the  envelope that  derives  from the
natural ground envelope and the tasks of the EML family, which shape it according to
the  order they are  applied.  The  envelope of  the  artificial  ground’s  bottom layer  is  a
fictitious line and does not correspond to any task, but it assists during the calculation
of all tasks under and inside the Artificial ground and over the natural ground envelope.
 
BNC (BENCH): The tasks of this family usually represent the anchoring benches (tasks
for  the  stabilization  of  the  fillings)  or  improvements  that  do  not  shape  the  natural
ground  envelope  (namely,  they  do  not  contribute  to  the  shaping  of  the  Artificial
ground). They require a section with the bench envelope or with the Artificial  ground,
depending on which one is the first to meet. After having being calculated, they shape
the bench envelope. They cannot be used in the typical cross section.
BNC.ENV. (BENCH ENVELOPE): It is the bottom envelope that derives from the natural
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ground envelope, the artificial ground and the tasks of the BNC family, which shape it
according  to  the  order they are  applied.  The  bench  envelope is  a fictitious  line  and
does  not  correspond to  any  task,  but  it  assists  during  the  calculation  of  all  works
under the Artificial ground and the natural ground envelope.
UNS (UNSUITABLES):  The tasks of this family represent works  referring  to  unsuitables
(e.g. excavation works, whose products cannot  be reused  for  filling).  They require  a
section  with  the  unsuitables  envelope,  which  they  shape  after  they  have  been
calculated. They cannot be used in the typical cross section.
UNS.ENV. (UNSUITABLES ENVELOPE): It is the bottom envelope that  derives  from the
natural ground envelope and the tasks of the UNS family, which shape it according to
the order they are applied. The unsuitables envelope is  a fictitious  line  and  does  not
correspond  to  any task,  but  it  assists  during  the  calculation  of  all  tasks  under  the
natural ground envelope.
DRW (DRAWING): The tasks – lines of this family do not affect nor do they contribute
to the calculations of sections, they do not extend and they can be of any shape. The
user can either draw them freely or  import them from a drawing  library.  These  tasks
can be used in the typical cross section.
WLL (WALL):  The  tasks  of  this  family represent  the  supporting  –  backing  walls  that
stabilize the slideslopes of cutting and filling, respectively. These are the first to shape
the  artificial  ground  envelope.  If  they  are  active**,  then  they  shape  the  Artificial
Ground  task  during the  calculation  of  sections.  These  tasks  cannot  be  used  in  the
typical cross section.
ERD (EXISTING ROAD): The tasks of this  family usually represent  the  artificial  ground
envelope of an existing road. They are used when making improvements on an existing
road. During the cross section calculation, the lines of the AGD, PVL and GTT tasks are
formed in such a way, so as to coincide with the particular task, at the part where the
ERD line is higher than them, in order to outline the roadway of the existing road. The
tasks if this family cannot be used in the typical cross section.
GRL (GUARDRAIL): This family represents the guardrails with barriers that  are  inserted
automatically by the  program,  when applying  the  typical  cross section.  They do  not
take part in calculations. Their position depends on the elevation of the filling and they
can be used in the typical cross section.
LGD  (LONGITUDINAL  DRAIN):  The  tasks  of  this  family  usually  represent  the
configuration  that  takes  place  for  the  placement  of  longitudinal  drains  under  the
artificial  ground  envelope.  They require  a section  with  the  artificial  ground  envelope
and they can be used in the typical cross section.

* Additional parameters (branch, road side, bearing line etc.) for tasks of the PVL, GTT
and WLL  types  that  are  inserted outside  the  typical  cross  section  can  be  specified
from the Properties dialogue box.
**Active are the walls whose value in the Shapes Artificial Ground field is Yes.

9.6.3 Families - Tasks

In the left part of the Typical  Tasks  window there is the Families – Tasks  group. The
code of every  family is  shown in capital  letters  in the  table  of  the  Families  –  Tasks
group.  The  family  codes  have  been  strictly  defined  by  the  program  and  it  is  not
possible for the user to change them. When you select a family of lines, you can view
the members of every family that correspond to the various types of a family’s tasks -
members. Left-click on the + symbol next to  each  task  family or  double-click on  the
family name, to view the tasks of this family. You can select a task by left-clicking on
it. The tasks are displayed in a tree structure below the code of  the  family to  which
they belong, and they are connected to their family with a line. 

Regarding the calculation of the areas, the quantities that result automatically  during
the calculation of a cross section refer to the whole task and not to an individual line
that belongs to this type of task. Therefore, you must create as many types of tasks
as the quantities you wish to measure separately. If, for  example,  you intend  to  use
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two base layers in a cross section, and you wish the program to calculate the lengths
or the areas separately for each layer, you must define two different types  of  tasks,
e.g. “Base 1” and “Base 2”. With these  two tasks  and  through  the  proper linkage of
the  quantities,  the  quantities  can  be  calculated  either  as  two  separate  final
quantities-columns of the mass table, or both quantities can be seen as a single final
quantity in the same column of the “Base” mass table.  It  is  also  possible  to  combine
the above two possibilities.

In order to create a new task you can: 

1.Add - define the new task in the task group.
2.Create the mass table column where the task will send its quantities, if you wish the

task to be calculated separately.
3.Link the particular task with the desired column of the mass table. 

Adding a New Task

You can add to every family as many members – task types as you wish, but you can
delete  only  the  members  that  you  have  added.  The  only  exception  constitute  the
tasks  of  the  Natural  ground, Topsoil  and  Artificial  ground,  which  are  unique  in  their
family.

How to create a new task

1.Run the Typical Tasks command of the Parameters menu and then right-click on the
name of an existing task that belongs to  the  same  family to  which  the  new family
will belong. From the displayed menu, select New Task.  Alternatively,  right-click on
the family name and select New Task for family...

2.This option opens the  dialogue  box where you can specify  the  parameters for  the
new task. 

3. In  the  Name  field,  type the  name of  the  new task.  The  color,  the  line  type (full,
axial, dashed, dotted, etc.) and the thickness of the line on the printout are defined
from the relevant drop-down lists. In the Dxf Layer field, type the name of the Layer
to which the line will belong when the drawing is exported to  a DXF  file.  If  you do
not wish the line to be displayed on the screen or on the printout, untick the Show
on  screen  and  Print  line  check  boxes  respectively.  If  you  wish  to  print  the  line
coordinates as  a legend  below  the  drawing  of  every  cross  section,  tick  the  Print
legend Dis. - Dis from axis check box.

4.To exit the dialogue box,  click  OK to  confirm  the  changes you have  made  or  click
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Cancel to return to the main screen.

You can link the quantities from the right part of the box in the  Selected  mass  table
columns group, or in the Mass Table Columns group.

The default parameter  values are  the  corresponding  values of  the  existing task  that
you clicked before, in case you have selected a task. 

Setting the Task Properties

To set the properties of a task, select the desired task, click the right mouse button,
and  from  the  displayed  menu  run  the  Task  properties  command.  Then  proceed  as
described above for the new tasks.

Deleting Tasks

To delete a task, select the task, click the right mouse button, and from the displayed
menu run the Delete task command.

Linking a Task with Columns

The calculated quantities of a task are linked with  the  relevant  columns  of  the  Mass
Table by assigning a task quantity to a column, from the following dialogue box:

Here  you  can  define  to  which  columns  of  the  mass  table  the  selected  task  will
contribute;  these  columns  will  be displayed  in the  table  of  the  Selected  mass  table
columns group. To add a new column, right-click on the table and from the displayed
menu, open the Add column submenu and then select a column. This menu contains all
columns of the Mass Table Columns group. In the Coefficient column of the table, type
the  coefficient  in  the  row  where  the  column  name  appears.  To  remove  a  column,
select the desired column, click the right mouse button and  from the  displayed  menu
run the Remove mass table column command.

9.6.4 Mass Table Columns

At the right part of the Typical Tasks  window there is the Mass Table Columns group.
This group corresponds to the columns of the mass – paving table. The user is free to
create and delete final quantities at will. Every task of the Families – Tasks  group can
be  linked to  as  many  Mass Table  Columns  as  you wish.  This  enables  you to  further
group certain quantities  and  to  view them all  in  one column  of  the  mass  table.  This
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linkage  is  specified  by  the  user,  who  can  also  add/remove  a  whole  quantity  or  a
percentage  of  a quantity to/from a mass  table  column.  Below each  column  you can
view which tasks have been assigned to that particular column. 

Adding a New Mass Table Column

To  create  a  new  mass  table  column,  run  the  Typical  Tasks  command  of  the
Parameters menu, right-click on an existing column, and from the displayed menu, run
the New mass table column command. This option opens the dialogue box where you
can  specify  the  parameters  for  the  new  column.  The  values  in  the  fields  of  this
dialogue box are the same as the ones in the  existing column  that  you had  selected
before running this second command. 

In  the  Name  field,  type the  column  –  quantity name,  which  will  appear  both  in  the
dialogue box of the typical tasks and in the cross section legend on the printout. Apart
from the name, there are also two groups, one for the way in which the quantity will
be  displayed  in  the  mass  table  and  one  for  the  way  in  which  the  quantity  will  be
displayed in the cross section drawing legend (quantities legend). 

In  the  Quantities Legend  group,  tick  or  untick  the  Display check  box,  depending  on
whether you wish or not to view the particular quantity in the  cross section  drawing
legend (quantities legend). From the Quantity type drop-down list, select the type of
the quantity that the program will calculate. Namely, select the area or the length. 

Regarding how the quantity will be displayed in the mass table, there are two lines in
which you can describe the particular quantity. If you wish, you can copy in the First

Line field the name that you specified in the Name field, by clicking the  button. 

Setting the Parameters for a Mass Table Column

To set the parameters for  a mass  table  column,  select  the  desired  column  and  from
the displayed menu, run the Mass table column properties command. Then proceed as
described above for the new columns.

Deleting a Column

To delete a Mass Table column, select the column, click the right mouse button,  and
from the displayed menu, run the Delete mass table column command.

Linking a Column with Tasks
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A Mass Table column can be linked with the appropriate quantities of calculated tasks.
To  do  this,  right-click on  a column  and  from the  displayed  menu open  the  Add  new
task  submenu  and  select  the  task  you wish  to  assign  to  the  selected  column.  This
submenu contains all tasks of the Family – Tasks  group. A quantity is transferred to a
column by means of a coefficient,  which,  when multiplied  by the  quantity,  gives the
value  that  will  be  added  numerically  to  the  selected  final  quantity.  Initially,  this
coefficient equals to  one.  To change the  coefficient  of  a task,  select  the  task  that
has been added below the column, click the right mouse button and from the displayed
menu  run  the  Coefficient  Change...command.  The  following  dialogue  box  appears  on
the screen,

and you can type the  new coefficient.  If  you wish  to  delete  a task  from a column,
select the desired task, click the right mouse button and from the displayed menu run
the Remove  task  command. The  program will  prompt  you to  confirm  the  deletion  by
showing  you  the  relevant  confirmation  message.  Click  Yes  to  delete  the  task  and
complete the procedure.

9.6.5 Order of Columns and Tasks

At the top of the initial dialogue box of the Typical Tasks, there are two buttons.  By
clicking the Select/Order Tasks button, the following dialogue box appears:

while by clicking the Select/Order Mass Table Columns button,  the  following  dialogue
box appears:
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In  the  first  field  of  the  Appearance  order in Dx-H  legend  group,  you can select  the
lines whose coordinates will be printed on a legend at the bottom of the cross section.
In  the  second  field  of  the  Appearance  order in  quantity  group,  you  can  select  the
areas  or  lengths  that  will  be  printed  below  the  name  and  chainage  of  the  cross
section. If you want to view a quantity or a task, tick the check box next to its name.
If  you wish  to  change the  order of  appearance,  then  use  the  mouse  to  select  the
desired quantity or task and then drag-and-drop it to the desired position.
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9.7 Creation - Automatic Insertion of Lines

The  existence  of  natural  ground  is  a necessary  prerequisite for  the  calculation  of  a
cross section. As a general rule for the lines that comprise the cross sections,  if  you
haven’t  requested  their  automatic  creation  by  the  program,  you  must  insert  them
yourself. The user can insert lines in two ways:

1.By creating a line within the Anadelta Tessera environment.
2.By proceeding to the batch import of lines from ACS text files.

Creating Lines

You can insert individual lines to a cross section  by specifying  each  line’s  points.  To
insert a line, you must first go to the cross section to which you wish to add the line.

How to create a line with the mouse

1.From the Actions menu, run the Insert Line command, or click the  button on the
 Lines toolbar.

2.The following dialogue box appears on the screen:

3.From the Task drop-down list, select the  typical  task  to  which  the  line  will  belong
(e.g. [NGD] Natural Ground for the natural ground), and in the Define group tick the
with points check box and then click OK. The with points option means that the line
will be defined by the manual insertion of points, while the from library option means
that  a user-selected new drawing  will  be imported from the  drawings  library.  This
option is very useful for line categories such as [DRW] Drawing,  [WLL]  Walls,  etc.,
which have a default form. 

4.Define the line points with the mouse within the drawing  area,  using also  the  snap
feature or the Input Form command.

5.To  finish  the  point insertion procedure,  click  the  right  mouse  button anywhere  on
the screen.

Creating a Line by Typing Absolute or Relative Coordinates

You can insert a line by typing its data on a list. This data can be either the absolute
coordinates, namely the distance from axis (X) and the absolute elevation (H), or data
relevant to the previous point of the line, such as the distance from the previous point
and the  elevation  discrepancy. The  usual  direction  in which  the  points  of  a line  are
inserted is from left to right. For closed shapes, use the clockwise direction.

How to create a line from the window of the Edit line command

1.From the Actions menu, run the Edit line command, or click the   button on  the
Lines toolbar. The following window appears on the screen:



276 Anadelta Tessera

Anadelta Software

2.Click the  button.  A menu with  all  the  available  typical  tasks  will  be displayed,
and you must select the task to which the line will belong. 

3.When you select  the  typical  task,  you will  return  to  the  first  window. In the  Line
drop-down list at the top of the box, you should see the name of the line that  will
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be  created (same as  the  selected  typical  task).  From  the  Define  with  drop-down
list, select the type of data that you will input.

A table occupies the main part of the dialogue box. Each line of the table corresponds
to a point of the selected line. The titles of the columns are shown in gray at the top.
The number of columns varies and depends on  how you have  selected  to  define  the
points. The available columns are: A/A, Ch, H, Dx or Length and Dh or Slope. The A/A
column is  always  displayed  and  shows  automatically  the  serial  number  of  the  cross
section. The user cannot intervene into this  column.  In the  other  columns  you must
enter the data of the points. 

To select a field, left-click in it and then start typing. Press the Enter key to confirm
the data you have entered and to move to the next field  on  the  right.  You  can also
move between the fields by using the up, down, right and left arrow keys. If you are
at the end of a row, you can press the Enter key to go to the first field  of  the  next
row.

You can insert points in five ways:

1. If you know the X, H coordinates (distance from axis and elevation in meters) of the
points that will comprise the line, select from the Define with: drop-down list the the
 Axis  Distance  and  Elevation  option  and  type  the  relevant  data  in  the  X  and  H
columns respectively. 

2. If you know the horizontal and vertical  distances of  a point from its  previous  one,
select from the Define with: drop-down list the Dx and Dh from previous option, and
then enter the horizontal distance in the Dx column and the vertical distance in the
Dh column. 

3. If you know the slope of a point with respect to its previous point and the horizontal
distance between these two points, select from the Define with: drop-down list the
Dx and Slope from previous option, and then enter the horizontal distance in the Dx
column and the slope in the Slope column. 

4. If you know the slope of a point with respect to its previous point and the vertical
distance between these two points, select from the Define with: drop-down list the
Dh and Slope from previous option, and then enter the  vertical  distance  in the  Dh
column and the slope in the Slope column. 

5. If you know the  slope  of  a point with  respect  to  its  previous  point and  the  slope
distance between these two points, select from the Define with: drop-down list the
Length and Slope from previous option, and then enter the  distance  in the  Length
column and the slope in the Slope column.

Every  time  you  enter  data  into  one  column,  the  other  columns  are  updated
automatically.

To insert a new point at the end of the table, simply select the last column of the last
row and press Enter. If you want to insert a new point between  two existing points,
select  the  immediate  next  point  and  press  the  Ctrl+I  keys.  The  new  point  will  be
inserted  right  above  the  selected  one  and  at  the  half  of  the  distance  from  the
previous point. This is the initial value, but you can change it. If you wish to delete a
point, simply select the row that contains the data of that point and press the Ctrl+D
keys.

From the same dialogue box you can carry out further operations to edit a line.



278 Anadelta Tessera

Anadelta Software

9.8 Importing a Line from a Text File

Importing a Line from a Text File (ACS)

This procedure is useful in case you want to import into your file the terrain survey for
every cross section (mostly for purposes of measurement) which is available in digital
form (ASCII text files). You can apply this procedure at any given time, either  during
the initial stage of the design or at a later stage, when processing your design.

Especially for the Natural Ground import, the program will also create cross sections, if
necessary.  Namely, the  program reads  the  text  file  and  updates the  Natural  Ground
line of all cross sections in your project. If the text file contains lines referring to cross
sections that are not included in the project, then the program will create these cross
sections and will load the Natural Ground line to them.

How to import a line from an ASCII text file

1.From the File menu, select the Import from ASCII submenu and then run  the  Lines
command. The Import Lines from ASCII dialogue box appears on the screen.

2.Select  the  desired  file  and  click  Open.  If  there  aren’t  any  cross  sections  in  your
project (e.g. the file has derived from the creation of a new cross section project),
then the program will assume that the line refers to the Natural Ground line and will
create the cross sections and the Natural Ground  that  corresponds  to  every  cross
section.

3. If  there  is  even  one  cross  section  in  your  project,  the  program  will  display  the
following dialogue box,

where you must define, from the Line in which points will be inserted drop-down list,
the line in which the points will be inserted. You can also select, if desired, whether
the lines will be moved horizontally or vertically when inserted.
To do this, tick the Move points: check box and next define the offset value. In the
 Horizontal and Vertical groups, you can define  the  horizontal  and  vertical  offsets,
respectively. If you wish to move the line by a fixed value, tick the by Dx or by Dy
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check box and type the distance in the Dx and Dy text fields respectively. The as is
option means that the line will not be moved towards the selected direction. If you
want  to  move  the  line  towards  a  direction  by  a  variable  distance,  which  will  be
different from cross section to cross section and will be determined by the program
from a diagram, select the by Dx + diagram or by Dy + diagram option respectively.
In this case, you must select from the Diagram drop-down list the diagram that will
be used. You can also add a fixed length to the values of the diagram; simply enter
the desired length in the Dx and Dy text field. If  required,  you can also  choose  to
invert the diagram signs.

4.After  you have  made  the  desired  settings,  click  the  OK  button to  proceed to  the
next stage. 

5. If you have selected a typical task of the WLL, GTT or PVL  families, the program will
display the following dialogue boxes:

         

6.Specify the properties of the inserted line and click the OK button to proceed.
7.Finally, the program will ask you to specify the way in which it will check whether a

cross section in the ACS file exists in your file. Namely, you must select whether the
check will be carried out based on the cross section’s name or chainage, as shown
in the figure below:
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If you want the cross sections to be updated based on their names, click the Name
button, or, if you prefer the update to take place based on the chainage, click the
Chainage button.

8.Click the button for the update  to  take  place; the  line  is  displayed  in the  drawing
area.

Specifications of Text Files (ACS).

The cross section data in a file of this type is arranged by groups. Every group-cross
section starts with a row with an * and is followed by a row  that  includes  the  name
and chainage of the cross section  (or  the  distance  from the  previous  cross section)
separated by at least one space (e.g. AA 0.00). The cross section points are shown in
the next rows (one per row). Every row  of  a point has two numbers,  the  first  being
the distance of the point from the axis and the second its elevation; the two numbers
are separated by at least one space.

If  the  first  row  of  the  file  has  a  number,  then  it  is  a  file  with  relative  chainages,
otherwise the file contains absolute chainages. In the case of absolute chainages, the
number  written  next  to  the  name  of  every  cross  section  represents  the  absolute
chainage of the cross section and the order in which the cross sections appear in the
file is insignificant. In the case of relative chainages, the number  at  the  beginning of
the file represents the starting chainage and the number written next to the name of
every cross section  represents  its  distance  from the  previous  cross  section;  in  this
case, the order in which the cross sections appear in the file is critical.
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9.9 Editing Lines

The  program offers  various  secondary  functions,  enabling  you  to  edit  the  lines  you
have inserted, so as to give them the desired form and properties.

Main Line Properties

The  appearance of  a line,  both  on  screen and  on  the  printout,  is  defined  from  the
Typical  Tasks  dialogue box. From there  you can select  whether  a line  will  appear  on
the screen and whether it will be printed. You can also select the color, the type and
the width of the line.

Moving a Line

When you move  a line,  the  whole  line  is  transferred,  without any changes regarding
the orientation or the relative positions of the points with  respect  to  each  other.  To
ensure the necessary accuracy, use the Input Form command or the snap feature.

How to move one or more lines at the same time with the mouse

1.Select the lines you wish to move.
2.From the shortcut menu that is displayed if you right-click in the drawing area, run

the Transformations command and then run the Move command.
3.Specify the reference point, based on which the line will be moved.
4.Specify the end point, namely the point where the reference point will be placed.

Once you have specified the second point, the line is moved to its new position.

How to move a line horizontally or vertically

1.Select the line you wish to move.
2.From the shortcut menu that is displayed when you right-click in the drawing area,

select  the  Edit  line  command,  or  click  the   button  on  the  Lines  toolbar.  The
particular line must appear  selected  (highlighted)  in the  Line  drop-down list  of  the
resulting dialogue box. Otherwise, select it.

3.To move the line horizontally or vertically, click the  button or the   button,
respectively. One of the following dialogue boxes appears on the screen, depending
on the button that you clicked:

In all cases, type the value of the offset in meters in the Move line by: field.
4.When you have finished, click the OK button to move the line and to return to  the

Edit Line dialogue box. Now you can view the new coordinates of the line that  you
moved. To return to the main screen, click the exit button on the right of the  title
bar.

Note that it is also possible to move multiple lines at the same time.



282 Anadelta Tessera

Anadelta Software

Line Rotation

You can rotate a line by selecting a center and a rotation angle towards the horizontal
direction.

How to rotate lines

1.Select the lines you wish to rotate.
2.From the shortcut menu that is displayed if you right-click in the drawing area, run

the Transformations command and then run the Rotation command.
3.Use the mouse or the Input Form command to specify a point that will become the

rotation center.
4.Set  the  rotation  angle  either  by  specifying  again  a  point  on  the  screen,  or  by

entering the angle with the Input Form command. If the angle value is positive, the
line will be rotated in a counterclockwise direction.

Once you have set the rotation angle, the rotation result appears on the screen.

Changing the Line Size

You can scale up or down a set of  selected  lines,  while  maintaining their  proportions
with respect to each other. To scale the lines up or down,  specify  a reference point
and a length,  which  will  be used as  the  scale  coefficient,  or  enter  the  value  of  the
coefficient. 

How to change the size of lines

1.Select the lines you wish to scale up or down.
2.From the shortcut menu that is displayed if you right-click in the drawing area, run

the Transformations command and then run the Scale command.
3.Use the mouse or the Input Form command to specify the reference point.
4.Set the scaling percentage by specifying a point on  the  screen with  the  mouse  or

by typing the percentage value (e.g. “200” for doubling the size) with the use of the
 Input Form.

Obviously, to scale up an object,  the  percentage that  you will  enter  must  be higher
than 100, while to scale down you must enter a percentage lower than 100.

Mirroring Lines

You  can  mirror  certain  lines,  either  by  the  horizontal  or  by  the  vertical  axis,  by
specifying an axis point. The original lines will be deleted.

How to mirror lines

1.Select the lines you wish to mirror.
2. From the  shortcut  menu,  which  is  displayed  if  you right-click in the  drawing  area,

select the Transformations  command  and  then  select  Mirror  by X  or  Mirror  by Y,
depending on the desired mirroring direction.

3.Use  the  mouse  or  the  Input  Form  command  to  specify  a  point  from  which  the
horizontal or the vertical mirroring axis will pass.

Once you have set the point, the mirroring result is displayed on the screen.

Inverting the Direction of Lines 

Lines are usually inserted in a clockwise direction. If you wish to change the direction
of  a  line,  namely  if  you  want  the  first  point  to  become  last,  the  second  point  to
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become last but one, etc., run the Invert direction command.

How to invert the direction of a line

1.Select the desired line.
2.From the shortcut menu that is displayed if you right-click in the drawing area, run

the Transformations command and then run the Invert direction command.

Parallel Offset of Lines

You can offset a line in parallel.

How to offset a line in parallel.

1.Select the line you wish to offset.
2. From the shortcut menu that is displayed if you right-click in the drawing area, run

the  Transformations  command  and  then  run  the  Offset  command.  The  following
dialogue box appears on the screen:

3. In the Offset distance text field, type the value of the offset in meters.
4.This  offset  is  first  performed separately for  every  part  of  the  line,  offsetting  it  in

parallel to the initial point. In this way, a new line is created and every part of this
new line has a fixed distance from the original line (offset function). Therefore, if the
value  you have  entered  in the  Offset  distance  field  is  positive,  the  offset  will  be
upwards  (assuming  the  direction  is  clockwise),  while  if  the  value  is  negative,  the
offset will be downwards.

5.When you have finished, click the OK button. This closes the dialogue  box,  returns
you to the main screen and applies the offset.

Line Duplication

You can create a duplicate of a line, offset by a certain distance. 

How to duplicate a line

1.Select the line you wish to duplicate. 
2. From the menu that is displayed if you right-click anywhere in the drawing area, run

the Duplicate command.
3.The following dialogue box appears on the screen,
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where you must enter the offset data of the new line with respect to the old one. If
the  Relative  distance  check  box  is  ticked,  in  the  X  and  Y  text  fields  enter  the
horizontal (Dx) and the vertical (Dy) distance between the new and the old line.  If
the Relative distance check box is not ticked, then in the X and Y  text fields enter
the  coordinates  that  the  new  point  will  have,  namely  the  point  that  you  had
selected before running this command.

4.Click OK. This closes the dialogue box and applies the duplication.

The new line that has been created will appear on the screen. This line belongs to the
Drawing typical task. It is also possible to duplicate multiple lines at the same time.

Deleting a Line

You can delete one or more lines, if desired. 

How to delete lines

1.Select the lines you wish to delete.
2.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Delete objects command, or click the  button on the main toolbar, or
press the Del key.

If you accidentally delete a line, you can restore it by using the Undo command. It is
also possible to delete multiple lines at the same time.
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9.10 Editing Line Points

Inserting a Line Point

You can insert one or more points to a line. 

How to insert points to a line from the main screen

1.Select the line point next to which you will insert another point.
2. From the shortcut menu that is  displayed  if  you right-click on  the  screen,  run  the

Expand to the beginning or Expand to  the  end  command, depending on  which  side
you wish to insert the point (the points of the boundaries have a counterclockwise
direction). This command adds a new point to the line on screen, before or after the
point  you originally  selected.  The  original  point is  highlighted  in  red,  and  you  can
move the new point by using the mouse pointer.

3.Set  the  position  of  the  new point either  by  clicking  the  left  mouse  button  or  by
using the Input Form command.

4.To finish the point insertion procedure,  click  the  right  mouse  button.  The  insertion
procedure for the last point that would be inserted to the line is cancelled and  the
procedure ends.

You can also insert a point from the window of the Edit line command.

Moving a Line Point

You can move the points of a line, so as to give the line the desired shape.

How to move a line point

1.Select the line you wish to edit and the point you wish to move.
2.Activate the selected point. The point will start moving, following the movement of

the mouse pointer.
3.Specify the new position of the point.

You can also move a point from the window of the Edit line command.

Editing a Line Point

From the dialogue box of the Edit point  command  you can edit  the  position  of  a line
point with respect to its previous or next point.

How to edit a line point

1.Select the line you wish to edit.
2. From the shortcut menu that is displayed if you right-click in the drawing area, run

the Edit point command. The following dialogue box appears on the screen:
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Select a line point and then edit the selected point or its next point or its previous
point. The name of the selected line is shown at the top of the box. To change line,
activate the box and select the new line from the drawing area. The selected point
is  the  reference point and  its  data are  shown in the  Reference  point:  group.  You
can change the reference point from the toolbar at the top of the box. If you click
the first button, the  first  point of  the  line  will  become the  reference point.  If  you
click  the  second  button,  the  previous  (from  the  selected)  point  will  become  the
reference  point.  If  you  click  the  third  button,  the  next  point  will  become  the
reference point, while  if  you click  the  fourth  button,  the  last  point of  the  line  will
become the reference point.

3.After you have set the reference point, specify the point to be edited by choosing
previous point or current point or next  point  respectively  from the  Edit  drop-down
list.

4.Edit  the  point by entering  the  appropriate  data in the  Point  to  edit  group.  Simply
type  the  new coordinates  of  the  point  in  the   and   text  fields.  You  can  also
specify the position of the  point with  respect  to  the  reference point.  By  selecting
from the Define with: drop-down list the Dx and Dh option, you can edit the relative
distances from the reference point, by typing the relevant values in the Dx and  Dh
fields. The Dx and slope option allows you to edit the values of the point’s horizontal
distance  and  slope  with  respect  to  the  reference  point.  With  the  Dh  and  slope
option, edit the value of the point’s vertical distance and slope with respect to the
reference point, while with the Length and slope option edit the value of the point’s
distance  and  slope  with  respect  to  the  reference point.  When  the  move  previous
check box is ticked, the points on the left of the point that you’re moving are  also
moved by the same distance. When the Move next check box is  ticked,  the  points
on the right of the point that you’re moving are also moved by the same distance. 

5. For  every  change you are  making,  click  the  Apply  button  to  move  the  point  and
update all fields with the new values.

6.To close the dialogue box and return to the main screen applying the changes, click
the OK button.

Deleting a Line Point

You can delete one or more points of a line.

How to delete a line point
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1.Select the line you wish to edit.
2.Select the point you wish to delete.
3.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Delete Point command or press the Ctrl+Del keys.

You can do the same from the dialogue box of the Edit line command.

Copying Line Points

You can copy the points of a line to another line.

How to copy the points of a line

1.Select the line whose points you wish to copy.  From the  menu that  is  displayed  if
you right-click in the drawing area, run the Copy points command.

2.Select the line to which the points will be copied. From the menu that is displayed if
you right-click in the drawing area, run the Paste points command. The points of the
line will be erased and the new points will be copied.

If you run the Paste points command without having selected a line, the  program will
create a new line and will open a dialogue box, where you must select the project to
which the new line will belong. By clicking the OK button, the program will create the
new line to which the points of the initial line will be copied.
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9.11 Creation - Management of Diagrams

When  the  cross  sections  are  updated  from  the  profile,  this  means  that  the  profile
diagram  is  inserted.  This  diagram contains  all  of  the  profile  elements  (PIs,  curvature
radii)  and  serves  for  the  determination  of  the  roadway  elevation  on  every  cross
section. 

How to update the Cross Sections from the Profile

1.Go to the Cross Sections workspace of the road you wish to update.
2.From the File menu, run the Update from Profile command. A message will appear on

the  screen,  informing  you  that  the  update  has  been  completed  successfully.  To
proceed and return to the cross sections workspace, click OK.

You  can  also  update  the  Cross  Sections  from  the  Profile  by  using  the  Manage
command of  the  Project  menu.  This  command  opens  the  following  dialogue  box:  To
proceed to the update, either click the  From  Profile  to  Cross  Sections  button in the
Quick Update  group of  the  Updates  tab,  or  click  the  Update  button  of  the  Update
group, after you have selected From Profile to Cross  Sections  in  the  two drop-down
lists of the group. If you use the second  way, you can select  whether  the  diagrams
and  the  chainages  of  the  road’s  cross  sections  will  be  updated  too,  by  ticking  or
unticking  the  relevant  check  boxes.  You  can  use  the  aforementioned  commands  to
update  again  the  Cross  Sections,  in  case  you  make  any  changes  in  the  Profile
workspace.

Note that  you can also  create and  edit  the  profile  diagram from  the  cross  sections
workspace. 

Management of Cross Section Diagrams

From the diagram management window, you can view the profile diagram, as well as all
diagrams that are transferred to the Cross Sections when updating from the other two
workspaces. From the  same  window  you can create your  own diagrams,  in order  to
use them either during the cross section calculation that is based on the typical cross
section, or for operations that are based on diagrams.

To  open  the  management  window,  run  the  Diagrams  command  of  the  Parameters
menu. The lines that have been created or edited in this  way, can be copied  to  the
Profile and to the Horizontal Alignment, by using the Manage command. 

Importing Cross Section Diagrams from Text Files

To  import diagrams  from an  ASCII text  file,  go  to  the  File  menu,  select  the  Import
from ASCII submenu and run the Diagrams command. A dialogue  box appears on  the
screen. Select the desired diagram file and click the Open button. 
The following dialogue box appears on the screen,
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where you must select the file format.

The file must have the format shown below,

and the ADG extension. The data of  the  diagram in a file  of  this  type is  arranged in
three columns. Every row has three numbers, the first being the chainage of a point in
the diagram, the second being the value of the  diagram size and  the  third  being the
rounding  radius  on  the  point;  these  three  numbers  are  separated  by  at  least  one
space.  The  same  file  may  contain  diagrams  that  are  separated  in  left  and  right
diagram. The end of every group – diagram is marked by a row with two zeros. If the
text  file  contains  a diagram,  tick  the  Singly  check  box and  from the  drop-down  list,
select  the  diagram to  which  you wish  to  import the  text  file  data.  If  both  diagrams
(left and right) are included in the text file, tick the in Pairs  check  box and  from the
relevant drop-down list select the diagram in which the data will be saved.

Click the OK button to import the diagram to the file. If you select New Diagram from
the drop-down list, the screen displays the relevant dialogue boxes, in which you must
type the names of the diagrams to be imported. Type the name of every diagram and
then click the OK button. 

Exporting Cross Section Diagrams to Text Files
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The drawings can be saved in an external text file.

How to export the drawings to an ASCII file

1.From  the  File  menu,  select  the  Export  to  ASCII  submenu  and  run  the  Diagrams
command. 

2.The following dialogue box appears on the  screen: If  you wish  to  include  only  one
diagram in the text file, tick the Singly check box and from the drop-down list select
the diagram you wish to export. If you want to export a pair of diagrams to the text
file,  tick  the  in  Pairs  check  box  and  from  the  relevant  drop-down  list  select  the
desired diagram. 

3.The relevant dialogue box appears on the screen.
4.Specify the path and the name for the file you wish to save. The selected diagram

will  be  saved  in  a  file  that  will  have  the  name  that  you  specified  and  the  ADG
extension.

5.Click OK to create the file.
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9.12 Cross Sections Calculation

For the cross sections to be calculated, the user or the program must create the main
components of  the  lines,  then  extend or  trim  parts  of  these  lines,  so  as  to  create
between them closed surfaces,  and  finally  measure  the  area of  these  surfaces.  The
calculation of a cross section and the setting of the calculation parameters are carried
out  through  the  Cross  Sections  Data  management  window.  This  operation  can  be
carried out collectively for all of the project’s cross sections.

Before you press the  button for the program to “close” the cross section,
you must first select the type of the cross section from the Cross Section Type drop-
down list.

Select one of the following types: with Points, with Typical, with Paving Typical, from
Composite Road. If you prefer to apply a typical cross section, use the drop-down list
to select the typical to be applied.

The cross section type determines the way in which  the  program will  proceed during
the calculation, namely: 
· When the cross section type is with Points,  the  program does  not  create any new

lines, but extends or trim the existing lines. 
· If you have selected the with Typical type, the program deletes the existing lines of

the PVL, GTT, AGD, LGD  and  SCC  families  and  creates  new lines of  the  PVL,  GTT,
AGD, LGD,  DRW, GRL  and  SCC  families.  If  the  cross section  includes  lines of  other
families, these lines will not be deleted and they will be used for the shaping of the
cross section’s typical. The lines that are inserted to the cross section and the way
in  which  these  lines will  be calculated,  are  directly  related to  the  selected  typical
cross section that will be applied.

· When calculating with Paving Typical, the procedure is the same as the  one of  the
calculation with Typical; the only difference here is that the typical’s paving section
(that corresponds to a cutting or a filling) is applied to every cross section, leaving
the  Artificial  Ground  line  unchanged,  in  the  exact  shape  that  it  had  before  the
paving typical is applied.

Cross Section Calculation Parameters

The cross sections, as well as the typical cross sections, are comprised of four layers:
the branches, the topsoil, the sideslopes and the pavings. You can define the form of
these elements from the following tabs of the Cross Sections Data window:
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Branches:  The  cross sections can  have  one  or  two
branches.  A single- branch cross section  is  the  one
whose paveway is continuous. An axis appears in the
middle of  the  single-branch  cross sections; the  road
profile  elevation  is  applied  to  this  axis.  The  single-
branch  cross sections are  split  in  two  sections,  the
left  and  the  right  section.  If  the  paveway  is  split,
then  the  cross  section  is  constituted  of  two
branches.  The  two  branches  can  have  a  fixed
distance between them or the distance can vary from
one cross section to another. To set the  parameters
for a particular cross section, go to the Branches tab
of the Cross Sections Data window.
The central axis also appears in the two-branch cross
sections, 
but there  are  also  two secondary  semiaxes,  one  on
the left of the central axis and the other on its right.
Each  of  the  semiaxes corresponds  to  a branch.  The
road  profile  elevation  is  applied  to  both  semiaxes.
Every  branch  of  the  cross  sections  is  split  in  two
parts, left and right.

Topsoil: You can set the topsoil type in four different
ways.  If  you  use  any  of  the  first  three  ways,  the
topsoil is created automatically by the program and it
is  parallel  to  the  Natural  Ground  line.  By  using  the
fourth  way, you can create an  independent line.  To
select one of the four ways, go to the Topsoil tab of
the Cross Sections Data window.
You  can also  select  whether  the  topsoil  will  extend
parallel  to  the  Natural  Ground  line  and  in  segments
(which are  user-defined)  or  around the  road  axis  or
around  the  points  where  the  Artificial  Ground  Line
intersects with the natural terrain or, finally, whether
under  the  Natural  Ground  there  will  be a line  having
its own geometry. In  the  first  three  cases you must
enter  the  topsoil  depth,  while  in  the  cases  where
there are  slopes in  a  region  around  the  axis  or  the
slopes,  you must  enter  the  right  and  left  distances
separately for the cuttings and the fillings. If  you do
not wish to have any topsoil, the value in the  Depth
text field must be zero. All  values are  in meters  (m).
If  you have  selected  the  topsoil  to  be in  segments,
then use the mouse to specify these segments in the
drawing  area.  Select  the  topsoil  line  and  more
specifically the right part of the segment you wish to
modify,  and  from  the  menu  that  is  displayed  if  you
right-click  in  the  drawing  area,  run  the  Change
Topsoil  command.  In  this  way  you  can  specify
whether  there  will  be  topsoil  in  the  particular
segment. 

Cross Section with Points

If the cross section is with Points, then, when the program searches for intersections,
it will not delete any lines, but it will attempt to close the cross section by extending
or  trimming  the  appropriate  lines.  For  calculations  of  this  type,  you  must  set  the
parameters referring to the branches and the topsoil.
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The  roadway  elevation  cannot  be defined  parametrically  if  the  cross section  is  with
Points  (you cannot  use the  typical  cross section).  The  road  profile  elevation  is  the
elevation of the intersection point between  the  axis (or  the  semiaxes in the  case  of
two-branch cross sections) and the Artificial Ground line. 

If your cross section has two branches, in order to view both semiaxes you must set
their distances from the main axis of the cross section. 

Cross Section with Typical

If you select the with Typical calculation way, the existing paving lines that have been
inserted automatically by the program, as well as the Artificial  Ground line,  regardless
of how it was inserted, are both deleted  and  re-created  based  on  the  user-selected
typical cross section. The user is not limited when using this method for calculating a
cross section. If you wish, some of the parametrical values of a cross section to which
a typical cross section is applied, can be different than the values that you have set
for the typical cross section, without having to change the typical cross section itself.
 

To set  the  topsoil,  from the  Topsoil  tab  you can select  the  same  settings  that  you
have selected for the typical cross section by ticking the  use Typical  defaults check
box. If you wish to configure the topsoil of the particular cross section in another way,
tick the use specific configuration check box and define the way in which the  topsoil
will be calculated. 

To define the branches and the road  profile  elevation  on  the  axis (or  the  semiaxes),
from  the  Branches  tab,  you can  also  select  between  the  defaults  and  the  specific
configuration,  by  ticking  the  respective  check  box.  In  the  second  case,  you  can
choose whether a cross section will have one or two branches by ticking the relevant
check box. To set the road profile elevation, type the desired value in the Road profile
el (absolute way). If you wish the roadway elevation value to be relative to the road
profile diagram, tick the From Profile check box (relative way).  For two-branch  cross
sections, if you wish both semiaxes to have a fixed distance from the main axis of the
cross section, type the distance in the Axis Dx text field both for the left and for the
right  semiaxis.  If  this  distance  is  not  fixed,  then  the  program  can  calculate  the
distance based on the cross section chainage and a specific diagram. All  you have to
do  is  tick  the  From  Diagram  check  box and  the  program will  calculate  the  distance
that derives from the Dx diagram of the left or the right semiaxis.
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To  create the  paving  and  slope  lines,  you  must  set
their  parameters.  To  do  this,  go  to  the  Paving  -
Slopes  tab,  which  contains  two groups,  one  for  the
Pavings  and  one  for  the  Slopes.  Here  too,  you  can
tick  in  every  group  the  use  Typical  defaults  check
box to apply the typical  to  the  cross section  or  you
can  use  a  specific  configuration  by  ticking  the
relevant check box. 

In addition, by unticking the Apply Selected Drawings
check box, you can deselect, at  the  particular  cross
section,  the  drawings that  have  been applied  based
on the typical. To display  again  these  drawings,  tick
the same box. 

Pavings: This  is  the  set  of  lines and  structures over
the  Artificial  Ground  and  the  Artificial  Ground  Ledge.
These lines comprise the cross section  paveway  and
they  can  be  created  either  directly  by  the  user  or
from  the  typical  and  then  be  applied  to  the  cross
section.
Sideslopes: This group refers to the sloped  segments
of the  Artificial  Ground. They can  be  created  either
by defining a sequence  of  slopes from the  typical  or
the user can create them by designing  them directly
into  a  specific  cross  section.  The  sideslopes  are
applied  until  an  intersection  with  the  final  natural
ground envelope is found. Their configurations for the
cutting and for the filling are different.

As  you will  see  analytically  in the  next chapter,  a typical  cross  section  in  Anadelta
Tessera  may  contain  many  sets  of  pavings  and  many  sets  of  sideslopes.  However,
only one set of pavings or sideslopes is selected and applied when the specific typical
cross section is first applied  to  a cross section.  Next,  for  a particular  cross section,
you  can  select  any  of  the  predefined  configurations  that  you  have  defined  in  the
typical  and  apply  this  configuration  both  to  the  left  and  to  the  right  part  of  every
branch.  To  do  this,  tick  the  with  specific  configuration  check  box  and  select  the
desired  configurations  from  the  relevant  drop-down  lists.  The  same  applies  to  the
sideslopes. Namely, here too you must tick the with specific configuration check box in
order  to  select  from  the  drop-down  lists  the  type  of  the  configuration  (cutting  or
filling) and then the slopes sequence for the specific configuration.

Cross Section with Paving Typical

The calculation method with paving  typical  is  the  same  as  the  one with  typical,  the
only difference is that the Artificial Ground task will not be deleted. Namely, during the
calculations, the program uses all  elements of the  typical  cross section  that  refer  to
the paving, but it does not use the  elements  that  refer  to  the  Artificial  Ground. The
Artificial Ground is calculated in the same way as in the  case  of  the  calculation  with
Points. 

The  settings  that  you can make are  the  same  as  the  settings  of  the  cross  section
with typical; the only difference here is that the Sideslopes group is inactive. 
The lines referring to the paving are the lines of the PVL (Paving Layer), SSC (Coating)
and GTT (Gutter) types. The cross section type does not play any role as regards the
“closing”  of  the  other  lines  (e.g.  benches,  improvements,  unsuitables,  etc.),  since
these lines have nothing to do with the use of the typical cross section. 
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Line Calculation Properties

Every  line  that  belongs  to  the  PVL  (paving  layer)  or  to  the  GTT  (gutter)  family  has
certain  additional  properties  compared to  the  lines that  are  defined  from the  typical
tasks  and  that  play  a  role  in  the  calculation  –  closing  of  the  particular  lines  and
therefore of the  cross sections containing  these  lines.  You  can set  these  properties
from the following dialogue boxes.

To open either of these boxes, select a line of the PVL or  GTT  family,  click  the  right
mouse button and from the displayed menu select Line properties.

Since a cross section may have two branches, a basic information for a line belonging
to either of the above families is the branch to which this line belongs. In the case of
a single-branch cross section, your only option is Unique, while in the case of a two-
branch  cross  section,  you  can  select  Left,  Right  or  Undefined,  depending  on  the
branch  to  which  the  line  belongs.  You  can  also  select  the  side  to  which  the  line
belongs by entering the appropriate side, namely Left,  Right,  Centre  or  Undefined,  in
the relevant field. Finally, if a line belongs to the encasement solids (GTT),  you must
define whether the solid will be based on a paving  layer  or  whether  it  will  shape the
paving layer. If the solid is based on a line, in order to define this line you must select
the Foundation line field, click the three-dot button on  the  left  of  the  field,  and  use
the mouse pointer to select the foundation line  of  the  solid within  the  drawing  area.
The field is updated with a number, which corresponds to the particular line, and once
you’ve run the calculation of the typical, the solid will be based on this line.

Especially for the encasement solids, their branch side also defines the behavior of the
layers when they meet such solids. Therefore, if they belong to the Left or Right side,
the layers meeting this solid end there and they do not continue on the other side of
the solid, namely outside the road. On the contrary, when the solid is  in  the  Centre,
then  the  layers  it  meets  up  to  the  foundation  layer  are  automatically  split  in  two
identical layers, one on the left and one on the right of the solid.

As  you  will  see  in  details  in  the  next  chapter,  which  refers  to  the  typical  cross
sections, all  of the aforementioned lines are sorted out in order of  calculation.  If  the
cross section derives by applying a typical (with Typical  or  with  Paving  Typical),  the
order of calculation for every line is predefined. If the cross section is calculated with
Points,  the  calculation  order  of  the  lines  belonging  to  the  aforementioned  families,
corresponds to the order these lines were created or inserted. In order for you to get
the  desired  result,  you must set  the  calculation  order manually.  To do  this,  run  the
Line  properties  command  as  described  above  and  then  select  the  Calculation  Order
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field. Click the three-dot button on the left of the field, and use the mouse pointer to
select the line after which the selected line will be calculated.

Excavation Percentage

To set the excavation percentage for the current cross section,  open  the  Quan.  tab
of the Cross Sections Data window.

In  the  tab  fields,  type  the  excavation
percentages, which can be grouped in up to  five
categories. If you change the  percentages,  click
again the Calculation button to calculate the new
quantities.  You  can  also  proceed  to  the  batch
calculation of the  excavation  percentages for  all
cross sections.
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9.13 Quantities - Areas

During the calculation of a cross section,  the  program calculates  the  length  and  the
area of every cross section  line.  You  can select  the  area by clicking  the  left  mouse
button  on  the  relevant  region  within  the  drawing  area.  By  selecting  the  area,  the
relevant region is colored. The data of the selected area appears at the bottom of the
 Status bar.

From the Quantities tab of the Cross Section Data window, you can quickly check  all
calculated quantities (length - area) of the current cross section, as these quantities
are linked together in the columns of the mass table.

In  the  window  of  the  Quantities  command  of  the  Actions  menu,  you  can  view  all
calculated quantities of the current cross section. You can also run this command by

clicking the  button on the Lines toolbar. 

This command opens the following dialogue box, which contains two tabs:
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In the Lengths – Areas of lines tab, you can see in a table all  the lines of the current
cross section, as well as the lengths and  areas that  have  been calculated  for  these
lines. 

In the Mass Table Columns tab of the same window, you can see  all  columns  of  the
mass  table  for  the  particular  cross  section,  together  with  the  Length,  Area  and
Current Meters quantities for each column. If desired, you can change the quantities
contained in these  columns. If  the  cross  section  is  recalculated,  the  quantities  are
restored automatically in their original values. If you want to  add  or  subtract  a fixed
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value to/from the quantities, then enter the desired value in one of the (±)Length and
(±)Area columns, respectively.
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9.14 Sideslopes Coating

The  program  can  create  automatically  a  sideslope  coating,  which  is  parallel  to  the
sideslopes  of  the  current  cross section,  even  if  such  coating  does  not  exist  in  the
typical  cross section.  The  sideslopes  coating  is  inserted after  the  calculation  of  the
cross section. 

How to create the sideslopes coating for a cross section

1.From the Actions menu, run the Insert Sideslopes Coating command, or click the 
button on the Lines toolbar.

2.The following dialogue box appears on the screen:

3. In this box, select from the Task drop-down list the typical task to  which  the  new
line will belong. The list shows only the typical tasks that belong to the SSC family.
The task to select is usually the Sideslopes Coating.

4.The next step is the determination of the line’s  starting  point.  Select  the  line  that
contains the  point from which  the  coating  will  begin and  make this  point  current.
Then click the Select starting point button. You will notice that the message exactly
below the field changes from Starting point not defined to a message that describes
the  selected  point,  e.g.  Start  from point 2  of  Shoulder. The  Side  field  is  updated
automatically with the side of the selected  line  that  contains  the  starting  point of
the sideslopes coating. Next, in the Thickness field, type in meters the  distance  of
the  coating  from the  sideslope.  If  you wish  to  also  use  the  paving  sideslopes  for
creating the line, tick the Use Paving Slopes check box.

5.Click the OK button to close the dialogue box; the line will be created.
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9.15 Drawings

The term drawings means predefined line types, which are stored in an internal library
and can be imported as a new line to a cross section. The drawings can be imported
to the internal library either from a text file, or they can be created by the user.

Creating an Internal Drawing Library

To save a line of a cross section in the internal drawing library of a project, select the
line and from the menu that is displayed if you right-click in the drawing area, run the
Add to Drawings command of the Tools submenu.

To import drawings from a text file, go to the File menu, select the Import from ASCII
submenu  and  run  the  Drawing  Library  command.  The  Drawing  Library  from  ASCII
dialogue box appears on the screen. Select the desired file and click Open. 

The  text  file  with  the  drawings  must  have  the
format  shown below,  and  the  .ADR  extension.  The
drawing  data  in  a  file  of  this  type  is  arranged  by
groups.  The  first  row  of  every  group-drawing
contains the  name  of  the  drawing.  The  next  rows
contain  the  points  of  the  drawing.  Every  row  has
two numbers, the first being the X coordinate of the
point  and  the  second  the  Y  coordinate;  these  two
numbers are  separated by at  least  one space. The
end of every group–drawing is  marked  by an  empty
row.

You  can  also  import  drawings  from  the  drawing
management window. 

New Project’s Internal Drawing Library

The drawings of a new project can also be imported from an external file of  drawings
(*.ADR). You can select this file  from the  General  Options  dialogue  box of  the  Tools
menu. More specifically, the full name and the path of the file are displayed in the New

project drawing library field of the i tab. If you wish to select a new file, click the 
button. Select the desired drawings file from the dialogue box that will appear on the
screen.  Once  you’ve  made  your  selection,  click  the  Open  button  to  return  to  the
General Options dialogue box, and then click the OK button to close the dialogue box
and return to the main screen.

Drawings Management

You can manage  the  drawings from the  window  of  the  Drawing  Library  command of
the Parameters menu.
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This command opens the management window that contains all  drawings of a project,
enabling you to view and edit the drawings of a project’s internal library. The drawing
that  has  been  selected  from  the  Selected  drawing  drop-down  list  appears  in  the
centre of the window. To view the drawings, use the toolbar at the top left of the box

 . The first button shows  the  first  drawing.  The  second  button shows
the  previous  (from the  selected)  drawing.  The  third  button shows  the  next  drawing
and the fourth button shows the last drawing. 

If you wish  to  give  a new name to  the  selected  drawing,  click  the   button;  this
opens a dialogue box, where you can enter the name by which the  file  will  appear  in
the  library.  You  can even  delete  the  selected  drawing  from  the  project’s  library  by

clicking the  button. To delete all drawings, click the  button.

To import drawings from ASCII text files, click the  button. To import the drawings

contained  in  the  library  of  another  Tessera  project,  click  the   button.  In  both
cases, the familiar dialogue box will open, and you can select the desired file and then
click the Open button.

Export of Drawings to an ASCII Text File

The drawings of a project’s internal  drawing  library can be saved  in an  external  text
file.

How to export the drawings to an ASCII file

1.From the File menu, select the Export to ASCII submenu and run the Drawing Library
 command.

2.Specify the path and the name for the file in which you will save your drawings. The
file will have the .ADR extension.

3.Click OK to create the file.
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Importing a Drawing to a Cross Section

To import a drawing to a cross section, proceed in the same way as you would do for
creating a line, and in the dialogue box, tick the  from  library  check  box.  Click  OK  to
open the following dialogue:

From  the  Selected  Drawing  drop-down  list,  select  the  drawing  to  be  imported.  The
buttons on  the  toolbar have  the  same  functions  as  the  buttons  in the  management
window.

In  the  Dependence point  field,  specify  the  point  whose  position  you  must  define  in
order to insert the drawing to the cross section.

Click the OK button to close the dialogue box. The screen displays the drawing, which
you must position either by using the mouse to select a point within the drawing area
(in this case it is recommended to activate the snap on point feature), or by using the
 Input Form. This operation can be carried out collectively for all of the project’s cross
sections.
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9.16 Walls

Generally, the walls in Anadelta  Tessera  are  divided in two categories,  depending on
the  position  they  will  get.  They  can  be  either  Filling  walls,  commonly  used  for
supporting  the  soil  at  the  foot  of  the  filling  slopes,  or  Cutting  walls,  which  are
commonly used to retain the soil of the cutting slope. You can insert walls collectively
for all of the project’s cross sections.

Generally the walls can be inserted like any other  line.  You  can also  insert  a wall  by
selecting  from  a  table  containing  the  dimensions  of  the  wall,  based  on  the  wall’s
position  in a cross section.  With this  method,  you  can  insert  a  wall  to  the  current
cross section  and  specify  only  the  distance  of  the  wall  from the  cross section  axis.
The  height,  the  type  and  the  individual  dimensions  of  the  wall  are  calculated
automatically by the program. The dimensions are selected according to the net height
of the wall, from wall tables, which  contain  geometrical  characteristics based  on  the
allowable tension of the ground and the slope of the  filling  sideslope  behind  the  wall.
The dimensions specified in these tables are as follows:

To insert a wall with this method, run the Insert Wall command from the Actions menu,

or click the  button on the Lines toolbar. 

This command opens the following dialogue box,
 

where you can set the wall insertion parameters. Note that, before inserting a wall in
this way, you must have calculated the cross section.
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From the  Task  drop-down  list,  select  the  typical  task  to  which  the  inserted line  will
belong. By left-clicking on the list, you can view all  typical tasks of the family (WLL);
select one of the  displayed  tasks. In  the  Selected  wall  table  drop-down  list,  choose
the table that will  be used for  the  selection  of  the  appropriate  wall.  You  can select
among ten tables, which contain all of the wall’s geometrical data.

In the Sideslope  slope  after  wall  field,  type the  value  of  the  sideslope  slope  outside
the wall. A sideslope after the wall will only exist in the case of a support wall. In the
Added  wall  height  field,  type  the  height  that  the  wall  will  have  above  the  natural
ground or the top envelope, depending on whether the wall is positioned  in a cutting
or filling, respectively.

In all  cases, click OK to insert the wall to the cross section, or  click  Cancel  to  abort
the procedure. The  OK  button transfers  you to  the  screen,  where you must specify
the position of the wall. The shape and the dimensions of the wall change each time,
in order for the wall to be adapted to the existing geometry of the lines. Click the left
mouse button to  finalize the  position  of  the  wall,  or  click  the  right  mouse  button to
stop the procedure without inserting the wall.

Properties of the WLL Family Lines

You can select whether the presence of the walls in  the  cross section  will  modify  or
not the Artificial Ground. If you select the Artificial Ground not to be affected, then its
configuration  will  not  depend  on  whether  it  meets  or  not  the  wall  line,  while  in  the
opposite case, the Artificial Ground will change according to the type and shape of the
wall. On the contrary,  the  Paving  Layers,  the  Encasement  Solids and  the  Sideslopes
Coating will always stop on the wall line. 

To edit the properties of a wall, select the wall and run the Properties command.

The above figure shows the dialogue box with the wall properties that you can edit. 

If you want the wall line to take part in the shaping of the Artificial  Ground, select Yes
in the Shapes Artificial Ground drop-down list. Otherwise select No (inactive wall); the
wall  line  will  exist  in  the  cross  section  (mainly  for  the  measurement  of  the  cross
section  area) but  it  will  not  modify  the  Artificial  Ground.  If  you  select  Yes  (active
wall), then the Artificial Ground will change from the first point of its intersection with
the Wall line, according to your selections as regards the other properties of the wall. 

For the Artificial  Ground to be shaped again, after you have activated or deactivated
the wall, the cross section must be recalculated.
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Importing Wall Tables

To import tables from an ASCII text file, go to the File menu, select the Import from
ASCII  submenu  and  run  the  Walls  Library  command.  The  Import  Walls  Library  from
ASCII dialogue box appears on the screen. Select the desired file and click Open. 

The file must have the format shown below,

and the .AST extension. The  wall  data in a file  of  this  type is  sorted  out  in groups,
depending on the allowable ground tension and the ground’s sideslope slope behind the
wall. The first row of every group contains two values, the sideslope angle in degrees
and the  allowable  ground  tension.  These  two values are  separated  by  at  least  one
space (e.g. 0 300). The next rows show the dimensions of  the  walls  with  respect  to
the useful wall height H?.  By order of  appearance,  the  data shown in the  table  are:
H?, h1, bo, bu, b1, b2, d1 and d2. When importing a wall, the program, based on the
calculated H?,  provides  the  dimensions  of  the  wall  by using the  other  values of  the
row corresponding to the H?. The end of every group is marked by an empty row.

Wall Tables of a New File 

The wall tables of a new project are also imported from a wall table file (*.AST). This
file  is  selected  from  the  General  Options  dialogue  box  of  the  Tools  menu.  More
specifically, the full name and the path of the file are displayed in the New project wall

library field of the Cross Sections  tab. If  you wish  to  select  a new file,  click  the  
button. Select the desired typical tasks file from the dialogue box that will appear  on
the screen. Once you’ve made your selection, click the Open button to return to  the
General Options dialogue box, and then click the OK button to close the dialogue box
and return to the main screen.

Exporting Wall Tables to an ASCII Text File

The wall tables can be saved in an external text file.

How to export wall tables to an ASCII file

1.From the File menu, select the Export to  ASCII  submenu  and  run  the  Walls  Library
command.

2.Specify the path and the name for the file you wish to save. The wall tables will be
exported to a file with the (*.AST) extension.

3.Click OK to create the file.
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9.17 Benches

The Insert Bench command of the Actions menu is  used for  inserting automatically  a
bench into the current cross section. You can also run  this  command  by clicking  the

 button on the Lines  toolbar. This command results in the creation (if required for
the cross section) of a bench  line,  which  always  belongs  to  the  Bench  Typical  Task
(BNC).  The  shape and  the  insertion way  of  the  benches  depend  on  the  parameters
that you have set  in the  Benches  tab  of  the  Road  Preferences.  You  can also  insert
benches collectively for all of the project’s cross sections. 

Bench Preferences

To  set  the  bench  insertion preferences,  run  the  Road  Preferences  command  of  the
Parameters menu and then open the Benches tab. The resulting dialogue box has two
groups.

The Insertion Preferences group contains settings referring to the criteria according to
which the program will determine whether a bench  will  be inserted or  not  to  a cross
section. In the Minimum terrain slope (%) and Maximum terrain slope fields, enter the
minimum and maximum slope that two successive points of the natural sideslope must
have, in order for  a bench  to  be inserted between  them.  In the  Minimum horizontal
step  and  Minimum  vertical  step  fields,  enter  the  minimum  horizontal  and  vertical
distance that two successive points  of  the  natural  terrain  must  have,  in order for  a
bench  to  be  inserted  between  them.  A  bench  cannot  be  inserted  between  points
whose slope  is  between  the  limits  that  you have  set,  but  their  in-between  vertical
distance does not exceed the minimum value. 

The  Calculation  Preferences  group  contains  settings  referring  to  the  shape  of  the
inserted bench. In the Start benches from field, specify the way in which the benches
will be inserted. Namely, if you wish to insert the first complete step to the highest or
to  the  lowest  point  of  the  section  to  which  the  bench  will  be  inserted,  from  the
relevant  drop-down  list  select  Top  or  Bottom,  respectively.  In  the  Horizontal  step
field, enter the horizontal distance – width of the benches, while in the  Vertical  step
field  enter  the  bench  height.  In  the  Benches  superelevation  field,  enter  the
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superelevation  of  each  bench.  When  inserting  benches  automatically,  the  program
uses the insertion preferences to determine the segments to which the bench lines will
be inserted and then shapes the lines according to the bench preferences. If there are
two adjacent bench segments and you wish to join them into a single part, enter the
desired value in the Minimum distance of  adjacent  benches  field.  The  program joints
automatically the benches whose in-between distance is smaller than the value which
has been entered in this field and leaves  the  benches  whose  distance  is  longer  than
this value unaffected. 

The  shape  of  the  benches  is  determined  according  to  the  method  that  you  have
selected from the drop-down list at the top of the Bench Preferences group. With the
option  with  minimum horizontal  step,  the  width  of  the  benches  equals  to  the  value
that you have entered in the Horizontal Step field. If this cannot be applied (usually at
the end of the line), the resulting bench is wider but never narrower. The option with
minimum vertical step is similar, only here the bench height remains fixed at the value
that  you  have  entered  in  the  Vertical  Step  field.  With  the  option  with  minimum
horizontal and vertical step, the width  of  the  benches  is  the  value  in the  Horizontal
Step field and their minimum height is the value that you have entered in the Vertical
Step field. If this cannot be applied, the program will make the benches wider.



309Cross Sections

Anadelta Software

9.18 Batch actions

Many  of  the  operations  of  the  Cross  Sections  workspace  can  be  carried  out
collectively for a group of  cross sections.  Most  of  these  operations  can be found  in
the  Batch  Actions  menu.  Any  command  contained  in  this  menu  opens  a  relevant
dialogue  box.  These  dialogue  boxes  contain,  among  others,  two  common  groups:
Selected cross sections and Cross section selection.

From these groups you can select the cross sections you wish to edit.

The Selected cross sections group is comprised of a window with four columns, which
contain  the  names  of  all  cross  sections  of  the  current  road,  their  chainages,  the
number of the cross section’s branches, and the calculation way of the cross section.
To select a cross section from the table, left-click on the cross section and its line will

appear  colored.  An  icon  appears on  the  left  of  every  cross section’s  name.  The  

icon appears next to the calculated cross sections, while  the   icon  appears next to
the  uncalculated  cross sections.  The  number  of  the  cross  sections  that  have  been
selected for editing and the total number of cross sections appear next to the name of
the group (e.g. 10/26).

To select only one cross section, select the cross section from the window and press
the Space bar on the keyboard. If you wish to deselect the cross section, click again
the  same  button.  You  can also  carry  out  these  operations  by  using  the  Insert  and
Delete  keys respectively,  or  by double-clicking  with  the  mouse.  The  selected  cross
sections appear in blue fonts. 
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To  select  all  cross  sections,  click  the  Select  button  at  the  bottom  of  the  Cross
Section selection group. To deselect all cross sections, click the Deselect button.

The  program gives you four  more options.  You  can select  or  deselect  certain  cross
sections between two chainages.  To do  this,  tick  the  Chainage  check box and  then
enter the respective chainages in the From and To text fields. Click the Select button
to add the cross sections to  the  existing set  of  the  selected  cross sections or  click
the Deselect button to remove them.

If you wish to select the cross sections that have been calculated based on a typical
cross section, tick the Typ. Cross Section check box and then select the typical cross
section from the drop-down list. You can also select only single-branch cross sections
or only two-branch cross sections; to do this, tick the Branches check box and  then
select  one  branch  or  two  branches,  respectively.  Finally,  you  can  select  only  the
cross sections that have been calculated or only those that have not been calculated,
by ticking the last check box and making the appropriate selection. In all  cases, click
the  Select  button  to  add  the  cross  sections  to  the  existing  set  of  selected  cross
sections  or  click  the  Deselect button  to  remove  them.  You  can  also  combine  these
four  options.  Namely, you can select  the  uncalculated  cross  sections  between  two
chainages. 

9.18.1 Batch Cross Section Calculation

The  actions  referring  to  the  calculation  of  a  cross  section  can  be  carried  out
collectively for all  of the project’s cross sections by running the Calculation command
from the Batch Actions  window.  The  purpose  of  this  command  is  to  carry  out  batch
calculations  in the  cross sections of  the  current  road  of  a project.  The  calculations
may also include settings for the parameters of the branches, the topsoil, the pavings,
the sideslopes or/and all  of the above. The window where you can make the settings
and the batch calculation is as follows, 
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and appears as soon as you run this command.

The  dialogue  box is  comprised  of  three  groups:  In  the  Selected  cross  sections  and
Cross  Section  selection  groups  you  can  choose  the  cross  sections  to  which  the
calculations will be applied. In the right part of the window you will find the Calculate
selected  cross sections  group,  where you  can  specify  the  type  of  the  calculations
that will be applied, as well as the corresponding parameters. In the same group, you
can specify the type of the batch calculation tasks for the selected cross sections. To
define the type of the calculations, proceed in the same way as you would for a single
cross section. The  calculations  can be performed with  Typical  Cross  section  or  with
Points.  The  as  is  option means  that  the  calculation  will  be  repeated  with  the  same
Typical, which had already been used in another calculation and is different for every
cross section, or without Typical, for any cross section that had been calculated with
Points.  This  is  very  helpful  when  recalculation  is  required  after  editing  the  terrain
model, something that could affect the natural ground of many cross sections, or after
changing  the  diagrams  (profile,  width,  superelevation),  something  that  affects  the
cross  sections’  calculation.  It  is  also  required  for  the  batch  recalculation  of  cross
sections  after  editing  one  or  more  typical  cross  sections  that  had  been  used  in  a
previous calculation. The as is option in the Topsoil and Branches tabs has the  same
meaning, namely the way in which the topsoil or the branches are calculated remains
unchanged.

In  all  cases,  click  the  Calculation  button  for  the  program  to  start  the  batch
calculation. At the end of the calculation, the program informs you on  the  results  by
displaying the relevant message in the message window at the bottom of the program
screen.  Any problems  that  may  have  occurred  will  appear  in  detail  in  the  message
window.  Click  the  Exit  button  or  press  the  Esc  key  to  close  the  dialogue  box  and
return to the program’s main screen. 
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Correction of Batch Calculation Errors

After the batch calculation, the message window shows three message categories: 

· Information, referring to the start and the end of the calculation process.
· Warnings, referring to problems that occurred during the calculation of specific cross

sections  and  that  the  program  solved  by  itself.  In  this  case,  you  must  check
whether  the  program  has  applied  the  correct  solution  to  the  particular  cross
sections.

· Errors,  referring  to  problems  that  occurred during the  calculation  of  specific  cross
sections  and  couldn’t  be solved.  In  this  case, you must go  to  the  cross  sections
involved, correct the problems listed in the message and request recalculation of the
cross section.

Every  warning  or  error  shows  the  name  of  the  cross  section  in  which  the  problem
occurred.  To  go  to  the  cross  section,  select  the  corresponding  message  from  the
message window in order to highlight it and double click on it. Or, from the menu that
is displayed if you right click in the  drawing  area when the  message is  selected,  run
the Cross section selection command.

To delete a message, select it, click the right  mouse  button,  and  from the  displayed
menu run the Delete message command. To delete all  messages of a category, select
the  Delete  submenu  of  the  aforementioned  menu  and  then  select  the  category  of
messages that  you wish  to  delete.  To delete  all  messages  from  the  aforementioned
submenu,  run  the  All  command.  To save  the  messages  in a text  file,  from the  Save
submenu select the category of  messages  you wish  to  save.  The  Save  dialogue  box
opens and you must select the folder where the file will be saved, as well  as  the  file
name.
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9.18.2 Batch Drawing Assignment

The actions referring to drawings can be carried out collectively  for  all  of  a project’s
cross  sections by running  the  Drawings  Assignment  command  of  the  Batch  Actions
menu. This command opens the following dialog box:

Here  you can insert  –  create new lines into certain cross sections of  a  project,  by
using a template line, which must exist as a drawing in the  project’s internal  drawing
library.

In  the  Selected  cross  sections  and  Cross  Section  selection  groups,  which  can  be
found in the left part of the window, you can choose the cross sections to which the
calculations will be applied.  It  the  right  part  of  the  window  there  are  two tabs that
enable you to assign drawings and insert them into the selected cross sections. From
the Selected drawing dropdown list, select the library drawing to be inserted.

From the Options tab, select the line to be created and the way in which the drawing
will  be placed  both  horizontally  and  with  respect  to  the  elevation.  From  the  Line  in
which  drawing  will  be  inserted  dropdown  list,  select  the  typical  task  in  which  the
selected  drawing  –  template will  be inserted in the  cross sections,  e.g.  drawing,  N.
Jersey, etc. From the Reference line dropdown list, select the line based on which the
new line will be inserted. From the Reference line S/N field, specify the serial number of
the  line  that  will  become  the  reference  line.  The  S/N  matters  only  if  the  selected
reference line is a line that can be found in a cross section more than once. Next, you
must  select  a reference line  point,  based  on  which  the  drawings  will  be  applied  to
every cross section. Select this point from the with reference point No field. The S/N
of a point is  shown in the  status bar  when the  point has  been  selected  within  the
drawing area. If you wish to insert the drawing to the last point of the  line,  you can
enter  a  value  higher  than  the  available  points,  e.g.  2000,  and  the  drawing  will  be
inserted to the last point of the reference line. You can also enter negative values in
this field. If you wish to insert the drawing to the last but one point of the line, enter
the -1 value, and so on. 
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In the Distance from group, specify the horizontal position of the drawing in the cross
section. You can insert a drawing in three ways: 

· The first way is the reference point + Dx. If you select this way, the drawing will be
inserted  in such  a way, so  that  its  dependence  point has  the  same  X  coordinate
with the reference line point that the user has entered in the  with  reference point
Nο.  The  horizontal  distance  that  you  enter  in  the  Dx  text  field  is  added  to  this
coordinate.

· The  second  way  is  axis  based  on  diagram +  Dx,  namely  the  drawing  dependence
point will be inserted in such a way, so that it has a fixed distance  from the  cross
section axis, depending on the cross section’s chainage. The distance  is  calculated
for  every  cross section  from the  diagram that  the  user  selects  from  the  Diagram
dropdown list (e.g. roadway width diagram). When diagrams referring to the left part
of the cross section are to be used, you must tick the Invert Diagram Signs  check
box,  so  that  their  values  correspond  to  the  left  part  of  the  cross  section.  The
horizontal distance that  you enter  in the  Dx  text  field  is  added to  this  diagram.  If
you want to use only the fixed distance of the Dx field with respect to every cross
section’s axis, select the Without diagram option. 

· The third and last way to insert a drawing is to combine the above two ways. With
this method, the X coordinate of the drawing’s dependence point is the sum of  the
distance  entered  in the  Dx field,  the  X coordinate  of  the  reference  point  and  the
value of the diagram at every cross section’s chainage. 

In the Elevation group, enter the position that the drawing will get with respect to the
elevation. There are four ways to insert a drawing with respect to the elevation: 

· The  first  way  is  the  from  reference  line  +  Dh.  If  you  select  this  way,  the
dependence point of  the  inserted drawing  will  have  the  elevation  of  the  reference
line at the distance from axis which was specified in the previous group. The vertical
distance that you enter in the Dh text field is added to this coordinate.

· The  second  way  is  the  from  reference  point  +  Dh.  If  you  select  this  way,  the
dependence point of the inserted drawing will have the elevation of the point which
was specified  in the  with  reference point No  field.  The  vertical  distance  that  you
enter in the Dh text field is added to this coordinate.

· The third way is the  absolute  based  on  diagram + Dh.  In  this  case, the  drawing’s
dependence  point will  have  a variable elevation,  depending on  the  cross  section’s
chainage. This elevation is calculated for every cross section from the diagram that
the user selects from the Diagram dropdown list  (e.g.  road  profile  diagram).  If  you
want to invert the signs of the diagram’s values, you must tick the  Invert  Diagram
Signs check box. The vertical distance that you entered in the Dh text field is added
to the value that is calculated based on the  diagram.  If  you want to  use only  the
fixed  distance  that  you have  entered  in  the  Dh  field,  select  the  Without  diagram
option. 

· The fourth and last way to insert a drawing is a combination of the second and third
ways. With this method, the elevation of the drawing’s dependence point is the sum
of the distance entered in the Dh field, the elevation of the reference point and the
value of the diagram at the cross section’s chainage. 

After you have set all  parameters,  click  the  Set  button.  The  program will  inform you
that  the  procedure has been completed.  If  an  error  occurs  during  the  process,  the
relevant message will be displayed in the message bar at the bottom of the screen.

If you have selected a typical task of the WLL, GTT or PVL families,  the  program will
display the relevant dialogue boxes shown in the figures. In these boxes you must set
the properties of the lines that will be inserted into the cross sections, e.g. Branches,
Side, etc., and then click the OK button to continue and finish the procedure.
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When you have finished assigning drawings, click the Exit  button to close the dialogue
box and return to the main screen.

9.18.3 Batch Bench Assignment

The actions referring to benches can be carried  out  collectively  for  all  of  a project’s
cross sections by running  the  Bench  Insertion  command  of  the  Batch  Actions  menu.
The purpose of this command is to insert collectively bench lines of a predefined form
into the cross sections of the current road of a project. This command results  in the
following dialogue box, 

which  is  comprised  of  three  groups.  The  Bench  data  group  contains  the  bench
insertion and calculation parameters, which  are  similar  to  those that  you can set  by
running  the  Road  preferences  command.  From  the  dropdown  list  at  the  top  of  the
group, select the BNC typical task, to which the lines that will be created will belong.

After you have set all parameters, click the Calculation button. The program will inform
you that the procedure has been completed. If an error occurs during the process, the
relevant message will be displayed in the message bar at the bottom of the screen.

When you have finished inserting benches, click the Exit button to close the dialogue
box and return to the main screen.

9.18.4 Batch Wall Assignment

The actions referring to walls can be carried out collectively for all  of a project’s cross
sections  by  running  the  Wall  Insertion  command  of  the  Batch  Actions  menu.  The
purpose of this  command  is  to  insert  collectively  wall  lines of  a predefined  form into
the  cross  sections  of  the  current  road  of  a  project.  This  command  results  in  the
following dialogue box,
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which is  comprised  of  four  groups.  The  Select  wall  group contains  the  wall  insertion
parameters, which are similar to those that you can set when inserting the wall into a
cross section.

The  Placement  group refers to  the  selection  of  the  wall’s  place,  since  it  cannot  be
selected with the mouse during the batch insertion. If you want the wall to be placed
at a fixed distance from the axis of the cross section, tick the Dx distance from axis
check box and type the distance in the  Dx  field.  It  is  also  possible  to  add  a second
distance to the fixed one; this second distance will derive from a diagram,  depending
on the cross section’s chainage. To do this, tick the based on diagram from axis + Dx
check box and from the Diagram dropdown list select one of the diagrams included in
the file. When diagrams referring to the left part of the cross section are to be used,
you  must  tick  the  Invert  Diagram  Signs  check  box,  so  that  their  values  can
correspond to the left part of the cross section. For example, if you wish  to  insert  a
wall into the left side of the pavement and at a distance of two meters from the end
of the pavement, tick the based on diagram from axis + Dx check box, select the left
pavement width diagram from the  Diagram  dropdown list,  type 2  in the  Dx  field  and
tick the Invert Diagram Signs check box.

After you have set all parameters, click the Insert button. The program will inform you
that  the  procedure has been completed.  If  an  error  occurs  during  the  process,  the
relevant message will be displayed in the message bar at the bottom of the screen.

When you have finished inserting walls, click the Exit  button to close the dialogue box
and return to the main screen.

9.18.5 Soil Improvement Insertion

The  actions  referring  to  soil  improvement can be carried  out  collectively  for  all  of  a
project’s  cross sections by running  the  Soil  Improvement Insertion  command  of  the
Batch Actions menu. This command opens the following dialog box:
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This  dialogue  box  is  comprised  of  four  groups.  In  the  Selected  cross  sections  and
Cross Section selection groups, which can be found in the left part of the window, you
can choose the cross sections to  which  the  calculations  will  be applied.  In  the  right
part  of  the  window  there  are  two  more  groups,  enabling  you  to  set  the  Soil
improvement parameters and the Soil improvement axis elevation. 
More specifically, in the Soil improvement parameters group you can set the following: 
· Reference line:  Select the line  that  will  determine  the  X coordinates  of  the  terrain

points from which the sideslopes of the new Soil Improvement will start. This line is
usually the Artificial Ground.

· Reference  line  S/N:  Enter  the  serial  number  of  the  line  that  will  become  the
reference line. The S/N matters only if the selected reference line is a line which can
be found in a cross section more than once.

· Soil Improvement Line: Select the typical task in which the new line will be inserted,
e.g. drawing, soil improvement, etc.

· Reference line points for soil improvement definition: In these fields you can set the
reference  line  points  that  will  determine  the  edges  of  the  Soil  Improvement
sideslopes (usually 1 for left and -1 for right).

· Soil improvement edges distance from reference points: In these fields you can set
an additional distance from the selected reference points.

· Soil improvement slopes: Set the slope that the sideslopes will have on the left and
right part of the soil improvement.

· Soil improvement bottom superelevations:  Define  any desired  superelevations  that
the bottom will have on the left and right part of the soil improvement.

In the Soil improvement axis elevation you can set the following:
· Dh:  In  this  field,  enter  the  elevation  of  the  Soil  Improvement with  respect  to  the

Natural Ground or with respect to a Diagram.
· Invert diagram signs: Tick this option when the Dh is calculated based on a Diagram

and the signs of the diagram values must be inverted.
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9.18.6 Guardrail management

The actions referring to guardrails can be carried out collectively for all  of a project’s
cross sections by running the Guardrails Management command of  the  Batch  Actions
menu. The purpose of this command is to  insert  guardrails  collectively  into the  cross
sections of the current road of a project, according to  the  predefined  form that  you
have chosen. This command results in the following dialogue box,

which is comprised of three groups. In the Side group, select the cross section side to
which the guardrail will be inserted. To place guardrails left and right, tick both boxes.
In the Operation group, select the task you wish to perform.
· Delete: If you select this option and click the Apply button, all  guardrails are deleted

from the selected cross sections.
· Insert: Select this field to activate the following options:

· according  to  h:  In  the  h>  field,  enter  the  minimum  Dh  according  to  which  the
guardrails  will  be  inserted  (The  Dh  is  calculated  between  the  elevation  of  the
guardrail reference point and the sideslope foot. 

· Mandatory: The program inserts guardrails in all of the selected cross sections. 

The  symbol appears for all cross sections in which guardrails have been placed.
After the placement of guardrails, the program performs an automatic check based on
the Checking Criteria that you have specified. If you change these criteria, click again
the Check button to apply the new criteria.  
The Checking Criteria group has the following fields:
· Minimum  guardrail  length:  In  this  field,  set  the  minimum  acceptable/  applicable

length  of  a cross section  or  a set  of  cross  sections,  in  which  a  guardrail  can  be
placed. If the applicable  length  of  a set  of  cross sections with  guardrail  is  shorter

than this value, the  symbol appears for these cross sections.
· Minimum  distance  between  guardrails:  In  this  field,  set  the  minimum  acceptable

distance  between  two  successive  sets  of  cross  sections  with  guardrail.  If  the
distance  between  two successive  sets  of  cross  sections  with  guardrail  is  shorter

than this value, the  symbol appears for the intermediary cross sections.
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9.18.7 Batch Line Management

Anadelta Tessera offers operations for batch line management.  These  operations  can
be carried out from the dialogue box of the Line management command of the  Batch
Actions menu.

From this box,  you can perform  four  operations  (copy,  cut,  modification,  delete),  as
described below.

The dialogue box is  comprised  of  three  groups.  The  Operation  group is  comprised  of
three sections. From the top section you can select the type of  the  operation to  be
performed,  from the  middle  section  you  can  select  the  lines  to  which  the  selected
operation shall refer to, and from the bottom section you can set the line modification
type and its parameters. 

Batch Line Copy

You can copy the lines of all cross sections belonging to a typical task.

How to copy simultaneously all lines of a typical task

1.Open  the  dialogue  box  of  the  Line  management  command  and  select  the  cross
sections you wish to edit.

2.Tick the Copy – Paste check box in the middle section of the Operation group.
3.From the Origin line dropdown list of the  middle  section,  select  the  typical  task  to

which the copied lines belong. If certain cross sections contain more than one lines
of the same  typical  task  (e.g.  two base  courses),  then  in the  S/N field  enter  the
serial number of the line you wish to copy. If this serial number is zero, then the by
Task and by Family check boxes are enabled. This means that the program will copy
all lines of the selected cross sections belonging to the typical task or family of the
selected typical task, respectively, depending on the ticked check box.

4.From the Destination line dropdown list of the middle section, select the typical task
of the lines to which the data of the lines that you selected in the Origin line will be
copied. If certain cross sections already contain lines of the particular typical task,
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then in the S/N field enter the zero value. With this option, the program creates new
lines without affecting the existing lines of the selected typical task. If you enter a
value  higher  than  zero,  then  the  new lines that  have  this  number  will  be inserted
and placed in the cross sections and any existing lines with the same number will be
deleted.

5. If you wish  to  modify  the  origin line,  select  the  type of  the  modification from the
Modification type dropdown list of the bottom section. In the remaining fields, make
the necessary settings according to the selected modification type.

6.Click the Apply  button to  carry  out  the  operation for  the  selected  cross sections.
The program will prompt you to confirm that you wish to copy the lines, by showing
you the relevant confirmation message. To complete the procedure, click Yes. If the
serial  number  of  the  typical  task  that  you  selected  from  the  Destination  line
dropdown list is zero and  the  typical  task  belongs  to  the  WLL,  GTT  or  PVL  family,
the  program  will  display  the  relevant  dialogue  boxes,  enabling  you  to  set  the
properties of the lines that will be created, such as Branches, Side,  etc.  After you
have set the properties for the particular lines, click the OK button to  proceed.  To
close the dialogue box, click the Exit button.

Batch Line Cut

You  can transfer  the  lines of  a  typical  task  to  another  typical  task,  which  already
exists or will be created in any cross section, as necessary. The procedure is similar to
the batch line copy, only in this case the origin lines are deleted permanently.

Line Modification

You can modify the lines of all cross sections belonging to a typical task. 

How to modify simultaneously all lines of a typical task

1.Open  the  dialogue  box  of  the  Line  management  command  and  select  the  cross
sections you wish to modify.

2.Tick the Modification check box in the top section of the Operation group.
3.From the Origin line dropdown list of  the  middle  section,  select  the  typical  task  of

the lines to be modified. If certain cross sections contain more than one lines of the
same typical  task  (e.g.  two base  courses),  then  in  the  S/N  field  enter  the  serial
number of the line you wish to modify. If the selected serial number is zero, then the
 by Task and by Family check boxes are enabled. This means that the program will
modify all lines of the selected cross sections belonging to the typical task or family
of the selected typical task, respectively, depending on the ticked check box.

4. If you wish  to  modify  the  origin line,  select  the  type of  the  modification from the
Modification type dropdown list of the bottom section. In the remaining fields, make
the necessary settings according to the selected modification type. 

5.Click the Apply button to carry out the operation for the selected cross sections. To
close the dialogue box, click the Exit button.

Deleting Lines

You can delete the lines of all cross sections belonging to a typical task.

How to delete simultaneously all lines of a typical task

1.Open  the  dialogue  box  of  the  Line  management  command  and  select  the  cross
sections you wish to edit.

2.Tick the Delete check box in the top section of the Operation group.
3.From the Origin line dropdown list of  the  middle  section,  select  the  typical  task  of

the lines to be deleted. If certain cross sections contain more than one lines of the
same typical  task  (e.g.  two base  courses),  then  in  the  S/N  field  enter  the  serial
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number of the line you wish to delete. If the selected serial number is zero, then the
 by Task and by Family check boxes are enabled. This means that the program will
delete all lines of the selected cross sections belonging to the typical task or family
of the selected typical task, respectively, depending on the ticked check box.

4.Click the Apply button to carry  out  the  operation.  The  program will  prompt  you to
confirm that you wish to delete the lines, by showing you the relevant confirmation
message. To complete the procedure, click Yes. To close the dialogue box, click the
 Exit button.

Modification Types

From the Modification type dropdown list in the bottom section of the Operation group
of  the  Batch  Line  Management  dialogue  box,  you  can  select  the  type  of  the
modification that will be applied to the selected  lines of  the  selected  cross sections.
The selectable modification types, as well as their  relevant  settings,  are  explained  in
detail below.

Line offset

The line offset can be performed in four ways:

1.To offset lines both horizontally and vertically, from the Modification type dropdown
list select Offset by Dx, Dh. In the Define Dx group,  set  the  horizontal  offset.  The
distance is given  according to  the  cross section’s  chainage  from the  diagram that
you select from the Diagram dropdown list. If  you want to  invert the  signs  of  the
selected  diagram’s values,  you must tick  the  Invert  Diagram Signs  check  box,  so
that their values correspond to  the  left  part  of  every  cross section.  The  distance
that you enter in the Dx text field is added to this diagram. If you want to use only
the fixed distance that you have entered in the Dx field, select the Without diagram
option. In the Define Dh group, set the vertical offset. The procedure that you must
follow to  set  the  vertical  offset  is  the  same  as  the  one for  setting the  horizontal
offset.

2.To offset the lines horizontally by defining the new coordinate of a line  point,  from
the  Modification  type  dropdown  list  select  Move  reference  point  to  X.  In  the
reference point No field select the reference point of the line. In the Define X field,
enter  the  new  X  coordinate.  The  coordinate  is  given  according  to  the  cross
section’s  chainage,  from  the  diagram  that  the  user  selects  from  the  Diagram
dropdown list. If you want to invert the signs of the selected diagram’s values, you
must tick the Invert  Diagram Signs  check box,  so  that  their  values correspond to
the left part of every cross section. The value entered in the X text field is added to
this  diagram.  If  you want to  use only  the  fixed  value  of  the  Dx  field,  select  the
Without diagram option.

3.To offset the lines vertically by defining the new coordinate of a line point, from the
Modification type dropdown list select Move reference point to H. In the reference
point No field, select the  reference point of  the  line.  In  the  Define  H  group,  enter
the  new  elevation  of  the  reference  point,  as  described  above  for  the  horizontal
offset.

4.To  offset  lines in parallel  by  setting  the  distance  of  the  parallel  offset,  from  the
Modification type dropdown list select Offset. In the Define D  group, set the offset
distance.

Line extension

To extend lines, you must add a new point to the selected lines, either at the start or
at the end of the lines:

1.To add a new point at the start of the lines, by setting the horizontal  and  vertical
distances from the first point of  the  line,  from the  Modification  type  dropdown list
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select  Extend  to  start  with  Dx,  Dh.  In  the  Define  Dx  group,  set  the  horizontal
distance of the new point from the first point of the line. In the Define Dh group, set
the vertical distance. If you type the –1000 value in the Dh field, then the elevation
of the  new point is  determined  by  the  program  in  such  a  way,  so  that  the  new
straight part has the same slope with the first part of the line.

2.To add a new point at the  end  of  the  lines,  by setting the  horizontal  and  vertical
distances from the  last  point of  the  line,  from the  Modification  type  dropdown list
select  Extend  to  end  with  Dx,  Dh.  Set  the  distances  as  described  above  for  the
extension to start.

Line interpolation

You can add a point to a line in two ways:

1.To add a point at a fixed distance from the start of the axes, from the Modification
type  dropdown  list  select  Interpolation  at  X.  In  the  Define  X  group,  define  the
position of the new point by entering the distance from the start of  the  axes.  The
elevation of the new point is determined by the program in such a way, so that the
slopes of the straight parts of the line remain unchanged. 

2.To  add  a  point  at  a  fixed  distance  from  a  certain  point  of  the  line,  from  the
Modification type dropdown list select Interpolation at Dx from reference point.  In
the Reference point No field, select the reference point of the line. In the Define Dx
group, set the distance of the new point from the reference point. The elevation of
the new point is determined by the program in such a way, so that the slopes of the
straight parts of the line remain unchanged. 

Cropping of lines

There are four ways to crop a line:

1.To remove a line segment before a certain distance from the start of the axes, from
the  Modification  type  dropdown list  select  Crop  before  X.  In  the  Define  X  group,
enter the distance from the start of the axes. The line segment that will be removed
is located on the left of the user-defined distance.

2.To  remove  a  line  after  a  certain  distance  from  the  start  of  the  axes,  from  the
Modification type dropdown list select Crop after X. In the Define X group, enter the
distance  from  the  start  of  the  axes.  The  line  segment  that  will  be  removed  is
located on the right of the user-defined distance.

3.To remove the line segment before a certain distance from a reference point,  from
the Modification type dropdown list select Crop at Dx before reference point. In the
 Reference  point No  field,  select  the  reference point of  the  line.  In  the  Define  Dx
group, set the distance from the reference point.

4.To  remove  the  line  segment  after  a certain distance  from a reference point,  from
the Modification type dropdown list select Crop at Dx after reference point. In  the
Reference  point No field,  select  the  reference point of  the  line.  In  the  Define  Dx
group, set the distance from the reference point.
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9.18.8 Batch Cross Sections Management

Anadelta Tessera offers features for the batch management of cross sections.  These
operations  can  be  carried  out  from  the  dialogue  box  of  the  Cross  sections
management command of the Batch Actions menu.

From this box, you can perform four  operations  (cross  section  deletion,  line  deletion,
line offset, modification of typical task), as described below.
The dialogue box is comprised of three groups. The desired operation is selected from
the Action group.

Batch Cross Section Deletion

You can delete simultaneously as many cross sections as you wish from your project.

How to delete simultaneously multiple cross sections

1.Open the dialogue box of the Cross sections management command and select the
cross sections you wish to delete.

2.From  the  Action  group,  tick  the  Delete  cross  sections  check  box.  To  delete  the
selected  cross  sections,  click  the  Apply  button.  The  program  will  prompt  you  to
confirm that  you wish  to  delete  the  cross sections,  by  showing  you  the  relevant
confirmation message. Click Yes to proceed or click No to cancel the procedure.

3.When you have finished, click the Exit button to close the dialogue  box and  return
to the Cross Sections workspace.

Deleting all Lines, apart from the Natural Ground

You can delete  all  lines  of  the  selected  cross  sections,  apart  from  the  line  of  the
Natural Ground task. 

How to delete all lines of the selected cross sections

1.Open the dialogue box of the Cross section management  command  and  select  the
cross sections you wish to edit.
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2. In the Action group, tick the Delete all  cross sections lines (except Natural ground)
and click the Apply button to proceed. The program will prompt you to confirm that
you  wish  to  delete  the  cross  sections’  lines,  by  showing  you  the  relevant
confirmation message. Click Yes to proceed or click No to cancel the procedure.

3.When the procedure has been completed, click the Exit button to close the dialogue
box and return to the Cross Sections workspace.

Moving cross section’s lines

You can move all  lines of the  selected  cross sections.  The  lines are  moved  at  fixed,
user-defined distances (horizontally and vertically). 

How to move all lines of the selected cross sections

1.Open the dialogue box of the Cross section management  command and  select  the
cross sections you wish to edit.

2. In the Action group, tick the Translate cross section lines check box. In the Dx and
Dh fields, type the horizontal and vertical distance, respectively, and then click the
Apply button to proceed. The program will prompt you to  confirm  that  you wish  to
move the cross sections’ lines, by showing you the  relevant  confirmation message.
Click Yes to proceed or click No to cancel the procedure.

3.When the procedure has been completed, click the Exit button to close the dialogue
box and return to the Cross Sections workspace.

Changing the Typical Task of all Lines

You  can convert  all  lines of  the  selected  cross sections,  apart  from the  line  of  the
Natural Ground, into lines of the DRW or AUX typical tasks. This  feature can be very
helpful  in  case  you  wish  to  view  two  different  configurations  in  the  same  cross
section.  Namely,  you  can  first  apply  a  typical  cross  section,  then  convert
simultaneously all lines into a Drawing and finally apply a second typical cross section
to  the  project’s  cross  sections.  In  this  way,  you  will  be  able  to  view  both  of  the
applied solutions to every cross section. 

How to change the typical task of all lines of the selected cross sections

1.Open the dialogue box of the Cross sections management command and select the
cross sections you wish to edit.

2. In the Action group, tick the Convert cross section lines into check box.
3.From  the  dropdown list,  select  one of  the  typical  tasks  [AUX]  Guideline  or  [AUX]

Typical  Slopes  or  [DRW]  Drawing  and  click  the  Apply  button  to  carry  out  the
procedure. The  program will  prompt  you to  confirm  that  you  wish  to  convert  the
cross sections’ lines, by showing you the  relevant  confirmation message.  Click  Yes
to proceed or click No to cancel the procedure.

4.When the procedure has been completed, click the Exit button to close the dialogue
box and return to the Cross Sections workspace.

9.18.9 Batch Cross Section Import from another Project

Anadelta Tessera enables you to  import into your  current  project  one or  more cross
sections  from another  project.  This  action  imports  all  of  the  desired  cross  sections
simultaneously.

How to import cross sections from another project

1.From  the  File  menu,  select  the  Import  submenu  and  run  the  Cross  Sections
command.

2.From the resulting dialogue box, select the file from which the cross sections will be
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copied. Next, click Open.
3.The following dialogue box appears on the screen:

4.The displayed cross sections correspond to the file you selected  previously;  select
which  of  these  cross  sections  will  be  imported  into  your  project.  Make  your
selections in the Selected cross sections and Cross Section Selection groups.

5.From  the  dropdown list  of  the  Road  selection  group,  select  the  road  whose  cross
sections you wish to add into your project.

6. In the Insert new with group, define  how the  cross sections will  be added.  If  you
tick the Overwrite old  cross sections  check  box,  the  program will  insert  all  of  the
selected  cross  sections  and  if  a  cross  section’s  chainage  coincides  with  the
chainage of  an  existing  cross  section,  the  latter  will  be  deleted.  If  you  tick  the
Preserve  old  cross  sections  check  box,  the  program  will  only  insert  the  selected
cross  sections  if  their  chainages  are  different  from  the  chainages  of  the  cross
sections that already exist the file.

7. In the Offset new cross section’s  Ch  by  text  field,  set  the  distance  by which  the
new cross sections’ chainages will be offset. Please note that the actions of step 6
above will be based on the new chainages.

8. If  you tick  the  Typ.  Tasks  and  Typ.  Cross  Sections  sync  box,  the  typical  cross
sections and the typical tasks of the source file will also be copied to your  current
project. 

9.When you have finished, click the Exit  button to close the dialogue  box and  return
to the Cross Sections workspace.

9.18.10 Batch Cropping of Lines

After the cross section calculation, you can batch crop the right or the left part of the
cross  section  at  a user-defined  distance  from the  axis.  To do  this,  select  the  Crop
Lines commands from the Batch Actions menu. The following window will appear on the
screen:
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Select  the  cross sections you wish  to  crop.  You  can also  select  the  Lines  cropping
side, as well as the cropping distance  from the  axis by entering  the  desired  value  in
the Crop at field. If the segment  to  be removed  is  at  the  left  of  the  axis,  then  you
must first choose the left side and  then  enter  a negative  value  in the  Crop  at  field.
Namely, in this case it is not enough to just select the left side.
The  Crop  Lines  command  removes  the  selected  segment  from  the  cross  sections,
closes the cross sections and calculates them with Points, leaving the Natural Ground
line unaffected.

9.18.11 Natural Ground from Cross Slopes

Anadelta  Tessera  enables  you  to  create  terrain  from  cross  slopes.  This  feature  is
required  only  in  cases  where  an  approximate  presentation  of  the  natural  ground  is
needed, when the only known data are the profile and the cross sections.  To create
terrain from cross slopes, run the Natural Ground from Cross Slopes command from the
 Batch Actions menu. The following dialogue box will appear on the screen:
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To  create  a  new  terrain  from  cross  slopes,  you  must  first  make  the  Cross  Slopes
Diagram (if it does not exist already). To create a diagram, proceed as follows:

· From the Parameters menu, select the Diagrams command.

· In the resulting dialogue box, click the  button. From the resulting dropdown list,
select the diagram you wish to make (in this  case, the  Natural  ground  cross slope
diagram). The values that you will enter for the slopes will be in (%), namely for  a
10% slope, simply  type 10.  Negative  slope  values mean  that  the  ground  descends
from left to right. 

· Enter the desired values and click the OK button to close the window. 
In  this  window,  it  is  also  possible  to  select  multiple  cross  sections  by  clicking  the
Select button, or you can select cross sections based on their Chainage.
In the Width left and Width right fields of the New ground section, type the boundaries
of the ground that will be created.  
Click the New button  to  erase  the  old  ground  and  create a new one based  on  your
settings.  
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9.19 Creating Diagram from Point

The cross sections workspace enables you to create a Dx or H diagram, regardless of
whether the cross sections are calculated or there is only the natural ground line. This
Dx or H diagram will be saved in the cross sections diagrams (Parameters - Diagrams).
To do this, select the Diagram from Point command of the Tools menu. The following
window will appear on the screen,

and you must select the cross sections whose points will be included in the diagram to
be  created.  Select  the  desired  cross sections from the  Selected  cross sections  and
Cross section selection groups. 
You can select the desired point in two ways: either by specifying directly the point or
by settings the point’s distance from the axis. Both ways are explained in detail below:
Directly: 
· By selecting the reference line through the from reference line field, you can enter

directly the number of the reference line’s point, based on which the diagram will be
created (-1 for the last point, -2 for the last but one point, etc.).

· By  selecting  the  from  flag  option,  the  point  to  be  exported  is  the  one  you  have
already marked with a flag in the cross section (e.g. Pavement, Roadway, etc.).

Indirectly:
· By selecting the reference line and then the from axis option,  you can set  directly

the point’s distance from the axis. When the point is located to the right of the axis,
the distance has positive values, while when the point is located to the  left  of  the
axis, the distance has negative values.

· By  selecting  the  reference  line  and  then  the  from  diagram  option,  the  point’s
distance from the axis will be determined according to  the  diagram’s values.  If  you
wish to increase the distance determined from the  diagram,  enter  the  value  of  the
additional  distance  into the  Dx  field.  If  you  are  referring  to  the  left  side  and  the
diagram’s values are positive (e.g. pavement width, roadway width), tick the Invert
diagram signs check box. 

In the Diagram to be created field, you can enter  the  desired  name of  the  diagram.
The  with  distances from  and  with  elevations  options  refer  to  the  type  of  the  new
diagram,  namely  the  diagram  will  be  created  based  either  on  the  point’s  relative
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distance from the axis or on the absolute point elevation (point  profile).  To save  the
new diagram, click the New button.
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9.20 Excavations

The  Excavation  Percentage command of  the  Tools  menu  determines  the  excavation
percentage  for  all  of  the  project’s cross sections,  so  that  you don’t  have  to  define
them  separately  for  every  cross  section.  You  must,  of  course,  use  this  option  to
determine the excavation percentage before calculating and printing the Mass Table or
the cross sections drawings. The use of this command results in the following window:

The  first  and  second  columns  show the  names  of  the  cross sections of  the  current
road (Cross  Section)  and  their  chainages.  It  is  not  possible  to  edit  this  information
here, you can only  change it  from the  window  of  the  Cross  Section  Data  command,
separately for every cross section.

The next columns show the excavation percentages, which can be separated in up to
five  categories.  In  these  columns  you  can  enter  the  percentages  for  every  cross
section, by typing their values in the fields of the values table. The values are entered
in  percentages,  from  0%  to  100%.  The  sum  of  a  cross  section’s  excavation
percentages must be equal to one hundred.

To move between the columns, use the Tab key for moving from left to  right,  or  the
Shif+Tab keys for moving from right to left. You can also use the arrow keys to move
up, down, right and left, while if you use the mouse you can go directly to the desired
field by clicking the right or left mouse button. 

To copy a whole set of consecutive  cells,  select  the  desired  cells  and  click  the  
button at the top right of the  window. To select  multiple  fields,  hold the  Shift  down
and use the arrow keys. Next,  select  the  area to  which  the  cells  will  be copied  and

click the  button. If you wish to zero the values of certain cells, select the cells by

following the aforementioned copy procedure and then click the   button.
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In  all  cases,  when  you  have  finished,  click  the  OK  button  to  apply  the  new
percentages to all  cross sections.  Finally,  you can import and  export  the  excavation
percentages to/from a text file.

Names of Categories

To  change  the  names  of  the  excavation
percentages,  open  the  Parameters  menu
and run the Road Preferences command. In
the  Percentages  tab  you  will  find  the
categories’  names  (K1,  K2,  K3,  K4,  K5),
which are originally assigned by default  by
the  program  (e.g.  Rock,  Semi-rock,  Soil).
More specifically, for every category there
is the Category Name text field. Type  the
desired name in this field and then click OK
to  save  your  settings.  The  titles  of  the
columns  in  the  window,  as  well  as  the
titles  of  the  mass  table  subcolumns  are
updated automatically.

Importing Percentages from a Text File

You can import into your project all excavation percentages for every cross section, if
they are available in electronic form (ASCII text  files).  You  can do  this  at  any given
moment,  either  during  the  initial  stage  of  the  design  or  at  a  later  stage,  when
processing your design, and as many times as you wish.

How to import excavation percentages from a text file

1.From  the  dialogue  box  of  the  Excavation  percentage  command,  click  the  
button.

2.A  dialogue  box appears on  the  screen.  Select  the  desired  file  and  click  the  Open
button. The file to select must have the form shown in the next section.

3.Finally, the program will ask you to specify the way in which it will check whether a
cross section in the APS file exists in your project. Namely, the check will be based
on the cross section’s name or chainage. 

Click  the  Name  button for  the  check  to  be carried  out  based  on  the  cross  section
name, or click the Chainage button if you prefer the check to be carried out based on
the chainage.

Click either button for the update to  take  place; the  new percentages are  displayed
on the screen.

Specifications of Percentages Text Files (APS)

The cross section data in a file of this type is arranged by columns. Each row  of  the
file corresponds to a cross section. The form of these files is as follows:
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The file is  comprised  of  the  following  columns:  Cross  section,  showing  the  names  of
the  current  road’s  cross  sections,  Chainage,  showing  the  chainage  of  every  cross
section, and five additional columns,  K1,  K2,  K3,  K4  and  K5,  showing  the  excavation
allocation percentages for every cross section. 

Exporting Percentages to a Text File

You can export from your project  to  a text  file  all  excavation  percentages for  every
cross section.

How to export the excavation percentages to a text file

1.From the dialogue box of the Excavation percentage command,  click  the   Save
button.

2. In the resulting dialogue box, specify the path and the name of the file and click the
 Save button.
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9.21 Mass Table

Before starting describing the creation of a mass table, it is worth mentioning in brief
certain general information that will help you better understand this procedure.

The total mass volume is the sum of  the  individual  volumes  between  two successive
cross sections of the road.

These individual volumes are limited, as shown in the figure below:

1.By the E1 and E2 vertical surfaces of two successive cross sections.
2.By the Π1 and Π2 surfaces of the sideslopes on both sides. 
3.By the surface of the roadway.
4.By the F surface of the natural ground. 

The necessary data for the calculation of the individual volumes are the areas of  the
Ε1 and Ε2 surfaces and the λ distance between them.

Therefore, by applying the approximate formula:

we can calculate  the  volume  contained  between  the  1  and  2  cross  sections  for  a
given  distance between them.

Mass Volume Calculation Methods.

Two methods are commonly used for the approximate calculation of the mass volume:
the method of average surfaces and the method of applicable lengths.

Let’s  assume  that  in  a  complete  cutting  (or  filling)  you  have  the  successive  cross
sections 1,2,3,..., whose  respective areas are  Ε1,  Ε2,  Ε3,...  The  distances between
the cross sections are λ1, λ2, λ3, ...

Method of Average Surfaces.
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By applying the familiar formula,

the result will be:

The   are  referred  to  as  average  surfaces  and  therefore  the
calculation of the V volume with the use of the above formula is referred to as method
of average surfaces.

The formula commonly used is:

Method of Applicable Lengths.

The above formula can also be written as follows: 

The   are  referred  to  as  applicable  lengths  and  therefore  the
calculation of the V volume with the use of the above formula is referred to as method
of applicable lengths.

The formula commonly used is:
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Through the  typical  tasks, the  user  can define  the  number  of  the  available  columns
that may be displayed in the mass table, as well as their titles (the title must be short
and  it  cannot  occupy  more  than  two  lines  per  column).  The  program  calculates,  if
applicable, the length and area of every typical task – line of a cross section (for the
method  of  average  areas,  the  program  calculates  the  average  length  and  area
between two successive cross sections). During the mass table calculation, the length
or the  area are  multiplied  by the  applicable  length  or  by the  distance  between  two
successive cross sections (depending on the method that is applied) in order to  give
the  respective  surface  and  volume  quantities.  These  quantities  are  summed  up
cumulatively. Each column of the mass table can be divided in a maximum of  twenty
(20)  subcolumns  and  when  the  mass  table  is  being  created,  you  can  select  the
subcolumns  you  wish  to  be  displayed.  These  subcolumns  are  the  Area  with  the
respectively  produced  Volume,  the  Length with  the  respectively  produced  Area,  the
Current Meters, and, for every category of allocation percentages (K1, K2, K3, K4 and
K5), the percentage, the allocated area and the allocated volume. 

As shown in the figure below (mass table):

In addition to the user-selected columns, the mass table always contains the columns
that  show  the  cross  section’s  name,  the  cross  section’s  chainage,  the  distance
between and the applicable length (if this is the selected method), based on which the
volumes and surfaces will be calculated.
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9.22 Mass Table Creation

To open the mass table creation window, go to the Print menu and run the Print mass
table command.

When creating the mass table, you can first select some general information that you
wish to view at the top of the mass table’s first page. To do this, use the fields of the
window shown below: 

To open this window, click the  Table Titles button. In the Main title of mass table
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field, enter the main title of the table. In the next two groups, enter the left and right
titles respectively. 

To  change  the  names  of  the  titles  for  the  Fixed  Columns  and  the  Mass  Haul

Subcolumns, click the Fixed columns  button to open the window shown below:

 In the two groups of the window, enter the titles for the axis data and for the mass
haul, respectively. 

Next, select the columns, namely the quantities that will be printed in the mass table,
as well as the quantity type (area, volume, length, etc.). From the Available Columns
check list,  which  contains  all  columns  of  the  Mass  Table  that  were  defined  in  the
typical tasks, select one or more columns by clicking in the box next to  the  column’s
name.  The  column’s  name  will  be  immediately  displayed  on  the  Selected  columns  -
subcolumns List. From the Subcolumns check list, select the  desired  subcolumns  you
wish to include in the current column. The columns and subcolumns of the Mass Table
are  displayed  in the  order they were entered.  If  you  wish  to  change  their  order  of
appearance, use the mouse to select the column or the subcolumn you want to move,
then drag-and-drop it to the desired position. 

If  you  want  to  change  a  subcolumn’s  name,  select  the  subcolumn,  click  the  right
mouse  button,  and  from  the  displayed  menu  run  the  Rename  command.  In  the
resulting dialogue box, 

type the new name of the subcolumn and click the OK button.
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If  you  have  selected  to  calculate  the  mass  table  for  a  set  of  cross  sections  by
applying  the  method  of  applicable  lengths,  then  you  can  choose  whether  the
applicable length of the first and last cross section of the set  will  be calculated  with
the contribution of the previous and next cross section, respectively, by enabling the
Include unselected cr. sections option.

Next,  you  can  proceed  to  the  calculation  of  the  mass  table  by  clicking  the  Print
button. When the calculation is completed, the Mass Table Preview window opens and
you can print the mass table. 

Mass Haul

Especially for the Mass Haul column, please note that: 

· The program will display the mass haul for  two quantities.  The  first  quantity is  the
one that has been marked with an + in the Selected columns-subcolumns list and is
deemed positive (usually  the  cuttings) and  the  other  quantity is  the  one that  has
been  marked  with  an  –  and  is  deemed  negative  (usually  the  fillings).  To  mark  a
quantity  as  positive  or  negative,  select  the  quantity  from  the  Selected  columns-
subcolumns list, click the right mouse button, and  from the  displayed  menu,  select
Positive for mass haul or Negative for mass haul, respectively.

· When selecting columns, the  table  must  also  show the  columns  that  contribute  to
the mass haul (e.g. cuttings and fillings) and then the mass haul column.

· Before  the  calculation  of  the  table,  you  must  also  define  the  relevant  expansion
coefficients, in order that they are properly included in the volume calculation.

Text Font

You can select the font that will be used for  printing  the  mass  table,  as  well  as  the
font size and style.

To  change  the  font  or  the  font  size  –  To  use  bold  or  italics  in  selected  text  or
numbers

1. In the Mass Haul dialogue box, click the  Font icon. 

2. In the dialogue box of the Font command,
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select the desired font from the  Font  list,  and  then  select  the  desired  script  from
the Script list.

3. From the Size list, select the desired font size.
4.From the Style  list,  select  the  desired  font style.  The  Sample  preview  field  shows

how the text will be displayed according to your settings.
5. In all  cases, click the OK button to close the dialogue box, save  your  settings  and

return to the previous dialogue box.
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9.23 Mass Table Printing - Export

You  can  print  the  Mass  Table  through  the  environment  of  Tessera.  You  can  also
transfer the Mass Table data to Microsoft Excel, for further processing.

Mass Table Printing- Export

To print the Mass Table, follow the two simple steps below.

1.Select a printer and set its properties (paper size, orientation, etc.).
2.Request  the  calculation  of  the  mass  table  quantities  and  the  layout  of  the  mass

table according to the print preferences.

The steps for printing the Mass Table are described in detail below.

Printer Selection – Print Properties Setting

First you must set the print preferences, such as the orientation and the paper size.

How to set the print preferences

1.From the Print menu, run the Mass Table Print command and then click the  icon.
2. In the Print parameters dialogue box, 

select one of the available printers from the drop-down list of the Printer group. The
other fields of the group show information about  the  selected  printer,  such  as  the
status, the model, the port or the location of the printer, as well as any additional
user-defined information – comment. 

3.To change the print options, click the Properties button.
4. In the Size field (paper size) of the Paper group, select from the drop-down list one

of the available paper sizes. In  the  Source  field,  select  one of  the  available  paper
feed trays. 

5. In the Orientation group, select the orientation of the text on the paper for printers
that support landscape orientation (Horizontal) or portrait orientation (Vertical).

If you change the current printer, the settings that are supported by the new printer
will be kept, while all other settings will be replaced by the default settings of the new
printer.
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Mass Table Preview

When you have finished setting the print preferences according to the aforementioned
procedure, you can first display the print preview of the Mass Table and then print the
table.

To preview a Mass Table

1.Click the Print button. The Mass Table Preview window appears on the screen.  

2.Click the maximize button in the title bar to view the window on full screen.
3.This window is comprised of the following items:

· Preview: the bottom part of the window where the image of the whole or part of the
table’s page is displayed.

· Toolbar: this is located at the top of the window. It carries the buttons that control
the  transition  from  page  to  page  and  the  modification  of  the  size  of  the  page’s

viewable  area   .
More  specifically,  the  buttons  of  the  toolbar  are  the  following  in  order  of
appearance:

· First page: Left-click on the first button to view the first page. 
· Next page: Left-click on the second button to view the next page. 
· Previous page: Left-click on the third button to view the previous page.
· Last Page: Left-click on the fourth button to view the last page.
· Zoom In: Left-click on the fifth button to zoom in on  the  page.  The  Zoom feature

does not affect the print size. 
· Zoom  Out:  Left-click  on  the  sixth  button  to  zoom  out  of  the  page.  The  Zoom

feature does not affect the print size. 



342 Anadelta Tessera

Anadelta Software

· Full  Frame:  Left-click  on  the  seventh  button to  return  to  the  original  view of  the
mass table.

· Print: Left-click on the eighth button to set the options before printing and to print
the Mass Table.

· Page Information: This  section  displays  the  number  of  the  current  page  and  the
number of the total pages of the mass table.

Mass Table Print

You can print the whole Mass Table or part of it in one or more copies.

How to print the Mass Table 

1. In the preview window, click the  button.
2. In the dialogue box of the Print command, make the desired settings.
3.Click the OK button to start printing the Table.

If desired, you can print only part of the Mass Table in more than one copy. 

Exporting the Mass Table to Microsoft Excel

You can transfer the Mass Table data to Microsoft Excel for further processing.

How to transfer the Mass Table data to Microsoft Excel

1. In the Mass Haul dialogue box, click the  button.
2. In the resulting dialogue box, specify the path and the name of the file and click the

 Save button.
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9.24 Dimensioning Points - Roadlines

To go to the dimensioning mode, lick the  button on the View toolbar. In the cross
section  you  can  see  the  dimensioning  and  roadlines  points,  which  determine  the
dimensions on the printout and create the roadlines in the Horizontal Alighment. 

For a point to be taken into account in the printout dimensioning, select the point and
from  the  Flags  definition  form,  select  Distance  if  you  wish  to  view  the  distance
between  two  successive  points,  or  Superelevation  if  you  want  to  view  the
superelevation of the segment to which the point belongs.  If  you want to  view both
the Distance and the Superelevation, select both options.
During cross section calculation with Typical, dimensioning is performed automatically if
these points have already been defined in the typical cross section. 

From  the  second  section  of  this  form you  can  define  how  the  Horizontal  Alignment
roadlines will  be created.  More  specifically,  you can define  the  cross section  points,
whose distances from the  axis will  be transferred to  the  Horizontal  Alignment  when
you run the Update  roadlines  from Cross  Sections  to  Horizontal  Alignment  command.
This kind of definition allows for a fully parametric configuration of the roadlines in the
Horizontal  Alignment,  so  that  the  roadlines  reflect  the  calculated  structures  in  the
Cross Sections in the best possible way.  
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9.25 Print Setup

In order to print-draw the cross sections, use the commands of  the  Print  menu.  The
commands of this menu are: 

1.Page Setup.
2.Print Preferences.
3.Cross Section Printing.

These commands must be used in the order they appear in the print menu. 

Print Preferences

The cross sections printing settings include the scale, the page margins, the font size
on the printout, as well as some more detailed settings. To make the  aforementioned
settings, run the Print preferences command of the Print menu. The resulting window
has three tabs:

1.The Configuration tab.
2.The Text options tab.
3.The Settings tab.

Configuration

The  Configuration  tab  enables  you to  set  multiple  scales,  so  that  the  program  may
select the most appropriate one. In the Scale group, you can set up to five scales. To
enable or disable a scale, tick or untick respectively the check box to the left  of  the
scale.  You  can also  set  directly  the  value  of  every  scale,  by  typing  it  in  the  right
check box. 

In  order to  print  the  cross sections,  the  program places the  cross sections  starting
from the top left part of the page and  continuing down or  to  the  left,  depending on
your  selection  in  the  Cross  section  scanning  group.  For  every  cross  section,  the
program checks whether it fits into the available height and width of the page, and if
not, it places the cross section by using a lower scale. If the cross section cannot be
printed in any scale, then the program adds this cross section to those that do not fit
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in the page and proceeds to the next cross section. When printing  is  completed,  the
program informs you on the cross sections that were not printed; these cross sections
remain selected. 

In the Cross sections per page group, tick the Up to check box and enter the desired
value to set the maximum number of cross sections that will be printed on one page. If
you wish to print  on  one page all  of  the  cross sections that  fit,  tick  the  all  that  fit
check box.

In the Distance between cross sections group, set the distances between  two cross
sections that will be printed on the same page. In the Horizontally (cm) and Vertically
(cm) fields, enter the horizontal and vertical distance, respectively. In the  same  way
(in  cm)  you  can  set,  if  desired,  the  margins  that  will  be  left  around  the  page,  by
entering the relevant values in the Top (cm), Bottom (cm), Left (cm) and Right (cm)
fields of the Page margins group. 

In the Natural ground printing limits group, set in meters the  natural  ground  and  the
topsoil that will be printed left and  right  to  the  extremes  of  the  cross section  works
and from the axis. If you wish to print the whole  natural  ground, simply  enter  a high
value, e.g. 200. If you tick  both  check  boxes, namely from  construction  (m)  or/and
from axis (m), the program calculates both distances and draws the natural ground up
to the longest resulting distance. 

The Dimensioning group refers to the dimensioning of the cross sections’ roadway and
to the printing of the superelevations. If you wish to  place  the  dimensions  on  top  of
the cross section, tick the Position check box. If you wish to place the dimensions at a
fixed  distance, over the  roadway,  tick  the  Over  the  roadway  check  box and  in  the
field  below,  enter  the  distance  in centimeters.  In  the  Superelevations  group,  select
whether the printout will include only the values of  the  superelevations  or  both  their
values and their arrows.

Text options

In the Text options tab, you can choose which of the available texts will be displayed
on the  cross section  printout,  by ticking  the  respective check  boxes.  You  can  also
select  the  font,  the  font  color  and  the  font  size.  If  the  cross  sections  are  to  be
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exported in a DXF file, in the same tab you can select the layer to which a text will be
exported. 

Settings

This Settings tab is comprised of two groups. 

In the Appearance order in quantity legend group, select the areas or the lengths that
will be printed below the name and chainage of the cross section. In the Appearance
order  in Dx-H  legend  group,  select  the  lines  whose  coordinates  will  be  printed  in  a
legend below the cross section drawing. Note that these settings are also available in
the dialogue box of the Typical Tasks command. 
The procedure is the same for both groups: If you want to print a quantity or a task,
tick the check box next to its name. If you wish to change the order of appearance on
the  printout,  use the  mouse  to  select  the  desired  quantity or  task,  and  then  drag-
and-drop it to the desired position. 
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9.26 Cross Sections Printing

To print cross sections, run the Print cross sections command of the Print menu.

The  buttons at the top of the resulting window open the dialogue boxes for
setting the print preferences and the page setup preferences, respectively. From the
Selected cross sections and Cross section selection groups, select the cross sections
that will be printed.  

To  preview  and  then  print  the  selected  cross  sections,  click  the  Print  button.  A
window will  appear  on  the  screen,  showing  the  print  preview  for  the  selected  cross
sections.

To print the cross sections drawing, click the  button in the preview window. The
dialogue box of the Print command opens and you can make your last settings before
printing the cross sections. Next, click the OK button to start printing.

To close the preview window, click the Exit  button. The Information group shows you
how  many  cross  sections  have  been  selected,  how  many  pages  are  required  for
printing the  selected  cross  sections,  and  how  many  cross  sections  fit  in  the  page
margins,  according  to  the  page  setup.  If  you  printed  the  cross  sections  (not  just
previewed them), then only the cross sections that didn’t fit in the  page margins  will
remain selected, otherwise all cross sections that you selected before the preview will
remain selected until you print them.
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9.27 Data Export

Exporting Lines to an ASCII File

The cross sections’ lines can be saved in an external text file.

How to export the cross sections’ lines to an ASCII file

1.From the File menu, select the Export to ASCII submenu and run the Lines command.
 

2.The following dialogue box appears on the screen:

From  the  Selected  cross sections  and  Cross  section  selection  groups,  select  the
cross sections whose lines will be included in the new file.  

3.Next, open the Export line tab and select the line you wish to export as well as the
file type. Select the line from the  Line  to  save  drop-down  list  and  in the  S/N  field
enter the line’s serial number, in case that a cross section has more than one lines
of the same typical task. If the value you enter is 0, then all  cross section’s lines of
the selected typical task will be exported. In this case, the points between the lines
are  separated  in  the  text  file  by  a  set  of  two  numbers,  -98765  -98765.  This
separation is also taken into account when importing multiple lines from a text  file.
You can create three types of files. The File with Dx – H option results in a file,  in
which the line coordinates are  determined  according to  the  distance  from the  axis
and the absolute elevation. With the File with Dx – Dh  option,  the  line  coordinates
are  determined  according  to  the  distance  from  the  axis  and  the  elevation
discrepancy  from the  profile  elevation  in the  cross  section.  Finally,  when  the  File
with  X,Y,H  option is  selected,  the  coordinates  of  the  lines’  points  are  determined
according  to  the  Horizontal  Alighment  of  the  road.  If  you  select  the  All  points
option,  the  resulting file  contains  all  points  of  the  selected  line.  If  you select  the
Selected  option,  the  resulting  file  contains  up  to  three  points,  depending  on  the
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ticked  check  boxes.  One  of  these  points  is  on  the  axis  and  the  other  two  are
defined from the  start  or/and  the  end  of  the  line.  The  points  in the  file  appear  in
ascending  order  according  to  the  chainage,  and  the  points  of  the  same  cross
section are shown from left to right. 

4.After you have set all parameters, click the Export button. Specify the path and the
name of the file you wish to create. 

5.Click on OK to create the file. The lines’ coordinates will be exported to the specified
file that will have the ACS extension.

How to export one line point per cross section to an ASCII file

From the File menu, select the Export to ASCII submenu and run the Lines  command.
The following dialogue box appears on the screen:

   

From the Selected cross sections and Cross section selection groups select the cross
sections whose points will be exported to the new file.  
Next,  open  the  Export  point  tab.  You  can  export  a  point  in  two  ways:  either  by
specifying  directly  the  point  or  by  setting  the  point’s  distance  from  the  axis.  Both
ways are explained in detail below:
Directly: 
· Select the reference line and from the from reference point field, enter directly the

number of the reference line’s point that you wish to export (-1 for the last point, -2
for the last but one point, etc.).

· With  the  from  flag  option,  the  point to  be exported  is  the  one  you  have  already
marked with a flag in the cross section (e.g. Pavement, Roadway, etc.).

Indirectly:
· By selecting the reference line and then the from axis option,  you can set  directly

the point’s distance from the axis. When the point is located to the right of the axis,
the distance has positive values. When the point is located to the  left  of  the  axis,
the distance has negative values.
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· By  selecting  the  reference  line  and  then  the  from  diagram  option,  the  point’s
distance from the axis will be determined according to  the  diagram’s values.  If  you
wish to increase the distance determined from the  diagram,  enter  the  value  of  the
additional  distance  into the  Dx  field.  If  you  are  referring  to  the  left  side  and  the
diagram’s values are positive (e.g. pavement width, roadway width), tick the Invert
diagram signs check box. 

The Point displacement option enables  you to  move  the  selected  point on  the  cross
section  according  to  the  distance  that  you  enter  in  the  relevant  field;  the
displacement does not affect the point’s elevation.
After you have set all  parameters, click the Export  button. Specify the  path  and  the
name of the new file and click OK to create the file.

You can also export the following items to an ASCII file:

· Percentage Export: This command exports the percentages of  every  cross section.
The  resulting file  will  have  the  .APS  extension  and  shall  include  the  Cross  section
name, the Chainage, and the percentages of the Soil, the Semi-Rock and the Rock.

· Cross  Sections  Data:  With  this  command  you  can  view  in  a  file  all  of  a  cross
section’s  data.  The  file  will  have  the  .TXT  extension  and  shall  include  the  Cross
section name, the Chainage, the X and H of the ground (point on axis), the Azimuth,
the cross section Angle, the cross section Distance from the main axis, the Oblique
width  of  the  left  and  right  pavement,  and  the  Oblique  width  of  the  left  and  right
roadway.

· Calculation Data: This type of export allows you to view in a table the way in which
the cross sections have been calculated. The  resulting file  has the  .TXT extension
and  includes  the  following  information:  the  Cross  section  name,  the  Chainage,
whether or not the chainage has been calculated, the Calculation way (with Typical
or with Points), the Typical cross section  that  has been used,  the  Paving  left  and
right to the axis, the left and right Sideslopes, as well as whether there is a left and
right Guardrail.

· Applied Walls: This command exports all  data of the applied  walls.  The  resulting file
will have the .TXT extension and shall include the Cross section name, the Chainage,
the  Side  to  which  the  wall  has  been  applied,  the  wall  height,  and  the  wall  type
(Filling/ Cutting). 

Exporting Files to DXF

From  the  dialogue  box of  the  Typical  Tasks  command  of  the  Parameters  menu,  you
can select the form and the appearance of the lines, as well as the lines that will  be
exported to the DXF file and the layer to which they will be exported. 

The form of all  other elements that will be exported, is defined from the  dialogue  box
of the Print Preferencescommand of the Print menu. Type the names of the layers for
every category of elements in the respective Dxf layer text box.

How to export data to a DXF file

1.From the File menu, select Export to DXF.
2.Select the desired cross sections from the dialogue box that appears on the screen.

From  the  Selected  cross sections  and  Cross  Section  Selection  groups,  select  the
cross sections that will be printed. 

3.Click the Export to Dxf button. The Export Cross Sections to Dxf window will open,
showing you a preview  of  the  cross  sections.  The  window  is  similar  to  the  Print
Cross  Sections  window  and  most  icons  are  the  same  in  both  windows.  The  only
difference here is the Dxf Export icon instead of the printer icon.

4.Click this icon and in the resulting dialogue  box,  enter  the  name of  the  DXF  file  in
the File Name field.

5. In the File Type field, select the type of the file according to the desired version, 14
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or 2000.
6. Finally, click Save to complete the creation of the file.

All of the selected cross section will be included in the same DXF file. The  layout  will
be the one that you have selected in the Print Preferences. Before exporting the file,
you must have also set the correct drawing scale, which also determines the font size.
Throughout the  program,  the  data  size  (names,  terrain  point  elevations,  PI  names,
station names and any other text) is given in cm. In a DXF file, this size is translated
into “universal” m. The conversion takes place by using the drawing scale.  
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10 Composite Cross Sections

10.1 Horizontal Alignment

The composite cross sections presuppose that at least one or more roads (dependent
 secondary) in the Horizontal Alignment workspace must have cross sections on  the

extension  of  another  road’s  (main  road)  cross  sections.  To  create  composite  cross
sections, proceed as follows:
After  the  creation  of  the  roads  (main  and  secondary  or  only  secondary)  and  the
stationing of the main road, you must proceed to the stationing of the secondary road
based on the main one. To do this, from the Road Design menu, select the Stationing
submenu  and  then  run  the  Stationing (Partial/Dependent)  command. In  the  resulting
window,

select  whether  the  dependent
stationing  will  be  applied  to  the
whole  secondary  road  or  to  a
specific  part  of  it.  This  part  is
defined  in  the  From  Ch.  and  To
Ch. fields. Tick  the  Depending  on
road  field  to  choose  the  road
based on  which  the  stationing  of
the  secondary  road  will  take
place.

In the Station Orientation group, select one of the available options:

· Perpendicular to main road:  With this  option,  the  cross sections of  the  secondary
road become extensions of  the  main  road’s  cross sections.  In  the  Maximum  angle
field,  enter  the  maximum allowable  angle  from the  perpendicular  to  the  secondary
road’s axis; the cross sections that have an angle higher than this value will not be
inserted in the secondary road.
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· Perpendicular to secondary road: With this option, the positions of  the  main  road’s
cross sections are projected to the secondary road. The resulting cross sections are
perpendicular  to  the  secondary  road.  This  type  of  dependent  stationing  does  not
generally result in composite cross sections. 

· With  central  projection:  If  you  select  this  option,  then,  apart  from  selecting  the
main road  on  which  stationing  will  be based,  you must also  select  another  road  –
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axis, on which central projection will be based. With this option, the cross sections
that will be created in the secondary road can be used for the creation of composite
cross  sections.  The  resulting  composite  cross  sections  will  be  placed  at  two
intersecting levels, whose sections will be vertical  lines,  passing  from the  points  of
intersection with the central projection axis. 

Next, the appropriate updates must be carried out separately for every road, from the
Horizontal  Alignment  to  Profile  and  from the  Horizontal  Alignment  to  Cross  Sections.
Then you must create the composite cross sections from the  main  road.  To do  this,
select  the  main  road,  open  the  Project  menu,  run  the  Manage  command  and  in  the
Update group, select from Horizontal Alignment to Composite Cross Sections.
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10.2 Profile

An important tool for studying the profiles of roads that are involved in the creation of
composite cross sections is the New Tangent Curve from projection command of  the
Profile menu. This command enables you to view the road profile of a secondary road
in the current profile. 
The elevation can be calculated either directly from the road profile of the secondary
road or  from the  road  profile  diagram  that  exists  in  the  horizontal  alignment  of  the
secondary road.
Note that a road’s cross sections do not always depend on the other road. 
For  the  aforementioned operation,  open  the  Profile  menu  and  run  the  New  Tangent
Curve from projection command. The resulting window that appears on the screen,

has  two  tabs,  which  include  all  of  the
project’s available roads. To update using the
data  of  the  road  profile  diagram  of  the
Horizontal Alignment,  select  the  road  that  is
displayed  in  the  From  Horizontal  Alignment
tab.  To  update  using  the  data  of  the  road
profile curve of the profile workspace,  select
the  corresponding  road  in  the  From  Profile
tab.  Click  the  OK  button  to  confirm  your
selection and return to the Profile workspace,
or click Cancel to undo your selections. 



358 Anadelta Tessera

Anadelta Software

10.3 Cross Sections

In the cross section’s  workspace  of  every  road,  you will  notice  that  the  axis of  the
other road appears at the positions of the composite cross sections.  The  axis of  the
current road appears in red, while the axes of all other roads appear in blue.
After the calculation of cross sections (separately for every road), you will notice that
the  outline  of  the  every  separately  calculated  cross  sections  appears  in  the  cross
sections space. To view the composite cross sections, you must go to the respective
workspace either by using the  drop-down  list  in  the  View  toolbar,  or  by clicking  the
respective  button  at  the  bottom  of  the  screen  (in  the  same  way  that  you  are
transferred to the cross sections of a road). 
The Oblique Widths must be used for the dependent cross sections (of the secondary
road),  so  that  the  widths,  which  are  increased  due  to  the  obliquity  of  the  cross
section,  as  well  as  the  superelevations  and  slopes are  defined  more accurately.  For
the batch calculation of the cross sections with the use of the oblique values, select
Calculation  from  the  Batch  Actions  menu  and  then  open  the  Paving-Slopes  tab  to
enable  the  Use  oblique  values  option.  If  you want to  apply  the  oblique  values  to  a

particular cross section, click the  button. 
After you have selected the cross sections of the secondary road by using the oblique
values, keep in mind that the values of the typical cross section will be distorted (e.g.
encasing solids, paveway – shoulder superelevation, sideslopes slopes).

Cross Sections Composition

In  the  Composite  Cross  Sections  workspace,  you  will  notice  that  a  new  menu
(Composite)  appears next to the Batch Actions; this Composite menu is enabled only
if you are currently on the composite road.  Therefore,  to  display  all  calculated  cross
sections in the composite cross sections space, from the Composite menu select  the
Update Composite Cross Sections command. To update only the current cross section,

from the same menu select Update Composite or click the   button. All  lines of the
calculated cross sections of both roads will appear on the screen.

Composite Cross Section Preferences

To  define  the  preferences  for  the  calculation  of  composite  cross sections,  from  the
Composite  menu  select  the  Composites’  Preferences  command.  In  the  resulting
window that appears on the screen,
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you  can  select  the  Road  calculation  order  and
the method that will be used for the composition
of the cross sections.
To change the road calculation order, select the
road (e.g. Road 1) and drag it below  Road 2,  if,
for example, you want Road 1 to be the  second
road  that  will  be  calculated.  If  you  want  to
disable a road so that it does not appear at all  in
the  Composites  workspace,  left-click  in  the
relevant  check  box  to  untick  it.  In  the
Composite  cross  section  with  group,  select  a
unique  artificial  ground  if  you  want  the  cross
sections to have a single artificial ground line, or
select  many  different  artificial  grounds,  if  you
want  the  composite  cross  sections  to  have
different artificial grounds.

Click  the  OK  button  to  confirm  the  changes  and  return  to  the  Composite  Cross
Sections workspace.
To set the preferences for a particular cross section, from the Composite menu select

Cross section  preferences  or  click  the   button.  The  same  window  appears,  only
this time the changes you are making are applied only to the current cross section.  
After the update of the composite cross section  and  the  setting of  the  preferences,
you can proceed to cross section calculation  by running  the  Calculation  command of
the Batch Actions menu.  Now  all  composite  cross sections will  have  been calculated
with  Points.  You  will  notice  that  some  green  dashed  lines  have  appeared  on  the
screen. These lines demarcate the boundaries of every cross section’s ground, so that
splitting may take place on the proper axis when you update the individual spaces from
the composite cross sections. You can also enter a splitting axis manually, by clicking

the   button.

Additional Features

The Composite menu offers the following additional options:

· Update  Individuals  from  Composites:  This  command  updates  the  individual  cross
sections from the composite ones.

· Synchronize Typical Tasks: With this option, you can synchronize  the  typical  tasks
of the composite road with the ones of the individual roads.

· Recreate Links: Use the link recreation option when you make certain modifications
(such as deletion or update from the horizontal  alignment) in the  cross sections of
the secondary road and you want to update the composites.

Sending Lines 

Another  feature  is  the  exchange  of  lines  between  the  roads  that  comprise  the
composite road. To do this, run the Send Lines (Comp. Cross Sections) commands of
the Batch Actions menu. The following window will appear on the screen:
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In the Line to be sent field of the Sending  elements  group,  select  from the  available
lines of the drop-down list the line you wish to send from the composite cross sections
to another road (or roads). In the S/N field, enter the serial number of the line that will
be sent to another road. The S/N matters only if the selected line is a line that can be
found in a cross section more than once (-1 to select the  last  line,  -2  to  select  the
last but one line etc.). To send lines of the same typical task or family, enter 0 in the
S/N  field  and  then  select  one  of  the  two  options  (by  Task  or  by  Family).  In  the
Available roads to send line to group, select the road to which the selected line will be
sent. Click the Send button to send the line. Click the Exit button to close the dialogue
box and return to the Cross Sections workspace. 
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11 Typical Cross Sections

11.1 Overview

In  general,  there  are  three  ways  to  create  a  project’s  typical  cross  sections  in
Anadelta Tessera. In the first way, cross sections are created automatically from the
Horizontal Alignment workspace and, apart from the natural ground line in every cross
section,  they also  include  the  pavement  width  diagram,  the  superelevation  diagram
and the  shoulder  width  diagram.  In the  second  way, cross  sections  result  from  the
data of the Profile workspace. In the third way, the user inserts the cross sections in
the  Cross  Sections  workspace  and  the  natural  ground  of  every  cross  section  is
inserted either collectively from ASCII files (e.g. ACS files), or by the user, separately
for every cross section. In all of the aforementioned cases, the user can either select
to calculate the cross sections based on a typical cross section, or to insert the data
of the other cross sections’ lines (artificial ground, paving layers, etc.) manually.

Every cross section project has a library of typical cross sections, which are displayed
in the Typical  selection  drop-down  list,  in  the  left  part  of  the  Typical  Cross  Section
Data window. To open the Typical Cross Section Data window, go to the typical cross
sections  workspace  by clicking  the  Typicals  button at  the  top  of  the  Cross  Section
Data  window.  To return  to  the  cross  sections  workspace,  click  the  Cross  Sections
button.  

A typical cross section can be either created in the typical cross sections workspace
or imported from a file (*.ATD or *.ADF). To import a typical cross section from a file,
go to the Cross Sections  workspace, open the File menu, select the Import submenu
and run the Typ. Cross Sections command.

You can also save one or more typical cross sections in an external file, in order to use
them in another  project  or  keep  them as  a backup copy.  To do  this,  go  to  the  File
menu, open the Export submenu and run the Typ. Cross Sections command.

A typical cross section has two formations, one for the filling and one for the cutting.
The program enables you to define separately the left and the right part of the cross
section for each one of these two formations. Besides, a typical cross section can be
either defined in an absolute way, namely with specific widths and superelevations, or
in a dynamic way, according to the respective diagrams.

When  a  typical  cross  section  is  applied  to  –  calculated  in  a  cross  section  of  the
project, it is actually adjusted to the data of  the  current  cross section.  This  applies
especially  to  the  dynamic  typical  cross  sections,  whose  values  (widths,
superelevations, etc.) depend on diagrams. These typicals are adjusted to every cross
section  according  to  their  chainage  and  to  the  diagram  values  for  the  particular
chainage.
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11.2 Operations

To describe the typical cross section mode, we must create a new file. 

Left-click  on  the  Typicals  button to  enable  the  typical  cross  sections’  creation  and
editing mode and to display one of the typical cross sections that are included in our
project:

This  mode  enables  you  to  create  and  test  a  typical  cross  section,  by  making
separately the settings for all main parts of the typical.

The  program screen in the  Typicals  workspace  is  very similar  to  the  window  of  the
Cross  Sections  workspace  and  has  the  same  menus.  The  difference  here  is  that
certain  commands  of  the  Actions,  Parameters  and  Print  menus  are  disabled.  This
window  also  features  the  main  toolbar  and  the  View  toolbar.  The  Cross  Sections
toolbar has only one button, the one that creates the line. 

A new window appears now in the left part of the program screen (in the same place
where  the  Cross  Section  Data  window  appeared  in  the  Cross  Sections  workspace).
This is the Typical  Cross  Section  Data  management  window, which  is  very similar  to
the previous one.
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The  management  window  is  primary,  since  here  you
can  make most  of  the  settings  referring  to  a  typical
cross section, while you can also view all  values of the
calculation  parameters  for  the  current  typical  cross
section. The name of the current typical cross section
(the  one you see  on  your  screen) is  displayed  in  the
Typical  Cross  Section  Selection  drop-down  list  of  the
window.  Exactly  below  this  list,  there  is  a  number,
showing you to  how many  cross sections the  current
typical cross section has already  been applied  in your
current project.
If  you  wish  to  enlarge  the  drawing  area,  you  may
choose not to display the management window. To do

this, click  the   button in the  View toolbar.  If  you
wish  to  display  again  the  Typical  Cross  Section  Data
window,  click  again  the  same  button.  When  the
management window is closed, the name of the typical
cross section appears in blue letters at the top left of
the drawing area.

The message window is displayed at the bottom of the screen and exactly below you
can see the status bar, just like in the Cross Sections workspace.

When defining the typical cross section, and generally every time you define slopes or
superelevations,  the  values  must  be  entered  in  percentages,  while  every  time  you
define distances, elevations, Dx, Dy values, they must be entered in meters. E.g., for
a 2/3 or 1/1.5 slope (where 2/3 is the ratio of y/x)  enter  66,6666  or  for  a 1:1  slope
enter 100, while for a 3:1 slope enter 300).
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11.3 Management

Importing Typical Cross Sections from a File

To import typical cross sections from an external file into the current project, use the
Typ. Tasks command of the Import submenu of the File menu. You can import typical
cross  sections  either  from  another  project  of  Anadelta  Tessera  (*.ADF),  or  from  a
typical cross sections text file. Note that the typical cross sections text files that are
exported from Anadelta Tessera have the *.AΤD extension.

How to import typical cross sections from another file

1.From  the  File  menu,  select  the  Import  submenu  and  run  the  Typ.  Cross  Sections
command.

2.The Open dialogue box appears on the screen. From the File Type  field,  select  the
type of file (*.AΤD or* .ADF), then select the desired file and click Open.

Creation of Typical Cross Sections Files (*.ATD)

You can save one or more cross sections of a project in the program’s external library
(C:\Program Files\Anadelta\Tessera\Csec) as a typical cross sections file. The default
extension of these files is .ATD.

How to export typical cross sections to a text file

1.From  the  File  menu,  select  the  Export  submenu  and  run  the  Typ.  Cross  Sections
command.

2.The Save dialogue box appears on the screen. Enter the name of the file  and  then
click the Save button.

Changing the Name of a Typical Cross Section

To change the name of the current typical cross section, click the Name Change 
button in the toolbar at the top of the management window. In the resulting dialogue
box,

type the new name in the relevant field.  Now  the  new name will  be displayed  in the
typical cross section selection list.

Typical Cross Section Selection

To select a typical cross section of the project, use the drop-down list in the Typical
Cross Section Data window. 
This is the Typical  Selection list, where you can see the  name of  the  current  typical
cross  section.  If  you  left-click  on  the  list,  a  menu  appears  with  all  typical  cross
sections  of  the  current  project,  and  you  can  choose  the  typical  you  wish  to  edit.
When  you  select  a  typical  cross  section,  below  the  list  you  can  see  whether  this
typical has been applied or not to any of the current project’s cross sections.
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Typical Cross Section Creation

By  default,  every  new file  contains  some  typical  cross sections.  You  can use  these
typicals as they are or you can edit them in order to  meet  the  requirements  of  your
projects. In addition, you can create as many new typical cross sections as you want.

How to create a new typical cross section

1.From the Typical  Cross  Section  Data  window, click  the  New Typical  Cross  Section
button.

2. In the resulting dialogue box that appears on the screen, enter the data of the new
typical cross section (name). 

3.When  you  have  finished,  click  the  OK  button  to  create  the  new  typical  cross
section.

The clicking of this button creates a new typical  cross section,  which  is  an  identical
copy of  the  one that  was  the  current  typical  cross section  before  you  started  the
creation process. The new typical cross section will be displayed in the  drawing  area
and in the Typical Selection drop-down list.

Deleting a Typical Cross Section

To  delete  a  typical  cross  section,  click  the  Delete  Typical  command  in  the  typical
cross sections management window. In the  confirmation message that  appears,  click
Yes to confirm that you wish to delete the typical cross section, otherwise click No.
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11.4 Main Parts

A typical cross section is comprised of certain main parts, which  can be defined  in a
number of ways. These main parts are described below. 

The  simplest  form  of  a  typical  cross  section  has  only  the  Artificial  Ground  line.  An
example of such a typical cross section is shown below:

Select it to display the cross section. To view the cutting and filling formations, click

the  or the  button, respectively. The Artificial  Ground is comprised of a single
line.  The  top  part  of  the  line  (the  one  where  the  paving  layers  are  seated)  is  the
ledge, while the  side  sloped  parts  are  the  sideslopes.  To view the  ledge  parts,  click

the   button.  The  reason  for  this  distinction  is  that  the  points  of  the  Artificial
Ground’s ledge line are defined in a different way than the sideslopes points. 

The number of a typical cross section’s branches is defined in the Branches tab.  The
type  of  the  branches  is  not  binding,  since  the  same  typical  may  be  used  for  cross
sections with one or two branches. 

When the two branches option has been selected, you can view on the screen the left
and right semiaxes,  as  well  as  the  formations  of  the  typical  inside  the  branches. To
better understand the aforementioned information, from the drop-down list select the
typical cross section A nj b2:

The cross section that is displayed, corresponds to the single-branch formation. Next,
from  the  Typical  cross section  points  window,  open  the  Branches  tab.  In  this  tab,
choose the two branches option. 

Now you can see on your screen what the typical’s formation will appear when applied
as a two- branch typical:
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Therefore, you can use this typical in your project both as a single-branch typical and
as a two-branch typical.

In the Sideslopes tab, enter the sideslope slopes for the current typical cross section.
In a typical cross section, you must define the minimum sideslope slopes both for the
cutting  and  for  the  filling. The  sideslope  slopes are  not  unique, meaning  that  in  the
same  typical,  you  can  enter  different  sets  of  sideslope  slopes  and  use  them
accordingly when the typical is applied to your road’s cross sections.  For example,  in
the A nj b2 typical cross section, two different sideslope formations have been defined
for the cutting. In the Sideslopes tab at the bottom of the window, you can see  the
available sideslope formations for the cuttings and for the fillings. Display the formation

of the cross section in a cutting by clicking the  button and from the Left Cutting
drop-down list select a different sideslope formation.  The  selected  formation  appears
to  the  left  of  the  cross  section.  To  restore  the  cross  section  in  its  original  state,
select from the drop-down list its previous  formation.

The  meaning  of  the  term  paving  in this  manual  and  in the  program includes  all  of  a
cross  section’s  elements  on  the  Artificial  Ground  (paving  layers,  shoulders,  encasing
solids, etc.), as well as the Artificial  ground ledge. The left and right paving formation
is not unique. Namely, in the same  typical  you can define  various  paving  formations,
which can be applied  during the  calculation  of  your  project’s cross sections.  Select,
for example, the typical  cross section  A nj  b2.  Next,  from the  Typical  Cross  section
Data window, select the Pavings tab. At the bottom of the window, you can see  the
available pavings, which can be applied whether the cross section is in a cutting or in
a  filling.  In  the  Left  Filling  drop-down  list  of  the  Defaults  group,  select  Fill  Lined.
instead of Fill Lined Tr.. A new formation will be displayed in the drawing area, with a
triangular ditch and a different shoulder formation. Note that although a typical cross
section supports many different paving formations,  all  pavings  must always  have  the
same number of layers and their layers must have the same thickness.
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11.5 Tests

Through  the  tests  we  can  see  how  the  typical  cross  section  behaves  in  various
superelevations and widths  values;  these  values are  taken from the  virtual  diagrams
that  simulate  here  the  true  superelevation  and  width  values  to  which  the  current
typical cross will be applied. Please note that the typical cross section is not modified
during  the  tests,  it  is  only  adapted  to-tested  in  various  diagram  values.  When  the
Tests  tab  is  selected,  the  layout  of  the  Typical  Cross  Section  Data  window  is
displayed as shown below: 

More specifically, you can change (  to increase  or   to  decrease  the  value)  the
axis position, the distance of the left and right semiaxis (two-branch cross sections),
the roadway width and the pavement width. In a similar way, you can also change (to
decrease   or   to  increase  the  value)  the  profile  elevation  and  the  half-cross
section elevation. The values of these sizes can vary for  the  two sides  of  the  road,
this is why there are two sets of buttons, one for each side. Every time you change a
value,  the  typical  cross  section  drawing  changes  accordingly.  To  view  the  current
value of a particular size, place and leave the mouse pointer over one of the buttons
that control this size.

At the bottom of the tab there are three buttons . Use the first button to
change  the  superelevations  of  the  road,  like  on  a  left  turn.  By  clicking  the  second
button, the  superelevations  get  their  values on  the  tangent,  while  the  third  button
changes the superelevations like on a right turn. 

At the bottom of the tab you will find the  button, which opens a dialogue box; in
this  box you can choose  the  desired  diagram and  enter  directly  the  desired  values.
Finally, from the drop-down list at the bottom of the tab, you can choose any of the
user-created diagrams and with the assistance of  the  buttons  on  the  left  of  the  list
you can decrease or increase their values.
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11.6 Creation and Insertion of Levels

Every typical cross section is divided horizontally into levels (layers). The levels of the
typical cross section represent the true paving layers and any change in the levels is
the only reason for the creation of a new typical cross section.

Namely, you will have to create a new typical cross section or to modify the  existing
one  only  if  you  wish  to  change  the  number  or  the  thickness  of  the  typical  cross
section’s  layers  in a part  of  your  project.  If  you wish  to  change  the  branches,  the
sideslope slopes, the formation of the paving layers or the formation  of  the  shoulder,
to change the encasing solids or to  insert  ditches,  etc.,  you don’t  have  to  create a
new typical cross section. 

Every typical cross section has at least one level that includes by default the Artificial
Ground ledge; this is the bottom level. You can define as many additional levels as you
wish, namely as many as the desired paving layers of your typical cross section.

In the Levels tab, you can define the number of the paving layers and the thickness of
each paving layer, but you cannot define the number and the positions of the paving
layer’s points. You can do  this  in the  drawing  area,  by opening the  Pavings  tab  and
running the Edit point command.

To  insert  the  layers,  click  the   button.  Click  the  button  as  many  times  as  the
desired number of layers. The order in which the layers appear in the Levels tab, from
top  to  bottom,  signifies  their  order  by  elevation.  The  elevation  of  the  axis  (profile
elevation) is applied to the axis of the highest layer. 

If there are already some layers and you create a new one,  the  new layer  will  have
the same characteristics as the layer that you had selected before creating the  new
one and it will be added exactly below the selected layer.

For every layer you must define the following: 

· Thickness: Set the thickness of each layer at its axis. To set the thickness,  in  the
Thickness  column  and  in the  field  that  is  on  the  same  row  with  the  layer’s  name,
type the value in meters.
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· Uniform:  If  your  typical  has  two  branches,  you  must  specify  whether  a  layer  is
uniform,  namely  whether  a  layer  is  common  to  both  branches.  In  case  that  the
current typical cross section has two branches, a third column, the Uniform column
is displayed in the  Levels  tab.  Double-click in the  field  of  this  column  to  make the
respective layer uniform or not. This action does not affect the use of  the  layer  in
the single-branch cross section.

To delete a layer, select the layer’s field and click the  button. Keep in mind that
you  cannot  delete  the  last/bottom  layer,  which  corresponds  to  the  Artificial  Ground
line.

To specify the Layer Material, namely the material that the layer will be made of, you
must  change  the  typical  task  to  which  the  layer  belongs.  You  can  do  this  in  the
drawing  area,  by opening the  Properties  command  window. After you have  selected
the  line,  open  the  command’s  window  by  pressing  the  F11  key  or  by  running  the
command from the menu that is displayed if you click the right mouse button. Change
the material from the drop-down list  of  the  Task  property,  which  contains  all  typical
tasks that have been created in the relevant window. 
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11.7 Setting the Branches

The typical cross section can be defined as single (one branch) or with two branches.
In Anadelta Tessera, you can use the same typical both for the parts where the road
has a single branch and for the parts where the road has two branches.

Here we must underline that the definition of a typical cross section as a single-branch
cross  section  or  a two-branch  cross section  is  not  binding.  It  only  means  that  the
semiaxes of the branches are  displayed  in the  drawing  area and  that  you can insert
lines into the inner pavings. During cross section calculation, your choice is applied as
default, but you can change it for certain cross sections.

To  set  the  number  of  branches, open  the  Branches  tab  and  tick  the  Single  branch
check box for a typical with one branch or the Two branches check box for a typical
with  two  branches.  Any  change  in  the  number  of  branches  will  be  reflected
immediately in the typical’s  drawing  area.  In  the  case  of  a two-branch  typical,  both
semiaxes are displayed on the screen. 

If you select the two branches option, the Left Inner Pav. and Right Inner Pav. drop-
down lists are enabled in the Pavings tab, both for the cutting and for the filling. From
these  drop-down  lists,  select  the  formations  that  the  layers  will  have  on  the  inner
sides of the two branches; this formation refers to the pavings. 

Setting the Road Profile Elevation for the Branches

You can set the road profile elevation either  in an  absolute  way  or  according to  the
profile diagram. In the first case, type the road profile elevation in the Road Profile el.
text  field;  in the  second  case,  tick  the  respective  From  Profile  check  box.  Do  the
same separately for every branch if the typical has two branches.

The  road  profile  elevation  is  always  applied  to  the  cross  section  axis  and  at  the
highest level. If the cross section has two branches, then the road profile elevation is
defined and applied separately to every branch. If you wish the profile elevation to be
applied lower or higher than the  value  of  the  road  profile  diagram,  type the  relevant
distance  (in  meters)  in  the  Road  Profile  el.  text  field.  In  this  case,  the  roadway
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elevation of the cross section to which the typical will be applied, will be the algebraic
sum of the user-defined value and the value that the road profile diagram has at  the
chainage of the particular cross section. Note that a positive distance value shifts the
cross section upwards, while a negative value shifts the cross section downwards.

Distance of the Semiaxes of a Two-Branch Typical

The distance of the left or right semiaxis of a two-branch typical cross section can be
either fixed or it may depend on  a diagram (Dx of  left  or  right  semiaxis).  In  the  first
case,  type  in  the  Axis  Dx  text  field  the  desired  distance  (in  meters),  while  in  the
second  case  tick  the  from  Diagram  check  box.  To  combine  the  above  two  cases,
enter a zero value in the text field and at the same  time  tick  the  check  box.  In  this
way, the distance of the semiaxes in every cross section will be the algebraic sum of
the value in the text field and the value of the Dx of left or right semiaxis diagram at
the respective chainage.
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11.8 Sideslopes

When defining  the  typical  cross section,  you must  set  the  sideslopes,  both  for  the
fillings  and  for  the  cuttings.  To  define  the  formation  of  the  sideslopes,  open  the
Sideslopes tab. 

As mentioned earlier, a typical cross section may contain multiple sideslope formations.
To define a sideslope formation, set the sequence of the sideslope’s slopes.

 

At  the  bottom of  this  tab,  you will  see  all  the  existing  sideslope  formations  for  the
current  typical  cross  section.  Every  typical  cross  section  must  have  at  least  two
sideslope  formations,  one  for  the  filling  and  one  for  the  cutting.  To  create  a  new
formation,  select  one of  the  formations  that  are  listed in the  table  (e.g.  Filling  1:3,

1:2, 2:3) and click the  button. A new formation, which is a copy of the selected
one,  will  be  displayed  on  the  screen.  The  initial  name  of  this  new  formation  is
comprised  of  the  word  New  and  the  name  of  the  sideslope  formation  that  you  had
selected  before  clicking  the  button (e.g.  New  Filling  1:3,  1:2,  2:3).  To  change  the
name of the formation, simply type the new name in the  formation’s  field.  When  you
have finished, press Enter to confirm the name. To delete a formation from the table,

select the desired formation and click the  button.

In the Defaults group, define the sideslope formations that you wish they are  applied
by default to the current typical cross section, both for the left and for the right part,
as  well  as  for  the  cutting  and  for  the  filling.  The  formations  are  selected  from  the
respective drop-down  lists  of  this  group.  The  selected  sideslope  formation  is  applied
instantly  and  appears  in  the  workspace  of  the  typical  cross  section.  The  default
sideslope  formations  are  also  applied  during  the  cross  sections  calculation,  unless
otherwise  selected  in  the  Cross  Sections  Data  window  during  the  calculation  of  a
particular cross section or in the dialogue box of the Calculation command in the Batch
Actions menu during batch calculation.
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11.9 Setting the Sideslopes

To edit a formation’s slopes, select the desired formation and click the  button. In
the resulting dialogue box that appears on the screen, you can edit the sideslopes.

Setting the Sideslope Slopes

In the table at the bottom of the dialogue box, enter the slopes and the corresponding
elevations. The slopes towards the natural ground are always positive and their values
must be positive, regardless of the side, and regardless of whether they are  referring
to a cutting or a filling; all elevations are also deemed positive.
To  define  the  formation  of  a  cutting’s  slopes,  in  the  table  at  the  bottom  of  the
dialogue box enter the sideslope slopes and the respective elevation  for  every  slope.
The  order in which  you must  enter  the  slopes’  values,  is  from  the  roadway  to  the
ground.  For the  last  slope,  the  program  ignores  the  elevation  value  that  you  have
entered and applies the  slope  up  to  the  required  elevation.  For the  cuttings’  slopes,
you  may  start  from the  first  slope  and  continue  setting  some  slopes,  which  will  be
applied  by default,  regardless  of  whether  there  is  an  intermediate  section  with  the
natural  terrain.  The  program  applies  these  mandatory  slopes  for  the  user-defined
elevation, and then tests the first non-mandatory slope up to the particular elevation,
and if no section with the natural ground is found, continues with the next slope, and
so on. 
To define a set of slopes as mandatory, select the last slope of the set and click the
Ctrl+Y  keys;  use  the  same  combination  of  keys  to  restore  a  slope  to  its  non-
mandatory  state.  The  mandatory slopes are  marked  in  blue  color.  The  slope  or  the
slopes  that  correspond to  the  ditches  can  be  set  as  mandatory.  In  the  case  of  a
triangular  ditch  having  a  slope  of  2/3,  namely  66.66%  downwards  and  a  depth  of
40cm, enter the mandatory slope -66.66 for an elevation of 0.4. The negative sign in
the  slope  value  is  mandatory,  because  instead  of  approaching  the  ground,  we  are
moving away from it, while the elevation, as mentioned above, does not require a sign.
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You can form the  filling  slopes in two ways.  In  the  first  way, the  calculation  of  the
slope  is  based  on  the  values  entered  in  the  relevant  table,  as  in  the  case  of  the
cutting. To use this method, tick the Classic way check box. 

Contrary to the cuttings, the order in which you must enter the sideslope slopes and
the respective elevations is from the ground to the roadway. For the last slope of the
filling  (the  slope  immediately  after  the  roadway),  the  program  ignores  the  elevation
value that you have entered and applies the slope  up  to  the  required  elevation.  The
program first tests the first user-defined slope up  to  the  respective elevation,  and  if
no section with the natural ground is found, continues with the next slope and so on.

The second way that you may use for the calculation of the filling slopes is based on
the Road Works Design Directives. To apply this method, tick the  using  fixed width  B
check  box  and  in  the  two  text  fields  below  enter  the  respective  values  for  the
calculation. In the Sideslope elevation limit h text  field,  enter  the  maximum sideslope
elevation  that  will  be  calculated  with  this  method.  For  elevations  higher  than  this
value, the sideslope is calculated with the Classic way.

In  the  Minimum Dy to  apply  slope:  field,  enter  the  minimum  elevation  that  the  last
slope of a sideslope formation (cutting or filing) must have, in order to be inserted into
a cross section. If the slope elevation is lower than the value that you have entered in
the field, then the slope  is  rejected  and  the  last  slope  to  be applied  is  the  previous
slope in the list of the particular sideslope formation.
If you wish to have round sideslope edges (in the cutting or/and in the filling), tick the
 with  rounding  check  box  and  enter  the  geometrical  data  of  the  rounding  in  the
relevant text fields.

To confirm your changes for a sideslope formation, click the OK button. This saves the
changes, closes the dialogue box and returns you to the Sideslopes tab. To view these
changes in the typical cross section’s workspace, you must have selected the  edited
sideslope formation in one of the four drop-down lists of the defaults group of the tab.
 
We  remind you the  three  important  points  that  you must  always  take  into  account
when setting the sideslope slopes: 

· The slopes towards the natural ground are deemed positive and entered as positive
values,  regardless  of  the  side,  and  regardless  of  whether  they  are  referring  to  a
cutting or a filling.

· All sideslope elevations must be positive. If you give a negative sign to an elevation,
the program will ignore it. The direction of the sideslopes is determined solely by the
sign of their slope.

· The slopes referring to ditches (negative or zero values for trapezoid ditches)  must
be characterized as mandatory, in case you wish the whole ditch to be applied, even
if there isn’t any intermediate section with the natural ground.
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11.10 Pavings

This  paragraph  describes  how to  set  the  parameters of  the  pavings,  namely  of  the
part over the Artificial Ground line.

As  we  have  already  mentioned,  Anadelta  Tessera  supports  the  existence  of  multiple
paving formations in the same typical cross section. By default, there are minimum two
paving  formations  for  the  single-branch  cross  sections  (cutting  -  filling)  and  three
paving  formations  for  the  two-branch  cross  sections  (cutting  -  filling  -  inner).  Of
course, you can insert more than one paving formations for the  cutting  or  the  filling,
as you can see in the example of the figure: there  are  two formations  for  the  filling,
one for the cutting and one inner paving in case  the  typical  cross section  is  defined
with two branches.

In the Defaults group, set the paving formations that you wish to be applied by default
to the current typical cross section, both for the cutting and for the filling, as well as
for  the  right,  left  and  inner  part  of  the  typical  two-branch  cross  sections.  The
selected formations are displayed in the typical cross section’s workspace, in the part
where  the  formations  will  be  applied  according  to  your  selection.  Note  that  any
changes  in  the  formation  of  the  pavings  can  only  be  made  from  the  typical  cross
section’s workspace, therefore you can change only a paving that has been selected
in the Defaults group. The pavings are selected from the respective drop-down lists of
this group. The selected paving is displayed instantly in the drawing  area.  To see  an
example, in the Typical mode select the A nj b2 typical. This typical has five pavings.
While in the drawing area you have selected to view the  cross section  in a filling, in
the Defaults group you will notice  that  the  Fill.  paving appears selected  in the  filling
both for the left and for the right part of the cross section. From the respective drop-
down list, select the Fill Lined Tr. paving for the right part of the filling. You will notice
that, when the new paving is applied, the cross section changes in the drawing area.

The paving formations that you select from the Defaults group are also applied during
the cross sections calculation,  unless  otherwise  selected  in the  Cross  Sections  Data
window during the  calculation  of  a particular  cross section  or  in the  dialogue  box of
the Calculation command in the Batch Actions menu during the batch calculation.
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To  create a new paving,  simply  click  the   button in the  Pavings  tab.  A new line
appears  in  the  table  below,  where  you  can  type  the  name  of  the  new  paving
formation. The initial name of this new formation is comprised of the word New and the
name of the paving formation that you had selected before clicking the button. Thus,
the creation of a new paving  results  in a copy  of  the  paving  that  you had  selected
before clicking the button. 

To delete a paving,  select  it  by left-clicking  in the  respective field  of  the  table  and

then click the  button. To change a paving’s name, simply type the  new name in
the paving’s field. When you have finished, press Enter to confirm the new name.

In  the  Pavings  tab  you  define  the  number  of  pavings,  as  well  as  which  of  these
pavings will be applied by default to the various parts of the typical cross section. The
form of the  paving  (widths,  layer  superelevations,  existence  and  types  of  shoulders,
encasing solids,  etc.)  is  defined  from the  drawing  area.  For this  purpose,  commands
are used for inserting and editing lines in a typical  cross section,  as  well  as  the  Edit
point command for the accurate calculation of a point’s position in the typical.
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11.11 Paving Sideslope Coating

The  sideslope  coating  is  defined  from  the  Pavings  tab  and  can  be  created
automatically in a typical cross section. The coating is either parallel to the sideslopes
(usually for the fillings) or to the slopes (usually for the cuttings). 

How to set the automatic sideslope coating

1.From  the  Pavings  tab  of  the  Typical  Cross  Section  Data  window, click  one of  the

 buttons, depending on whether the coating will be applied to the left or to
the right of the typical cross section. The coating will be applied to the paving that
has  been  selected  in  the  Defaults  group  and  according  to  whether  you  have
selected the cutting or the filling.

2.The following dialogue box appears on the screen:

For  the  sideslope  coating  to  be  applied  automatically,  tick  the  Auto  Sideslope
Coating check box. From the Task drop-down list, select the  typical  task  to  which
the new line will belong. The list shows only the typical tasks of the SSC family. The
typical task that you must select is usually Sideslope Coating for the filling or Outer
Gutter Filling for the cutting. 

3.Next, you must define the sideslope coating starting point. To define the point, left-
click  on  the  Not  defined  phrase  below  the  drop-down  list  to  display  the  Select
reference  point  phrase  at  the  top  left  corner  of  the  drawing  area.  Select  the
desired point and then click the Accept point phrase. Now the field is  updated  and
displays the selected point, e.g. Starting from point 2 of the Shoulder. 

4. If the sideslope coating refers to a filling, tick the Sideslope parallel check box. Next,
in the Thickness field, type in meters the distance of the coating from the sideslope.
If  you wish  to  also  use the  paving  sideslopes  (in  addition  to  the  artificial  ground
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sideslopes) for the creation of the line, tick the Use Paving Slopes  check box. If the
filling refers to  the  cutting  and  to  the  creation of  a debris  removal zone,  tick  the
With slopes check box. In  the  list  below,  enter  the  slopes and  the  horizontal  step
(distance) according to which every slope will be applied. The step of the last slope
must always be zero. The program extends the last slope until it finds a section with
the top or the bottom envelope. 

5.Click the OK button to close the dialogue box and create the line.
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11.12 Outer Gutter Filling of Fixed Width

The  Outer  gutter filling  of  fixed  width  line  is  a  special  case  of  the  Debris  Removal
Zone. When  this  line  is  defined  to  have  a fixed width,  then  its  end  is  a  mandatory
point through which the cross section’s sideslope must pass. 

How to define the Outer Gutter Filling of fixed width

1. If there isn’t any Outer Gutter Filling line, click the  button to create a new one.
In the resulting window, select the Paving side,  the  Level  of  the  new line  and  the
type of the line you wish to create.  Here,  select  the  Outer  Gutter Filling  line.  Use
the  Edit  point  command  to  select  the  calculation  way  (e.g.  Dx  and  slope  from
previous) of the end point of the line. 

2.Next, in the Pavings tab of the Typical  Cross Section Data window, click one of the

 buttons, depending on whether the outer gutter filling line of fixed width will
be applied to the left or to the right of the typical cross section. 

3.The following dialogue box appears on the screen:

4.Select  the  mandatory  point  through  which  the  sideslope  will  pass  and  tick  the
Sideslope on fixed distance check box.

5.Click  the  Point  selection  button  to  confirm  the  point  that  you  selected  in  the
previous step.

6. In the Distance from point field,  enter  the  additional  distance  of  the  Outer Gutter
Filling.

7.Click the OK button to close the dialogue box.
8.Click the cross section Calculation to view the new form of the cross section. 
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11.13 Guardrails Support

To  define  how and  where the  Guardrails  will  appear  in  the  cross  section,  open  the

Pavings  tab  of  the  Typical  Cross  Section  Data  window  and  click  one  of  the   
buttons, depending on whether the guardrail refers to the left or to  the  right  part  of
the  typical  cross  section.  The  clicking  of  either  button  results  in  the  dialogue  box
shown below:

From the Task drop-down list  of  the  Guardrail  data group,  select  the  task  by which
the  guardrail  will  be inserted into the  cross section.  Next,  select  the  design  of  the
guardrail. This can be either Standard, or you can select it from the drawings library,
by choosing the drawing that represents the particular guardrail.  To do  this,  tick  the
From  drawing  library  check  box.  To  select  the  drawing  that  will  be  used  for  the
guardrail, click the Select button to open the drawings library and then select both the
drawing  that  will  be used and  the  drawing’s  dependence  point,  which  will  determine
the exact position of the guardrail in the cross section. With the use of the Edit point
command, you can depend this point on another point of the typical  cross section  in
order to define the exact position of the guardrail.
In the Widening due to guardrail group, you can select whether the cross section will
be  widened  due  to  the  guardrail.  In  the  Widening  width  field,  enter  the  desired
widening  of  the  cross  section.  The  point  to  which  the  widening  will  be  applied,  is
displayed  below  the  relevant  field  and  appears  selected  on  the  cross  section.  To
change  this  point,  select  another  appropriate  point  and  click  the  Point  selection
button.    
To confirm your settings and close window, click the OK button. 
Note that in the Typicals mode the guardrails are always displayed, regardless of any
elevation discrepancies, in order to remind you to define them correctly, so that they
can be inserted into certain cross sections that use the particular typical.
To insert the guardrails into a given cross section, go to the Cross Sections workspace

and click one of the  buttons, depending on whether the guardrail refers to  the
left or to the right part of the cross section. If you wish to calculate the guardrails in
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order to use them in all  cross sections on user-defined conditions, run  the  Guardrails
Management command of the Batch Actions menu.  
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11.14 Insertion - Editing of Lines

To insert a new line into a typical cross section, run  the  Insert  line  command  of  the

Actions  menu  or  click  the   button.  The  following  dialogue  box  appears  on  the
screen:

This command is mostly used for inserting left and right pavement gutters, shoulders,
and generally lines that correspond to a paving, apart from the lines that are inserted
originally when creating a level. From the Paving drop-down list of the box, select the
paving to which the new line will belong. Only the pavings that  you have  selected  in
the Defaults group of the  Pavings  tab  in the  Typical  Cross  Section  Data window are
available on the list. Next, select the level and the typical task to which the new line
will belong from the Level and Task drop-down lists, respectively.  

Finally, from the Define group select how the line will be inserted and then click the OK
button to insert the line. The with points option means that the line will be defined by
user-inserted points, while  the  from  library  option means  that  the  line  will  have  the
form of a predefined drawing, which the user will select from the drawings library.

In the first case, define the line points either with the mouse, within the drawing area
(you can also use the snap feature), or with the use of the Input Form command.

Editing Lines

The  program offers  various  secondary  functions,  enabling  you to  edit  the  lines  that
you have inserted into a typical cross section, so as to give  them the  desired  shape
and properties. 

Moving a Line

When you move  a line,  the  whole  line  is  transferred,  without any changes regarding
the orientation or the relative positions of the points with  respect  to  each  other.  To
ensure the necessary accuracy, use the Input Form command or the snap feature.

How to move one or more lines simultaneously by using the mouse

1.Select the lines you wish to move.
2.From the shortcut menu that is displayed when you right-click in the drawing area,

select the Move command.
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3.Specify the reference point based on which the line will be moved.
4.Specify the end point, where the reference point will be placed.

Once you have specified the second point, the line is moved to its new position.

Deleting Lines

You can delete one or more lines, if desired. 

How to delete lines

1.Select the lines you wish to delete.
2.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Delete objects command, or click the  button in the main toolbar,  or
press the Del key.

If you accidentally delete a line, you can restore the line by using the Undo command.
Please keep in mind that the program will not allow you to delete a line on which other
lines depend.

Editing line points

Inserting a Line Point

You can insert one or more points to a line. 

How to insert points to a line 

1.Select the line point next to which you wish to insert the new point. Note that the
program allows you to insert the new point further than the cross section’s axis with
respect to the current point. 

2. From the shortcut menu that is displayed if you right-click in the drawing area, run
the Extend to start  or Extend  to  end  command.  The  first  command  appears when
the current point is on the left side of the road, while the second command appears
when the current point is on the right side of the road. When the current point is at
the  cross  section’s  axis,  then  both  commands  appear  simultaneously.  By  running
either command, a new point appears, which is highlighted in red. Move  the  mouse
pointed to select the new point’s position.

3.Set  the  position  of  the  new point either  by  clicking  the  left  mouse  button  or  by
using the Input Form command.

4.To finish the point insertion procedure, click the right mouse button. The insertion of
the last points is cancelled and the procedure stops.

Offsetting a Line Point

You can offset a line point, so as to give it the desired shape.

How to offset a line point

1.Select the line you wish to edit and the point you wish to offset.
2.Activate the selected point. The point will start moving, following the movement of

the mouse pointer.
3.Specify the new position of the point.

Deleting Line Points

You can delete one or more points of a line.
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How to delete a line point

1.Select the line you wish to edit.
2.Select the point you wish to delete.
3.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Delete Point command or press the Ctrl+Del keys.

You cannot delete points on which other points depend. To do that, you must first use
the Edit point command to edit all  the dependent points and then you can delete the
point.
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11.15 Calculating the Position of a Line Point

To  edit  the  points  of  a line  in a typical  cross section,  use the  Edit  point command.
With this command you can select the way in which  a line  point is  calculated  in the
typical cross section, by correlating the position with a reference position in the same
typical  cross  section  (e.g.  axis,  a  different  point  of  the  same  or  another  line,  a
diagram, etc.). 

How to define the position of a line point

1.Select the line you wish to edit.
2.Select the point you wish to edit.

3. From the shortcut menu that is displayed if you right-click in the drawing area, run

the Edit point command or  click  the   button in the  Typical  Cross  Section  Data
window. The layout of the window changes, allowing you to define the position of a
point.  The  name and  the  data of  the  selected  line  are  shown  at  the  top  of  the
window. The selected point that  you are  editing  is  written  in red  letters.  You  can

change  the  selected  point  either  by  using  the   buttons  at  the  top  of  the
window or by selecting the point from the drawing area, after having activated the
box.

4.From the Definition mode drop-down list, select the desired way to define a point.
There are five ways to define a point’s position:

5.Dx  and  Dy:  With  this  option  you  can  define  a  point’s  position  by  entering  the
horizontal and vertical distance of the point from a reference position. 

6.Dx  and  Slope  from  prev.:  With  this  option  you  can  define  a  point’s  position  by
entering the point’s  horizontal  distance  from a reference position  and  the  slope  of
the straight segment between the current point and  the  previous  point of  the  line
(the point closest to the cross section’s axis). This way is mainly  used for  defining
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points of the top paving layer (e.g. traffic layer).
7.Dy  and  Slope  from prev.:  With  this  option you  can  define  a  point’s  position  in  a

similar way as previously, by entering the point’s vertical distance from a reference
position and the slope of the  straight  segment  between  the  current  point and  the
previous point of the line (the point closest to the cross section’s axis). This way is
mainly used for defining sideslope points.

8.Length and Slope from prev.: With this option you can define a point’s  position  by
entering the length and the slope of the straight segment between the current point
and the previous point of the line (the point closest to the cross section’s axis).

9.Section and Slope from prev.: With this option you can define a point’s position by
entering  the  slope  of  the  straight  segment  between  the  current  point  and  the
previous  point of  the  line  (the  point  closest  to  the  cross  section’s  axis)  and  the
distance of this segment from the intersection with another segment of the  typical
cross  section.  This  way  is  mainly  used  for  defining  points  of  a  paving  layer  with
respect to the sideslopes of the previous layer (e.g. Base, SubBase).

10.Slope and Slope from prev.: With the option you can define a point’s position as a
section  between  two  half-lines;  the  first  half-line  is  defined  from  the  slope  from
another defined point and the other from the slope of the straight segment between
the current point and the previous point of the line (the point closest to  the  cross
section’s axis).

11.Detailed explanations on how to  fill  in  the  relevant  fields  for  each  case  are  given
hereunder.

12.To  calculate  the  typical  cross  section  according  to  the  new  data,  click  the
Calculation  button.  To  save  the  changes  that  you  have  made,  click  the  Save
button. To cancel all changes and restore the typical into its original state, click the
 Cancel button.

Setting the Dx or the Dy:

As  we  have  previously  seen,  you  can  define  a  point  by  entering  its  horizontal  or
vertical distance from a reference position. 

The  Dx  or  the  Dy  distance  can  be  set  as  a  fixed  distance  from  the  axis  (or  the
semiaxes if the cross section has two branches) for the horizontal distance (e.g. 3 m
from the axis) and from the  road  profile  elevation  that  you have  set  for  the  vertical
distance. To do this, type the distance in the Dx or in the Dy field, and from the drop-
down list below the field select from axis. 

If you wish the distance to be measured from another previous point of the line, select
 from point. In this case, the phrase Not defined will appear below the drop-down list.
This  means  that  the  point from  which  the  distance  will  be  measured  has  not  been
defined yet. To define  the  point,  left-click  on  the  Not  defined  phrase to  display  the
Select reference point phrase at the top left corner  of  the  drawing  area.  Select  the
desired point and then click the Accept point phrase. The field will be updated and the
selected point will be displayed. To select a different point, repeat the procedure. 

If  you wish  the  horizontal  or  the  vertical  distance  to  be calculated  from  a  diagram,
then from the first drop-down list select from diagram and next, from the drop-down
list  that  is  displayed  below,  select  the  diagram  based  on  which  the  point  will  be
calculated. The T that appears next to every diagram’s name indicates a typical cross
section diagram, which can be edited from the Tests  tab.  In  the  typical’s  workspace
these diagrams are virtual, but when the typical is applied to certain cross sections of
the  project,  the  program  will  search  and  apply  the  width  of  the  particular  (real)
diagram at the cross section’s chainage.  The  from  rev.  diagram  option is  the  same,
only here the values of the diagram are applied with the reverse sign. In the Dx or Dy
text field, you may enter a fixed distance, which will be added to the current value of
the diagram.
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Setting the Slope

To set the slope of the straight segment between the current and the previous point,
choose  one  of  the  following  options.  If  you  choose  the  absolute  option,  type  the
point’s slope in the text field. A positive slope means that the point will be placed at a
higher elevation with respect to the previous point of the line, while a negative slope
means the opposite.

If you wish the slope to be calculated  from a diagram,  then  from the  drop-down  list
select from diagram and next, from the drop-down list that is displayed below, select
the diagram based on which the slope will be calculated. The  T  that appears next to
every diagram’s name indicates a typical cross section  diagram,  which  can be edited
from the Tests tab. In  the  typical’s  workspace  these  diagrams  are  virtual,  but  when
the typical is applied to certain cross sections of the project, the program will search
and apply the slope of the particular (real) diagram at the cross section’s chainage.

The from rev.  diagram  option is  the  same,  only  here  the  values of  the  diagram are
applied  with  the  reverse sign.  In  the  Slope text  field,  you  may  enter  a  fixed  slope,
which will be added to the current value of the diagram.

If you wish to apply the slope of another straight segment, then in the drop-down list
select  from  segment.  Select  the  segment  in  the  same  way  that  you  select  the
reference point for the horizontal and vertical distances. Note that a segment’s slope
is  defined  from  the  second  point  that  has  been  placed  on  the  segment,  which  is
usually located away from the axis, regardless of the side. Use this option if you wish
the paving layers to have the same superelevation with the top  layer,  or  if  you wish
the layer sideslopes to have the same  slope  with  the  sideslopes  of  the  top  layer.  In
this way, any changes in the slopes of the top layer are applied instantly to the other
layers.

To set the slope of the road’s shoulder, in the drop-down list select from function for.
A  shoulder’s  slope  can be calculated  in two ways: with  Variable  superelevation  and
with  Pavement  superelevation.  The  calculation  way  is  selected  from  the  drop-down
list. More specifically:

Calculation with Variable Superelevation

To define how the shoulder’ slope will be calculated, go to the Parameters  menu, run
the Road preferences command, and in the Shoulders group of the General tab  select
the desired calculation way by ticking the respective check box. 

If you tick the Edge superelevation difference check box, enter the maximum value in
the text field next to  the  box;  the  superelevation will  be formed by segment,  based
also on the values in the Shoulder tangent superelevation fields. The superelevation of
the shoulders on the tangent is  the  value  that  the  user  enters  in the  relevant  field.
For  the  inner  side  (downslope  –  lower  side)  of  a  turn,  when  the  pavement
superelevation  exceeds  the  shoulder  superelevation  on  tangent,  then  the  shoulder
superelevation  follows  the  pavement  superelevation.  For  the  outer  side  (upslope  –
higher  side),  where  an  edge  is  formed,  the  shoulder  superelevation  maintains  the
tangent value, as long as the edge superelevation difference  is  lower  than  the  value
that  you  have  entered  in  the  Preferences.  When  the  superelevation  difference
between the  shoulder  and  the  pavement  becomes equal  to  the  Edge superelevation
difference,  then  every  time  the  pavement  superelevation  is  increased,  the  shoulder
superelevation is decreased (the shoulder is “raised”).

Namely, in the last case, if:
 q is the current pavement superelevation

dq is the Edge superelevation difference
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eu is the shoulder superelevation at the high side
then the following formula shall apply:
|q| +| eu| = |dq|

If  you  tick  the  Superelevation  on  curve  external  check  box,  enter  the  absolute
shoulder superelevation value in the text field next to the box; the superelevation will
be  formed  by  segment,  based  also  on  the  values  in  the  Shoulder  tangent
superelevation  fields.  The  shoulder  superelevation  on  the  tangent  and  on  the  inner
side  of  the  turns is  the  value  entered  in  the  Shoulder  tangent  superelevation  field,
while the shoulder superelevation on the outer side of the turn is the value entered in
the Superelevation on curve external field. 

Calculation with Pavement Superelevation

This calculation is based on the value that you have entered in the Shoulder tangent
superelevation field. The superelevation of the shoulders on the  tangent  is  the  value
that the user enters in the relevant field. For the inner side of  a turn, all  information
mentioned  as  regards  the  previous  calculation  applies  here  too.  Namely,  when  the
pavement  superelevation exceeds  the  shoulder  superelevation  on  tangent,  then  the
shoulder superelevation becomes equal to the pavement superelevation. Regarding the
outer side, however,  when the  pavement  superelevation becomes different  than  the
value  that  you  have  entered  for  the  tangent,  then  the  shoulder  superelevation
becomes equal to the pavement superelevation.

Setting the Section

To  define  the  position  by using the  Section and  slope  method,  you must select  the
segment according to  which  the  section  will  be determined.  To select  the  segment,
proceed  as  you  would  do  for  selecting  the  segment  for  setting  a  slope.  Use  this
method when a line must extend up  to  a user-defined  segment.  This  method usually
serves for  the  calculation  of  the  paving  width  based  on  the  sideslope  of  a  previous
layer (at a higher level) of the typical cross section.
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11.16 Selected Drawings

From  the  typical  cross  section  workspace,  you  can
insert  certain  additional  standard  drawings  to  specific
positions, based on the main axis of the cross sections
or  based  on  two  semiaxes  for  two-branch  cross
sections.  To  insert  drawings  to  the  axis,  open  the
Selected  Drawings  tab  of  the  Typical  Cross  Section
Data  window.  This  tab  includes  a  list  of  all  of  the
selected  drawings  that  are  applied  to  the  current
typical  cross  section,  as  well  as  two  buttons  for
inserting and deleting  drawings to/from the  typical.  To

insert  a drawing,  click  the   button,  which  opens  a
box, enabling you to select a drawing from the  current
drawings library. In addition, from the drop-down list at
the top of the box, select the task to which the line will
belong and exactly below select the position of the line
with respect to the cross section’s axis (center, right or
left). Usually the drawing is inserted in the middle of the
axis  for  the  single-branch  typical  cross  sections  (N.
Jersey), while  in the  case  of  two-branch  typical  cross
sections,  the  drawing  is  inserted to  the  left  or  to  the
right  of  the  semiaxes  of  the  right  and  left  branch,
respectively. 

To  delete  a  selected  drawing  while  working  in  the
typical  cross  section  workspace,  select  the  drawing
from the list of the  Selected   Drawings  tap  by clicking

the left mouse button and then click the  button.

If you don’t  want to  apply  the  selected  drawings,  but
you wish to keep them, untick the Apply field.
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11.17 Topsoil

From the Topsoil tab  of  the  Typical  Cross  Section  Data  window, you can define  the
formation of the topsoil, the clearance of the top soil, and the way that the topsoil is
calculated in a typical cross section.

First you must define the topsoil clearance depth, namely the distance  of  the  topsoil
line  from  the  natural  ground  line.  In  the  Depth  field,  enter  the  desired  distance  in
meters.  Next,  you must define  the  natural  ground  area  in  which  the  topsoil  will  be
calculated. You can leave this area free in the typical, in order to define it separately
for  every  cross section  of  the  project,  or  you  can  select  its  automatic  calculation
either  for  a  fixed  distance  from  the  axis  of  every  cross  section  or  for  the  whole
construction zone plus a distance from the sideslope edges.
· With the in segments option, the user defines and  forms  the  topsoil  separately for

every cross section.
· With  the  in  region  around  axis  option,  the  topsoil  clearance  is  determined

automatically in a region above and below the axis, as this region is  determined  for
every side from the Region width in fill or Region width in cut field, and according to
the cross section type. This region is separate from the construction zone that  will
derive during the cross section calculation.

· With  the  in  region  around  slopes  option,  the  topsoil  clearance  is  determined
automatically  in  a  region  above  and  below  the  axis  that  extends  beyond  the
construction zone. This region is determined for every side from the Region width in
fill or Region width in cut field, and according to the cross section type. In this case,
the  values  in  the  fields  indicate  the  distances  from  the  sideslope  edges  that
demarcate the construction zone.

Finally, if the particular typical cross section is to be used for the rehabilitation of an
existing road, select the Topsoil exception option from the Road rehabilitation group at
the bottom of the tab. With this option, the topsoil will not be calculated for the part
of the cross section that corresponds to an existing paving; it will be calculated  only
for the parts left and right to the paving. The existing road  is  indicated  according to
every cross section’s chainage by two diagrams (Exist. Road diagram right and  Exist.
Road diagram left), which can be updated automatically from the horizontal alignment,
provided that they are depicted there in the form of lines. Apart from the topsoil line in
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the region of the  existing road,  the  program also  enables  you to  exclude the  paving
part  that  coincides  with  the  older paving  of  every  cross  section  in  the  project,  by
simply selecting the Edit paving option from the Road Rehabilitation group.

Note that you can view immediately every change that you are making  in the  topsoil
tab, since the topsoil is immediately updated in the drawing area,  while  you can also
view the new settings in the typical cross section’s workspace.
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12 Drawing

12.1 Lines

The  simplest  object  in  Anadelta  Tessera  is  the  zigzag  line,  which  is  referred  to  as
drawing  line  in  the  program.  The  drawing  lines  can  be  comprised  of  one  or  more
straight  segments  and  they can be closed or  open.  To  draw  these  lines,  you  must
define the points of their peaks.

Drawing a Line

A line is comprised of a series of connected straight segments, which can be managed
as a single object.

How to draw a drawing line

1.From the Drawing menu, run the  Line  command,  or  from the  Drawing  group of  the

Drawing Elements toolbar click the  button. You will see the highlighted box in the
middle of the mouse cross, showing you where the line point will be inserted. 

2.Click the left mouse button to define the start point (1) of the line.
3. In the  same  way  define  the  end  point of  every  straight  segment  of  the  line  (e.g.

(2), (3), (4) and (5)).
4.When you have finished setting the peaks of the line, click the  right  mouse  button

to end the procedure.

After you have inserted a line, you can convert it into a breakline, a road tangent  or
even a boundary of an existing road.

Drawing a Quadrilateral

You can easily and quickly draw lines in the form of a rectangle.

How to draw a quadrilateral

1.From the Drawing menu, select the New
Quadrilateral command. 

2.Click  the  left  mouse  button  to  define
the first angle (1) of the quadrilateral.

3. In  the  same  way,  define  the  opposite
angle  (2)  of  the  quadrilateral.  The
insertion  is  completed after  the  second
click  and  the  quadrilateral  remains
selected. 
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The resulting quadrilateral is a rectangle, whose sides are parallel to the X and Y axes.
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12.2 Curves

The  program enables  you to  draw  curves,  such  as  circles,  ellipses,  circular  arcs  or
elliptical arcs.

Drawing a Circle

To draw a circle, you must define its radius and center.

How to draw a circle

1.From  the  Drawing  menu,  select  the
New Circle submenu  and  then  run  the
Center, Radius command; or, from the

Elements Drawing toolbar, click the 
button.

2.Click  the  left  mouse  button  to  define
the center point (1).

3.Click  again  the  left  mouse  button  to
define a point for the circumference of
the  circle  (2).  The  insertion  is
completed  and  the  circle  remains
selected.

Drawing a Circular Arc

There are two ways to draw a circular arc. The main way is to define three points —
the first point, the final point and the intermediate point of the circular  arc.  You  can
also define the center, the beginning and the end. By default, Anadelta Tessera draws
the circulars arcs in a counterclockwise direction.

Drawing an Ellipse

You can create complete ellipses and elliptical arcs. The main  method for  drawing  an
ellipse is to define its center, the length of the primary and secondary axis, and finally
the orientation of the axes. Both axes are vertical to each other. The  order in which
you define the axes is totally insignificant.
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How to draw an ellipse (first way)

1.From the Drawing menu, select the New Ellipse submenu  and  run  the  Center,  Radii
command.

2.Click the mouse button to define the center (1) of the ellipse.
3.Set  the  length  and  the  orientation of  the  first  axis by defining  a point  (2)  in  the

drawing area. The axis radius is equal to the distance of the point from the  center
of the ellipse.

4.Set the length of the second axis by defining a third point (3) in the drawing area.
The axis radius  is  equal  to  the  distance  between  the  center  and  the  point of  the
second axis.

The elements of the ellipse can be defined in a different order.

How to draw an ellipse (second way)

1.From the Drawing menu, select the New Ellipse submenu  and  then  run  the  Center,

Radius, Angle command; or, from the Elements Drawing toolbar, click the  button.
2.Click the mouse button to define the center (1) of the ellipse.
3.Set the length of the first axis by defining a point (2) in the drawing area. The axis

radius is equal to the distance between the two points.
4.Set the length and the orientation of the second axis by defining a third point (3) in

the  drawing  area.  The  radius  and  the  orientation  of  the  axis  are  equal  to  the
distance and the orientation between the center and the point of the second axis.

Drawing an Elliptical Arc

To draw elliptical arcs, you must define all elements of the ellipse, by using the second
way that is described in the previous paragraph. The arc starts at the point by which
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you defined the length and the orientation of the second axis. Next, you must define
the  end  of  the  elliptical  arc.  The  arcs  are  always  drawn  in  a  counterclockwise
direction.

How to draw an elliptical arc

1.From the Drawing menu, select the New Ellipse submenu and then run  the  Elliptical

Arc, command; or, from the Elements Drawing toolbar, click the  button.
2.Define the center (1) of the ellipse.
3.Set the length of the first axis by defining a point (2) in the drawing area. The axis

radius is equal to the distance between the two points.
4.Set the length and the orientation of the second axis by defining a third point (2) in

the drawing area.
5.  The  radius  and  the  orientation  of  the  axis  are  equal  to  the  distance  and  the

orientation between the center and the point of the  second  axis,  similarly  to  point
(3) of the second way that was described in the previous paragraph.

6.Set the end of the arc by defining a point (3).
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12.3 Clothoids

Drawing a Clothoid Curve

Anadelta Tessera offers the unique feature of drawing clothoid curves. 

To insert a clothoid, run the New Clothoid command of the  Drawing  menu and  define
the main tangent of the clothoid in the same way that you define a straight segment.
The clothoid is inserted with the second mouse click and remains selected. When the
length  of  the  clothoid  is  zero,  its  tangent  appears on  the  screen; this  tangent  also
serves as a selection line (handle). Next, define the data – parameters of the clothoid.

How to input the clothoid’s data 

1.Open the Properties command window.
2.Select the clothoid you wish to edit.
3. In  the  Properties  command  window, select  the  value  of  the  Parameters  property.

Click the three-dot button that is displayed when this field is selected.

The following dialogue box appears on screen:
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1. In  the  three  fields  of  the  Input  way  group,  you  can  set  the  parameter  A  of  the
curve, the length L of the clothoid, as well as the offset DR. According to literature,

these three values are  interrelated with  the  and formulas.  Depending
on the  selected  calculation  way  for  these  values,  when  you  click  the  respective
button at the top of the group, only one of the three text fields is active, while the
other two fields show the data values that the program calculates automatically.

2. In the Start Radius and End Radius fields, enter the radii of the circular arcs at the
start and the end of the clothoid. If you wish the clothoid to start from the tangent,
tick the Infinite check box. The Start Length (L) field shows the clothoid length that
the program has calculated from the tangent up to the start radius (if  the latter is
not infinite). Namely, this value corresponds to the length of the initial segment that
is not drawn on the screen. Finally, the Angle field shows the calculated value of the
DR offset angle.

3.Click the OK button to close the dialogue box.

The clothoid curves can be edited too, like any other drawing object. Also, every time
you insert a new drawing element,  the  characteristic  parts  of  the  clothoid  appear  in
green (start and end curvature centers, start and end point of  the  clothoid)  so  that
you can apply the snap feature to them.
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Drawing a Parabola

Anadelta Tessera enables you to draw various types of parabolas. 

To insert a parabola, run the New Parabola  command  of  the  Drawing  menu  and  then
draw the  main  tangent  of  the  parabola  in the  same  way  that  you  define  a  straight
segment. The parabola, whose length is zero, is inserted with the second mouse click
and remains selected. When the length of the parabola is zero, its tangent is drawn on
the  screen; this  tangent  also  serves  as  the  parabola’s selection  line  (handle).  Next,
define  the  data –  parameters of  the  parabola  in the  same  way  that  you  define  the
clothoid data. The additional feature that characterizes the parabola is selected  from
the Curve Type field.
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12.4 Texts

The text enriches a drawing by providing important information. You can use texts to
give information about the nature of the design, e.g. title, surveyor, project owner and
supervising service, as well as explanations in the study. 

Creating a Text

To  create one or  more text  lines,  use the  New Text  command. Every  text  line  is  a
separate object that can be moved, centered and edited as desired.

How to create a text

1.From  the  Drawing  menu,  run
the  New  Text  command  or,  in
the  Elements  Drawing  toolbar,

click the  button.
2.Use the mouse to select where

the  first  character  (1)  will  be
inserted.

A  new text  object,  entitled  New
Text, is inserted in the project.

Text Editing 

Texts are inserted with default properties. To give them the form and the content  of
your choice, edit them in the window of the Properties command.

Text Typing

In  the  field  of  the  Text  property  in
the  Properties  window,  type  the
desired  content  of  the  text  and
press Enter.

Text Font and Font Height

The font height  of  the  new texts  is
0.3 cm on paper and the font type is
 Arial.  The  font  size  on  screen  is
similar  to  the  font  size  on  the
printout,  according  to  the  print
scale.

To change the text font,  select  the
text  you wish  to  edit  and  open  the
window of  the  Properties  command.
In  the  field  of  the  Font  property,

click  the  three-dot  button  .  In
this box, you can choose a new font
or  whether  the  characters  will
appear bold or italic.

To change the font height, open the
window  of  the  Properties  command
and  in  the  Height  field  type  in
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centimeters the new height.

Text Alignment

For every text, the initial point of alignment is the bottom left, the distance from this
point is equal to zero and the rotation angle is also zero.

Every text has a center point. A center point is the point of the box that determines
the place of the text on the screen.  There  are  nine available  places in the  box that
can be defined as center points. 

To change the center point, open the window of the Properties command and select a
value from the drop-down list of the Center property.
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12.5 Images

To insert one or more images, use the Image command.

How to insert an image

1.From  the  Drawing  menu,  run  the  New  Image  command  or,  from  the  Elements

Drawing toolbar, click the  button.
2.Define the point at which the  bottom left  corner  of  the  image will  be inserted.  An

image with the Anadelta Software logo is inserted into the project.
3.Next, open the Properties command window.

4. In the field of the Image property, click the three-dot button  which is located to
the right of the field. A dialogue  box appears on  the  screen.  Select  the  image file
that will be inserted into the drawing.
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12.6 Object Properties

You can specify the main properties  of  the  new drawing  objects before  creating the
objects.  The  values  of  the  properties  that  will  be  applied  to  the  new  objects  are
referred to as current values.

Defining the Color for the New Objects

You can set the value of the Color property for the new drawing objects.

How to set the current Color

1.Deselect all objects.
2. From the Object Properties toolbar or from the window of the Properties command,

select one of  the  colors  available  in the  Color  drop-down  list  or  select  Other…  to
define a new color.

Defining the Line Type for the New Objects

You can set the value of the Line type property for the new drawing objects.

How to define the current type of line

1.Deselect all objects. 
2. From the Object Properties toolbar or from the window of the Properties command,

select one of the line types available in the Line type drop-down list.

Defining the Line Type Scale for the New Objects

You can set the value of the Line type scale property for the new drawing objects.

How to define the current Line type Scale

1.Deselect all objects. 
2.Open the window of the Properties command and type the desired value in the field

of the Line Type Scale property.

Defining the Line Width for the New Objects

You can set the value of the Line width property for the objects that will be created.

How to define the current Line width

1.Deselect all objects.
2. From the Object Properties toolbar or from the window of the Properties command,

select one of the line widths available in the Line width drop-down list.
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12.7 Layers

With  the  help  of  the  layers,  you  can  further  categorize  the  drawing  objects.  The
layers are groups in which you can organize and  group various  drawing  objects.  This
grouping  facilitates  the  management  of  the  Horizontal  Alignment  data.  For  every
group, you must set certain values for the main  properties.  The  main  properties  of  a
drawing object can be set either based on the object’s layer, or they can be different
from the values of the layer’s properties. 

Working with Layers

The drawing objects always belong to a layer. This can be the base  layer  or  a user-
created layer. In every layer there are specific values for the Color, the Line type and
the Line width properties. You can use the layers to organize your drawing in groups of
objects, in order to manage and edit the drawing objects easily and quickly.

For  example,  you can create a layer  that  shall  include  the  outlines  of  the  buildings.
The desired properties for the drawing objects (color, line type and line thickness) can
be assigned to the layer instead of being assigned separately to every object. To draw
a new outline, you must make the layer of these lines current and then start drawing.
You don’t have to define again the line  type,  the  line  color  and  the  line  width  every
time you draw an outline.

Every time a new design begins, Anadelta Tessera creates automatically a layer, which
is entitled  Base.  By  default,  the  property values of  the  Base  layer  are  Black  for  the
Color, Continuous for the Line type and 0.1 mm for the Line width. You cannot delete
or rename the base layer.

To manage and edit the layers, open the Layers window.

How to open and close the Layers management window

1.From the Drawing menu, run the Layers command, or press the F9 key, or click the

 button in the toolbar. The management window appears on the screen.
2.Proceed to the desired changes.

3.When you have finished, click the exit button  to close the management  window
and return to the main screen.

Creating and Renaming Layers

You can create and rename a layer for every set of lines, and also assign the common
properties of the lines to this layer. By grouping the objects in layers, you can easily
control their appearance and make changes quickly and efficiently.

How to create a new layer
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1.Open the Layers management window. 

2.Click the New Layer  button at the top of the window.

This  creates  a new layer  with  a  unique  name,  e.g.  New  Layer,  New  Layer  1,  New
Layer 2, etc. After you have created a layer, you can rename it. The property values
of the new layers are Black for the Color, Continuous for the Line type and 0.1 mm for
the Line width, but you can change them, if desired.

Changing the Name of a Layer

You can change the name of a layer at any given time, in order to show clearly what
the layer  represents  in the  drawing.  You  cannot,  however,  change the  name of  the
Base layer.

How to rename a layer

1.Open the Layers management window.
2.Left click on the layer’s name field to activate it.
3.Type the new name and press Enter.

4.Click the exit  button  to  close the  management  window  and  return  to  the  main
screen.

How to make a layer current

You always draw in the  current  layer.  When  a layer  is  current, you can create new
objects in this layer and these new objects may have the same properties as the layer
(provided  that  the  object’s  properties  have  the  Layer  option  enabled).  When  the
current layer is non visible or non selectable, you cannot create new drawing objects.

How to make a layer current

1.Deselect all objects.
2. From the Object Properties toolbar or from the window of the Properties command,

select one of the layers available in the Layer drop-down list.

Checking the Layers

Anadelta Tessera will not display the objects that are drawn in non visible layers. Also,
the program will  not  print  the  objects that  are  drawn  in non  printable layers.  If  you
want to hide temporarily some of the drawing objects while working on details of your
drawing,  you can make a layer  or  a set  of  layers  non  visible.  The  layers  containing
elements that don’t have to be printed, such as auxiliary lines, can also be made non
visible.

Checking the Layers’ Visibility

The non-visible layers will not be displayed on the screen, but you can still print them.
 

How to make a layer visible or non-visible

1.Open the Layers management window.

2.Select the fields of the layers that you want to make visible or non visible.
3.Double-click on the Visible field.

4.When you have finished, click the exit button  to close the management  window
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and return to the main screen.

Checking the Layers’ Printability

You  can  select  which  layers  will  be  printed.  If  the  layer  contains  information  that
doesn’t  have  to  appear  on  the  final  drawing  (for  example,  auxiliary  lines),  you  can
select not to print this information. In this case, the layer’s objects are shown on the
screen,  but  they  will  not  be  printed.  Therefore,  you  don’t  have  to  erase  the  data
before printing.

How to make a layer Printable/Non printable

1.Open the Layers management window. 

2.Select  the  fields    of  the  layers  that  you  want  to  make  printable  or  non
printable.

3.Double-click on the Printable field.

4.When you have finished, click the exit button  to close the management  window
and return to the main screen.

Checking the Layers’ Selectability

You  may  often  want to  edit  objects in specific  layers,  while  viewing  the  objects  of
other layers that cannot be edited. You cannot  edit  or  select  the  objects of  a non-
selectable layer, but the objects are visible when the layer is visible.

It is possible to use the snap feature on  objects of  a non-selectable  layer.  You  can
make a layer non selectable, non visible and  non  printable.  You  can also  change the
color, the line width and the other main properties.

How to make a layer Selectable/Non selectable

1.Open the Layers management window.

2.Select  the  fields   of  the  layers  that  you  want  to  make  selectable  or  non
selectable.

3.Double-click on the Selectable field.

4.When you have finished, click the exit button  to close the management  window
and return to the main screen.

Assigning Color to a Layer

You  can  assign  a  color  to  a  layer  from  the  management  window  of  the  Layers
command. 

How to assign a color to a layer

1.Open the Layers management window.
2.Select a layer and click on the respective color field.
3.Select  one of  the  colors  available  in the  drop-down  list  of  the  Color  property,  or

select Other … to define a new color.

4.When you have finished, click the exit button  to close the management  window
and return to the main screen.

Assigning the Line Type to a Layer

Every line type presents the visual information in a different way. A line type can be a
continuous  line  or  a repeated pattern of  dashes,  dots  and  spaces,  enabling  you  to
distinguish the role of a line. The name and the definition of the line type describe the
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specific sequence of characters, the relevant sizes and their characteristics.

How to assign a line type to a layer

1.Open the Layers management window.
2.Select a layer and click on the respective field of the Line type property.
3.From the drop-down list of the Line type  property,  select  one of  the  available  line

types.

4.When you have finished, click the exit button  to close the management  window
and return to the main screen.

Assigning the Line Width to a Layer

The line width adds thickness to the objects that are drawn by using a specific line. All
drawing objects can be viewed thickened and  with  texts  both  on  the  screen and  on
the printout. By defining the line width for a layer or an object, you can simulate the
object’s width on the printout. By changing the width of objects and layers,  you can
enhance the presentation quality of your drawings.

How to assign a line width to a layer

1.Open the Layers management window. 
2.Select a layer and click on the respective field of the Line width property.
3.From  the  drop-down  list  of  the  Line  width  property,  select  one  of  the  available

widths.

4.When you have finished, click the exit button  to close the management  window
and return to the main screen.

Deleting a Layer

You can delete any layer, at any given time when processing a drawing. You cannot,
however, delete the Base layer. When a layer is deleted, its objects are transferred by
default to the base layer.

How to delete a layer

1.Open the Layers management window. 

2.Select the desired layer and click the  button.
3.Anadelta Tessera will prompt you to confirm  that  you wish  to  delete  the  layer,  by

showing you the relevant dialogue box.

4.When you have finished, click the exit button  to close the management  window
and return to the main screen.

Using the Layers’ Properties

When you draw  by using a layer,  it  is  recommended  that  the  default  properties  are
those of the layer. The objects whose  main  properties  have  the  Layer  value  acquire
the  properties  of  their  layer.  The  same  can apply  for  every  new object  that  will  be
created.  When  designing  in  this  way,  you  are  able  to  maintain  a  well-organized
drawing.

If  you want the  color,  the  line  type  or  the  line  width  of  a  particular  object  to  be
different than those of the layer, you can change the  properties  of  this  object.  The
properties  of  an  object  can  have  either  a  fixed  value  (e.g.  red  for  color)  or  the
respective value  of  the  layer.  In  the  first  case, the  object’s  value  prevails  over the
layer’s value.
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12.8 Object Import

Importing Drawing Objects from DXF files

If your drawing objects are available in digital form (DXF) and you wish to import them
into your design, you can do this anytime, either during the first stage of your design
or while editing your design, and for as many times as you wish.

You can import any drawing object (lines, circular arc, texts, etc.) from a DXF file. You
can also do this with the simultaneous import of  terrain  model  elements.  From a DXF
file  you  can  import  objects  such  as  line,  polyline,  circle,  arc,  ellipse,  elliptical  arc.
Regarding  their  main  properties,  the  imported  objects  maintain  their  original  layer,
which will be transferred to another layer.

How to import drawing objects from DXF files

1.From the File menu, select Import from Dxf and then run the Import Drawing from
DXF command.

2.From the dialogue box of the Open window, select the DXF file and click Open. After
the program has read the file, select, if necessary, zoom extents.

Importing Drawing Objects from ASCII files

By using the Import Drawing command, which is the first command of the Import from
ASCII submenu, you can import drawing lines from text files.

How to import terrain points from a text file

1.From  the  File  menu,  select  the  Import  from  ASCII  submenu  and  then  run  the
Drawing Data command. This command will be displayed in the menu only if you first
select the creation of a new file or open an existing one. From the dialogue box that
appears on the screen, select a terrain  point file  (such files  have  usually the  .RLN
extension).

2. From  the  Browse  field,  find  the  subfolder  where  your  file  is  located.  Select  the
desired file and click Open.

3.Confirm by clicking OK. The program reads the lines and imports them to the file. If a
problem  occurs  during the  file  transfer,  the  program will  display  the  relevant  error
message on the screen.
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12.9 Object Editing

There  is  only  one  way  to  edit  objects  in  the  Anadelta  Tessera  environment.  First
select  the  objects and  then  edit  them.  In this  section,  you will  learn how to  select
objects, how to view the selected objects on  the  screen,  how to  change their  main
properties, and how to carry out general and special editing operations.

Selection of Objects

For  the  lines  and  curves,  the  aforementioned  data  shall  apply.  For  the  drawing
objects, there are two additional methods of selection.

Filtering All Selected Objects

With the Batch Selection command,

you can select a set based on the common properties and the category of the drawing
objects.  For example,  you can select  simultaneously all  the  red  drawing  lines of  the
Horizontal Alignment, without selecting any other object, or, you can select all objects
except for these lines.

To create a set of selected objects based on the value of the Color, Line type or/and
Line width properties, you should first see whether the property has the Layer  value.
For example, an object can be black, either because its value in the Color property is
Black or because it has the Layer value and the value in the layer’s Color property has
been set to Black. 

How to create a set by using the Batch Selection command

1.From the Edit menu, select the Batch Selection command or press the Ctrl+A keys.
2. In the Objects group of the Batch Selection window, tick the respective check box

(es) to the left of every category of drawing objects that you wish to select. Note
that there are four categories of drawing objects: the lines (Lines  check  box),  the
circles that also include the circular arcs (Circles check box), the ellipses that  also
include the elliptical arcs (Ellipses check box) and the texts (Titles check box).

3. In  the  Selection  conditions  group,  define  the  selection  criteria  for  sorting  out  the
objects. This group includes all  of the identifiable properties of the drawing objects.
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To enable a selection condition, tick the relevant check box on its left.
4.Enter the property value by selecting it from the drop-down list to the right of  the

ticked box.
5.Click OK.

Anadelta Tessera selects all drawing objects that match the user-selected criteria and
closes the dialogue box of the Batch Selection command. 

By default, Anadelta Tessera creates a new set  of  selection.  To add  this  set  to  the
already selected  objects,  tick  the  preserve current  selection  check  box.  To  remove
this  set  from  the  already  selected  objects,  tick  the  remove  items  from  current
selection check box.

Select All

With the Select all command of the Edit menu, you can easily select all  visible objects
of the enabled modes. 

To select all objects of an enabled mode

From the Edit menu, run the Select all command or press the Shift+Ctrl+A keys.

Editing the Main Properties

In Anadelta Tessera you can edit  the  main  properties  of  the  drawing  objects in two
ways: either from the Object Properties toolbar or from the window of the  Properties
command.

Copy Objects

You can copy  one or  more  drawing  objects  in  your  current  file  or  from  one  file  to
another.

Copy Objects

With the Copy command, the objects are copied to Clipboard.

How to copy objects to Clipboard

1.Select the objects you wish to copy. 
2. From the Edit menu, select the Copy command or press the Ctrl+C keys, or click the

copy icon.

The  objects  are  copied  to  Clipboard.  The  reference  point  of  the  objects  is  the
intersection  point  of  the  diagonals  of  the  fictitious  box  that  contains  the  selected
object.  If  you want to  define  manually  the  reference  point  for  the  set  of  selected
objects, run the Copy with Basepoint command.

How to copy objects to Clipboard, by selecting the reference point

1.Select the objects you wish to copy. 
2. From the Edit menu, select the Copy with Basepoint command.
3.Set the reference point.

Cut Objects

With  the  Cut  command,  the  drawing  objects  are  deleted  from  the  current  file  and
transferred to Clipboard. 
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How to transfer objects to Clipboard

1.Select the objects you wish to cut. 
2. From the Edit menu, select the Cut command or press the Ctrl+X keys, or click the

cut icon.

Paste Objects

The objects that you copied or transferred to Clipboard can be imported again to the
same or to another file.

How to import objects from the Clipboard

From the Edit menu, select the Paste command or press the Ctrl+V keys, or click the
paste icon.

The objects in the Clipboard will be imported to the drawing. 

Moving Objects

When you move  objects,  the  objects are  moved  as  they  are,  without  any  changes
regarding  the  orientation  or  their  relative  positions  with  respect  to  each  other.  To
ensure the necessary accuracy, use the Input Form command or the snap feature.

How to move one or more objects simultaneously

1.Select the drawing objects you wish to move.
2.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Transformations submenu and then run the Move command.
3.Set the reference point.
4.Set the end point. 

Moving Drawing Objects with the Mouse

You can move certain categories of drawing objects by using the  points.  To do  this,
activate the center of a circle or a circular arc, of an ellipse or an elliptical arc, or the
insertion point of a text character.

How to move an object with the mouse

1.Select the drawing object you wish to move.
2.Activate the appropriate point. For texts and images, simply left click on them again.
3.Specify the new position of the point.

Moving Drawing Objects by Using the Coordinates

From  the  window  of  the  Properties  command,  you  can  move  categories  of  certain
drawing objects, such as circles or circular arcs, ellipses or elliptical arcs, images and
texts.  Simply  select  the  desired  object  and  open  the  window  of  the  Properties
command.  In  the  fields  of  the  Center  X  and  Center  Y  properties  for  the  curved
objects, and Text X and Text Y for texts and images, type the new coordinates of the
center point. The drawing objects will be offset, so that their centers are transferred
to the position indicated by the new coordinates.

Especially for texts and  images,  you can change the  value  of  the  Move property, in
order to move the letters or the image without offsetting the center point. The offset
is equal to the value that the user entered in the field, both for the X and  for  the  Y
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axis.

Object Rotation

To rotate the drawing objects, select a reference point and a rotation angle  towards
the horizontal direction. The objects always rotate in a counterclockwise direction. 

How to rotate an object

1.Select the drawing objects you wish to rotate.
2.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Transformations submenu and then run the Rotate command.
3.Set the reference point. 
4.Set the rotation angle either by specifying a point on the screen, or by entering the

angle with the use of the Input Form command.

Rotation of Texts, Ellipses or Images

From the window of the Properties command, you can rotate texts, ellipses or images.
Simply select the text or the ellipse that you wish to rotate and open the  window  of
the Properties command. In the Text Angle or Angle field, type the horizontal rotation
angle (the rotation direction is counterclockwise and the angle is entered in degrees).
The text or the ellipse or the image will rotate around its center.

Changing the Size and Shape of Objects

You can scale up or down a set of selected objects, while preserving their proportions
with  respect  to  each  other.  To  scale  the  objects  up  or  down,  specify  a  reference
point and a length, which will be used as the scale coefficient, or  enter  the  value  of
the coefficient. 

How to change the size of the selected objects

1.Select the drawing objects you wish to scale up or down.
2.From the shortcut menu that is displayed if you right-click in the drawing area, open

the Transformations submenu and run the Scale command.
3.Set the reference point. 
4.Set the scaling percentage either by specifying a point on the screen or  by typing

the percentage value (e.g. “200” for double size) with  the  use of  the  Input  Form.
When you define a point on  the  screen,  Anadelta  Tessera  calculates  the  distance
between the reference point and the user-defined point;  the  scaling percentage is
the one tenth (1/10) of this distance.

Obviously, to scale up an object, you must enter a percentage higher than 100, while
to scale down an object you must enter a percentage lower than 100.

Changing the Size of Circles

To make a circle bigger or smaller, activate a point on its circumference and specify a
new position for this point. When you move this point, the circle radius is increased or
decreased accordingly,  but  the  center  of  the  circle  remains  fixed.  You  can  do  the
same from the dialogue box of  the  Properties  command.  Simply  select  the  circle  and
open the window. Type the new value in the field of the Radius command. 

Changing the Shape of an Ellipse

To change the  lengths of  an  ellipse’s  axis,  activate  a point on  the  circumference of
the ellipse and specify a new position  for  this  point.  When  you move  this  point,  the
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ellipse  radii  are  increased  or  decreased  accordingly,  but  the  center  of  the  ellipse
remains fixed. You can do the same from the dialogue box of the Properties command.
Simply select the ellipse and open  the  window. Type  the  new values in the  fields  of
the X Radius and Y Radius properties.

Changing the Shape of Circular and Elliptical Arcs

To change the shape of an arc, activate a point on the circumference of the arc and
specify  a new position  for  this  point.  When  you  move  this  point,  the  arc  radius  is
increased or decreased, and the arc center also changes accordingly. You can do the
same for  the  circular  arcs from the  dialogue  box of  the  Properties  command. Simply
select  the  circular  arc  and  open  the  Properties  window. Type  the  new value  in  the
field  of  the  Radius  command. The  arc  will  be  drawn  again,  so  that  its  center  point
remains fixed and the positions of the  three  points  of  the  arc’s  circumference match
the new radius value.

Deleting Objects

You can delete all of the selected objects. 

To delete all the selected objects

1.Select the drawing objects you wish to delete.
2.From the Edit menu, select the Delete command, or press the Del key, or  click  the

 icon.

You  can do  the  same  by  selecting  the  Delete  objects  command  from  the  shortcut
menu that appears when you right-click in the drawing area.

How to delete all drawing points

From  the  File  menu,  select  the  Delete  submenu  and  then  run  the  Drawing  Data
command. 
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12.10 Editing Lines

The program offers some additional editing features  regarding the  position  and  shape
of the drawing lines.

To edit a drawing line

1.Select the drawing line you wish to edit. 
2. From the shortcut menu that is displayed when you right-click in the drawing area,

select the desired editing command.

Mirroring Drawing Lines

You can mirror the drawing  lines,  either  by the  horizontal  or  by the  vertical  axis,  by
specifying an axis point. The original object will be deleted.

How to mirror drawing lines

1.Select the drawing lines you wish to mirror.
2. From the shortcut menu that displayed if you right-click in the drawing area, select

the  Transformations  submenu  and  run  the  Mirror  (X  axis)  or  Mirror  (Y  axis)
command, depending on the desired direction.

3.Specify the point through which the horizontal or the vertical mirroring axis will pass.

Breaking Drawing Lines

You can break a drawing line into one or more objects. The line can be broken only at
certain of its peaks – points.

Breaking Drawing Lines in Straight Segments

You can break a drawing  line  in smaller  lines;  each  of  these  lines will  have  only  two
points.

How to break drawing lines into straight segments

1.Select the drawing lines you wish to break.
2.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Tools submenu and then run the Break in segments command.

Breaking a Drawing Line in Two Lines

You can break a drawing line in two individual lines based on a reference point.

How to break a drawing line in two

1.Select the drawing line you wish to break.
2.Select the appropriate point.
3. From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Tools submenu and then run the Break at point command.

The line will be broken in two segments. The  selected  point will  become the  start  of
one line and the end of the other line.

Editing Drawing Line Points

You can delete or move the points of a line. You can also add points to a drawing line.
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Deleting a Drawing Line Point

You can delete one or more points of a drawing line.

How to delete a drawing line point

1.Select the drawing line you wish to edit.
2.Select the point you wish to delete.
3.From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Delete Point command.

Offsetting a Drawing Line Point

You can offset the points of a drawing line, in order to give the line the desired shape.

How to offset a drawing line point

1.Select the drawing line you wish to edit.
2.Activate the point you wish to move.
3.Specify the new position of the point.

Batch Move of Drawing Line Points

From  the  Points  property  of  the  Properties  command,  you  can  change  the  points’
positions simultaneously.

How to move simultaneously the points of a drawing line 

1.Select  the  drawing  line  you
wish to edit.

2. From  the  shortcut  menu  that
appears  if  you  right-click  in
the  drawing  area,  open  the
window  of  the  Properties
command.  In the field  of  the
Points  property,  click  the

three-dot button , which is
located  to  the  right  of  the
field.  The  window  of  the
Points  List  command  appears
on  the  screen.  This  window
has  two  columns,  which
correspond  to  the  X  and  Y
coordinates.  Every  row
corresponds to a line point.

3.Change  the  values  in  the
desired  fields  by  typing  the
new coordinates. 

4.Click OK.

Inserting a Drawing Line Point

You can insert one or more points to a drawing line. 

How to insert points to a drawing line 
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1.Select the drawing line you wish to edit.
2.Select the point before or after the point you wish to insert. 
3. From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select Extend towards start  or  Extend  towards end,  depending on  which  direction
you wish to insert the new point. The order of the points is the same as the order in
which they were inserted.

4.Specify the position of  the  new point.  Continue  with  the  next point.  To finish  the
point insertion procedure, click the right mouse button or press the Esc key.

Converting Drawing Lines

You can convert a drawing line into a breakline, a road tangent or a diagram. 

How to convert a drawing line

1.Select the drawing line you wish to convert.
2. From  the  shortcut  menu  that  is  displayed  if  you  right-click  in  the  drawing  area,

select the Convert submenu and then select the desired  conversion,  i.e.  breakline,
road, existing road diagram or generic use diagram.

Please keep in mind that in order for a line to be converted to a breakline, all  points of
the line must coincide with terrain points, while in order for a line to be converted to a
diagram, there should be at least one road in your project. In the case  of  more than
one  road,  the  program will  display  a dialogue  box and  you must select  the  road  for
which the diagram will be created.
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12.11 Data Export

Exporting Drawing Data to a Text File

You can create a file that will contain the drawing lines of your project.

How to export the drawing objects to an ASCII file

1.From the File menu, select the Export to ASCII submenu and run the  Drawing  Data
command.

2.Specify the path and the name for the file you wish to save. The terrain points will
be exported to a file with the .RLN extension.

3.Click OK to create the file.
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